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Nuove funzionalita

L'elenco che segue contiene le principali novita e miglioramenti in WaveLab Elements e fornisce i
link alle descrizioni corrispondenti.

Nuove funzionalita nella versione 11.2.0

Tratto di matita morbido

° Un nuovo metodo di correzione degli errori che consente di rimuovere piccoli click dal
materiale audio tracciando una linea per sostituire il campione danneggiato. Vedere
Scheda Processa.

Nuove funzionalita nella versione 11.0.0

In evidenza

File audio multicanale interlacciati

° Wavelab Elements supporta adesso i file audio multicanale interlacciati con configurazione
dei canali fino a 5.1. Vedere File audio multicanale.

Supporto per le funzionalita multicanale nei montaggi audio

° Wavelab Elements supporta adesso le funzionalita multicanale nei montaggi audio. Vedere
Operazioni multicanale nel montaggio audio.

Ducking

° Il ducking consente di controllare il livello di una traccia audio con un‘altra traccia audio.
Questa funzionalita viene comunemente utilizzata per controllare il livello della musica di
una traccia con il livello della voce su un‘altra traccia. Vedere Ducking delle tracce.

Pulizia e miglioramento delle tracce

° La finestra dell'Inspector consente adesso di pulire e migliorare la qualita delle proprie
tracce. Per pulire 'audio possono essere utilizzati i plug-in DeEsser, DeNoiser e
DeHummer. I plug-in Voice Exciter, Reverb, EQ e Maximizer consentono invece di
migliorare la qualita del materiale audio. Vedere Finestra dell'Inspector.

Registrazione di tracce singole o multiple nel montaggio audio

° E possibile adesso registrare una o piu tracce direttamente nel montaggio audio. Wavelab
Elements rileva automaticamente i bus di ingresso della propria periferica ASIO disponibili
e crea i bus di ingresso stereo e mono. Vedere Registrazione nella finestra Montaggio
audio.

Monitoraggio in ingresso

° E possibile adesso monitorare il segnale in ingresso nel montaggio audio. Questo consente
di ascoltare I'effetto che la propria configurazione di WavelLab Elements ha sul segnale in
ingresso. Vedere Monitoraggio in ingresso.

Monitoraggio diretto

° La funzione di monitoraggio diretto consente di monitorare il segnale in ingresso con una
latenza inferiore. Se 'opzione Monitoraggio diretto € attivata, il segnale in ingresso viene
monitorato direttamente senza passare attraverso il montaggio audio e i rispettivi effetti.
Vedere Monitoraggio diretto.




Nuove funzionalita

Altre novita

Sostituzione dell'audio nel video

° E possibile adesso sostituire la traccia audio di un video con un altro file audio. Vedere
Sostituzione dell'audio nel video.

Pubblicazione diretta dei podcast attraverso i servizi di hosting di podcast

° Wavelab Elements consente adesso di caricare direttamente i propri podcast sui servizi di
hosting di podcast. Vedere Podcast.

DeEsser

° DeEsser € un tipo speciale di compressore che riduce le sibilanti eccessive, principalmente
per le registrazioni vocali. Il plug-in & descritto nel dettaglio nel documento separato
Riferimento dei plug-in.

EnvelopeShaper

° EnvelopeShaper puo essere utilizzato per attenuare o enfatizzare il guadagno della fase di
attacco e dirilascio del materiale audio. Il plug-in e descritto nel dettaglio nel documento
separato Riferimento dei plug-in.

Expander

° Expander riduce il livello in uscita in relazione al livello in entrata per i segnali al di sotto
del valore soglia definito. Questo effetto & particolarmente utile se si desidera enfatizzare
I'intervallo dinamico o ridurre il rumore nei passaggi silenziosi. Il plug-in & descritto nel
dettaglio nel documento separato Riferimento dei plug-in.

Maximizer

° Maximizer consente di aumentare l'intensita acustica del materiale audio senza rischio
di clipping. Il plug-in & descritto nel dettaglio nel documento separato Riferimento dei
plug-in.

Mix6to2

° Mix6to2 consente di eseguire rapidamente il mixdown in stereo di un formato mix
surround. Il plug-in e descritto nel dettaglio nel documento separato Riferimento dei
plug-in.

MonoToStereo

° MonoToStereo trasforma un segnale mono in un segnale pseudo-stereo. Il plug-in puo
essere utilizzato su un file mono o su un file stereo con canali uguali. Il plug-in & descritto
nel dettaglio nel documento separato Riferimento dei plug-in.

PingPongDelay

° PingPongDelay ¢ un effetto delay stereo che alterna ciascuna ripetizione del delay tra
i canali sinistro e destro. Il plug-in e descritto nel dettaglio nel documento separato
Riferimento dei plug-in.

Finestra Timecode

° La finestra Timecode consente di visualizzare la durata registrata, lo scostamento
temporale rispetto a diverse posizioni e i colori dinamici in base al contesto. Vedere
Finestra Timecode.

Normalizzatore dell'intensita acustica
° E possibile utilizzare il Normalizzatore dell'intensita acustica per ottenere un valore di
intensita acustica specifico. Vedere Normalizzatore dell'intensita acustica.

Processamento multi-core per i montaggi audio

° Wavelab Elements supporta adesso il processamento multi-core per i montaggi audio.
Questo consente di eseguire un processamento piu rapido dei montaggi audio con piu
tracce, clip ed effetti. Il segnale audio in WavelLab Elements viene processato come segue:
le clip per prime, poi le tracce, quindi i gruppi di clip, processati ciascuno in parallelo.



Nuove funzionalita

Successivamente, viene processata l'uscita. Se si sta utilizzando la Sezione Master, questa
viene processata per ultima. Vedere Montaggio audio.

Arresto della registrazione quando la posizione di registrazione raggiunge il
marker successivo

° L'opzione Arresta quando la posizione di registrazione raggiunge il marker successivo
consente adesso di arrestare automaticamente la registrazione quando la posizione di
registrazione raggiunge il successivo marker visibile del montaggio. I marker nascosti non
vengono tenuti in considerazione. Vedere Area dei controlli delle tracce stereo e mono.

Numero di tracce del montaggio audio aumentate a 15

° E possibile adesso aggiungere 15 tracce ai montaggi audio. Vedere Tracce.

Assegnazione delle tracce

° E possibile adesso assegnare i canali del montaggio audio ai canali di uscita del montaggio.
Vedere Finestra di dialogo Assegnazione delle tracce.

Intervalli di selezione su tracce multiple

° E possibile adesso definire degli intervalli di selezione su pil tracce per le operazioni di
copia/incollaggio nella finestra del Montaggio audio. Vedere Intervalli di selezione nei
montaggi audio.

Lin One Dither

° Lin One Dither & un plug-in di dithering dotato di funzioni di noise shaping supplementari
per aumentare il rapporto segnale-rumore apparente mediante l'alterazione dello spettro
del segnale audio a basso livello. Lin One Dither é stato aggiunto a WavelLab Elements. II
plug-in e descritto nel dettaglio nel documento separato Riferimento dei plug-in.

Analizzatore di fase

° L'Analizzatore di fase indica la relazione di fase e ampiezza tra due canali stereo. Vedere
Analizzatore di fase.

Spettrometro

° Lo Spettrometro utilizza le tecniche FFT (Fast Fourier Transform - Trasformata di Fourier
veloce) per visualizzare un grafico della frequenza, fornendo un’analisi della frequenza in
tempo reale precisa e dettagliata. Vedere Spettrometro.

Bit-meter

° II Bit-meter indica il numero di bit utilizzati. Vedere Bit-meter.

Ondoscopio

° L'Ondoscopio consente di visualizzare una forma d’onda in tempo reale che mostra
graficamente il segnale audio in corso di monitoraggio. Vedere Ondoscopio.

L'editor dei podcast si chiama adesso «Feed RSS»

° L'Editor dei podcast € stato potenziato e rinominato Feed RSS. Vedere Editor dei feed RSS.

Da ultimo, ma non meno importante

Nomi personalizzati per le porte audio

° E possibile adesso specificare dei nomi personalizzati per le porte audio nella scheda
Connessioni audio. Vedere Definizione di nomi personalizzati per le porte audio.

Invio dei flussi audio di file mono a un altoparlante dedicato

° E possibile specificare un altoparlante dedicato a cui inviare il flusso audio dei file mono.
Vedere Invio dei flussi audio di file mono a un altoparlante dedicato.

Potenziamento della finestra di dialogo di avvio

° La finestra di dialogo Avvio é stata potenziata. Vedere Finestra di dialogo Awvio.
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Spostamento della selezione verso sinistra o verso destra

° E possibile adesso spostare una selezione della propria lunghezza verso sinistra o verso
destra. Vedere Selezione di un intervallo audio in un file audio.

Definizione della modalita di selezione dei canali

° La modalita di selezione dei canali consente di alternare la selezione di tutti i canali e la
selezione dei singoli canali quando si fa clic e trascinamento nella finestra della forma
d'onda. Vedere Selezione dei canali nei file audio.

Preset degli effetti predefiniti

° E possibile salvare le impostazioni dei parametri degli effetti per i plug-in VST 3 e VST 2
come preset degli effetti predefiniti. Vedere Salvataggio dei preset predefiniti per i plug-in
VST.

Inserimento delle note nei modelli dei montaggi audio

° E possibile adesso includere le note che sono state scritte nella finestra Note quando si
crea un modello di un montaggio audio basato su un montaggio audio. Vedere Finestra di
dialogo Modelli dei montaggi audio.

Riproduzione di file multicanale su altoparlanti stereo

° Se il proprio sistema audio consiste in un numero di altoparlanti inferiore rispetto ai canali
audio del file audio multicanale, & possibile assegnare diversi altoparlanti alla stessa porta
audio per riprodurre ad esempio il file multicanale su degli altoparlanti stereo. Vedere
Riproduzione di file multicanale.

L'indicatore di picco delle tracce del montaggio visualizza i canali stereo sinistro e
destro

° L'indicatore di picco delle tracce nel montaggio audio visualizza adesso il livello del
volume per il canale sinistro e destro delle tracce stereo in maniera indipendente. Vedere
Indicatore di picco delle tracce.

Ancora piu opzioni per le selezioni temporali nel montaggio audio

° E disponibile adesso un numero maggiore di opzioni per la creazione e l'estensione delle
selezioni temporali nei montaggi audio, all'interno del menu a tendina Estendi nella
sezione Selezione temporale della scheda Modifica. Vedere Scheda Modifica (Montaggio
audio).

Inserimento di file audio stereo in tracce mono o viceversa

° Quando si inserisce un file audio stereo in una traccia mono & possibile decidere di creare
automaticamente una traccia stereo o suddividere il file stereo in due tracce mono. Vedere
Inserimento di file audio stereo in tracce mono o viceversa.

Eliminazione di selezioni delle clip

° E possibile adesso eliminare un intervallo di selezione allinterno di una clip. Vedere
Eliminazione di parti delle clip all'interno degli intervalli di selezione.

Miglioramento dei metodi di aggiunta dei punti curva degli inviluppi

° Sono adesso disponibili delle possibilita supplementari per I'aggiunta di punti curva multipli
degli inviluppi. Vedere Aggiunta dei punti curva degli inviluppi.

Visualizzare/nascondere i pannelli nella finestra dell'Inspector

° E possibile visualizzare o nascondere i pannelli nella finestra dell'Inspector per focalizzarsi
esclusivamente sui pannelli desiderati. Vedere Visualizzare/nascondere i pannelli nella
finestra dell'Inspector.

Annullamento delle attivita in background tramite le scorciatoie da tastiera

° E possibile adesso premere Alt/Opt-. sulla tastiera del computer per annullare i processi
di renderizzazione in esecuzione in background. Vedere Annullamento delle attivita in
background.



Nuove funzionalita

Limitazione del ridimensionamento per valori DPI elevati ai multipli di 100

° L'opzione Limita la scala ai multipli di 100 consente di decidere se il fattore di scala deve
essere in multipli di 100 o se sono ammessi valori intermedi. Vedere Scheda Visualizzazione
(Preferenze globali).
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Introduzione a WavelLab
Elements

Documentazione indipendente dalla piattaforma

La presente documentazione € relativa ai sistemi operativi Windows e macOS.

Le funzioni e le impostazioni che sono specifiche per una di queste piattaforme sono indicate in
maniera chiara. In tutti gli altri casi, le descrizioni e le procedure riportate nella documentazione
sono valide sia per Windows che per macOS.

Alcuni aspetti da tenere in considerazione:

e Gli screenshot sono stati presi da Windows.

e Alcune funzioni disponibili nel menu File in Windows sono disponibili nel menu del nome del
programma in macOS.

Guida online

Sono disponibili diverse modalita per accedere alla guida online. La documentazione e
disponibile online sul portale steinberg.help. La maggior parte del materiale qui disponibile puo
anche essere scaricata in formato PDF.

Documentazione
La documentazione di riferimento € costituita da diversi manuali.
Per visitare la pagina steinberg.help, eseguire una delle sequenti operazioni:

e Digitare www.steinberg.help nella barra degli indirizzi del proprio browser internet.
e Nel programma, selezionare Aiuto > steinberg.help.

e Windows: Per aprire la sezione di aiuto per una finestra di dialogo attiva su steinberg.help,
fare clic sullicona a forma di punto di domanda nella barra del titolo per visualizzare il
pulsante Guida, quindi fare clic sul pulsante Guida, oppure premere F1.

e macOS: Per aprire la sezione di aiuto per una finestra di dialogo attiva su steinberg.help,
fare clic sullicona a forma di punto di domanda nella finestra di dialogo per visualizzare il
pulsante Guida e fare clic sul pulsante Guida, oppure premere Cmd-?.

Manuale operativo

Si tratta del documento di riferimento principale di WaveLab Elements che contiene
le descrizioni dettagliate delle operazioni, dei parametri, delle funzioni e delle diverse
tecniche di utilizzo del programma.

Riferimento dei plug-in
Descrive le funzionalita e i parametri dei plug-in inclusi.

DDP Player
Descrive le funzionalita e le funzioni del DDP Player incluso.

11
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Introduzione a WavelLab Elements
Convenzioni tipografiche

Descrizioni comando

e Pervisualizzare le descrizioni comando, spostare il mouse su un’icona dell'interfaccia.
e Per utilizzare la guida del menu, spostare il mouse su una voce del menu.

e Pervisualizzare le informazioni sul tipo di modifica da eseguire durante I'utilizzo di mouse
e tasti di modifica nella finestra Montaggio audio, spostare il mouse sulla finestra del
montaggio. Il testo della sezione di guida viene visualizzato nella linea info nella parte
inferiore della finestra.

Modalita ‘Cos &?’

La modalita Cos & fornisce delle descrizioni comando estese relativamente alle icone e
alle funzioni dell'interfaccia utente. Alcune descrizioni comando di tipo Cos &? includono un
collegamento a un argomento della guida dedicato su steinberg.help.

Per aprire la modalita Cos &€?, eseguire una delle sequenti operazioni:

e Inunafinestra qualsiasi, premere Shift-F1 e spostare il mouse su un elemento
dellinterfaccia, o selezionare Guida > Cos €?.

e Inuna finestra di dialogo, selezionare l'icona a forma di punto di domanda su qualsiasi barra
del titolo (Windows) o nella finestra di dialogo (macOS) e spostare il mouse su un elemento
dell'interfaccia o su un‘opzione del menu.

LINK CORRELATI
Linea info a pag. 227

Convenzioni tipografiche

Nella presente documentazione vengono utilizzati elementi strutturali e di markup per
presentare le informazioni in base al relativo scopo.

Elementi strutturali

Prerequisiti
Descrivono le azioni da completare o le condizioni da soddisfare prima di poter avviare
una procedura.

Procedimento
Elenca i passaggi da seguire per ottenere uno specifico risultato.

Importante

Fornisce informazioni in merito a situazioni o casi specifici che potrebbero avere effetti
vari sul sistema, sulle unita hardware collegate, o che potrebbero causare un rischio di
perdita di dati.

Nota
Fornisce informazioni riguardo ad alcuni aspetti che & utile prendere in considerazione.

Suggerimento
Aggiunge informazioni supplementari o suggerimenti utili.

Esempio
Riporta un esempio.

Risultato
Descrive il risultato di una procedura.
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Introduzione a WavelLab Elements
Convenzioni tipografiche

Dopo il completamento di questa operazione
Fornisce informazioni riguardo alle azioni o ai processi da eseguire a seqguito del
completamento della procedura.

Link correlati
Riporta un elenco degli argomenti correlati che & possibile trovare all'interno della

documentazione.
Markup

Il testo in grassetto indica il nome di un menu, un‘opzione, una funzione, una finestra di dialogo,
una finestra, e cosi via.

ESEMPIO
Nel Montaggio audio, fare clic su Modifica.

Se il testo in grassetto e separato da un simbolo ‘maggiore di', cio indica una sequenza di diversi
menu da aprire.

ESEMPIO
Selezionare File > Preferenze > Connessioni audio.

I nomi dei file e i percorsi d'accesso alle cartelle sono visualizzati con un carattere diverso.

ESEMPIO
example_file.txt

Elementi tipografici
I seguenti elementi tipografici contrassegnano le diverse fasi e situazioni descritte di seguito.

Prerequisiti
Indicano le azioni da completare o le condizioni da soddisfare prima di poter avviare
una procedura.

Procedimento
Elenca i passaggi da seguire per ottenere uno specifico risultato.

Importante

Fornisce informazioni in merito a situazioni o casi specifici che potrebbero avere effetti
vari sul sistema, sulle unita hardware collegate, o che potrebbero causare un rischio di
perdita di dati.

Nota
Fornisce informazioni riguardo ad alcuni aspetti che & utile prendere in considerazione.

Suggerimento
Aggiunge informazioni supplementari o suggerimenti utili.

Esempio
Riporta un esempio.

Risultato
Mostra il risultato di una procedura.
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Introduzione a WavelLab Elements
Comandi da tastiera

Markup

Dopo il completamento di questa operazione

Fornisce informazioni riguardo alle azioni o ai processi da eseguire a seqguito del
completamento della procedura.

Link correlati

Riporta un elenco degli argomenti correlati che & possibile trovare all'interno della
documentazione.

Il testo in grassetto indica il nome di un menu, un‘opzione, una funzione, una finestra di dialogo,
una finestra, ecc.

ESEMPIO
Per aprire la finestra di dialogo Metadati, aprire la finestra Metadati e fare clic su Modifica.

Se il testo in grassetto e separato da un simbolo di maggiore, significa che e presente una
sequenza di diversi menu da aprire.

ESEMPIO
Selezionare File > Apri.

Comandi da tastiera

Molti dei comandi da tastiera predefiniti, altrimenti noti come scorciatoie da tastiera, fanno uso
dei tasti modificatori, alcuni dei quali sono specifici per ciascun sistema operativo.

Ogni volta che nel presente manuale sono descritti i comandi da tastiera con dei tasti
modificatori, viene indicato per primo il tasto modificatore di Windows, seguito dal tasto
modificatore di macOS e quindi dal comando da tastiera.

ESEMPIO
Ctrl/Cmd - Z significa: premere Ctrl in Windows o €Cmd in macOS, quindi premere Z.
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Configurazione del sistema

Prima di iniziare a lavorare, & necessario definire alcune impostazioni.
IMPORTANTE

Prima di eseguire qualsiasi collegamento, assicurarsi che tutte le apparecchiature siano spente.

LINK CORRELATI
Collegamento delle apparecchiature a pag. 15
Definizione delle connessioni audio a pag. 17

Collegamento delle apparecchiature

La configurazione del proprio sistema dipende da molti fattori diversi: ad esempio dal tipo di
progetto che si desidera creare, dalle apparecchiature esterne utilizzate o dall'hardware installato
nel computer.

Schede audio e riproduzione in background

Latenza

Quando si attiva la riproduzione o la registrazione in WavelLab Elements, la altre applicazioni non
possono accedere alla scheda audio. Allo stesso modo, se un‘altra applicazione utilizza la scheda
audio, non é possibile eseguire la riproduzione con WavelLab Elements.

E possibile esequire WavelLab Elements insieme ad altre applicazioni e consentire sempre alle
applicazioni attive l'accesso alla scheda audio.

PROCEDIMENTO

1. Selezionare File > Preferenze > Connessioni Audio.
2. Selezionare la scheda Opzioni.

3. Attivare l'opzione Rilascio del driver.

4. Eseguire una delle sequenti operazioni:

e Sesidesiderarilasciare il driver quando WavelLab Elements € in background, attivare
l'opzione Quando WaveLab Elements € in background.

e Sesidesidera rilasciare il driver quando Cubase/Nuendo sono in primo piano, attivare
'opzione Quando Cubase/Nuendo sono in primo piano.

LINK CORRELATI
Scheda Connessioni audio a pag. 18

La latenza ¢ il tempo che trascorre tra il momento in cui l'audio viene inviato dal programma e
il momento in cui esso viene realmente percepito dall'ascoltatore. Se lavorare con una latenza
molto bassa puo essere di fondamentale importanza in un’applicazione DAW che opera in tempo
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Configurazione del sistema

ASIO-Guard

reale come Nuendo o Cubase di Steinberg, la stessa cosa non & sempre valida per Wavelab
Elements.

Quando si lavora con WaveLab Elements, gli aspetti piu rilevanti riguardano la stabilita e la
qualita della riproduzione, nonché la precisione delle modifiche.

La latenza in un sistema audio dipende dalle unita hardware audio utilizzate, dai relativi driver
e dalle impostazioni definite. In caso di interruzioni del flusso audio, scricchiolii o discontinuita
durante la riproduzione, aumentare il valore del parametro ASIO-Guard nella scheda Opzioni
della sezione Connessioni audio, oppure incrementare la dimensione del buffer nel pannello di
controllo ASIO, specifico per la scheda audio utilizzata.

LINK CORRELATI
ASIO-Guard a pag. 16
Scheda Connessioni audio a pag. 18

ASIO-Guard

La funzione ASIO-Guard consente di pre-processare tutti i canali, oltre ai plug-in VST. Il suo
utilizzo permette di ridurre le interruzioni del flusso audio e di processare un numero di tracce o
di plug-in maggiore.

Valori elevati della funzione ASIO-Guard aumentano la latenza ASIO-Guard. Questo si manifesta
ad esempio quando, muovendo un fader del volume, la variazione del parametro viene udita con
un leggero ritardo.

NOTA

I plug-in di ricampionamento e determinati altri plug-in caratterizzati da latenze elevate
accumulano i campioni prima di processarli. Questa funzionalita richiede valori ASIO-Guard
elevati.

LINK CORRELATI
Configurazione della funzione ASIO-Guard a pag. 16

Configurazione della funzione ASIO-Guard

E possibile specificare la lunghezza del buffer ASIO-Guard.

PROCEDIMENTO
1. Selezionare File > Preferenze > Connessioni audio.
2. Fare clic sulla scheda Opzioni.

3. Nel menu ASIO-Guard, specificare la lunghezza del buffer ASIO-Guard.

Piu alto e il livello, maggiori saranno la stabilita e le prestazioni del processamento audio.
Tuttavia, livelli elevati causano anche un aumento della latenza ASIO-Guard e del consumo di
memoria.

LINK CORRELATI
Scheda Connessioni audio a pag. 18
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Definizione delle connessioni audio

Definizione delle connessioni audio

Per poter riprodurre e registrare un file audio in WavelLab Elements, & necessario specificare in
che modo i canali di ingresso e uscita in WavelLab Elements sono connessi alla scheda audio e
quale dispositivo si intende utilizzare per la riproduzione e la registrazione audio.

E possibile definire le impostazioni dei buffer per il proprio dispositivo. E necessario selezionare
almeno due canali per la riproduzione e la registrazione stereo.

Se non si dispone di schede audio di terze parti, € possibile selezionare il driver Generic Low
Latency o le opzioni Built-in Audio (solo macOS). Con la maggior parte delle schede audio di
terze parti pud anche essere utilizzato il driver Generic Low Latency. Questo offre il vantaggio di
poter eseguire la registrazione e la riproduzione a diverse frequenze di campionamento.

LINK CORRELATI

Selezione di un driver audio a pag. 17
Scheda Connessioni audio a pag. 18
Registrazione a pag. 271

Selezione di un driver audio

La selezione di un driver audio consente a WaveLab Elements di poter comunicare con l'unita
hardware audio collegata.

NOTA

Sui sistemi operativi Windows, si consiglia di accedere alla propria unita hardware utilizzando un
driver ASIO progettato in maniera specifica per quella periferica. Se non ¢ installato alcun driver
ASIO, contattare il produttore della propria unita hardware per maggiori informazioni sui driver
ASIO disponibili. Se non & disponibile alcun driver ASIO specifico, & possibile utilizzare il driver
ASIO generico a bassa latenza (Generic Low Latency ASIO driver).

PROCEDIMENTO
1. Selezionare File > Preferenze > Connessioni audio.
2. Aprire il menu a tendina Periferica audio e selezionare il proprio driver.

3. Facoltativo: fare clic su Pannello di controllo e regolare le impostazioni desiderate.

LINK CORRELATI

Scheda Connessioni audio a pag. 18

Driver ASIO a pag. 17

Selezionare il driver ASIO generico a bassa latenza (solo Windows) a pag. 18

Driver ASIO

Audio Stream Input/Output (ASIO) € un protocollo di driver per dispositivi del computer per
audio digitale specificato da Steinberg. Il protocollo ASIO fornisce un'interfaccia a bassa latenza e
ad alta fedelta tra un'applicazione software e la scheda audio di un computer.

LINK CORRELATI

Selezione di un driver audio a pag. 17
Selezionare il driver ASIO generico a bassa latenza (solo Windows) a pag. 18
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Configurazione del sistema
Definizione delle connessioni audio

Selezionare il driver ASIO generico a bassa latenza (solo Windows)

Se non & disponibile alcun driver ASIO specifico, & possibile utilizzare il driver ASIO generico a
bassa latenza (Generic Low Latency ASIO driver).

NOTA

La documentazione relativa al driver ASIO generico a bassa latenza si trova alla seguente
posizione: C:\Program Files\Steinberg\Asio\Help

PROCEDIMENTO
1. Selezionare File > Opzioni > Connessioni audio.
2. Aprire il menu a tendina Periferica audio e selezionare Generic Low Latency ASIO Driver.

3. Facoltativo: fare clic su Pannello di controllo e regolare le impostazioni desiderate.

LINK CORRELATI
Selezione di un driver audio a pag. 17
Scheda Connessioni audio a pag. 18

Scheda Connessioni audio

Questa scheda consente di specificare in che modo i bus di ingresso e uscita in WavelLab
Elements sono collegati alla scheda audio e di decidere quale dispositivo utilizzare per la
riproduzione e la registrazione dell'audio.

e Per aprire la scheda Connessioni audio, selezionare File > Preferenze > Connessioni audio.

Impostazioni globali

Periferica audio
Consente di selezionare la periferica audio da utilizzare per la riproduzione e la
registrazione dell'audio. Se non si dispone di una scheda audio di terze parti, &
possibile selezionare il driver Generic Low Latency o le opzioni Built-in Audio (solo
macOS).

Nomi delle porte

Apre la finestra di dialogo Nomi delle porte audio in cui € possibile specificare dei
nomi personalizzati per ciascuna porta di ingresso e uscita audio.

Pannello di controllo
Quando si seleziona un driver ASIO, il pulsante del Pannello di controllo é attivo. Fare
clic sul pulsante per aprire l'applicazione delle impostazioni relative alla scheda audio,
solitamente installata con la scheda audio stessa. A seconda della scheda audio e del
relativo driver, tale applicazione fornisce le impostazioni per le dimensioni del buffer, i
formati digitali, i collegamenti I/0O aggiuntivi, ecc.

Aggiorna
Questo pulsante fa in modo che le periferiche audio vengano valutate nuovamente per
riflettere le modifiche applicate alle periferiche.
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Definizione delle connessioni audio

Scheda Riproduzione
¥

Surround

51 (LRCLFEL

Speaker Device Port

Left

Right

Center

4 Low Frequency Effects
Left Surround

Right Surround

Questa scheda consente di selezionare i bus che vengono utilizzati per la riproduzione.

Configurazione dei canali

Consente di assegnare dei bus di riproduzione alle porte della periferica. E possibile
scegliere tra i formati Universale, Stereo, Surround e Ambisonics. Nella tabella sotto
il menu Configurazione dei canali, & possibile specificare la Porta della periferica per
ciascun canale di un bus di riproduzione.

Scheda Registrazione

La prima volta che viene rilevata una periferica audio, WavelLab Elements assegna
automaticamente dei bus di ingresso. E possibile utilizzare questa configurazione o modificare i
bus di ingresso.

iguration Stereo

Speaker
Left

Right

Questa scheda consente di aggiungere i bus che sono utilizzati per la registrazione e il
monitoraggio dellingresso. Gli ingressi definiti qui saranno poi disponibili nella finestra di
dialogo Registrazione.

Aggiungi bus
Aggiunge un nuovo bus di registrazione all'elenco dei bus.

Rimuovi il bus selezionato
Consente di rimuovere il bus selezionato dall'elenco.
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Definizione delle connessioni audio

Sposta il bus verso I'alto/Sposta il bus verso il basso

Consente di spostare il bus selezionato verso l'alto o verso il basso nell'elenco. Questo
va inoltre a modificare I'ordine dei bus nei menu di WavelLab Elements.

Configurazione dei canali

Consente di assegnare dei bus di registrazione alle porte della periferica. E possibile
scegliere tra i formati Mono, Stereo, Surround o Ambisonics. Nella tabella sotto il
menu Configurazione dei canali, & possibile specificare la Porta della periferica per
ciascun canale di un bus di registrazione.

Elenco dei bus

Visualizza tutti i bus. I bus possono essere rinominati e spostati all'interno dell'elenco.
Per rinominare un bus, cliccarci sopra due volte e inserire un nuovo nome.

Scheda Opzioni

Questa scheda consente di specificare il numero di buffer e la funzionalita del driver di controllo.

ASIO-Guard

Aumentando questo valore, viene migliorata l'elasticita del flusso audio per evitare
interruzioni e salti. Piu alto & il livello, maggiori saranno la stabilita e le prestazioni
generali del processamento audio. Tuttavia, livelli elevati causano anche un aumento
della latenza ASIO-Guard e del consumo di memoria.

Esegui un breve fade-in all'avvio della riproduzione

Se questa opzione € attivata, viene eseguito un breve fade-in all'avvio della
riproduzione. Questo previene la formazione dei click che vengono solitamente
prodotti dalle forme d’onda che non iniziano in corrispondenza di un punto di zero.

La dissolvenza ¢ lineare e ha una durata di 10 millisecondi oppure corrisponde alla

dimensione del blocco del dispositivo audio se la dimensione del blocco ¢ inferiore a 10
millisecondi.

Esegui un breve fade-out all'arresto della riproduzione

Se questa opzione € attivata, viene eseguito un breve fade-out all'arresto della
riproduzione. Questo previene la formazione dei click che vengono solitamente
prodotti dalle forme d’onda che non iniziano in corrispondenza di un punto di zero.
Consente inoltre di eliminare qualsiasi segnale audio causato dalla latenza e qualsiasi
coda generata dai plug-in di riverbero.

La dissolvenza ¢ lineare e ha una durata di 10 millisecondi oppure corrisponde alla
dimensione del blocco del dispositivo audio se la dimensione del blocco ¢ inferiore a 10
millisecondi.

Rilascio del driver
Consente di eseguire WavelLab Elements insieme ad altre applicazioni e di garantire
sempre alle applicazioni attive l'accesso alla scheda audio.

e Sel'opzione Quando WaveLab Elements é in background é attivata, il driver
viene rilasciato quando WaveLab Elements € in background.
e Sel'opzione Quando Cubase/Nuendo sono in primo piano ¢ attivata, il driver
viene rilasciato quando Cubase/Nuendo sono in primo piano.
Frequenza di campionamento preferita

Consente di specificare la Frequenza di campionamento preferita per la
riproduzione.
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Ritardo del cambio di frequenza di campionamento

Dopo che WavelLab Elements invia una richiesta alla periferica audio di operare a una
nuova frequenza di campionamento, il driver invia a WavelLab Elements un feedback
una volta completata l'operazione.

La maggior parte dei driver non richiede di specificare un ritardo (timeout) per il
cambio di frequenza di campionamento. Tuttavia, alcuni driver inviano un feedback
ritardato o non lo inviano del tutto. In questi casi & possibile specificare un valore di
timeout.

Dopo il tempo qui specificato, WaveLab Elements considera accettata la frequenza di
campionamento e tenta di avviare la riproduzione o la registrazione. Se perd WavelLab
Elements riceve un feedback dal driver, il timeout scade.

Se si dovessero verificare dei problemi relativi al cambio di frequenza di
campionamento, aumentare il valore di timeout a 3 o pit secondi. Il tempo ideale &
il tempo piu breve che funziona adeguatamente.

La parte inferiore-destra della Sezione Master visualizza una barra di progresso in
attesa del feedback del driver.

LINK CORRELATI
ASIO-Guard a pag. 16
Sezione Master a pag. 284
Riproduzione a pag. 92
Registrazione a pag. 271

Definizione di nomi personalizzati per le porte audio

E possibile specificare dei nomi personalizzati per ciascuna porta audio di ingresso e uscita della
propria unita hardware audio collegata. Quando si salva un preset di connessioni audio, i nomi
personalizzati delle porte audio sono parte integrante del preset. E possibile salvare pil preset di
connessioni audio con nomi differenti per la stessa periferica audio.

PROCEDIMENTO
1. Selezionare File > Preferenze > Connessioni audio.
2. Fare clic su Nomi delle porte.

3. Incima alla finestra di dialogo Nomi delle porte audio, selezionare Porte di uscita audio o
Porte di ingresso audio dal menu a tendina.

4. Nell'elenco delle porte audio, fare doppio-clic sul nome della porta che si intende modificare
e digitare un nuovo nome.

¥ Audio Port Mames e

Output Audio Ports

Port System Name Show As

' OK X Cancel

5. Facoltativo: ripetere questa operazione per tutti i nomi delle porte da modificare.
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6. Fare clic su OK.

LINK CORRELATI
Scheda Connessioni audio a pag. 18

Invio dei flussi audio di file mono a un altoparlante dedicato

E possibile specificare un altoparlante dedicato a cui inviare il flusso audio dei file mono.

PROCEDIMENTO

1. Nella scheda Connessioni audio, fare clic su Riproduzione.

2. Nel menu Configurazione dei canali, selezionare Universale.
3. Specificare una Porta della periferica per il File mono.

Channel Configuration Universal

Speaker Device Port

Mono File

Left

Right

LINK CORRELATI
Scheda Connessioni audio a pag. 18

Registratori CD/DVD

Per istruzioni generali sull'installazione di registratori interni o la connessione di registratori
esterni tramite USB o Firewire, fare riferimento al manuale di istruzioni del proprio computer o
registratore.

Assicurarsi che sulla propria unita di registrazione sia installata l'ultima versione del firmware.
Per i registratori CD, il firmware esistente deve supportare la modalita disc-at-once. Inoltre,
I'utilizzo di un'unita con un firmware piu datato pud impedire, ad esempio, la scrittura di marker
di sotto-indice nelle tracce.

Dispositivi di controllo remoto

E possibile utilizzare degli appositi dispositivi Steinberg per controllare da remoto WavelLab
Elements.

Numerosi comandi possono essere controllati tramite le manopole e i cursori di un dispositivo di
controllo remoto.

NOTA

Sono supportate esclusivamente le periferiche di controllo remoto di Steinberg.

Scheda Dispositivi di controllo remoto

Questa scheda consente di selezionare un’unita Steinberg per il controllo remoto di WavelLab
Elements, nonché di visualizzare la mappa di controllo dei dispositivi di controllo MIDI.
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e Per aprire la scheda Dispositivi di controllo remoto, selezionare File > Preferenze >
Dispositivi di controllo remoto.

e Editing

B Active In-Port Steinberg CC121-1 ¥ Qut-Port  Steinberg CC121-1

Mame Steinberg CC121 xpand : Collapse

Wavelab Elements Action Control Name Message Cond.1 Cond.2

Play button

Play button

Play button

Play button

Stop button

Cycle button
Record button
Previous anchor button In
Mext anchor button
Forward button
Rewind button

Scheda Modifica del dispositivo

Questa scheda consente di selezionare un dispositivo di controllo MIDI e visualizzare la mappa di
controllo.
Active

Consente di attivare il dispositivo selezionato e di scansionare le porte MIDI.

Porta di ingresso/Porta di uscita
Consente di selezionare la porta di ingresso/uscita MIDI del dispositivo che si desidera
utilizzare.

Nome
Consente di inserire un nome per la mappa.

Espandi/Riduci
Consente di espandere/ridurre la struttura ad albero delle cartelle per la mappa di
controllo.

Elenco delle cartelle di WaveLab Elements

Questa struttura ad albero delle cartelle elenca i parametri che € possibile controllare
in remoto. La cartella superiore rappresenta i contesti. I parametri correlati possono
essere controllati se il contesto ¢ attivo. Ad esempio, se un file audio & attivo.

Un controllo remoto pud essere utilizzato in diversi contesti se questi sono esclusivi.
Ad esempio, alcuni parametri possono essere utilizzati per un file audio attivo o per un
montaggio audio attivo.

La cartella Globale contiene i parametri che possono essere sempre controllati.
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Scheda Opzioni

Emula la rotellina del mouse
Se questa opzione € attivata, la manopola Al dei controller Steinberg funziona come se
fosse una rotellina del mouse nell'interfaccia utente di WavelLab Elements, tranne che
per i plug-in.

Modifica il campo numerico che ha il focus

Se questa opzione € attivata, la manopola Al dei controller Steinberg puo essere
utilizzata per modificare il campo numerico focalizzato che & possibile trovare in molte
finestre e finestre di dialogo di WaveLab Elements.

CC121 Advanced Integration Controller

E possibile utilizzare la periferica CC121 Advanced Integration Controller di Steinberg per
controllare WavelLab Elements.

Questa sezione descrive i preset di fabbrica di WavelLab Elements per il CC121. Per informazioni
dettagliate sulle modalita di utilizzo del controller, fare riferimento al manuale fornito con il
CC121. Si noti che CC121 & stato progettato e realizzato originariamente per Cubase. La seguente
panoramica combina le funzioni di WaveLab Elements con i controlli di CC121. I controlli che non
sono elencati nel paragrafo seguente non sono assegnati a un parametro.

Sezione Channel

E possibile utilizzare tutti i controlli della sezione channel di CC121, ad esclusione del fader, per
controllare gli elementi della traccia attiva in un montaggio audio di WavelLab Elements. Il fader
puo essere utilizzato per la Sezione Master.
Fader

Consente di controllare il fader della Sezione Master.

Manopola PAN
Consente di controllare il guadagno della traccia attiva.

Mute
Consente di attivare/disattivare la funzione Mute per la traccia attiva.

Solo
Consente di attivare/disattivare la funzione Solo per la traccia attiva.

CHANNEL SELECT
Consente di selezionare la traccia precedente/successiva nel montaggio audio.
Per spostare il cursore sul bordo della clip precedente/successiva nel montaggio
audio, tenere premuto Alt. Per spostare il cursore sul bordo della regione precedente/

successiva nel montaggio audio, tenere premuto Shift. Per spostare il cursore sul
marker precedente/successivo nell’Editor audio, tenere premuto Ctrl/Cmd.

Sezione EQ

Tramite la Sezione EQ & possibile controllare facilmente il plug-in Studio EQ di Steinberg.

Se il pulsante EQ TYPE nell'unita CC121 ¢ attivato, € possibile regolare i parametri del plug-in
Studio EQ focalizzato. E possibile impostare tutti i parametri di equalizzazione necessari, come
Q/F/G per ciascuna banda, definire il parametro EQ TYPE e attivare/disattivare la funzione ALL
BYPASS. Disattivando il pulsante EQ TYPE & possibile passare alla modalita di navigazione di
WavelLab Elements. Nella modalita di navigazione di WaveLab Elements, & possibile accedere a
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una serie di funzioni alternative come scorrimento, ingrandimento e passaggio da una finestra
all'altra.

Pulsante EQ TYPE attivato:

Manopole dell'ampiezza di banda (Q)
Consentono di regolare 'ampiezza di banda (Q) di ciascuna banda di equalizzazione.

Manopole della frequenza (F)
Consentono di regolare la frequenza (F) di ciascuna banda di equalizzazione.

Manopole del guadagno (G)
Consentono di regolare il guadagno (G) di ciascuna banda di equalizzazione.

ON
Consente di attivare/disattivare le bande di equalizzazione.

ALL BYPASS

Consente di attivare/disattivare la funzione di bypass per tutti i plug-in della Sezione
Master.

Pulsante EQ TYPE disattivato:
LOW ON

Consente di aprire 'Editor audio.
LOW-MID ON
Consente di aprire la finestra Montaggio audio.
HIGH ON
Consente di aprire la scheda delle preferenze.
Manopola EQ-1 per I'EQ Gain (G)
Consente di scorrere verso sinistra/destra lungo la linea temporale.
Manopola EQ-2 per il 'EQ Gain (G)
Consente di regolare I'ingrandimento orizzontale sulla linea temporale.
Manopola EQ-3 per I'EQ Gain (G)
Consente di regolare I'ingrandimento verticale sulla linea temporale.
Manopola EQ-4 per I'EQ Gain (G)
Consente di scorrere le tracce nella finestra Montaggio audio o di eseguire uno
scorrimento in senso verticale nell’Editor audio.
Manopola EQ-1 per I'EQ Frequency (F)
Consente di scorrere verso sinistra/destra lungo la linea temporale della panoramica
dell’Editor audio.
Manopola EQ-2 per I'EQ Frequency (F)
Consente di aumentare/ridurre l'ingrandimento orizzontale della linea temporale della
panoramica dell'Editor audio.
Manopola EQ-3 per I'EQ Frequency (F)
Consente di aumentare/ridurre l'ingrandimento verticale della linea temporale della
panoramica dell'Editor audio.
Manopola EQ-4 per I'EQ Frequency (F)

Consente di eseguire uno scorrimento in senso verticale lungo la linea temporale della
panoramica dell'Editor audio.
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Sezione Trasporto
In questa sezione & possibile controllare le funzioni di trasporto di WavelLab Elements.

Pulsante Precedente
Consente di scorrere la posizione del cursore verso sinistra.
Pulsante Riavvolgimento
Consente di scorrere la posizione del cursore di modifica verso sinistra.

Pulsante Avanti
Consente di scorrere la posizione del cursore di modifica verso destra.

Pulsante Seguente
Consente di scorrere la posizione del cursore verso destra.

Pulsante Ciclo
Consente di attivare/disattivare la modalita Ciclo.

Pulsante Arresta la riproduzione

Consente di arrestare la riproduzione. Premere nuovamente per spostare il cursore alla
posizione di inizio precedente. Premere una terza volta per spostare il cursore all'inizio
del progetto.

Pulsante Riproduci
Consente di avviare la riproduzione.

Pulsante Registra

Premere una volta per aprire la finestra di dialogo Registrazione. Premere
nuovamente per avviare la registrazione. Premere una terza volta per interrompere
la registrazione. Il file registrato si apre nell'Editor audio.

Sezione Function

In questa sezione, & possibile regolare alcune funzioni come dissolvenze e livello degli inviluppi,
utilizzando la manopola VALUE.

Manopola VALUE

Ruotare questa manopola per regolare la funzione assegnata. Premere la manopola
per reinizializzare il valore del parametro.

Pulsante FUNCTION 1
Consente di regolare le impostazioni di fade-in della clip attiva.

Pulsante FUNCTION 2
Consente di regolare le impostazioni di fade-out della clip attiva.

Pulsante FUNCTION 3
Consente di regolare il livello di inviluppo della clip attiva.

Pulsante FUNCTION 4

L'ultimo elemento su cui si & fatto clic nella sezione Spinta della scheda Modifica,
all'interno della finestra Montaggio audio, viene assegnato a questo pulsante.

Sezione AI KNOB

Wavelab Elements pud essere controllato con la manopola Al (Al knob) dei controller CC121,
CI2+ e CMC-AI di Steinberg. Con la manopola Al € possibile controllare il parametro su cui punta
il mouse.
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NOTA

La manopola Al funziona solo sui parametri che sono automatizzabili.

In questa sezione & possibile controllare i parametri tramite la manopola Al

AI KNOB
Consente di controllare i parametri del plug-in VST 3, di emulare la rotellina del
mouse, ad esempio per eseguire lo scrolling, nonché di modificare un campo numerico
focalizzato. Per controllare un parametro con la manopola Al spostare il cursore del
mouse sul parametro che si desidera controllare e spostare la manopola Al E possibile
attivare/disattivare I'emulazione della rotellina del mouse e la modifica del campo
numerico focalizzato nella scheda Opzioni.

LOCK

Quando il cursore punta su un parametro, premere LOCK per controllare questo
parametro indipendentemente dalla posizione del cursore del mouse.

Indicatore CUBASE READY

L'indicatore CUBASE READY non ha alcuna funzione in WavelLab Elements.

Sezione Foot Switch

Il foot switch ha la stessa funzione di Shift. Premere e tenere premuto il foot switch mentre si
ruota la manopola Al per eseguire delle regolazioni di precisione dei parametri.
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Linee guida generali per
I'utilizzo di WaveLab Elements

Questo capitolo descrive le lingue guida generali per l'utilizzo di WaveLab Elements. La
conoscenza di queste procedure consente di lavorare in modo piu efficiente con il programma.

LINK CORRELATI

Regole generali delle operazioni di editing a pag. 28
Gestione di base delle finestre a pag. 30

Finestra di dialogo Awvio a pag. 28

Regole generali delle operazioni di editing

Le operazioni comuni di editing si applicano a tutti i prodotti Steinberg.

e Per selezionare e spostare elementi dell'interfaccia o per selezionare degli intervalli, eseguire
un trascinamento con il mouse.

e Utilizzare i tasti della tastiera del computer per inserire valori numerici e testo, per navigare
negli elenchi o in altri elementi selezionabili dell'interfaccia e per controllare le funzioni di
trasporto.

e Le comuni operazioni come taglia, copia, incolla o la selezione di elementi multipli possono
essere eseguite tramite le scorciatoie standard da tastiera.

NOTA

Il comportamento del prodotto e regolato anche dalle impostazioni delle preferenze.

LINK CORRELATI
Linee guida generali per l'utilizzo di WavelLab Elements a pag. 28

Finestra di dialogo Avvio

Al lancio di WaveLab Elements, si apre la finestra di dialogo Avvio, nella quale & possibile
selezionare il file o il modello da aprire.
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Finestra di dialogo Awvio

v Wavelab Elements

™ O ¢ 30

4 Recent Podcast Music More

" D% owm A

Al Audio Montage Audio File

Filter:

] Create Empty Window

+” Create Empty...

Nella finestra di dialogo Avvio & possibile selezionare il tipo di file che si desidera aprire. E
possibile aprire i file utilizzati di recente o creare nuovi file a partire dai modelli.

Sono disponibili i sequenti tipi di file:
e Montaggio audio

e File audio
e Feed RSS

Recenti

File utilizzati di recente
Consente di aprire gli ultimi file utilizzati in WavelLab Elements.

Elenco dei file utilizzati di recente

Consente di aprire i file utilizzati di recente. Per aprire un file utilizzato di recente,
selezionare il file desiderato e fare clic su Apri.

Modelli

Crea una finestra vuota
Crea una finestra di WavelLab Elements vuota.

Altre opzioni

Usa come impostazioni predefinite (non visualizzare piu questa finestra di dialogo)

Se questa funzione ¢é attiva, l'opzione che si seleziona viene utilizzata dal momento
corrente in poi e la schermata di avvio non viene piu visualizzata. Per visualizzare
la finestra di dialogo Avvio nel caso in cui questa opzione é stata attivata, premere
Ctrl/Cmd durante l'avvio di WavelLab Elements.

Sfoglia
Consente di selezionare i file da aprire.
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Crea vuoto
Crea una finestra di WavelLab Elements vuota.

Gestione di base delle finestre

WavelLab Elements segue le linee guida per l'interfaccia di Windows/macOS. Questo significa che
vengono applicate le procedure standard di Windows/macOS.

LINK CORRELATI
Linee guida generali per l'utilizzo di WavelLab Elements a pag. 28

Selezione audio

Quasi tutti i tipi di operazioni di editing e di processamento eseguiti in WaveLab Elements hanno
effetto su una selezione audio. Ci sono numerosi modi per effettuare una selezione audio.

e Per selezionare l'intero file audio, fare doppio-clic su di esso.

e Per selezionare un file audio contenente dei marker, cliccarci sopra tre volte.

LINK CORRELATI
Selezione di un intervallo tramite trascinamento a pag. 30
Selezione dei canali nei file audio a pag. 32

Selezione di un intervallo tramite trascinamento

Il metodo standard per selezionare un intervallo nella finestra della forma d'onda o del
montaggio consiste nell'eseguire un clic e trascinamento.

OPZIONI

e Per selezionare un intervallo, eseguire un trascinamento completamente verso il lato sinistro
o destro della finestra della forma d'onda o del montaggio.
La forma d'onda scorre automaticamente, consentendo di selezionare sezioni piu ampie
rispetto a quelle che possono essere visualizzate nella finestra stessa. La velocita di
scorrimento dipende dalla lontananza dal bordo della finestra.

e Perridimensionare un intervallo di selezione orizzontalmente o verticalmente nella finestra
della forma d’'onda, fare clic sulla casella di selezione ed eseguire un trascinamento.

e Perridimensionare un intervallo di selezione verticalmente nella finestra del montaggio, fare
clic sulla casella di selezione ed eseguire un trascinamento.
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LINK CORRELATI

Selezione audio a pag. 30

Finestra della forma d'onda a pag. 111
Finestra di montaggio a pag. 190

Selezione di un intervallo audio in un file audio

E possibile modificare, processare o riprodurre delle selezioni di un file audio.

e Per accedere alle opzioni relative alla selezione degli intervalli audio, nell’Editor audio
selezionare la scheda Modifica.

Le opzioni di selezione che seguono sono disponibili nella sezione Selezione temporale:

Tutto
Consente di selezionare l'intera forma d'onda.

Alterna
Consente di attivare/disattivare l'intervallo di selezione.

Estendi

Apre un menu in cui € possibile selezionare le seguenti opzioni per la creazione o
I'estensione degli intervalli di selezione:

e L'opzione Estendi a inizio file consente di estendere la selezione fino all'inizio del
file audio. Se non & presente alcuna selezione, ne viene creata una a partire dalla
posizione del cursore di modifica.

e L'opzione Estendi a fine file consente di estendere la selezione fino alla fine del
file audio. Se non & presente alcuna selezione, ne viene creata una a partire dalla
posizione del cursore di modifica.

e L'opzione Estendi fino al marker precedente consente di estendere il bordo
sinistro della selezione fino al marker piu vicino a sinistra o all'inizio del file audio.
Se non e presente alcuna selezione, ne viene estesa una fino alla posizione del
marker precedente.

e L'opzione Estendi fino al marker successivo consente di estendere il bordo
destro della selezione fino al marker a destra piu vicino o fino alla fine del file
audio. Se non e presente alcuna selezione, ne viene estesa una fino alla posizione
del marker successivo.

e L'opzione Estendi al cursore consente di estendere la selezione fino alla posizione
del cursore di modifica.

e L'opzione Dall'inizio del file al cursore consente di selezionare l'intervallo tra
I'inizio del file audio e la posizione del cursore di modifica.

e Da cursore a fine file consente di selezionare l'intervallo tra la posizione del
cursore di modifica e la fine del file audio.

e L'opzione Da cursore a marker precedente consente di selezionare l'intervallo tra
la posizione del cursore di modifica e il marker precedente o l'inizio del file audio.

e L'opzione Da cursore a marker successivo consente di selezionare l'intervallo tra
la posizione del cursore di modifica e il marker successivo o la fine del file audio.

e L'opzione Sposta la selezione verso sinistra sposta la selezione della sua intera
lunghezza verso sinistra.

e |'opzione Sposta la selezione verso destra sposta la selezione della sua intera
lunghezza verso destra.
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e L'opzione Dalla posizione di riproduzione alla fine consente di creare un
intervallo di selezione dalla posizione di riproduzione fino alla fine della selezione o
fino alla fine del file se non & presente alcuna selezione. Se la riproduzione non &
attiva, viene utilizzata la posizione del cursore di modifica.

e L'opzione Dall'inizio alla posizione di riproduzione consente di creare un
intervallo di selezione dalla posizione di riproduzione fino all'inizio della selezione o
fino all'inizio del file se non & presente alcuna selezione. Se la riproduzione non &
attiva, viene utilizzata la posizione del cursore di modifica.

e L'opzione Raddoppia la lunghezza della selezione consente di raddoppiare la
lunghezza dell'intervallo di selezione corrente.

e L'opzione Dimezza la lunghezza della selezione consente di dimezzare la
lunghezza dell'intervallo di selezione corrente.
Canali
Apre un menu in cui € possibile selezionare le seguenti opzioni:

e |'opzione Estendi a tutti i canali consente di estendere l'intervallo di selezione
corrente a tutti i canali.

e L'opzione Solo canale sinistro consente di ridurre l'intervallo di selezione solo al
canale sinistro.

e L'opzione Solo canale destro consente di ridurre l'intervallo di selezione solo al
canale destro.
Regioni
Apre un menu in cui € possibile selezionare le seguenti opzioni:
e |'opzione Regione di loop consente di selezionare l'intervallo tra due marker di
loop tra i quali si trova il cursore di modifica.

e L'opzione Regione generica consente di selezionare l'intervallo tra due marker
generici tra i quali si trova il cursore di modifica.

LINK CORRELATI
Editor audio a pag. 43

Selezione dei canali nei file audio

Nell'Editor audio ¢ possibile selezionare i singoli canali, entrambi i canali di un file stereo, oppure
dei cluster di canali di un file audio multicanale. Questo consente di applicare un'operazione

a un solo canale, a entrambi i canali di un file stereo, oppure a dei cluster di canali di un file
multicanale.

OPZIONI

e Il canale che viene selezionato quando si fa clic nella finestra della forma d'onda dipende
dalla posizione di clic.

Il cursore di modifica indica quale canale viene selezionato. Il puntatore del mouse indica a
quale canale saranno applicate le modifiche.

e Per selezionare il canale sinistro, fare clic nella meta superiore del canale sinistro.
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e Per selezionare entrambi i canali, fare clic nell'area centrale tra il canale sinistro e il
canale destro.

e Perselezionare il canale destro, fare clic nella meta inferiore del canale destro.

e Per alternare la selezione di tutti i canali e la selezione dei singoli canali quando si fa clic
nella finestra della forma d’onda, fare clic su Alterna la modalita di selezione dei canali a

sinistra della linea del tempo.

.L'_"
0 ms
b
Toggle Channel Selection Mede
Shortcut: =

e Per spostare il cursore di modifica sul canale successivo/precedente, premere Tab o Tab-

Shift.

LINK CORRELATI

Selezione audio a pag. 30

Spostamento dell'intervallo di selezione su altri canali a pag. 33
Finestra della forma d'onda a pag. 111

Riproduzione dei canali audio focalizzati a pag. 104

Spostamento dell'intervallo di selezione su altri canali

E possibile spostare lintervallo di selezione definito per un canale su tutti i canali o spostare

I'intervallo di selezione su un altro canale.

PROCEDIMENTO

1. Nella finestra della forma d'onda dell’Editor audio, selezionare un intervallo.

2. Eseguire una delle seguenti operazioni:

e Nella scheda Modifica, sezione Selezione temporale, fare clic su Canali e selezionare
Estendi a tutti i canali, Solo canale sinistro o Solo canale destro.

e Nellarea dei controlli dei canali, fare clic sul canale sul quale si desidera spostare
I'intervallo di selezione.
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e Per estendere l'intervallo di selezione dal proprio cluster di canali originale, in verticale
su altri cluster di canali, fare Shift-clic sul cluster di canali sul quale si intende estendere
I'intervallo di selezione.

e Per spostare l'intervallo di selezione sul canale successivo/precedente utilizzando i
comandi da tastiera, premere Tab o Tab - Shift.

e Per spostare l'intervallo di selezione su un altro canale utilizzando il mouse, premere
Ctrl/Cmd - Shift e trascinare la selezione in un’altra posizione.

LINK CORRELATI

Selezione dei canali nei file audio a pag. 32
Area dei controlli dei canali a pag. 113
Finestra della forma d'onda a pag. 111

Selezione nella vista panoramica dell'Editor audio

Gli intervalli che vengono selezionati nella vista panoramica dell’Editor audio si applicano anche
alla vista principale.

PROCEDIMENTO

e Nellafinestra della forma d’onda dell’Editor audio, tenere premuto Ctrl/Cmd, quindi fare
clic e trascinamento nella panoramica.

LINK CORRELATI
Finestra della forma d'onda a pag. 111

Spostamento di un intervallo di selezione

Se un intervallo di selezione ha lunghezza corretta ma si trova nella posizione errata, € possibile
spostarlo.

PROCEDIMENTO
1. Nella finestra della forma d'onda, tenere premuto Ctrl/Cmd - Shift.

2. Fareclic nella parte centrale della selezione e trascinarla verso sinistra/destra.

LINK CORRELATI
Finestra della forma d'onda a pag. 111
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Estensione e riduzione della selezione

E possibile ridimensionare un intervallo di selezione nella finestra della forma d’'onda o nella
finestra del montaggio.

Sono disponibili diverse modalita di estensione/riduzione della selezione:

Utilizzando il mouse e i comandi da tastiera

e Per estendere la selezione, selezionare un intervallo, fare Shift-clic al di fuori dell'intervallo
di selezione ed eseguire un trascinamento verso sinistra/destra. E anche possibile fare clic e
trascinare i bordi dell'intervallo di selezione verso sinistra/destra.

e Per estendere la selezione fino al limite precedente/successivo (marker o inizio/fine del file),
premere Shift e fare doppio-clic sull'area non selezionata compresa tra i limiti.

Utilizzando solamente i comandi da tastiera

e Per spostare l'inizio o la fine di una selezione nella finestra della forma d'onda verso sinistra o
destra, tenere premuto Shift e premere Freccia sinistra/Freccia destra. Per eseguire uno
spostamento secondo incrementi pit ampi, tenere premuto Shift e premere Pagina su o
Pagina giu.

e Per estendere una selezione fino al bordo precedente o successivo nella finestra della forma
d’'onda (marker o inizio/fine del file audio), tenere premuto Ctrl/Cmd - Shift e premere
Freccia sinistra o Freccia destra.

Eliminazione delle selezioni

Sono disponibili diverse opzioni per I'eliminazione di un intervallo selezionato.

Editor audio

Le seguenti opzioni si trovano nella scheda Modifica della sezione Taglio.

Ritaglia
Consente di rimuovere i dati audio esterni alla selezione.

Elimina
Consente di rimuovere la selezione. L'audio a destra della selezione viene spostato
verso sinistra per riempire lo spazio vuoto.

Finestra Montaggio audio

Le seguenti opzioni sono disponibili nella scheda Modifica all'interno della sezione Rimozione.

Cancella I'intervallo selezionato
Consente di cancellare le parti delle clip che si trovano allinterno dell'intervallo di
selezione nella traccia attiva, senza riempire lo spazio vuoto.

Elimina la clip selezionata/Elimina l'intervallo selezionato

Se & presente un intervallo di selezione, le parti delle clip che si trovano all'interno
dell'intervallo di selezione nella traccia attiva vengono eliminate e la sezione destra
della clip viene spostata verso sinistra per riempire lo spazio vuoto.

Se non e selezionato alcun intervallo, le clip selezionate vengono eliminate.
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Cursori

In diverse posizioni di WavelLab Elements sono disponibili dei controlli a cursore per la modifica

dei parametri. Per modificare il valore di un cursore, € possibile procedere in diversi modi.

e Posizionare il mouse sul cursore e muovere la rotellina del mouse senza fare clic. Tenere
premuto Ctrl/Cmd durante l'utilizzo della rotellina per scorrere piu velocemente. Questo
modificatore si applica anche alle rotelline di ingrandimento. Per spostare un cursore,
cliccarci sopra e trascinarlo.

e Per spostare la maniglia di un cursore in una determinata posizione, fare clic sul cursore
nella posizione scelta.

e Per spostare la maniglia di un cursore gradualmente, fare clic-destro o fare clic al di
sotto della maniglia. Tenere premuto il pulsante per passare automaticamente al valore
successivo.

e Perreimpostare il cursore al valore predefinito, se disponibile, fare Ctrl/Cmd -clic sul cursore

oppure fare clic con la rotellina del mouse o fare doppio-clic sulla maniglia.

LINK CORRELATI
Linee guida generali per l'utilizzo di WavelLab Elements a pag. 28

Rinomina degli elementi delle tabelle

E possibile rinominare gli elementi contenuti nelle tabelle nelle finestre Marker e CD.

e Perrinominare un elemento, fare doppio-clic su di esso o selezionarlo e premere Invio,
quindi inserire il nuovo nome.

e Perrinominare I'elemento precedente/successivo, premere Freccia su o Freccia giu.
In questo modo si sposta il focus sull'elemento precedente/successivo, rimanendo nella
modalita di modifica.

LINK CORRELATI
Finestra Marker a pag. 308
Finestra CD a pag. 265

Gruppi di schede

Grazie ai gruppi di schede & possibile visualizzare contemporaneamente il contenuto di file,
finestre degli strumenti di utility o indicatori differenti, senza dover navigare tra le diverse
finestre. Ciascun gruppo di schede dispone di contenuti propri e di una linguetta distintiva.

E possibile disporre di due gruppi di schede file.
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Gruppi di schede file vuoti

Gruppi di schede file con montaggi audio

Surround Montage 2

LINK CORRELATI
Creazione di gruppi di schede file a pag. 37
Utilizzo dei gruppi di schede a pag. 38

Creazione di gruppi di schede file

PROCEDIMENTO

1. Nella parte superiore-destra della finestra relativa a una scheda file, aprire il menu a tendina
Gruppo di schede.
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2. Selezionare Crea un gruppo di schede (suddividi verticalmente) o Crea un gruppo di
schede (suddividi orizzontalmente).

LINK CORRELATI
Gruppi di schede a pag. 36
Utilizzo dei gruppi di schede a pag. 38

Creazione di gruppi di schede file all'interno di gruppi di schede
vuoti

PROCEDIMENTO

e Nella parte superiore-destra di un gruppo di schede file vuoto, fare clic su Crea un
gruppo di schede (suddividi verticalmente) o su Crea un gruppo di schede (suddividi
orizzontalmente).

LINK CORRELATI
Gruppi di schede a pag. 36
Utilizzo dei gruppi di schede a pag. 38

Utilizzo dei gruppi di schede

Il pulsante Gruppo di schede situato nella parte superiore-destra della finestra di ciascuna
scheda consente di massimizzare, spostare e chiudere i gruppi di schede. Le schede hanno usi
diversi a seconda del tipo di finestra.

Gruppi di schede delle finestre degli strumenti di utility

e Per nascondere un gruppo di schede delle finestre degli strumenti di utility, aprire il
menu a tendina Opzioni dei gruppi di schede delle finestre degli strumenti di utility
e selezionare Nascondi tutto.

e Perriordinare le schede contenute in un gruppo di schede, trascinare ciascuna scheda
desiderata in una nuova posizione nella barra delle schede.

e Per ancorare il gruppo di schede in un‘altra posizione, aprire il menu a tendina Opzioni dei
gruppi di schede delle finestre degli strumenti di utility e selezionare Ancora il gruppo
di schede in un punto qualsiasi. A questo punto & possibile selezionare dove ancorare il
gruppo di schede.

Gruppi di schede file
e Per chiudere un gruppo di schede file, fare clic sul pulsante Gruppo di schede e selezionare
Nascondi tutto.

e Perriordinare le schede contenute in un gruppo di schede, trascinare ciascuna scheda
desiderata in una nuova posizione nella barra delle schede.

e Per spostare una scheda in un altro progetto, trascinarla nel progetto desiderato.

e Perincollare i contenuti di una scheda in un file audio, trascinare la scheda sulla forma
d'onda. La scheda ¢ inserita nella posizione del cursore.

e Per massimizzare il gruppo di schede file attivo, aprire il menu a tendina Opzioni del gruppo
di schede file e selezionare Nascondi gli altri gruppi di schede file.
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File di picco

Per visualizzare tutti i gruppi di schede file, aprire il menu a tendina Opzioni del gruppo di
schede file e selezionare Visualizza gli altri gruppi di schede file.

E inoltre possibile fare doppio-clic sullintestazione di un gruppo di schede file per
visualizzare/nascondere gli altri gruppi di schede file.

LINK CORRELATI
Gruppi di schede a pag. 36
Creazione di gruppi di schede file a pag. 37

File di picco

Un file di picco (estensione . gpk) viene creato automaticamente da WavelLab Elements ogni volta
che un file audio viene modificato o aperto in WavelLab Elements per la prima volta. Il file di picco
contiene informazioni sulla forma d'onda e determina in che modo questa viene disegnata nella
finestra della forma d'onda o in quella di montaggio.

I file di picco riducono il tempo richiesto per disegnare la forma d'onda corrispondente. Per

impostazione predefinita, il file di picco viene salvato nella stessa posizione del file audio.

LINK CORRELATI
Ricostruzione delle visualizzazioni dei picchi a pag. 39

Ricostruzione delle visualizzazioni dei picchi

Solitamente, i file di picco vengono aggiornati automaticamente quando la relativa data &
antecedente a quella del file audio. Tuttavia, puo accadere che la data del file audio non venga
aggiornata automaticamente. In questo caso, € possibile forzare la ricostruzione del file di picco.

PROCEDIMENTO
1. Nell'Editor audio, selezionare la scheda Vista.

2. Nella sezione Picchi, fare clic su Ricostruisci la visualizzazione.

LINK CORRELATI
File di picco a pag. 39
Scheda Visualizza (Editor audio) a pag. 116

File compagno

I file compagno (estensione .vs) contengono i preset della Sezione Master e le impostazioni di
visualizzazione per i file audio. Se questa funzione é attiva quando si salva un file, le impostazioni
vengono ricreate la volta successiva che si carica il file.

I file compagno sono disponibili solamente nell’Editor audio.
Le seguenti impostazioni di visualizzazione sono incluse nei file compagno:

e Dimensione e posizione della finestra
e Livello diingrandimento

e Posizione dello scorrimento

LINK CORRELATI
Salvataggio dei file compagno in un’altra posizione a pag. 40
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Preset della Sezione Master a pag. 301

Salvataggio dei file compagno in un’altra posizione

Per impostazione predefinita, i file compagno vengono salvati nella stessa posizione del file
audio. Tuttavia, & possibile selezionare un‘altra posizione di salvataggio.

PROCEDIMENTO
1. Selezionare File > Preferenze > Cartelle.

2. Fare clic su File compagno e specificare un‘altra posizione file.

LINK CORRELATI
File compagno a pag. 39
Scheda Cartelle (Preferenze) a pag. 89

Precisione del processamento

Wavelab Elements € in grado di caricare i campioni audio in diversi formati, ma il processamento
interno avviene sempre a 64 bit in virgola mobile.

Anche il mixaggio all'interno di WavelLab Elements avviene a 64 bit in virgola mobile. I campioni
PCM a 32 bit possono essere trasferiti in formato 64 bit in virgola mobile e quindi convertiti
nuovamente a 32 bit.

I plug-in vengono processati per impostazione predefinita a 64 bit in virgola mobile. E comunque
possibile impostare il processamento dei plug-in a 32 bit in virgola mobile.

La precisione del processamento dei plug-in e dei file temporanei puo essere impostata nella
scheda Audio delle Preferenze globali.

NOTA

Il processamento a 64 bit in virgola mobile, rispetto al formato 32 bit in virgola mobile ha una
precisione doppia ma richiede un tempo di processamento leggermente maggiore.

I file temporanei a 64 bit in virgola mobile hanno una precisione doppia ma richiedono un tempo
di lettura e scrittura maggiore rispetto al formato 32 bit in virgola mobile e i relativi file hanno
dimensione doppia.

LINK CORRELATI
File temporanei a pag. 69
Scheda Audio (Preferenze globali) a pag. 408

Standard dell'intensita acustica EBU R-128

La raccomandazione dell'intensita acustica EBU R-128 stabilisce dei metodi specifici per la
misurazione dell'intensita acustica, delle dinamiche e dei valori di picco; definisce inoltre i valori
di riferimento per condurre queste misurazioni. Sebbene i valori di riferimento siano pensati per
'ambito della trasmissione, i metodi di misurazione sono utili in qualsiasi applicazione che abbia
a che fare con il controllo audio e dell'intensita acustica.

Wavelab Elements supporta tali misurazioni audio in diverse posizioni per il rilevamento tramite
indicatori, I'analisi audio e il processamento.
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Misurazione dell'intensita acustica

Questo metodo tiene in considerazione la sensibilita alle frequenze dell'orecchio umano a diversi
livelli di intensita acustica. Sono disponibili 3 tipi di misurazione:

1. Intensita acustica integrata, detta anche intensita acustica del programma: indica il valore
medio dell'intensita acustica di una traccia audio. Questa misurazione utilizza un metodo di
applicazione del gate per ignorare lunghi periodi di silenzio.

2. Intensita acustica a breve termine: viene misurata I'Intensita acustica ogni secondo in un
blocco audio di 3 secondi. Questa misurazione fornisce informazioni sui passaggi audio piu
forti.

3. Intensita acustica momentanea: ogni 100 ms viene misurato un intervallo di 400 ms di audio.
Questa misurazione offre un feedback istantaneo sull'intensita acustica.

Intervallo dell'intensita acustica

Questo metodo misura le dinamiche del segnale audio. Esso rileva il rapporto tra le sezioni piu
forti e quelle piu deboli (ma non silenziose). Il segnale audio viene diviso in piccoli blocchi. Viene
creato un blocco audio ogni secondo e ciascun blocco dura 3 secondi (sovrapposizione blocchi
analizzata).

I1 10% superiore dei blocchi deboli e il 5% superiore dei blocchi forti vengono esclusi dall'analisi
finale. L'intervallo dell'intensita acustica calcolato & il rapporto tra i restanti blocchi audio piu
forti e piu deboli. Questa misurazione aiuta a decidere se e in che misura la compressione o
'espansione possa o debba essere applicata all'audio.

Picchi reali

Quando un segnale digitale viene convertito in un segnale analogico, EBU R-128 consiglia di
misurare una stima dei picchi reali, piuttosto che fare riferimento ai picchi digitali, per evitare
clipping e distorsione. Questa stima puo essere eseguita campionando il segnale 4 volte e
memorizzando i valori di picco.

Assegnazione nomi e unita
EBU R-128 propone alcune convenzioni di assegnazione nomi e unita:

e Una misurazione relativa (ad esempio un valore relativo a un livello di riferimento): «LU»
come «Loudness Unit» (1 LU equivale a 1 dB).

e Una misurazione assoluta, «LUFS», acronimo di «Loudness Unit Full Scale». 1 LUFS equivale a
1 dB nella scala AES-17.

Quando Wavelab Elements fa riferimento a un valore di intensita acustica secondo gli standard
EBU R-128, tali unita vengono utilizzate al posto dei dB.

LINK CORRELATI

Normalizzatore dell'intensita acustica a pag. 176
Analisi globale a pag. 160

Scheda Formati (Preferenze globali) a pag. 409

Reinizializzazione delle risposte predefinite

In WavelLab Elements, & possibile impostare alcune finestre di dialogo e messaggi di avviso
su Non visualizzare piu. Se si desidera visualizzare nuovamente questi elementi, & necessario
reinizializzare le risposte predefinite.
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PROCEDIMENTO
1. Selezionare File > Preferenze > Globale.
2. Fare clic su Opzioni.

3. Fare clic su Reinizializza le risposte predefinite.

RISULTATO

Tutte le opzioni relative ai riquadri dei messaggi vengono riportate alle rispettive impostazioni
predefinite.

LINK CORRELATI
Scheda Opzioni (Preferenze globali) a pag. 410
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La finestra Area lavoro

La finestra Area lavoro fornisce un ambiente di editing e di riproduzione per ciascun particolare
tipo di file audio. Ogni ambiente contiene delle funzioni specifiche per I'utilizzo e lo scopo di
ciascun tipo di file.

e L'Editor audio per la visualizzazione e la modifica dei file audio.
e Lafinestra Montaggio audio per 'assemblaggio e la modifica dei montaggi audio.

e L'Editor dei feed RSS per la preparazione e il caricamento dei feed RSS.

La finestra Area lavoro ¢ altamente personalizzabile in modo da adattarsi alle proprie esigenze e
al proprio specifico flusso di lavoro.

Elementi della finestra Area lavoro
La finestra Area lavoro contiene i seguenti elementi:

e Una barra dei menu

e  Gruppidi schede per inserire i file da modificare. E possibile spostare il contenuto di una
scheda in un‘altra scheda, creare una nuova scheda vuota, visualizzare il percorso del file e
accedere ad altre funzioni tramite clic-destro.

e Un setdifinestre degli strumenti di utility. Gli strumenti effettivamente disponibili
dipendono dal tipo di file al quale si sta lavorando. Le finestre degli strumenti di utility
possono essere attivate/disattivate singolarmente.

LINK CORRELATI

Editor audio a pag. 43
Montaggio audio a pag. 43
Editor dei feed RSS a pag. 44

Editor audio

L'Editor audio offre una serie di strumenti di utility e di funzioni per I'esecuzione di operazioni
di editing dell'audio con precisione al singolo campione, per I'analisi dell'audio a elevata qualita e
per il processamento.

L'Editor audio include diversi strumenti di misurazione e analisi.

La finestra della forma d'onda offre una rappresentazione grafica del file audio e consente di
visualizzare, riprodurre e modificare il file.

LINK CORRELATI
Modifica dei file audio a pag. 111

Montaggio audio

Nella finestra Montaggio audio & possibile assemblare le clip audio in un montaggio. E possibile
disporre, modificare e riprodurre delle clip sia nelle tracce stereo sia in quelle mono.
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La finestra Area lavoro
Editor dei feed RSS

Le funzionalita includono effetti basati su clip e tracce, automazione volume e panoramica,
nonché funzioni di dissolvenza incrociata e dissolvenza ad ampio intervallo.

In una traccia audio & possibile inserire un numero qualsiasi di clip. Una clip contiene un
riferimento a un file audio sorgente nell’hard disk, nonché posizioni di inizio e di fine nel file.

La finestra del montaggio offre una rappresentazione grafica delle clip nelle tracce. In essa e
possibile visualizzare, riprodurre e modificare tracce e clip.

LINK CORRELATI
Montaggio audio a pag. 190

Editor dei feed RSS

Nell'Editor dei feed RSS & possibile assemblare, definire e pubblicare il proprio feed RSS su
internet.

LINK CORRELATI
Feed RSS a pag. 381

Scheda File

La scheda File rappresenta il centro di controllo di WavelLab Elements. In questa scheda ¢
possibile salvare, aprire, renderizzare, importare ed esportare i file. Vengono qui inoltre fornite
informazioni dettagliate sui propri file ed & possibile configurare le preferenze di WavelLab
Elements.

WHLE ©OVIEW € EDIT & INSERT @g PROCESS D RENDER

CURRENT FILE

W5 1 01.waviC

@ Info W\ Audio File Properties
-~ Channel Configuration Surround
Custom .
LRS
New From Current File
ate 441 z

Templates —
52 bit float

% Audio Montage
MmC

2 Render

I el Podcast

LY Preferences

Info

Offre una serie di informazioni sul file attivo e consente di modificare le proprieta
audio dei file audio e dei montaggi audio.
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Scheda File

Nuovo

Consente di creare file audio, montaggi audio o feed RSS. E possibile creare dei nuovi
file o utilizzare un modello.

Apri
Consente di aprire file audio, montaggi audio o feed RSS.

E inoltre possibile aprire dei file che sono stati precedentemente copiati negli appunti
in Esplora file/macOS Finder.

Importa
Consente di aprire diversi formati file. Sono supportati i seqguenti formati:
e Aggiungi file al montaggio
e Audio sconosciuto

Questa opzione consente di specificare il modo in cui WavelLab Elements dovrebbe
interpretare il formato file audio che si desidera aprire.

E inoltre possibile importare delle tracce CD audio da un CD audio.

Salva con nome

Consente di salvare il file o il progetto attivi. E possibile specificare il nome, il formato
file e la posizione. Pud essere inoltre salvata una copia del file attivo.

Salva tutto

Consente di salvare contemporaneamente tutti i file modificati del progetto. L'elenco
dei file offre una vista panoramica di tutti i file che sono stati modificati.

E possibile utilizzare il filtro per visualizzare tutti i file modificati, solamente i file audio
o solamente i montaggi audio.

Esporta
Consente di renderizzare il file attivo.

Preferenze

Consente di visualizzare e modificare le preferenze di Wavelab Elements. E possibile
configurare le preferenze per le sequenti parti di WavelLab Elements:

e Globale
e Connessioni audio
e Scorciatoie
e Plug-in
e Dispositivi di controllo remoto
e Cartelle
e File audio
e Montaggi audio
Strumenti
Consente di accedere ai seguenti strumenti di utility:
e CD/DVD dati

e Conversione batch

LINK CORRELATI

Scheda Info a pag. 46

Configurazione di Wavelab Elements a pag. 405
Finestra di dialogo Formato file speciale a pag. 144
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Scheda Info

Scheda Info

La scheda Info offre una serie di informazioni sul file attivo e consente di modificare le proprieta
audio dei file audio e dei montaggi audio.

e Per aprire la scheda Info, selezionare la scheda File e fare clic su Info.
WFRALE O©VIEW € DT & INSERT ®g PROCESS 5 RENDER

CURRENT FILE

W51 01.wav(

Name

5.1.01|

Folder C: | 44.1_16Bit-Interleav
L3 Mew

= Open

File Properties
&, Import _
Size
Date Freit

Format M
Audio Properties
Channel Configuration  Surround
Layout 51(LRCLFELs
Sample Rate 44 100 Hz

Bit Depth 24 bit

Sample Attributes
Tune
Key Range

Velocity Range

L?J Copy to Clipboard veal in File

Ei Delete
A seconda del file sorgente selezionato, sono disponibili diverse informazioni e opzioni.

Nome
Visualizza il nome, I'estensione file e la posizione del file attivo. E possibile modificare
questi attributi.

Proprieta dei file
Visualizza la dimensione, la data e il formato del file attivo.
Proprieta audio

Per i file audio, viene visualizzata |la Configurazione dei canali, |a Frequenza di
campionamento e la Profondita in bit del file attivo.

Per i montaggi audio, viene visualizzata la Configurazione dei canali e la Frequenza
di campionamento del file attivo.

E possibile modificare questi attributi.

Attributi dei campioni (solo file audio)
Visualizza gli attributi musicali tonalita, intervallo di tonalita e intervallo di velocity.

Metadati
Visualizza i metadati del file attivo o del file che e stato selezionato nella finestra
Browser dei file.
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Finestre degli strumenti

Copia negli appunti
Consente di aprire un menu nel quale & possibile selezionare le informazioni sul file
attivo che si desidera copiare negli appunti.
Individua in Esplora file/macOS Finder
Consente di aprire Esplora file/macOS Finder per mostrare la posizione del file attivo.
Elimina
Elimina il file attivo.

LINK CORRELATI
Finestra Browser dei file a pag. 65

Finestre degli strumenti

In WaveLab Elements sono disponibili diverse finestre degli strumenti di utility che consentono di
visualizzare, analizzare e modificare il file attivo.

Solitamente, i contenuti di una finestra degli strumenti vengono sincronizzati con il file attivo,
ad eccezione degli indicatori audio, che visualizzano il file audio in riproduzione. Le finestre
degli strumenti possono venire ancorate o disancorate e possono essere salvate nei layout
personalizzati. Alcune finestre degli strumenti di utility sono disponibili solamente per specifici
tipi di file.

E possibile accedere alle finestre degli strumenti di utility tramite il menu Finestre degli
strumenti di utility.

LINK CORRELATI
Apertura e chiusura delle finestre degli strumenti di utility a pag. 47

Apertura e chiusura delle finestre degli strumenti di utility

E possibile chiudere tutte le finestre degli strumenti di utility non necessarie per il proprio
progetto.

e Per aprire una finestra, selezionare Finestre degli strumenti di utility e selezionare una
delle finestre disponibili.

e Per chiudere una finestra ancorata, fare clic-destro sulla rispettiva scheda e selezionare
Nascondi.

e Per chiudere una finestra non ancorata, fare clic sul rispettivo pulsante X.
LINK CORRELATI

Finestre degli strumenti a pag. 47

Finestre scorrevoli

Le finestre scorrevoli sono nascoste nella cornice della finestra Area lavoro. Quando si porta il
puntatore del mouse sul nome della finestra, questa scorre divenendo visibile. La finestra viene
nuovamente nascosta quando si fa clic in un qualsiasi altro punto.
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Ancoraggio e disancoraggio delle finestre degli strumenti di utility e degli indicatori

SHIHUYIN P4 X

Scheda di una finestra a scorrimento

MARKERS
i Fiter @ T T & ¢l

Name Time & Length a Clip Reference Offset

1 1Ieell Clip 1 7555 4 597 ms

SUDIUYIN P4

2 bl
3 [IpRll

PR

Una finestra a scorrimento aperta

Ancoraggio e disancoraggio delle finestre degli strumenti di
utility e degli indicatori

Le finestre degli strumenti di utility e le finestre degli indicatori possono essere utilizzate come
finestre ancorate, fluttuanti o scorrevoli. E possibile muovere liberamente le finestre e ancorarle
in diverse posizioni.

e Per disancorare una finestra degli strumenti di utility o degli indicatori, trascinare la scheda
corrispondente in un‘altra posizione.

La finestra diventa quindi fluttuante e puo essere spostata liberamente.

e Per ancorare una finestra degli strumenti di utility o degli indicatori, fare clic e tenere
premuto il pulsante del mouse sulla rispettiva barra del titolo oppure fare clic sul pulsante
Opzioni a destra della barra del titolo e selezionare Ancora il gruppo di schede in un punto
qualsiasi.

I simboli di colore giallo indicano le posizioni delle finestre ancorate, i simboli rosa indicano
le posizioni delle finestre scorrevoli. Trascinare la finestra in una di queste posizioni.

MARKERS
Func Filter

) [ ET
1 1Pkl

5 [1PRII

3 [1kell

4 Il
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Ancoraggio e disancoraggio delle finestre degli strumenti di utility e degli indicatori

Functions & +- MARKERS _
Functions  Filter

g) Name
NS

5 11PMII

3 1kl

4 Ivpll

e Per ancorare una finestra degli strumenti di utility o degli indicatori alla rispettiva ultima
posizione di ancoraggio, fare clic sul pulsante Opzioni I= a destra della barra del titolo e
selezionare Ancora nuovamente all'ultima posizione.

r

MARKERS
Functions Filter @ T = ’ |
q) Name Time 4 Length ﬁ Clip Reference Offset
L Clip 1 7s553ms 4 597 ms
2 lvpll

Auto Transparency

3 lbell ) X Hide

4 110l

LINK CORRELATI
Finestre scorrevoli a pag. 47

Nascondere la barra del titolo nelle finestre degli indicatori
fluttuanti

Per preservare spazio su schermo, la barra del titolo delle finestre degli indicatori fluttuanti pud
essere automaticamente nascosta nel caso in cui la finestra non rappresenti la finestra attiva.
Questa impostazione puo essere regolata singolarmente per ciascuna finestra fluttuante.

PROCEDIMENTO

1. Inuna finestra degli indicatori fluttuanti, fare clic sul pulsante Opzioni che si trova nella
parte superiore-destra della finestra.

2. Selezionare Barra del titolo automatica.

49



La finestra Area lavoro
Barra dei comandi

Barra dei comandi

La barra dei comandi della finestra dei file consente di creare, aprire e salvare i file, oltre che
di annullare/ripetere le modifiche effettuate. E inoltre possibile utilizzare il campo di testo per
trovare rapidamente i file aperti e accedervi, oltre che per attivare le parole chiave.

* AUDIOMONTAGE

Nuovo

Consente di creare un file audio, un montaggio audio o un feed RSS. E possibile creare
dei nuovi file o utilizzare un modello.

Apri
Consente di aprire un file audio, un montaggio audio o un feed RSS.

Salva
Salva il file attivo.

Salva con nome

Consente di salvare il file attivo. E possibile specificare il nome, il formato file e la
posizione. Pud essere inoltre salvata una copia del file attivo.

Attiva un aggiornamento in Cubase/Nuendo

Aggiorna il progetto di Cubase/Nuendo nel caso in cui il file attivo era stato aperto
utilizzando l'opzione Modifica in WaveLab.

Annulla
Consente di annullare le modifiche.

Ripeti
Consente di ripetere le modifiche precedentemente annullate.

Naviga indietro/Naviga in avanti

Nell'Editor audio e nella finestra Montaggio audio, questi comandi consentono di
navigare fino alla posizione del cursore, al fattore di ingrandimento o all'intervallo
di selezione precedenti/successivi, senza dover annullare/ripetere l'operazione di
modifica.

Personalizza la barra dei comandi
Consente di selezionare i pulsanti da visualizzare sulla barra dei comandi.

Massimizza la finestra

Consente di massimizzare la finestra. Per ripristinare la dimensione della finestra, fare
clic nuovamente sul pulsante.

Opzioni di layout
Consente di determinare la posizione della barra dei comandi e della barra di
trasporto.

LINK CORRELATI
Wavelab Exchange a pag. 372

Barra di stato

La barra di stato, situata nella parte inferiore della schermata dell’Editor audio e della finestra
Montaggio audio consente di visualizzare una serie di informazioni relative alla finestra attiva
utilizzando le unita specificate nei righelli.
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La finestra Area lavoro
Barra di stato

Le informazioni visualizzate nella barra di stato vengono aggiornate sulla base della posizione
del cursore e della selezione audio eseguita.

Tempo/Livello (dB)
Consente di visualizzare il tempo del file audio nella posizione del cursore del mouse.
Nell’Editor audio, visualizza anche il livello.

Il valore tra parentesi mostra il tempo dalla posizione del cursore di modifica alla
posizione del cursore del mouse.

Informazioni audio nella posizione del cursore di modifica
Consente di visualizzare il tempo nella posizione del cursore di modifica. Queste
informazioni cambiano se si riposiziona il cursore.

e Per definire la posizione del cursore, fare clic sul campo Informazioni audio
presso il cursore di modifica in modo da aprire la finestra di dialogo Posizione
del cursore.

e Per focalizzare la posizione del cursore, fare clic-destro sul campo Informazioni
audio presso il cursore di modifica.

Indicatore della selezione audio (Editor audio)/Indicatore dell'intervallo audio
(Montaggio audio)
Nell'Editor audio, questa funzione visualizza la lunghezza della selezione corrente o la
lunghezza totale del file audio, nel caso in cui non sia stata definita alcuna selezione.
Nella finestra Montaggio audio, questa funzione visualizza la lunghezza della
selezione audio, se e selezionata una clip, o la dimensione del montaggio audio.

Se e stato eseguito un ingrandimento, € possibile fare clic-destro sull'indicatore per
visualizzare l'intervallo audio selezionato, la clip selezionata o il file intero. Fare clic
sullindicatore per aprire la finestra di dialogo Selezione dell'intervallo, nella quale &
possibile definire o rifinire una selezione.

Indicatore di zoom
Consente di visualizzare il fattore di zoom corrente.

e Per aprire un menu a tendina nel quale poter definire ulteriori impostazioni di
zoom, fare clic sull'indicatore.

e Per aprire la finestra di dialogo Fattore di ingrandimento, nella quale poter
modificare il fattore di ingrandimento, fare clic-destro sull'indicatore.

Indicatore delle note del campionatore (solo Editor audio)

Indica la nota del file audio corrente (se definita). Fare clic sull'indicatore per aprire la
finestra Attributi dei campioni.

Proprieta dei file audio/Proprieta dei montaggi audio
Nell'Editor audio, questo indicatore consente di visualizzare la profondita in bit e la
frequenza di campionamento. Indica inoltre se il file audio € mono o stereo. Fare clic
sullindicatore per aprire la finestra di dialogo Proprieta audio.
Nella finestra Montaggio audio viene visualizzata la frequenza di campionamento del
montaggio audio. Fare clic sull'indicatore per aprire la finestra di dialogo Frequenza di
campionamento.
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La finestra Area lavoro
Menu contestuali

Bypass della Sezione Master

Se questa opzione & disattivata, la Sezione Master viene ignorata durante la
riproduzione. La renderizzazione tiene comunque in considerazione tutti i plug-in.

Informazioni sulle operazioni di background

La barra di stato consente di visualizzare 'avanzamento di alcune operazioni di
background, come ad esempio la renderizzazione di un effetto. L'operazione puo
essere messa in pausa o annullata tramite gli appositi pulsanti.

(%) l [Elapsed: 645/ Remaining: 34|

Menu contestuali

Righello

In WavelLab Elements sono disponibili diversi menu contestuali. Questi menu raggruppano i
comandi e/o le opzioni specifici della finestra attiva.

I menu contestuali vengono visualizzati se si fa clic-destro su specifiche aree e sono utili per
velocizzare il flusso di lavoro.

Ad esempio, & possibile fare clic-destro su una scheda file per aprire un menu contestuale con
alcune opzioni file rilevanti. Facendo clic-destro sul righello della finestra della forma d'onda
viene visualizzato il menu contestuale del Righello del tempo, che consente di accedere a
diverse opzioni per la modifica del formato di visualizzazione del righello del tempo.

E possibile trovare la maggior parte dei comandi dei diversi menu contestuali nelle schede, nella
finestra dei file e nei menu principali; tuttavia, alcuni di essi sono disponibili esclusivamente nei
menu contestuali. Se si ricerca una funzione, fare clic-destro sulla finestra di lavoro corrente per
verificare se € disponibile un menu contestuale.

Z then C

Menu contestuale nella finestra di montaggio

LINK CORRELATI
Righello del tempo e Righello del livello a pag. 52

del tempo e Righello del livello

Nell'Editor audio, & possibile visualizzare un righello del tempo e un righello del livello all'interno
della finestra della forma d'onda. Nella finestra Montaggio audio, & possibile visualizzare un
righello del tempo nella finestra di montaggio.

E possibile determinare le unita di tempo e livello visualizzate dai righelli. Sono disponibili le
seguenti unita:

e Timecode
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e Orologio
e Campioni
e Misure e movimenti

Righello del tempo

|J.=

Righello del livello (solo Editor audio)

LINK CORRELATI

Finestra di montaggio a pag. 190

Finestra della forma d'onda a pag. 111

Opzioni del righello del tempo e del righello del livello a pag. 53
Finestra di dialogo Formato tempo a pag. 56

Opzioni del righello del tempo e del righello del livello

E possibile specificare separatamente i formati del tempo e del livello (ampiezza) per ciascun
righello in ciascuna finestra della forma d'onda e i formati del tempo per ciascun righello nella
finestra di montaggio.

LINK CORRELATI

Righello del tempo e Righello del livello a pag. 52
Menu del righello del tempo a pag. 53

Menu Righello del livello (solo Editor audio) a pag. 54

Menu del righello del tempo

I menu del righello del tempo consente di impostarne il tipo di visualizzazione, come ad esempio
il formato del timecode e del tempo.

e Per aprire il menu del righello del tempo, fare clic-destro sul righello del tempo.
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Timecode

Consente di visualizzare un elenco di frame per secondo per diversi tipi di timecode
SMPTE e per la risoluzione CD.

E possibile specificare il tipo di timecode nella finestra di dialogo Formato tempo.

Orologio
Consente di visualizzare le unita di tempo. E possibile definire delle impostazioni
aggiuntive per le unita di tempo nella finestra di dialogo Formato tempo.

Campioni
Visualizza le posizioni sotto forma di numero di campioni. Il numero di campioni per
secondo dipende dalla frequenza di campionamento del file audio. Ad esempio, a
44,1 kHz, ci sono 44.100 campioni per secondo. E possibile definire delle impostazioni
aggiuntive per i campioni nella finestra di dialogo Formato tempo.

Misure e movimenti
Visualizza le misure e i movimenti. E possibile definire delle impostazioni aggiuntive
per le misure e i movimenti nella finestra di dialogo Formato tempo.

Dimensione file (solo Editor audio)
Consente di visualizzare le posizioni in megabyte. I decimali rappresentano i kilobyte.

Visualizza la griglia (solo finestra Montaggio audio)
Consente di visualizzare delle linee verticali nella finestra del montaggio, allineate ai
contrassegni del righello del tempo.

Formato tempo
Apre la finestra di dialogo Formato tempo che consente di modificare I'aspetto dei
formati del righello del tempo.

Salva le impostazioni correnti come predefinite
Se questa opzione & attivata, il righello del tempo utilizza il formato del tempo corrente
in tutte le nuove finestre della forma d'onda o finestre del montaggio.

Imposta lI'origine del righello all'inizio del file
Se questa opzione € attivata, la posizione zero del righello & impostata all'inizio del
primo campione.

Imposta l'origine del righello al cursore

Se questa opzione € attivata, la posizione zero del righello & impostata sulla posizione
corrente del cursore di modifica.

LINK CORRELATI

Righello del tempo e Righello del livello a pag. 52
Finestra di dialogo Formato tempo a pag. 56

Menu Righello del livello (solo Editor audio) a pag. 54

Menu Righello del livello (solo Editor audio)
Il menu del righello del livello consente di definirne il formato.

e Per aprire il menu del righello del livello, fare clic-destro sul righello del livello nell'Editor
audio.

54



La finestra Area lavoro
Righello del tempo e Righello del livello

Current Sett

dB
Consente di impostare il formato del livello sui decibel.

+-100%
Consente di impostare il formato del livello sulla percentuale.

Normalizzato +1 /-1

Consente di impostare il formato del livello su una gradazione del righello
corrispondente all'audio a 64 bit a virgola mobile.

Intervallo 16 bit
Consente di impostare il formato del livello su una graduazione del righello
corrispondente all'audio a 16 bit.

Intervallo 24 bit

Consente di impostare il formato del livello su una graduazione del righello
corrispondente all'audio a 24 bit.

Salva le impostazioni correnti come predefinite

Se questa opzione € attivata, il righello del livello utilizza il formato del livello corrente
in tutte le nuove finestre della forma d’'onda.

LINK CORRELATI
Righello del tempo e Righello del livello a pag. 52
Menu del righello del tempo a pag. 53

Lavorare con una visualizzazione basata su un indicatore

Se si sta lavorando su materiale basato sul tempo, & possibile selezionare il formato
dell'indicatore (misure, battiti e unita), che verra visualizzato sulla legenda del righello. In questo
modo & possibile trovare punti di stacco collegati musicalmente.

PROCEDIMENTO

1. Nella finestra della forma d'onda o di montaggio, fare clic-destro sul righello del tempo e
selezionare Misure e battiti.

2. Fare clic-destro sul righello dei tempi e selezionare Formato tempo.

3. Nella scheda Misure e movimenti, impostare i parametri Indicazione metrica e Tempo su
valori adeguati al proprio file audio.

4. Impostare il parametro Unita per nota da un quarto su un numero che si ritiene adatto.
Ad esempio, € possibile applicare lo stesso valore utilizzato dal proprio sequencer MIDI.
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5. Fare clic su OK.

LINK CORRELATI
Righello del tempo e Righello del livello a pag. 52
Finestra di dialogo Formato tempo a pag. 56

Impostazione della posizione del cursore di modifica

Molte operazioni, come la riproduzione e la selezione, dipendono dalla posizione corrente
del cursore di modifica. La riproduzione ad esempio, inizia spesso a partire dalla posizione
del cursore. La posizione corrente del cursore di modifica & indicata da una linea verticale
lampeggiante.

Il cursore di modifica pud essere spostato in diversi modi:

e Fareclicin un punto della finestra della forma d'onda o di montaggio oppure sul righello del
tempo. Se é stata effettuata una selezione, fare clic sul righello del tempo per impedire la
deselezione.

e Fareclic e trascinare il cursore sul righello del tempo.
e Utilizzare i controlli di trasporto.

e Nell’Editor audio e nella finestra Montaggio audio, selezionare la scheda Vista e utilizzare
le opzioni disponibili nella sezione Cursore.

e Utilizzare i tasti freccia.

e Fare doppio-clic su un marker.

LINK CORRELATI
Righello del tempo e Righello del livello a pag. 52
Finestra di dialogo Formato tempo a pag. 56

Finestra di dialogo Formato tempo

In questa finestra di dialogo, & possibile personalizzare il formato del tempo del righello. II
formato del tempo del righello viene inoltre utilizzato, ad esempio, in vari campi del programma
relativi al tempo, nella barra di stato e in alcune finestre di dialogo.

e Per aprire la finestra di dialogo Formato tempo, fare clic-destro sul righello nell’Editor
audio o nella finestra Montaggio audio e selezionare Formato tempo.

Nell'Editor audio € possibile definire formati del tempo diversi per la vista panoramica e la
vista principale.

v Time Format *

Timecode

Frames pe

25 (SMPTE EBU)
Quarter Fran

ndredth Frames
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Scheda Timecode
In questa scheda € possibile configurare I'aspetto del Timecode.

Fotogrammi (frame) al secondo

Elenca i valori di frame rate standard. Dal menu a tendina, selezionare Altro per
inserire un frame rate personalizzato. E inoltre possibile scegliere quali frame o unita
vengono visualizzati.

Mostra frame assoluti

Consente di visualizzare il formato di tempo come numero di frame, senza alcun altro
elemento.

Mostra quarti di frame
Consente di aggiungere il numero di frame al formato del tempo.

Mostra centesimi di frame
Consente di aggiungere il numero dei centesimi di frame al formato del tempo.

Mostra unita
Consente di aggiungere unita di tempo al formato del tempo del righello.

Scheda Orologio
In questa scheda & possibile configurare I'aspetto del righello dell'Orologio.

Mostra unita
Consente di aggiungere unita di tempo al formato del tempo del righello.

Compatto
Consente di visualizzare il tempo senza indicatori di unita.

Scheda Misure e movimenti

In questa scheda & possibile configurare I'aspetto del righello delle Misure e movimenti.

Indicazione metrica

Consente di modificare I'indicazione metrica utilizzata per visualizzare il tempo
rappresentato come notazione musicale.

Tempo
Consente di regolare il tempo utilizzato per visualizzare il tempo rappresentato come
notazione musicale.

Unita per nota da un quarto

Consente di regolare il numero di unita per ciascuna nota da un quarto. Queste
vengono utilizzate per visualizzare il tempo compatibile con il proprio sequencer.

Visualizza i tick
Consente di visualizzare/nascondere i tick nel righello delle Misure e movimenti.

LINK CORRELATI
Righello del tempo e Righello del livello a pag. 52
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Gestione delle schede

Una scheda rappresenta il contenitore di un file in WaveLab Elements. E possibile aprire
numerose schede, ma ne risulta attiva soltanto una alla volta. Il menu contestuale Schede offre
una serie di opzioni relative alle schede.

Schede file

Le seguenti opzioni sono disponibili quando si fa clic-destro su una scheda file.

W\ Track A AN Track B AN Track C e Track 1

Crea un montaggio audio
Consente di selezionare I'opzione Dal file audio corrente per creare un montaggio
audio con il file audio corrente, sotto forma di una clip.
Aggiungi a
Consente di aggiungere il file attivo a un altro editor.
Chiudi
Consente di chiudere la scheda attiva.

Chiudi tutto tranne questo
Consente di chiudere tutti i file eccetto quello attivo.

Chiudi tutti i file audio
Chiude tutti i file audio.

Info
Consente di visualizzare informazioni relative al file attivo.

Individua in Esplora file/macOS Finder
Consente di aprire Esplora file/macOS Finder per mostrare la posizione del file.
Copia negli appunti

Consente di aprire un menu nel quale & possibile selezionare le informazioni sul file
che si desidera copiare negli appunti.

File recenti
Consente di aprire i file utilizzati di recente.

LINK CORRELATI
Chiusura dei file a pag. 61
Creazione di montaggi audio da un file audio a pag. 207

Attivazione della modalita a schermo intero

E possibile utilizzare WaveLab Elements in modalita a schermo intero.

PROCEDIMENTO

e Selezionare Area lavoro > Schermo intero.

Reinizializzazione del layout predefinito di un‘area lavoro
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Reinizializzazione del layout predefinito di un'area lavoro

PROCEDIMENTO

e Selezionare Area lavoro > Ripristina il layout predefinito.
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Gestione dei file

In WaveLab Elements, i file possono essere gestiti in vari modi. Ad esempio, & possibile
rinominare i file direttamente in WavelLab Elements, oppure salvarli con modalita differenti.

LINK CORRELATI

Apertura dei file a pag. 60
Salvataggio dei file a pag. 61
Browser dei file a pag. 64

Apertura dei file

E possibile aprire uno o piu file contemporaneamente.

PROCEDIMENTO
1. Selezionare File > Apri.

2. Selezionare il tipo di file che si desidera aprire.
Selezionare ad esempio File audio.

3. Da Esplora file/macOS Finder, selezionare i file da aprire.

4. Fare clic su Apri.

RISULTATO
Ciascun file selezionato si apre in una scheda.

LINK CORRELATI

Chiusura dei file a pag. 61

Salvataggio dei file a pag. 61

Apertura di file dagli appunti a pag. 60

Apertura automatica dei file in un gruppo di schede dedicato a pag. 61

Apertura di file dagli appunti

E possibile aprire dei file in WaveLab Elements che sono stati precedentemente copiati negli
appunti in Esplora file/macOS Finder.

PROCEDIMENTO
1. In Esplora file/macOS Finder, copiare i file che si desidera aprire negli appunti.
2. In Wavelab Elements, selezionare File > Apri.

3. Fareclic su Apri i file dagli appunti.

RISULTATO
I file si aprono in nuove schede file.
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Apertura automatica dei file in un gruppo di schede dedicato

E possibile specificare un tipo di file per ciascun gruppo di schede. I file che si aprono al termine
del processo di renderizzazione, i file audio che vengono aperti da un montaggio audio o i file
che si aprono tramite Esplora file/macOS Finder vengono automaticamente aperti nel gruppo di
schede corrispondente per questo specifico tipo di file.

e Per specificare un tipo di file prioritario per un gruppo di schede, fare clic su Opzioni del
gruppo di schede file nell'intestazione di un gruppo di schede e selezionare un tipo di file.

udio Montage

d

Chiusura dei file

E possibile chiudere i file mediante la chiusura della relativa scheda. Possono essere chiusi singoli
file, file multipli o tutti i file tranne quello selezionato.

OPZIONI

e Per chiudere una scheda di un file, fare clic sul pulsante X relativo alla scheda corrispondente
o premere Ctrl/Cmd-W, oppure fare clic-destro sulla scheda e selezionare Chiudi.

Wi track-1 =

e Per chiudere una scheda file senza salvare le modifiche, tenere premuto Ctrl/Cmd - Shift e
fare clic sul pulsante X relativo alla scheda. Questo consente di evitare di dover confermare
un messaggio di allerta quando si desidera chiudere una scheda non salvata.

e Per chiudere tutte le schede file tranne la scheda selezionata, fare clic-destro sulla scheda file
desiderata e selezionare Chiudi tutto tranne questo.

LINK CORRELATI
Apertura dei file a pag. 60

Salvataggio dei file

E possibile salvare i file con lo stesso nome e posizione esistenti, oppure specificare un nome,
una posizione e un formato file nuovi in fase di salvataggio.

IMPORTANTE

Nell'Editor audio, tutte le operazioni di salvataggio, ad eccezione di Salva copia, azzerano la
storia delle operazioni di annullamento; di conseguenza, dopo il salvataggio non & piu possibile
annullare o ripristinare alcuna operazione.
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Salvataggio dei file

OPZIONI

e Una volta salvato il file, selezionare File > Salva o premere Ctrl/Cmd-S per aggiornare il file
e rendere permanenti le modifiche.

e Sesidesidera specificare un nuovo nome, posizione e/o formato file, selezionare File > Salva
con nome.

LINK CORRELATI
Indicatori di cambio scheda a pag. 62
Salvataggio di piu file alla volta a pag. 62

Indicatori di cambio scheda

L'angolo colorato della scheda consente di verificare se si tratta o meno di un file salvato e se il
file & stato renderizzato in Cubase.
Bianco

Il file non & modificato.

Verde (solo Editor audio)
Il file viene utilizzato come un formato file decodificato e salvato.

Rosso
Il file & stato modificato e le modifiche non sono ancora state salvate.

Giallo
Il file & stato renderizzato in Cubase.

Indicatore di modifiche non salvate
Quando sono state apportate delle modifiche a un file, viene visualizzato un asterisco a
fianco del nome del file fino al suo salvataggio.

M Track 1*

Salvataggio di piu file alla volta

E possibile salvare alcuni o tutti i file aperti in una volta.

PROCEDIMENTO
1. Aprire la finestra File e fare clic su Salva tutto.
2. Selezionare ifile che si desidera salvare.

3. Fare clic su Salva.

Salvataggio di copie dei file

E possibile salvare delle copie dei file sui quali si sta lavorando.

PROCEDIMENTO
1. Selezionare File > Salva con nome.
2. Specificare un nome e una posizione.

3. Fare clic-destro su Salva e selezionare Salva copia.
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Eliminazione di file

Ritorno alla versione del file salvata

E possibile riportare il file su cui si sta lavorando allo stato dell'ultimo salvataggio. In questo
modo vengono annullate tutte le modifiche apportate al file dall'ultimo salvataggio.

PROCEDIMENTO

1. Selezionare File > Apri.

2. Selezionare il tipo di file che si desidera aprire.
3. Fareclic su Ritorna al file salvato.
4

Nella finestra di dialogo di avviso, fare clic su Si per riportare allo stato dell'ultimo
salvataggio.

RISULTATO
L'ultima versione salvata del file viene caricata dal disco.

Backup automatici

E possibile creare automaticamente delle copie di backup dei propri file, in modo da prevenire la
perdita di dati.

Ad esempio, se si seleziona Salva con nome e si specifica un nome di file gia utilizzato in tale
cartella, verra richiesto se si desidera sostituire il file esistente o sostituire il file esistente e
rinominare il vecchio file. Se si fa clic su Sostituisci e mantieni la vecchia versione, il nome di
backup del file audio che viene sostituito corrispondera al nome originale, con l'estensione .bak
aggiunta alla fine.

Salvataggio dei montaggi audio

Le operazioni di salvataggio per i montaggi audio corrispondono a quelle per i file audio.
Tuttavia, € necessario considerare alcuni punti durante il salvataggio dei montaggi audio.

e Ifile del montaggio audio contengono esclusivamente i riferimenti ai file audio. Se si
desidera rinominare i file audio ai quali fanno riferimento dei montaggi audio, rinominare i
file audio desiderati nella finestra Info dell’Editor audio. Tutti i riferimenti delle clip vengono
aggiornati automaticamente.

e Seil montaggio audio contiene clip che fanno riferimento a file audio senza titolo, salvare
questi file audio prima di salvare il montaggio audio.

LINK CORRELATI
Rinomina dei file a pag. 64
Salvataggio dei file a pag. 61

Eliminazione di file

E possibile eliminare il file attivo direttamente da WaveLab Elements.

PREREQUISITI

Il file che si desidera eliminare non deve essere copiato negli appunti, incollato in un altro file
aperto o aperto in un‘altra applicazione.
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PROCEDIMENTO

1. Aprire il file che si desidera eliminare.
2. Selezionare la scheda File.

3. Fare clic su Info.

4. Fareclic su Elimina.
5

Fare clic su OK.

RISULTATO
Il file, compresi i relativi file marker e picchi, viene eliminato.

Rinomina dei file

E possibile rinominare un file e aggiornare automaticamente tutti i relativi riferimenti. Ad
esempio, se si rinomina un file audio chiamato India in Sitar, tutti i file aperti che fanno
riferimento al file India vengono aggiornati in modo da fare riferimento al file Sitar.

File audio, file di picco e file marker vengono anch'essi rinominati di conseguenza.
LINK CORRELATI

File di picco a pag. 39
Rinomina dei file a pag. 64

Rinomina dei file
E possibile rinominare i file direttamente da WaveLab Elements.

PREREQUISITI

Se si desidera rinominare un file al quale fanno riferimento altri file, aprire i file che fanno
riferimento al file che si sta per rinominare in WavelLab Elements.

PROCEDIMENTO
1. Aprire il file che si desidera rinominare.
2. Eseguire una delle seguenti operazioni:

e Selezionare la scheda File, fare clic su Info, specificare un nuovo Nome, una nuova
Cartella e/o un'estensione file e fare clic su Applica le modifiche.

e Premere F2, specificare un nuovo Nome, una nuova Cartella e/o un'estensione file e
fare clic su OK.

LINK CORRELATI
Rinomina dei file a pag. 64
Scheda File a pag. 44

Browser dei file

La finestra Browser dei file consente di navigare tra i file direttamente da WavelLab Elements. La
modalita Riproduzione automatica ¢ utile per velocizzare il processo di anteprima dei file audio.

Il Browser dei file fornisce tutte le funzioni standard di esplorazione dei file e contiene una
serie di controlli aggiuntivi per ascoltare i file audio e tutte le regioni definite dai marker. E
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possibile utilizzare questo strumento per aprire o inserire i file trascinandoli direttamente in
un'altra posizione.

E inoltre possibile decidere di visualizzare solamente dei tipi di file specifici.

LINK CORRELATI
Finestra Browser dei file a pag. 65

Finestra Browser dei file
In questa finestra, € possibile sfogliare i file e aprirli in WaveLab Elements.

e Per aprire la finestra Browser dei file, selezionare Finestre degli strumenti di utility >
Browser dei file.

FILEBROWSER

':g(—‘ 4\‘ = b Yy ) » L= |

Date Modified 1ple Rate Bits Bit Rate Length Chan ) Name Start Length
Y -
rd

5 M

Visualizza la cartella corrente nell'albero delle cartelle
Sincronizza l'albero delle cartelle con I'elenco dei file, in modo che la cartella selezionata
nell’elenco dei file verra visualizzata anche nell'albero delle cartelle.
Indietro/Avanti/Directory superiore
Consentono di navigare nell'elenco e nella gerarchia dei file.

Posizione
Questo menu consente di selezionare una posizione per navigare tra i file ed elenca le
posizioni utilizzate di recente.

Riproduci attraverso la Sezione Master
Se questa opzione & attivata e si riproduce il file audio selezionato, questo viene
riprodotto attraverso i plug-in della Sezione Master.

Modalita Riproduzione automatica
Se questo pulsante ¢ attivato, la riproduzione viene avviata automaticamente quando
si seleziona un file.

Riproduci il file audio selezionato
Consente di riprodurre il file audio selezionato.

Cerca

Se questo pulsante & attivato, € possibile inserire del testo nel campo di ricerca. Se &
disattivato, & possibile cercare specifici formati file.

Elenco dei tipi di file
Consente di selezionare il tipo e il formato dei file da visualizzare.
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Struttura ad albero delle cartelle
Visualizza le cartelle disponibili sul computer utilizzato.

Cartelle preferite
L'elenco delle cartelle preferite consente di accedere rapidamente a determinate
cartelle. Ciascun tipo di file dispone di una propria cartella preferiti. E possibile
aggiungere delle cartelle all'elenco delle cartelle preferite mediante trascinamento
dall'albero delle cartelle all'area delle cartelle preferite, oppure facendo clic-destro su
una cartella e selezionando Aggiungi all'elenco delle cartelle preferite.

Elenco dei file
Visualizza le seguenti informazioni relative a ciascun file:

e Nome mostra il nome del file audio.

e Dimensione indica la dimensione del file audio.

e Tipo mostra il tipo di file audio.

e Data di modif. indica la data in cui & avvenuto l'ultimo salvataggio del file.

e Frequenza di campionamento mostra il valore della frequenza di
campionamento in Hz.

e Bitindica la profondita in bit. «<32F» indica il formato 32 bit in virgola mobile
mentre «64F» 64 bit in virgola mobile.

e Bit rate mostra il bit rate (o velocita in bit) in kbps.
e Durata mostra la durata del file audio.

e Canali visualizza il numero di canali.

Quando si seleziona un file audio nella finestra Browser dei file, i metadati
corrispondenti vengono visualizzati nella finestra Metadati e nella sezione relativa ai
metadati della scheda Info. Quando si fa clic in un qualsiasi altro punto, la finestra
Metadati visualizza i metadati del file audio, del montaggio audio o del processo batch
selezionati.

Mostra in Esplora file/Mostra in macOS Finder

Se si fa clic-destro nell'elenco dei file, & possibile selezionare Mostra in Esplora file/
Mostra in macOS Finder per aprire il file selezionato in Esplora file/macOS Finder.

Crea cartella
Se si fa clic-destro nell'elenco dei file, € possibile selezionare I'opzione Crea cartella per
aggiungere una nuova cartella per I'organizzazione dei propri file.

Regioni audio
Se il file selezionato contiene dei marker, questi vengono visualizzati nella sezione delle
regioni audio.
Se la sezione delle regioni audio € nascosta, selezionare un file contenente i marker e
fare clic su Visualizza le regioni audio.
Per nascondere la sezione delle regioni audio, fare clic-destro e selezionare Nascondi.

| This file contains audio regions

{ Show Audio Regions

LINK CORRELATI
Finestra Browser dei file a pag. 65
Scheda Cartelle (Preferenze) a pag. 89
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Aggiunta di cartelle all'elenco delle cartelle preferite a pag. 67
Finestra Metadati a pag. 153
Scheda Info a pag. 46

Aggiunta di cartelle all’'elenco delle cartelle preferite

L'elenco delle cartelle preferite nella finestra Browser dei file consente di accedere rapidamente
a determinate cartelle. Ciascun tipo di file dispone di una propria cartella preferiti.

PROCEDIMENTO
e Nellafinestra Browser dei file, eseguire una delle seguenti operazioni:
e Trascinare una cartella dall'albero delle cartelle all'area delle cartelle preferite.

e Fare clic-destro su una cartella e selezionare Aggiungi all'elenco delle cartelle
preferite.

e Fare clic-destro sull'area delle cartelle preferite e selezionare Aggiungi la cartella
selezionata all'elenco delle cartelle preferite per aggiungere la cartella attualmente
selezionata all'elenco delle cartelle preferite.

LINK CORRELATI
Finestra Browser dei file a pag. 65

Passaggio da un file all'altro

E possibile tenere aperti piu file e passare dall'uno all‘altro.

OPZIONI
e Per portare un file in primo piano, fare clic sulla scheda corrispondente.
e Per scorrere i diversi file, tenere premuto Ctrl/Cmd e premere Tab ripetutamente.

e Per scorrere indietro e in avanti gli ultimi due file attivi, premere Ctrl/Cmd-Tab. Tra una
fase e l'altra & necessario rilasciare tutti i tasti.

e Per scorrere indietro, premere Ctrl/Cmd - Shift-Tab.
e Per passare dal file attivo all'ultimo file modificato, premere F5.

File utilizzati di recente
Tutti i file utilizzati di recente in WaveLab Elements sono salvati in un elenco. In questo modo

I'accesso ai progetti recenti € piu rapido.

Apertura di file utilizzati di recente

E possibile aprire i file utilizzati di recente mediante il menu File o dalla scheda File recenti, nella
quale & visualizzato un numero maggiore di file e sono disponibili delle opzioni supplementari.

PROCEDIMENTO

1. Selezionare File > Apri.

2. Selezionare il tipo di file che si desidera aprire.
3. Fareclic su File recenti.
4

Facoltativo: utilizzare il campo di ricerca per inserire il nome del file che si sta cercando.
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5. Selezionare il file che si desidera aprire.

6. Fare clic su Apri.

LINK CORRELATI
Scheda File recenti a pag. 68

Scheda File recenti

Questa scheda consente di visualizzare e gestire tutti i file utilizzati di recente in WavelLab
Elements. E possibile cercare file, aprire piu file contemporaneamente e rimuovere file singoli
o file che non possono essere individuati.

e Per aprire la scheda File recenti, selezionare File > Apri, selezionare uno dei tipi di file e fare
clic su File recenti.

\ Audio File Name Usage D Sam e Bits Bit Rate Leng|
N Tra io 32F 9mn 5

—
= Orowse
== Browse

@ Recent Files

Visualizza solamente i file creati da WaveLab Elements
Consente di visualizzare solo i file che non sono stati aperti dal momento della
creazione da parte di WavelLab Elements. Ad esempio, un file renderizzato presenta
questo stato fino all'apertura.

Campo di ricerca
Consente di eseguire delle ricerche testuali nelle colonne Nome o Percorso, a seconda
della colonna selezionata.

Rimuovi i file non esistenti
Consente di rimuovere dall'elenco i file che non & possibile trovare sul supporto
utilizzato.

Rimuovi i file selezionati
Consente di rimuovere tutti i file selezionati dall'elenco.

Apri
Consente di aprire i file selezionati.

Filtraggio di file utilizzati di recente in base al nome

Il campo diricerca nella scheda File recenti consente di filtrare I'elenco dei file preferiti in base al
nome.

e Per specificare se utilizzare la colonna Nome o Percorso, fare clic rispettivamente
sull'intestazione della colonna Nome o Percorso.

e Per cercare un file, inserire il testo che si desidera cercare nel campo diricerca.

e Per portare il focus dal campo di ricerca all'elenco dei file utilizzati di recente, premere
Freccia giu.

e Per portare il focus dall'elenco dei file utilizzati di recente al campo di ricerca, premere Ctrl/
Cmd-F.
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Impostazione del numero di file utilizzati di recente da visualizzare

E possibile specificare il numero di file che devono essere visualizzati nellelenco dei file utilizzati
di recente.

PROCEDIMENTO
1. Selezionare File > Preferenze > Globale.
2. Selezionare la scheda Visualizzazione.

3. Nella sezione Storia, definire il numero massimo di elementi da elencare nel menu File
recenti.

File temporanei

Wavelab Elements crea dei file temporanei per salvare i risultati intermedi del processamento
dei file audio e per le funzioni di annullamento/ripetizione. E possibile specificare la posizione in
cui WavelLab Elements salva i propri file temporanei e definire la precisione del processamento
dei file temporanei stessi.

Per impostazione predefinita, WavelLab Elements crea dei file temporanei a 32 bit in virgola
mobile. Utilizzare l'opzione 64 bit in virgola mobile se si desidera creare dei file audio a 64 bitin
virgola mobile o dei file PCM a 32 bit.

NOTA

I file temporanei a 64 bit in virgola mobile hanno una precisione doppia ma richiedono un tempo
di lettura e scrittura maggiore rispetto al formato 32 bit in virgola mobile e i relativi file hanno
dimensione doppia.

E possibile modificare la precisione del processamento dei file temporanei utilizzando I'opzione
File temporanei. Questa opzione ¢ regolabile nelle Preferenze globali, all'interno della scheda
Audio.

LINK CORRELATI
Definizione delle cartelle per I'apertura e il salvataggio dei file a pag. 89
Scheda Audio (Preferenze globali) a pag. 408

Annullamento e ripetizione

E possibile annullare e ripetere un numero qualsiasi di operazioni desiderate, anche dopo il
salvataggio del file. L'unica limitazione & data dallo spazio su disco disponibile.

Quando si annulla o si ripete un‘operazione nell’Editor audio o nella finestra Montaggio
audio, il fattore di ingrandimento, la posizione del cursore, la posizione di scorrimento, lo
stato di selezione della clip e l'intervallo temporale vengono riportati allo stato antecedente
all'esecuzione dell'operazione.

e Per annullare o ripetere un'operazione, fare clic su Annulla ¥} o Ripeti {™ nella barra del

titolo dell’Editor audio o nella finestra Montaggio audio.

LINK CORRELATI
Storia delle versioni a pag. 70
Annullamento delle modifiche agli effetti a pag. 259
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Storia delle versioni

La storia delle versioni consente di visualizzare una storia di tutte le versioni e di tornare a una
versione precedente. Nella finestra Storia & possibile visualizzare tutte le versioni del montaggio
audio o del file audio al quale si sta lavorando.

Nella storia di WaveLab Elements, ciascuna versione consiste in un file audio o in un montaggio
audio che possono essere ripristinati. Ciascuna modifica al file audio o al montaggio audio crea
una nuova versione.

La finestra Montaggio audio e la finestra Editor audio dispongono di finestre della Storia
indipendenti.

E possibile annullare e ripetere le operazioni eseguite e ripristinare delle versioni precedenti,
anche dopo il salvataggio dei file. La versione iniziale si trova in cima all'elenco, mentre la
versione pil recente € in fondo.

Il nome dell'operazione che ha creato la versione viene visualizzato nella riga Versione all'interno
della finestra Storia.

LINK CORRELATI
Finestra della Storia per i montaggi audio a pag. 70
Finestra della Storia per i file audio a pag. 71

Finestra della Storia per i montaggi audio

Questa finestra mostra tutte le versioni del montaggio audio al quale si sta lavorando. E possibile
annullare e ripetere le operazioni eseguite e ripristinare delle versioni precedenti. La versione
iniziale si trova in cima all'elenco, mentre la versione piu recente ¢ in fondo.

e Per aprire la finestra Storia, aprire la finestra Montaggio audio e selezionare Finestre degli
strumenti di utility > Storia.

HISTORY
Functions ¥} (™

Version Vv Description

Elenco della storia
Nell'elenco della storia sono disponibili le seguenti colonne:

Versione
Visualizza il tipo di operazione che ha creato la versione corrispondente.

Data
Visualizza la data di esecuzione dell'operazione.

Descrizione
Consente di aggiungere una descrizione a una versione.

Menu Funzioni

Nel menu Funzioni sono disponibili le sequenti opzioni:
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Annulla/Ripeti

Consente di annullare/ripetere l'ultima operazione. Le funzioni annulla/ripeti possono
essere utilizzate anche dopo il salvataggio.

Ripristina la versione selezionata
Consente di ripristinare la versione selezionata.

Apri la versione selezionata in una nuova scheda
Consente di aprire la versione selezionata in una nuova scheda.

Elimina la versione selezionata
Consente di rimuovere dalla storia la versione selezionata.

Cancella la storia

Consente di cancellare la storia. Questa funzione permette di liberare memoria e
spazio su disco. Se si cancella la storia, non & possibile annullare alcuna operazione
precedente.

Mantieni le versioni annullate

Per impostazione predefinita, se si ritorna a una versione precedente tutte le versioni
che erano state create dopo la versione selezionata vengono eliminate. Per mantenere
tutte le versioni nella storia anche se si ritorna a delle versioni precedenti, attivare
'opzione Mantieni le versioni annullate.

ESEMPIO

Sono state apportate le modifiche A, B, C e D. Si annullano successivamente le modifiche C e D.
Si esegue quindi la modifica E. Nella versione predefinita della storia, la storia contiene adesso

le modifiche A, B ed E. Se 'opzione Mantieni le versioni annullate ¢é attivata, |a storia contiene
le modifiche A, B, C, D ed E. Cid significa che anche dopo I'annullamento dei diversi passaggi, &

ancora possibile ritornare alle versioni annullate.

Finestra della Storia per i file audio

Questa finestra mostra tutte le versioni del file audio al quale si sta lavorando. E possibile
annullare e ripetere le operazioni eseguite e ripristinare delle versioni precedenti. La versione
iniziale si trova in cima all'elenco, mentre la versione piu recente & in fondo.

e Per aprire la finestra Storia, aprire 'Editor audio e selezionare Finestre degli strumenti di
utility > Storia.

Version # Description

Initial Version

6 ® New Marker

Elenco della storia
Nell'elenco della storia sono disponibili le seqguenti colonne:

Versione
Visualizza il tipo di operazione che ha creato la versione corrispondente.
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Data
Visualizza la data di esecuzione dell'operazione.

Descrizione
Consente di aggiungere una descrizione a una versione.

Menu Funzioni
Nel menu Funzioni sono disponibili le sequenti opzioni:

Annulla/Ripeti

Consente di annullare/ripetere l'ultima operazione. Le funzioni annulla/ripeti possono
essere utilizzate anche dopo il salvataggio.

Ripristina la versione selezionata
Consente di ripristinare la versione selezionata.

Apri la versione selezionata in una nuova scheda
Consente di aprire la versione selezionata in una nuova scheda.

Elimina la versione selezionata
Consente di rimuovere dalla storia la versione selezionata.

Cancella la storia

Consente di cancellare la storia. Questo permette di liberare memoria e spazio su
disco e cancellare qualsiasi file audio coinvolto. Se si cancella la storia, non € possibile
annullare alcuna operazione precedente.

Mantieni le versioni annullate

Per impostazione predefinita, se si ritorna a una versione precedente tutte le versioni
che erano state create dopo la versione selezionata vengono eliminate. Per mantenere
tutte le versioni, attivare 'opzione Mantieni le versioni annullate.

Un esempio: sono state apportate le modifiche A, B, C e D. Si annullano
successivamente le modifiche C e D. Si esegue quindi la modifica E. Nella versione
predefinita della storia, la storia contiene adesso le modifiche A, B ed E. Se I'opzione
Mantieni le versioni annullate ¢ attivata, la storia contiene le modifiche A, B, C, D ed
E. Cio significa che anche dopo I'annullamento dei diversi passaggi, & ancora possibile
ritornare alle versioni annullate.

Navigazione all'indietro e in avanti

Modifica

Nei file audio e nei montaggi audio & possibile navigare fino alla posizione del cursore, al

fattore di zoom e all'intervallo di selezione precedenti/successivi senza dover annullare/ripetere

l'operazione di modifica eseguita.

e Per navigare indietro o avanti, fare clic su Naviga indietro [ o Naviga in avanti [ nella

barra del titolo dell'Editor audio o della finestra Montaggio audio.

dei valori

In diversi punti del programma, i valori numerici possono essere modificati tramite una
combinazione di campi di testo e potenziometri.

I valori talvolta si compongono di diversi elementi, ad esempio 12 min 30 sec 120 ms. Ciascun

valore pud essere modificato utilizzando uno dei seguenti metodi:
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e Per modificare un valore, fare clic in un campo valori e digitare un nuovo valore o fare clic
sulle piccole frecce nel campo valori.

e Per modificare il valore di un'unita per volta, premere Freccia su o Freccia giu.

e Per modificare il valore utilizzando la rotellina del mouse, posizionare il cursore del mouse
sopra un valore e muovere la rotellina oppure utilizzare la manopola Al del proprio controller
MIDI.

e Per modificare il valore con il mouse, fare clic su un valore e trascinare il mouse verso l'alto o
verso il basso.

e Per saltare ai valori massimo e minimo, premere rispettivamente i tasti Home o Fine.

e Per spostarsi da un elemento del valore a un altro, premere Freccia sinistra o
Freccia destra.

Operazioni di trascinamento

In WavelLab Elements molte operazioni possono essere eseguite tramite trascinamento e rilascio;
alcune di queste operazioni possono peraltro essere eseguite esclusivamente in questo modo.
Nella documentazione, queste vengono denominate operazioni di trascinamento.

e Per trascinare un oggetto, fare clic e tenere premuto il pulsante del mouse dopo aver
posizionato correttamente il cursore, quindi trascinare. Per rilasciare l'oggetto, rilasciare il
pulsante del mouse.

Molti tipi di oggetti come ad esempio file, testo, clip, marker e voci di un elenco, possono essere
trascinati tra diverse posizioni di origine e di destinazione.

NOTA

E inoltre possibile trascinare e rilasciare i file da WavelLab Elements a Nuendo di Steinberg.

e Perriposizionare una scheda all'interno del proprio gruppo a schede, trascinarla
orizzontalmente. Per spostare una scheda in un‘altra finestra, trascinarla verticalmente.

e Per aprire un file, trascinarlo sulla barra delle schede dalla finestra del Browser dei file di
Wavelab Elements, da Esplora file/macOS Finder o da un‘altra applicazione.

e Per creare una copia di un file, trascinare la relativa scheda verticalmente in un‘altra
posizione della barra delle schede, quindi premere Ctrl/Cmd e rilasciare il pulsante del
mouse.

e Epossibile ancorare e disancorare le finestre degli strumenti di utility e le finestre degli
indicatori mediante trascinamento.

LINK CORRELATI
Ancoraggio e disancoraggio delle finestre degli strumenti di utility e degli indicatori a pag. 48

Trascinamento nell’Editor audio e nella finestra Montaggio audio

E possibile eseguire diverse operazioni a seconda del punto in cui si esegue un trascinamento
nella finestra dell'Editor audio o di Montaggio.

e Perinserire un file audio in un altro file audio, trascinare la barra del titolo del file sulla
forma d'onda di un altro file. E anche possibile trascinare un file audio nellEditor audio dalla
finestra del Browser dei file, da Esplora file/macOS Finder, o da un‘altra applicazione.

e Per spostare un marker, trascinarlo in un‘altra posizione nel righello del tempo.
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e Per creare una copia di un marker, premere Shift e trascinare il marker desiderato in
un'altra posizione del righello del tempo.

e Per eliminare un marker, trascinarlo verso l'alto al di fuori del righello del tempo.

e Per copiare una selezione audio, trascinare una parte dell'audio selezionata sull'area della
forma d’onda dello stesso file o di un altro file.

e Per modificare I'estensione di un intervallo di selezione, posizionare il cursore di modifica
all'inizio/fine dell'intervallo di selezione e trascinarlo verso sinistra o destra.

e Per spostare il cursore di modifica senza perdere la selezione corrente e farlo scattare su un
punto di ancoraggio, premere Shift e spostare il mouse vicino al cursore del file/montaggio
audio. La forma del cursore del mouse cambia ed ¢ possibile trascinare il cursore verso
sinistra e destra.

e Per spostare il cursore di modifica senza modificare o perdere la selezione corrente, premere
Shift, fare clic sul cursore di modifica e trascinarlo su un‘altra posizione.

e Per scorrere la forma d'onda orizzontalmente, fare clic sulla barra sopra il righello del tempo
e trascinarla verso sinistra o verso destra. E possibile fare clic su qualsiasi punto della forma
d’'onda utilizzando il terzo pulsante del mouse e trascinare verso sinistra o verso destra.

e Per creare un marker generico da un testo selezionato, rilasciare sul righello del tempo il
testo selezionato in un‘applicazione esterna. Il testo diventa cosi il nome del marker.

e Per creare una copia stereo di un file mono o una copia mixata di un file stereo, trascinare
una scheda in un'altra posizione all'interno della barra delle schede, premere Ctrl-Alt
(Windows) o Ctrl-Opt (Mac) e rilasciare il pulsante del mouse.

LINK CORRELATI

Finestra della forma d'onda a pag. 111
Finestra di montaggio a pag. 190
Finestra Browser dei file a pag. 65

Trascinamento nella finestra Feed RSS

E possibile riordinare gli episodi nell'elenco degli episodi mediante trascinamento.

e Per modificare I'ordine degli episodi nell'elenco degli episodi, trascinarli in un‘altra posizione.

LINK CORRELATI
Feed RSS a pag. 381

Trascinamento nella Sezione Master

E possibile riordinare gli effetti nella Sezione Master mediante trascinamento.
e Per modificare I'ordine di processamento nella Sezione Master, trascinare gli effetti tra

diversi slot di effetti.

LINK CORRELATI
Finestra Sezione Master a pag. 284

Operazioni di zoom nella finestra Area lavoro

E possibile regolare lo zoom nella finestra Area lavoro utilizzando le tecniche di zoom standard.
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Zoom in orizzontale

Quando si riduce al massimo lo zoom, l'intero file viene visualizzato nella finestra.

Quando si aumenta al massimo lo zoom, ciascun campione occupa numerosi pixel sullo
schermo. Questo consente una modifica accurata della forma d'onda a livello del singolo
campione.

Zoom in verticale

Quando si riduce al massimo lo zoom, l'altezza della forma d’onda si adatta alla finestra.

Quando si aumenta lo zoom progressivamente, il display visualizza solo una parte
dell'altezza totale. La barra di scorrimento verticale consente di regolare con precisione la
sezione visualizzata. Fare riferimento al righello per verificare quale parte della forma d'onda
e visualizzata sul display.

Per ottimizzare I'ingrandimento verticale della forma d'onda, premere Ctrl/Cmd, fare clic
sul righello del tempo, tenere premuto il pulsante del mouse ed eseguire un trascinamento
verso l'alto o verso il basso.

Elevato livello di ingrandimento

Quando si ingrandisce molto il livello di ingrandimento, ciascun campione viene visualizzato
con uno scalino e un punto. I gradini consentono di visualizzare lo stato digitalizzato reale,
mentre i punti rendono piu semplice visualizzare i campioni, specialmente per i campioni
audio a zero.
La curva rappresenta anche una stima del segnale analogico ricostruito che offre dei
suggerimenti sui picchi reali.

-

-

124

dl =

Ingrandimento nelle sezioni panoramica e vista principale (solo Editor
audio)

E possibile ottenere diversi livelli di ingrandimento nelle sezioni panoramica e vista
principale. Nella panoramica, un indicatore di intervallo nel righello del tempo indica quale
sezione del file viene visualizzata nella vista principale.

Per regolare il livello di ingrandimento, trascinare i bordi dell'indicatore di intervallo.

Per scorrere la vista principale, trascinare l'indicatore dell'intervallo. L'indicatore di intervallo
si trova nella parte superiore della vista d'insieme.

75



Gestione dei file
Operazioni di zoom nella finestra Area lavoro

Ingrandimento tramite i controlli di zoom

Sia la vista principale sia quella d'insieme dispongono di controlli di zoom orizzontale e verticale.

e Per eseguire un ingrandimento in senso orizzontale, fare clic sul controllo Ingrandimento
orizzontale e trascinare verso sinistra o verso destra oppure utilizzare la rotellina del mouse.

e Per ridurre al minimo il fattore di ingrandimento, fare doppio-clic sul controllo
Ingrandimento orizzontale.

e Peringrandire in senso verticale, fare clic sul controllo Ingrandimento verticale e trascinare
verso |'alto o verso il basso oppure utilizzare la rotellina del mouse.

e Per alternare un‘altezza ottimizzata e il fattore di ingrandimento predefinito, fare doppio-clic
sul controllo Ingrandimento verticale.

LINK CORRELATI
Operazioni di zoom nella finestra Area lavoro a pag. 74

Operazioni di ingrandimento per mezzo dello strumento
Ingrandimento

Lo strumento Ingrandimento puo essere utilizzato per ingrandire una sezione specifica della
forma d'onda in modo che questa occupi l'intera finestra della forma d'onda. Questo strumento e
disponibile solamente nell’Editor audio.
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LINK CORRELATI
Utilizzo dello strumento Ingrandimento nella vista principale a pag. 77
Utilizzo dello strumento Ingrandimento nella panoramica a pag. 77

Utilizzo dello strumento Ingrandimento nella vista principale

La selezione effettuata nella vista principale della finestra della forma d’onda viene ingrandita
fino a occupare l'intera vista principale.

PROCEDIMENTO
1. Nell'Editor audio, selezionare la scheda Visualizza.
2. Nella sezione Ingrandimento, fare clic su Ingrandimento.

3. Nella vista principale della finestra della forma d'onda, fare clic e trascinare verso sinistra o
destra, quindi rilasciare il pulsante del mouse.

La parte selezionata dell’'onda ora occupa l'intera vista principale.

LINK CORRELATI
Operazioni di ingrandimento per mezzo dello strumento Ingrandimento a pag. 76
Scheda Visualizza (Editor audio) a pag. 116

Utilizzo dello strumento Ingrandimento nella panoramica

La selezione effettuata nella panoramica della finestra della forma d'onda viene visualizzata nella
vista principale.

PROCEDIMENTO

e Nella panoramica della finestra della forma d'onda, fare clic e trascinare verso sinistra o
destra, quindi rilasciare il pulsante del mouse.

RISULTATO
L'intervallo selezionato della forma d'onda viene visualizzato nella vista principale.

LINK CORRELATI
Operazioni di ingrandimento per mezzo dello strumento Ingrandimento a pag. 76

Ingrandimento mediante l'utilizzo del mouse

Mediante l'utilizzo del mouse & possibile modificare il fattore di ingrandimento facendo clic e
trascinamento oppure utilizzando la rotellina.

e Peringrandire orizzontalmente, nella finestra della forma d’onda o di montaggio,
posizionare il cursore del mouse sul righello del tempo, fare clic e trascinare verso l'alto
o verso il basso.

e Peringrandire orizzontalmente mantenendo la posizione del cursore, posizionare il cursore
del mouse sul righello del tempo, premere Shift e trascinare verso I'alto o verso il basso.
A questo scopo € possibile utilizzare anche la rotellina del mouse. Premere Ctrl/Cmd - Shift,
puntare il cursore su una forma d’'onda e muovere la rotellina.

e Per eseguire un ingrandimento in senso orizzontale intorno alla posizione del cursore
utilizzando la rotellina del mouse, premere Ctrl/Cmd, puntare il cursore su una forma
d’onda e muovere la rotellina.
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Per eseguire un ingrandimento in senso orizzontale intorno alla posizione del cursore di
modifica, premere Ctrl/Cmd - Shift, puntare il cursore su una forma d'onda e muovere la
rotellina del mouse.

Per eseguire un ingrandimento in senso verticale utilizzando la rotellina del mouse, premere
Shift, puntare il cursore su una forma d'onda e muovere la rotellina.

Solo Editor audio

Per ingrandire verticalmente, nella finestra della forma d'onda, posizionare il cursore del
mouse sul righello del livello, fare clic e trascinare verso sinistra o verso destra.

Per riportare l'ingrandimento verticale a 0 dB, fare doppio-clic sul righello del livello.

Per impostare il fattore di ingrandimento verticale al suo valore ottimale, che corrisponde ai
campioni minimo e massimo attualmente visualizzati, assicurarsi che il righello del livello sia
impostato a 0 dB, quindi cliccarci sopra due volte.

LINK CORRELATI
Operazioni di zoom nella finestra Area lavoro a pag. 74

Ingrandimento tramite la tastiera

Un modo veloce per ingrandire la finestra della forma d'onda o di montaggio attiva & utilizzare i
tasti freccia sulla tastiera del computer.

Per eseqguire un ingrandimento in senso orizzontale nella finestra della forma d'onda o di
montaggio attiva, premere Freccia su o Freccia giu.

Per eseguire un ingrandimento in senso verticale nella finestra della forma d'onda o di
montaggio attiva, tenere premuto Shift e premere Freccia su o Freccia giu.

Per eseguire un ingrandimento in senso verticale in modo da adattare la visualizzazione
all'altezza disponibile, premere Ctrl/Cmd - Shift - Freccia su.

Per ridurre I'ingrandimento al minimo, premere Ctrl/Cmd - Freccia giu.

Per aumentare al massimo l'ingrandimento, premere Ctrl/Cmd - Freccia su.

LINK CORRELATI
Preferenze globali a pag. 405
Operazioni di zoom nella finestra Area lavoro a pag. 74

Opzioni di ingrandimento

Le opzioni di ingrandimento consentono di accedere rapidamente ai diversi parametri disponibili
per I'impostazione del fattore di ingrandimento.

Le opzioni di ingrandimento sono disponibili nell’Editor audio e nella finestra Montaggio audio
allinterno della scheda Vista, nella sezione Ingrandimento.

Tempo

Apre un menu a tendina che consente di regolare il fattore di zoom in modo da
visualizzare l'intervallo temporale selezionato. L'opzione Ingrandimento 1:1 consente
di impostare il fattore di ingrandimento in modo tale che un pixel sullo schermo
rappresenti un campione.

Per modificare il fattore di ingrandimento, fare clic su Modifica il fattore di
ingrandimento. Si apre cosi la finestra di dialogo Fattore di ingrandimento, in cui
é possibile modificare le seqguenti impostazioni:
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Operazioni di zoom nella finestra Area lavoro

e L'opzione Definisci intervallo temporale consente di specificare l'intervallo
temporale da visualizzare.

e L'opzione Campioni per pixel consente di specificare il numero di campioni audio
rappresentati da ciascun pixel.

e L'opzione Pixel per campione consente di specificare il numero di pixel utilizzati
per rappresentare un singolo campione audio.

Ingrandimento

Attiva lo strumento Ingrandimento che consente di definire un intervallo temporale
sul quale viene eseguito uno zoom.

Ingrandisci la selezione

Consente di ingrandire la finestra in modo che la selezione corrente occupi l'intera
finestra del montaggio.

Visualizza I'intera clip (solo finestra Montaggio audio)
Consente di regolare la vista per la visualizzazione della clip attiva.

Visualizza tutto
Visualizza l'intero intervallo audio.

Microscopio
Consente di aumentare al massimo l'ingrandimento.

Aumenta lI'ingrandimento dell’audio (10 x)/Riduci I'ingrandimento dell’'audio (10 x)
Consente di aumentare/ridurre l'ingrandimento per grandi incrementi.

Ingrandisci I'audio/Riduci I'ingrandimento dell'audio
Consente di aumentare/ridurre l'ingrandimento per piccoli incrementi.

Livello

Consente di regolare il fattore di ingrandimento per visualizzare solo i campioni sotto
al valore in dB selezionato.

Ottimizza l'ingrandimento verticale (solo Editor audio)

Consente di modificare il fattore di ingrandimento verticale in modo che i picchi siano
chiaramente visibili. Questa regolazione & eseguita sulla base della sezione di onda
visibile nella finestra della forma d'onda/di montaggio.

Riporta lo zoom a 0 dB

Consente di regolare il fattore di ingrandimento in modo da visualizzare i livelli audio
finoa 0 dB.

Ingrandimento verticale/Riduzione ingrandimento verticale

Consente di aumentare/ridurre l'ingrandimento delle forme d'onda con un livello pit
basso/alto.

LINK CORRELATI

Operazioni di zoom nella finestra Area lavoro a pag. 74
Scheda Visualizza (Editor audio) a pag. 116

Scheda Visualizza (Montaggio audio) a pag. 197
Scheda Modifica (Montaggio audio) a pag. 199
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Operazioni di zoom nei montaggi audio

Le operazioni di zoom eseguibili nella finestra del Montaggio sono molto simili a quelle
applicabili nell’Editor audio. Tuttavia, sono disponibili alcune opzioni di ingrandimento
aggiuntive per le tracce.

LINK CORRELATI

Finestra di montaggio a pag. 190

Pulsanti di ingrandimento nella finestra Montaggio audio a pag. 80

Visualizzazione di un numero maggiore o minore di tracce nei montaggi audio a pag. 80
Operazioni di zoom nella finestra Area lavoro a pag. 74

Pulsanti di ingrandimento nella finestra Montaggio audio

I pulsanti di ingrandimento disponibili nella finestra Montaggio audio consentono di applicare
dei preset di zoom.

e Perimpostare I'ingrandimento in modo che le clip attive occupino il 25%, il 50% o il 100%
dello spazio disponibile, fare clic sui pulsanti corrispondenti.

e Per selezionare un'area specifica, fare clic su Ctrl/Cmd, quindi trascinare il rettangolo di
selezione sopra le tracce e le clip che si desidera ingrandire.

LINK CORRELATI
Operazioni di zoom nei montaggi audio a pag. 80
Visualizzazione di un numero maggiore o minore di tracce nei montaggi audio a pag. 80

Visualizzazione di un numero maggiore o minore di tracce nei montaggi audio

E possibile aumentare o ridurre il fattore di ingrandimento in modo da visualizzare un numero
maggiore o minore di tracce nella finestra del Montaggio audio.

e Pervisualizzare piu tracce, fare clic sull'icona a lente di ingrandimento piu piccola.

i

Displays more tracks

=

e Pervisualizzare un numero inferiore di tracce, fare clic sull'icona a lente di ingrandimento piu
grande.
e Per fare in modo che un singola traccia occupi l'intera finestra del montaggio, fare clic sulla

freccia in giu nella parte centrale-inferiore dell'area dei controlli delle tracce e selezionare
Zoom avanti dal menu a tendina Impostazioni delle tracce.

Per ridurre nuovamente il fattore di ingrandimento, fare clic sulla freccia in giu nella parte
inferiore-centrale dell'area dei controlli delle tracce e selezionare Zoom indietro.
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Preset

E anche possibile fare clic-destro su una traccia e selezionare Visualizza l'intera clip dal
menu a tendina.

LINK CORRELATI

Operazioni di zoom nei montaggi audio a pag. 80

Area dei controlli delle tracce a pag. 191

Pulsanti di ingrandimento nella finestra Montaggio audio a pag. 80

E possibile creare dei preset per salvare delle impostazioni di comune utilizzo. WavelLab Elements
fornisce una selezione di preset di fabbrica che possono essere utilizzati dalla maggior parte
delle finestre di dialogo.

E possibile salvare dei preset personalizzati. Al successivo caricamento del programma tali preset
risulteranno disponibili.

I preset vengono salvati come file singoli e possono essere organizzati in sottocartelle. La cartella
radice e diversa per ciascun tipo di preset e non puo essere modificata.

LINK CORRELATI

Salvataggio dei preset a pag. 81

Caricamento dei preset a pag. 82

Salvataggio dei preset predefiniti per i plug-in VST a pag. 83

Salvataggio dei preset

E possibile salvare dei preset e caricarli in un secondo momento.

PROCEDIMENTO
1. Aprire la finestra di dialogo che si desidera utilizzare e modificare i parametri.
2. Aprire il menu a tendina Preset e selezionare Salva con nome.

3. Facoltativo: fare clic sullicona cartella e inserire un nome per la sotto cartella che si desidera
utilizzare come posizione per questo preset.

4. Inserire un nome.

5. Fare clic su Salva.

LINK CORRELATI
Caricamento dei preset a pag. 82
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Caricamento dei preset

Per applicare un preset salvato o un preset di fabbrica a una finestra di dialogo o a un plug-in, &
necessario caricare il preset.

PROCEDIMENTO
1. Nella finestra di dialogo, aprire il menu a tendina Preset.

2. Selezionare il preset che si desidera applicare.

LINK CORRELATI
Salvataggio dei preset a pag. 81

Modifica dei preset

E possibile modificare i preset e salvare le modifiche effettuate.

PROCEDIMENTO

1. Aprire la finestra di dialogo che si desidera utilizzare.
2. Caricare il preset che si desidera modificare.

3. Modificare i parametri della finestra di dialogo.
4

Aprire il menu a tendina Preset e selezionare Salva.

Eliminazione dei preset

PROCEDIMENTO

1. Aprire la finestra di dialogo che si desidera utilizzare.

2. Selezionare il preset che si desidera eliminare.

3. Aprire il menu a tendina Preset e selezionare Organizza i preset.
4

In Esplora file/macOS Finder, selezionare il file preset che si desidera eliminare e premere
Canc.

Preset temporanei

Alcune finestre di dialogo consentono di salvare e caricare fino a 5 preset temporanei. Cio risulta
utile se si desidera testare e confrontare rapidamente impostazioni diverse.

LINK CORRELATI

Salvataggio temporaneo dei preset a pag. 82
Ripristino di preset temporanei a pag. 83

Salvataggio temporaneo dei preset

PROCEDIMENTO
1. Aprire la finestra di dialogo che si desidera utilizzare e modificare le impostazioni.

2. Aprire il menu a tendina Preset.
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3. Dal sotto menu Salvataggio temporaneo, selezionare uno slot.

LINK CORRELATI
Preset temporanei a pag. 82
Ripristino di preset temporanei a pag. 83

Ripristino di preset temporanei

PROCEDIMENTO
1. Aprire la finestra di dialogo in cui € stato salvato il preset.
2. Aprire il menu a tendina Preset.

3. Dal sotto menu Ripristina, selezionare un preset.

LINK CORRELATI
Preset temporanei a pag. 82
Salvataggio temporaneo dei preset a pag. 82

Salvataggio dei preset predefiniti per i plug-in VST

E possibile salvare le impostazioni dei parametri degli effetti per i plug-in VST 3 e VST 2
come preset degli effetti predefiniti. In tal modo & possibile caricare automaticamente queste
impostazioni ogni volta che si crea una nuova istanza dell'effetto.

PROCEDIMENTO
1. Aprire il plug-in per il quale si intende personalizzare il preset predefinito.

2. Incima alla finestra del plug-in, fare clic sul pulsante Preset.

3. Esequire una delle sequenti operazioni:
e Periplug-in VST 3, selezionare Preset predefinito > Salva come preset predefinito.

e Periplug-in VST 2, selezionare Banco predefinito > Salva come banco predefinito.

RISULTATO

Le impostazioni degli effetti vengono salvate come preset predefinito. Ogni volta che si apre una
nuova istanza dell'effetto, viene caricato automaticamente il preset predefinito.

LINK CORRELATI
Caricamento di preset personalizzati a pag. 83
Rimozione dei preset predefiniti a pag. 84

Caricamento di preset personalizzati

E possibile caricare le impostazioni dei parametri del plug-in che sono state salvate come preset
predefinito.

PROCEDIMENTO

1. Aprire il plug-in per il quale si intende caricare il preset predefinito.
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2. Incima alla finestra del plug-in, fare clic sul pulsante Preset.

3. Eseguire una delle seguenti operazioni:

e Periplug-in VST 3, selezionare Preset predefinito > Carica il preset predefinito.

e Periplug-in VST 2, selezionare Banco predefinito > Carica il banco predefinito.

LINK CORRELATI
Salvataggio dei preset predefiniti per i plug-in VST a pag. 83
Rimozione dei preset predefiniti a pag. 84

Rimozione dei preset predefiniti

E possibile rimuovere il preset che & stato salvato come preset predefinito.

PROCEDIMENTO
1. Aprire il plug-in per il quale si intende rimuovere il preset predefinito.

2. Incima alla finestra del plug-in, fare clic sul pulsante Preset.

3. Esequire una delle sequenti operazioni:

e Periplug-in VST 3, selezionare Preset predefinito > Rimuovi il preset predefinito.

e Periplug-in VST 2, selezionare Banco predefinito > Rimuovi il banco predefinito.

RISULTATO

La volta successiva che si apre una nuova istanza del plug-in selezionato, viene applicato il preset
di fabbrica predefinito.

LINK CORRELATI
Salvataggio dei preset predefiniti per i plug-in VST a pag. 83
Caricamento di preset personalizzati a pag. 83

Modelli

E possibile salvare sotto forma di modelli le impostazioni dei file utilizzate regolarmente. I
modelli sono utili quando si creano nuovi file audio, montaggi audio o feed RSS.

Scheda Modelli

Questa scheda visualizza tutti i modelli e consente di creare e aprire dei modelli.

e Per aprire la scheda Modelli, selezionare File > Nuovo, selezionare un tipo di file e fare clic
su Modelli.
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Templates

Use Template Nar fault File Name

Elenco dei modelli disponibili

Consente di visualizzare I'elenco di tutti i modelli salvati.

Aggiungi modello

Consente di aggiungere un nuovo modello o aggiornare un modello esistente.

Esplora

Consente di aprire la cartella in cui sono posizionati i file dei modelli. In questa cartella
e possibile rinominare ed eliminare i modelli.

Usa il nome del modello come nome file predefinito

Se questa opzione e attivata e si fa clic su Aggiungi modello, viene creato un nuovo
file che utilizza il nome del modello. Se questa opzione ¢ disattivata, il nuovo file sara
«senza titolo».

Creazione di modelli

E possibile creare un modello a partire da un montaggio audio, file audio o feed RSS attivo e
utilizzarlo come punto di partenza per i nuovi file creati.

PROCEDIMENTO
1. Selezionare File > Nuovo.
2. Selezionare il tipo di file per il quale si desidera creare un modello.
3. Fareclic su Modelli.
4. Nella scheda Modelli, eseguire una delle sequenti operazioni:
e Per creare un nuovo modello, fare clic su Aggiungi modello, definire le impostazioni
desiderate e fare clic su Crea.
e Per aggiornare un modello esistente, fare clic su Aggiungi modello, inserire il nome del
modello che si desidera aggiornare e fare clic su Crea.
5. Facoltativo: se si intende utilizzare il nome del modello come nome file predefinito, attivare
l'opzione Usa il nome del modello come nome file predefinito.
6. Durante il salvataggio o 'aggiornamento di un modello del file audio o del montaggio audio,

& possibile configurare impostazioni aggiuntive.

e Quando si salva un modello di un file audio viene visualizzata la finestra di dialogo
Modello del file audio. In questa finestra & possibile selezionare se WaveLab Elements
deve allegare o meno un formato file audio.

e Quando sisalva un modello di un montaggio audio si apre la finestra di dialogo Modelli
dei montaggi audio. In questa finestra di dialogo & possibile selezionare se includere o
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meno plug-in, clip e/o marker delle tracce. Si pud inoltre decidere se WavelLab Elements
deve allegare o meno un formato file audio.

Finestra di dialogo Modello del file audio

La finestra di dialogo Modello del file audio consente di visualizzare le proprieta audio del
modello in corso di creazione. E inoltre possibile definire se associare sempre una specifica
configurazione file audio con metadati opzionali durante la creazione di un modello di file audio
oppure no.

e Per aprire la finestra di dialogo Modello del file audio, selezionare File > Nuovo, fare clic su
File audio, quindi fare clic su Modelli. Nella scheda Modelli, fare clic su Aggiungi modello.

¥ Audio File Template X

Create template b
Track 1.wav
Mono, 16 bi

Attach Audio File Format

Template Name |

+ Save X Cancel

i

Allega il formato del file audio

Se questa opzione € attivata, ogni volta che si aprono le finestre di dialogo Renderizza
o Salva con nome, la configurazione del file audio specificata di seguito viene proposta
per impostazione predefinita.

Nome del modello
Consente di inserire un nome per il modello.

Finestra di dialogo Modelli dei montaggi audio

Nella finestra di dialogo Modelli dei montaggi audio, € possibile regolare una serie di opzioni
durante la creazione di un modello di montaggio audio.

e Per aprire la finestra di dialogo Modelli dei montaggi audio, selezionare File > Nuovo,
fare clic su Montaggio audio, quindi fare clic su Modelli. Nella scheda Modelli, fare clic su
Aggiungi modello.
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i

I Audio Montage Template X

reate template

surround-montage.m.

Options

put Plug-ins

Attach Audio File Format

Template Name

Includi le clip

Se questa opzione € attivata, le clip vengono salvate nel modello.

Includi i plug-in delle tracce e dell'uscita del montaggio

Se questa opzione € attivata, i plug-in delle tracce e del montaggio vengono salvate nel
modello.

Includi i marker

Se questa opzione € attivata, i marker vengono salvati nel modello.

Includi le note

Se questa opzione € attivata, le note che sono state scritte nella finestra Note vengono
salvate nel modello.

Allega il formato del file audio

Se questa opzione € attivata, ogni volta che si utilizza la funzione Renderizza nella
Sezione Master, |la configurazione del file audio specificata sotto viene proposta per
impostazione predefinita.

Nome del modello

Consente di inserire un nome per il modello.

LINK CORRELATI
Finestra Note a pag. 270

Creazione di file dai modelli

E possibile creare un file da un modello per utilizzarne le impostazioni.

PROCEDIMENTO

1.

2
3.
4

Selezionare File > Nuovo.
Selezionare il tipo di file che si desidera creare.
Fare clic su Modelli.

Dall'elenco dei modelli disponibili, selezionare il modello che si desidera utilizzare come base
per il nuovo file.
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Eliminazione dei modelli

PROCEDIMENTO

1.

2
3
4.
5

Selezionare File > Nuovo.

Selezionare il tipo di file per il quale si desidera eliminare dei modelli.
Fare clic su Modelli.

Fare clic su Esplora.

In Esplora file/macOS Finder, eliminare i modelli.

Rinomina dei modelli

PROCEDIMENTO

1.

2
3
4.
5

Selezionare File > Nuovo.

Selezionare il tipo di file per il quale si desidera rinominare dei modelli.
Fare clic su Modelli.

Fare clic su Esplora.

In Esplora file/macOS Finder, rinominare i modelli.

Impostazione di modelli predefiniti

E possibile impostare un modello come modello predefinito. Questo modello viene aperto
quando si fa clic su Nuovo nella barra dei comandi.

PROCEDIMENTO

1. Selezionare File > Nuovo.

2. Selezionare il tipo di file che si desidera aprire.

3. Selezionare Modelli.

4. Fare clic-destro su un modello e selezionare Imposta come predefinito.
LINK CORRELATI

Barra dei comandi a pag. 50

Definizione delle scorciatoie per i modelli

E possibile definire sequenze di tasti e parole chiave per i modelli. In tal modo & possibile aprire
in maniera estremamente rapida uno specifico modello.

Quando si creano dei modelli dalle scorciatoie, viene tenuta in considerazione I'opzione Usa il
nome del modello come nome file predefinito nella scheda Modelli.

PROCEDIMENTO

1.
2.
3.

Selezionare File > Nuovo.
Selezionare il tipo di file che si desidera aprire.

Selezionare Modelli.
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4. Fare clic-destro su un modello e selezionare Definisci una scorciatoia.

5. Nella finestra di dialogo Definizione delle scorciatoie, modificare la scorciatoia per il
modello selezionato.

6. Fare clic su OK.

LINK CORRELATI
Scheda Modelli a pag. 84

Confronto tra cartelle di lavoro e cartelle di documenti

Wavelab Elements consente di distinguere due tipi di cartelle: cartelle di lavoro e cartelle di
documenti.

e Nelle cartelle di lavoro vengono salvati i file temporanei.

e Le cartelle di documenti contengono file specifici di WaveLab Elements, come file audio,
montaggi audio, ecc.

LINK CORRELATI
Scheda Cartelle (Preferenze) a pag. 89

Definizione delle cartelle per I'apertura e il salvataggio dei file

E possibile specificare quale cartella aprire quando si esegue un‘operazione di apertura o
salvataggio. E inoltre possibile specificare fino a tre cartelle di lavoro per i file temporanei.

PROCEDIMENTO
1. Aprire il file per il quale si desidera specificare delle cartelle.
2. Selezionare File > Preferenze > Cartelle.

3. Nella scheda Cartelle, fare clic sul tipo di cartella per cui si desidera specificare una
posizione.

4. Specificare una posizione nel campo Cartella.

5. Facoltativo: a seconda del tipo di cartella selezionato, € possibile configurare impostazioni
aggiuntive.

LINK CORRELATI
Scheda Cartelle (Preferenze) a pag. 89

Scheda Cartelle (Preferenze)

In questa scheda & possibile specificare le cartelle dei documenti e di lavoro predefinite per
ciascun tipo di file.

e Per aprire la scheda Cartelle, selezionare File > Preferenze > Cartelle.
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Current

ve Folder Changes

N
N
E.
E.

Nell'elenco sulla sinistra, specificare il tipo di cartella per cui si desidera configurare le
impostazioni.

Cartella per i file temporanei
Specificare una cartella per il salvataggio dei file temporanei.

File compagno
Specificare una cartella per il salvataggio dei file compagno, ovvero i preset della
Sezione Master e le impostazioni di visualizzazione dei file audio.

Cartella cache
Attivare l'opzione Usare una cartella cache per i file decodificati per specificare una
cartella cache. La cartella cache contiene i file wave creati quando si lavora con dei
file in formati compressi, come ad esempio i file MP3. Per evitare I'ingrandimento
oltre misura della cartella cache, WavelLab Elements verifica la data di ciascun file in
questa cartella ed elimina i file creati prima di un numero specifico di giorni. E possibile
specificare il numero di giorni tramite I'opzione Elimina i file piu di vecchi di.
Se l'opzione Usare una cartella cache per i file decodificati & disattivata, i file
compressi sono decodificati a ogni apertura.

File audio - Cartella di apertura/Cartella di salvataggio
Le cartelle di apertura e salvataggio predefinite per i file audio.

Montaggio audio - Cartella di apertura/Cartella di salvataggio
Le cartelle di apertura e salvataggio predefinite per i file del montaggio audio.

A seconda dell'elemento selezionato, sono disponibili diverse impostazioni sul lato destro della
finestra di dialogo.

Cartella corrente
In questo campo viene visualizzata la cartella utilizzata per impostazione predefinita. E
possibile fare clic sul pulsante cartella a destra per individuare la cartella o crearne una

nuova.

Mantieni l'ultima utilizzata
Consente di ricordare l'ultima cartella utilizzata per Salvare o aprire i file del tipo
selezionato.

Cambia quando viene modificata la cartella di salvataggio/Cambia quando viene
modificata la cartella di apertura
Consente di aggiornare la cartella di apertura predefinita quando si modifica la cartella
di salvataggio predefinita e viceversa. Attivare questa opzione per entrambe le cartelle
di apertura e salvataggio per fare in modo che un tipo di file specifico utilizzi la stessa
cartella per il salvataggio e l'apertura di questo tipo di file.
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Utilizza per il browser dei file

Nel Browser dei file, la cartella non cambia quando si alternano i tipi di file per
impostazione predefinita.

Se si attiva I'opzione Utilizza per il browser dei file e si disattiva Mantieni l'ultima
utilizzata, la posizione della cartella che é stata selezionata nel campo Cartella
corrente di ciascun tipo di file viene visualizzata quando si alternano i tipi di file nel
Browser dei file.

Se si attivano le opzioni Utilizza per il browser dei file e Mantieni l'ultima utilizzata,
la cartella che e stata selezionata nel campo Cartella corrente di ciascun tipo di file
viene visualizzata quando si seleziona un tipo di file per la prima volta. Quando si passa
a un‘altra cartella nel Browser dei file, viene utilizzato il comportamento proprio della
funzione Mantieni l'ultima utilizzata. Cio significa che quando si seleziona il tipo di
file viene visualizzata I'ultima cartella utilizzata per quel tipo specifico.

E possibile regolare queste impostazioni in maniera indipendente per ciascun tipo di
file.

Alla riapertura dell'applicazione, ritorna a questa cartella
Attivare questa opzione per ripristinare una cartella specifica ogni volta che si apre
Wavelab Elements. In questo modo, qualsiasi modifica alle cartelle di salvataggio/
apertura é solo temporanea e queste vengono reinizializzate al riavvio di WavelLab
Elements.

Copia di informazioni audio negli appunti

E possibile copiare le informazioni relative al nome e alla posizione del file audio selezionato,
compresa qualsiasi posizione del cursore e informazione di selezione. Questa informazione pud
essere incollata in un’applicazione di testo esterna.

Pud essere utile se si necessitano informazioni di selezione/percorso accurate durante, ad
esempio, la scrittura di uno script.

PROCEDIMENTO
1. Fare clic sulla scheda File.
2. Fare clic su Info.

3. Fare clic su Copia negli appunti e selezionare le informazioni che si intende copiare negli
appunti.

Impostazione del focus sul file corrente

Se si stanno eseguendo delle modifiche all'interno di una finestra fluttuante o di una finestra
degli strumenti di utility e si desidera riportare il focus su una finestra di montaggio/della forma
d’'onda, é possibile utilizzare 'opzione Imposta il focus sul file corrente.

PROCEDIMENTO

e Inuna qualsiasi finestra, premere Ctrl/Cmd -F12 per impostare il focus sulla finestra di
montaggio/della forma d'onda.
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Questo capitolo descrive i metodi per controllare le funzioni di riproduzione e di trasporto.

LINK CORRELATI
Barra di trasporto a pag. 92

Barra di trasporto

Con la barra dei comandi & possibile controllare la riproduzione di un file audio o montaggio
audio, navigare tra diverse posizioni in un file audio o montaggio audio e aprire la finestra di
dialogo Registrazione.

La barra di trasporto & disponibile nell’Editor audio e nella finestra Montaggio audio.
Per impostazione predefinita, le opzioni della barra di trasporto estesa sono nascoste.

e Per attivare la barra di trasporto estesa, fare clic su Estendi la barra di trasporto nella barra
di trasporto.

I - - [ Y[« [» (5 = [+ =

Preset

Consente di salvare e applicare dei preset.

Salta l'intervallo

Se questo pulsante € attivato, la riproduzione salta l'intervallo selezionato e qualsiasi
regione entro i marker di esclusione.

Esegui pre-roll/Esegui post-roll

Attiva il pre-roll o il post-roll per i comandi Riproduci da un punto di ancoraggio,
Riproduci fino a un punto di ancoraggio e Riproduci intervallo audio.

Fare clic-destro sul pulsante per selezionare la lunghezza di pre-roll o di post-roll e
specificare a quali comandi si desidera applicare il pre-roll/post-roll. Per modificare le
durate di pre-roll/post-roll, selezionare Modifica le durate di pre-roll e post-roll.

Riproduci intervallo audio

Consente di riprodurre l'intervallo audio selezionato. Le impostazioni di post-roll e
pre-roll sono tenute in considerazione. Fare clic-destro sul pulsante per aprire un menu
contenente le opzioni e le modalita di selezione automatica correlate.

e Sel'opzione Selezione automatica dell'intervallo ¢ attivata, I'intervallo viene
selezionato automaticamente in funzione delle azioni di modifica effettuate.

e Selafunzione Riproduci a partire dall'inizio della nuova selezione temporale &
attivata quando si seleziona un intervallo con il mouse mediante trascinamento da
sinistra a destra e si avvia la riproduzione, la riproduzione viene avviata a partire
dall'inizio della selezione. Se si arresta e si avvia nuovamente la riproduzione o si
sposta il cursore di modifica, la riproduzione viene avviata a partire dalla posizione
del cursore di modifica. Se questa opzione & disattivata, la riproduzione viene
sempre avviata a partire dalla posizione del cursore di modifica.
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Se sono attivate le opzioni Riproduci a partire dall'inizio della nuova selezione
temporale e Loop, la riproduzione viene automaticamente riavviata quando si
seleziona un nuovo intervallo.

Se l'opzione Riproduzione automatica durante I'editing ¢ attivata, la
riproduzione viene riavviata automaticamente quando si tiene premuto il pulsante
del mouse durante la modifica degli intervalli o dei punti di ancoraggio e quando
si utilizzano delle scorciatoie per avviare la riproduzione. Questa opzione ¢ utile, ad
esempio, per trovare un loop.

Questa opzione funziona anche se la modalita di selezione automatica non & attiva.

Se l'opzione Riproduci la traccia in Solo durante I'editing ¢ attivata e si tiene
premuto il pulsante del mouse mentre si modificano gli intervalli nella finestra dei
montaggi, la traccia viene messa in solo quando si avvia la riproduzione utilizzando
le scorciatoie per i comandi Riproduci intervallo audio, Riproduci da un punto
di ancoraggio o Riproduci fino a un punto di ancoraggio. Questa opzione &
disponibile solamente nella finestra Montaggio audio.

E possibile selezionare diversi intervalli audio per la riproduzione:

Selezione temporale

Regione tra le coppie di marker

Clip (solo montaggio audio)

Dissolvenza incrociata (solo montaggio audio)
Fade-in (solo montaggio audio)

Fade-out (solo montaggio audio)

Riproduci fino a un punto di ancoraggio/Riproduci da un punto di ancoraggio

Consente di eseguire la riproduzione fino/da un punto di ancoraggio. Le impostazioni
di pre-roll e post-roll sono tenute in considerazione. Fare clic-destro sul pulsante per
aprire un menu contenente le opzioni e le modalita di selezione automatica correlate.

Se l'opzione Selezione automatica del punto di ancoraggio ¢ attivata, il punto di
ancoraggio viene selezionato automaticamente in funzione delle azioni di modifica
effettuate.

Se l'opzione La barra spaziatrice attiva "Riproduci da un punto di ancoraggio”
é attivata e si preme la Barra spaziatrice per avviare la riproduzione, vengono
tenute in considerazione le impostazioni selezionate per I'opzione Riproduci da un
punto di ancoraggio. Se il punto di ancoraggio selezionato non e disponibile, la
riproduzione viene avviata a partire dalla posizione di riproduzione predefinita.

Se l'opzione Riproduzione automatica durante l'editing é attivata, la
riproduzione viene riavviata automaticamente quando si tiene premuto il pulsante
del mouse durante la modifica dei punti di ancoraggio e quando si utilizzano delle
scorciatoie per avviare la riproduzione. Questa opzione & utile, ad esempio, per
trovare un loop.

Questa opzione funziona anche quando la modalita di selezione automatica non &
attiva.

Se l'opzione Riproduci la traccia in Solo durante I'editing ¢ attivata e si tiene
premuto il pulsante del mouse mentre si modificano i punti di ancoraggio
nella finestra dei montaggi, la traccia viene messa in solo quando si avvia

la riproduzione utilizzando le scorciatoie per i comandi Riproduci intervallo
audio, Riproduci da un punto di ancoraggio o Riproduci fino a un punto di
ancoraggio. Questa opzione & disponibile solamente nella finestra Montaggio
audio.
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E possibile selezionare quale punto di ancoraggio utilizzare come riferimento per i
comandi Riproduci da un punto di ancoraggio e Riproduci fino a un punto di
ancoraggio. Quando sono disponibili diverse possibilita, ad esempio piu marker, viene
utilizzato come punto di ancoraggio di riferimento l'ultimo elemento selezionato o nel
caso in cui nessun marker & selezionato, I'elemento piu vicino alla posizione del cursore
di modifica.

E possibile selezionare uno dei sequenti punti di ancoraggio:
e Cursore di modifica

e Inizio del file

e Inizio dellintervallo temporale selezionato

e Fine dell'intervallo temporale selezionato

e  Tuttii marker

e Marker diinizio della regione

e Marker di fine della regione

e Inizio della clip (solo montaggio audio)

e Fine della clip (solo montaggio audio)

e Punto selezionato dell'inviluppo della clip attiva (solo montaggio audio)

Quando viene rilevato un punto di ancoraggio, ad esempio un coppia di marker di
regione, questo € indicato da un marker di ancoraggio verde.

Sposta il cursore all'inizio del file/Sposta il cursore alla fine del file

Consente di spostare la posizione del cursore di modifica all'inizio/alla fine del
progetto.

Sposta indietro la posizione di riproduzione/Sposta in avanti la posizione di
riproduzione

Consente di spostare la posizione del cursore di modifica verso sinistra/destra. Se si
fa clic durante la riproduzione, quest'ultima salta alla nuova posizione del cursore di
modifica.

Per spostare il cursore di modifica all'inizio/alla fine del file, premere Ctrl/Cmd e fare
clic sui pulsanti Sposta indietro la posizione di riproduzione/Sposta in avanti la
posizione di riproduzione.

I punti di ancoraggio della navigazione consentono di spostare il cursore di modifica in
specifiche posizioni nel file audio o nel montaggio audio. Fare clic-destro sui pulsanti
Sposta indietro la posizione di riproduzione/Sposta in avanti la posizione di
riproduzione per aprire il menu a tendina Punti di ancoraggio della navigazione. In
questo menu ¢ possibile impostare il tipo di punto di ancoraggio. Se si fa clic durante la
riproduzione, quest’ultima continua dalla posizione di ancoraggio.

Loop

Consente di attivare la modalita loop. Fare clic-destro sul pulsante di loop per definire
se eseguire il loop in maniera continua o soltanto alcune volte.
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Arresta la riproduzione

Consente di arrestare la riproduzione. Se la riproduzione & gia stata arrestata, il
cursore di modifica si sposta alla posizione di inizio precedente. Fare clic-destro sul
pulsante per aprire il menu a tendina Riporta il cursore al punto di partenza.

e Sel'opzione Dopo la riproduzione standard ¢é attivata, all'arresto della
riproduzione regolare il cursore ritorna alla posizione di partenza.

e Sel'opzione Dopo la riproduzione automatizzata é attivata, il cursore di modifica
ritorna alla posizione di partenza quando la riproduzione viene arrestata dopo le
opzioni Riproduci da un punto di ancoraggio, Riproduci fino a un punto di
ancoraggio o Riproduci I'intervallo audio.
Avvia la riproduzione dal cursore di modifica

Avwvia la riproduzione del file audio o del montaggio audio attivo a partire dalla
posizione del cursore di modifica.

Se l'audio in corso di riproduzione non ¢ il file audio attivo, il pulsante Riproduci ha un
colore diverso. Questo si verifica, ad esempio, se si passa a un‘altra finestra file durante
la riproduzione.

(2] e

Il pulsante di riproduzione quando si esegue la riproduzione nella finestra attiva (sinistra) e in
un‘altra finestra (destra)

E inoltre possibile avviare la riproduzione a partire dall'ultima posizione di arresto. Fare
clic-destro sul pulsante per aprire il menu a tendina Sequenza principale.

e Sesiseleziona Awvia, la riproduzione viene avviata a partire dalla posizione del
cursore.

e Sesiseleziona Riprendi dall’'ultima interruzione, la riproduzione viene avviata a
partire dall'ultima posizione di arresto.

Registra
Consente di aprire la finestra di dialogo Registrazione.

Riquadro del tempo

Consente di visualizzare il cursore di modifica o la posizione di riproduzione. Fare clic
per selezionare un‘altra unita di tempo.

Barra di trasporto nell’Editor dei feed RSS

Nell'Editor dei feed RSS, una barra di trasporto semplificata consente di riprodurre I'episodio del
feed RSS selezionato.

 ODEIEIEAEEENEN 00000000 |

Pulsante Riproduci

Facendo clic sul pulsante Riproduci nella barra di trasporto, viene avviata la riproduzione del file
audio o del montaggio audio attivi a partire dalla posizione del cursore di modifica.

Per avviare la riproduzione € anche possibile utilizzare Barra spaziatrice o il tasto Invio tast.
num. della tastiera. Se si preme Barra spaziatrice durante la riproduzione, la si arresta, mentre
premendo Invio tast. num. si riavvia la riproduzione a partire dall'ultima posizione di avvio.

Se il pulsante Loop ¢ attivato, la selezione audio, se disponibile, viene riprodotta in loop. In caso
contrario, viene riprodotta in loop la regione definita dai marker di loop. Se non sono disponibili
intervalli di selezione o marker di loop, viene riprodotto in loop l'intero file.
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Il comando standard 'Riproduci' non ¢ influenzato dalle opzioni Riproduci intervallo audio,
Riproduci da un punto di ancoraggio e Riproduci fino a un punto di ancoraggio.

Pulsante Arresta la riproduzione

Quando si fa clic sul pulsante Arresta la riproduzione nella barra di trasporto o si preme 0 sul
tastierino numerico, I'azione che si ottiene cambia a seconda della situazione.

e Sesiattiva il pulsante Arresta la riproduzione in modalita arresto, il cursore di
modifica si sposta sul marker di inizio riproduzione precedente o sull'inizio della selezione
(indipendentemente da quanto € vicino), fino al raggiungimento dell'inizio del file.

e Senon ¢ presente alcuna selezione o se il cursore di modifica € posizionato a sinistra della
selezione, esso viene spostato invece all'inizio del file.

Riproduzione di intervalli audio

E possibile riprodurre degli intervalli audio utilizzando le opzioni Riproduci intervallo audio
disponibili nella barra di trasporto.

PROCEDIMENTO

1. Nella barra di trasporto, fare clic-destro su Riproduci intervallo audio e selezionare il tipo di
intervallo che si desidera riprodurre.

2. Facoltativo: attivare le opzioni Esegui pre-roll e/o Esegui post-roll.

3. Posizionare il cursore di modifica all'interno dell'intervallo che si desidera riprodurre o
definire un intervallo di selezione.

L'intervallo selezionato e, se attivati, le durate di pre-roll e post-roll vengono visualizzati sul
righello del tempo.

4. Perriprodurre l'intervallo selezionato, fare clic sul pulsante Riproduci intervallo audio sulla
barra di trasporto o premere F6.

RISULTATO

Viene riprodotto l'intervallo selezionato. Le impostazioni di pre-roll e post-roll sono tenute in
considerazione. Se & attivata la modalita Loop, il pre-roll viene utilizzato solo prima del primo
loop e il post-roll solo dopo l'ultimo loop.

Riproduzione da o fino a un punto di ancoraggio

E possibile riprodurre l'audio da o fino a un punto di ancoraggio utilizzando le funzioni Riproduci
da un punto di ancoraggio o Riproduci fino a un punto di ancoraggio disponibili nella barra di
trasporto.

PROCEDIMENTO

1. Nella barra di trasporto, fare clic-destro su Riproduci da un punto di ancoraggio o su
Riproduci fino a un punto di ancoraggio e selezionare un tipo di punto di ancoraggio.
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In base al tipo di punto di ancoraggio selezionato, posizionare il cursore di modifica
nella finestra della forma d'onda o di montaggio all'interno dell'intervallo che si desidera
riprodurre.

Ad esempio, se ¢ stata selezionata I'opzione Marker di inizio della regione, fare clicin un
punto qualsiasi all'interno dell'area ricompresa tra la coppia di marker di regione da cui/fino
a cui si desidera eseqguire la riproduzione. Il marker del punto di ancoraggio verde salta al
punto di ancoraggio selezionato.

Facoltativo: attivare le opzioni Esegui pre-roll e/o Esegui post-roll.

Per esequire la riproduzione dal marker del punto di ancoraggio, fare clic sul pulsante
Riproduci da un punto di ancoraggio sulla barra di trasporto o premere F7. Per eseguire la
riproduzione fino al marker del punto di ancoraggio, fare clic sul pulsante Riproduci fino a
un punto di ancoraggio sulla barra di trasporto o premere F8.

RISULTATO

La riproduzione viene avviata o arrestata in corrispondenza del punto di ancoraggio. Le
impostazioni di pre-roll e post-roll sono tenute in considerazione.

Le funzioni "Riproduci da un punto di ancoraggio” e "Riproduci fino a un punto

di ancoraggio”

E possibile riprodurre 'audio da o fino a un punto di ancoraggio utilizzando le funzioni Riproduci
da un punto di ancoraggio o Riproduci fino a un punto di ancoraggio disponibili nella barra
di trasporto. Queste funzioni di riproduzione si comportano in modo diverso a seconda delle
impostazioni di pre-roll e di post-roll.

Riproduci da un punto di ancoraggio

e Se ¢ attivato il post-roll, la riproduzione inizia a partire dalla posizione del punto
di ancoraggio e si arresta dopo il tempo di post-roll. Se non & selezionato alcun
post-roll, la riproduzione continua fino alla fine del file audio o del montaggio
audio.

e Se é attivato il pre-roll, la riproduzione inizia a partire dal punto di ancoraggio
selezionato, meno il tempo di pre-roll.

e Sesono attivati il pre-roll e il post-roll, la riproduzione inizia a partire dal punto
di ancoraggio selezionato meno il tempo di pre-roll e termina dopo il punto di
ancoraggio piu il tempo di post-roll.

e Se ¢ attivata la modalita loop, le impostazioni di pre-roll e post-roll vengono tenute
in considerazione. In questo modo & possibile riprodurre un loop attorno alla
posizione del cursore di modifica senza dover regolare ulteriori impostazioni.

Riproduci fino a un punto di ancoraggio

e Lariproduzione inizia dal cursore e termina nel punto di ancoraggio selezionato.
Se il cursore si trova oltre il punto di ancoraggio selezionato, la riproduzione
inizia dal punto di ancoraggio selezionato. Se il pre-roll & attivo, viene tenuto in
considerazione.

e Se ¢ attivato il pre-roll, la riproduzione inizia a partire dal punto di ancoraggio
selezionato meno il tempo di pre-roll, fino al punto di ancoraggio selezionato.
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Se non é stato selezionato alcun punto di ancoraggio, I'opzione Riproduci fino a
un punto di ancoraggio ¢ disattivata.

Le impostazioni del loop non producono alcun effetto.

Utilizzo della modalita di selezione automatica

E possibile utilizzare la modalita di selezione automatica in combinazione con le scorciatoie
di riproduzione per riprodurre gli intervalli audio o i punti di ancoraggio. Questo agevola il
monitoraggio delle operazioni di modifica.

PROCEDIMENTO

1. Nella barra di trasporto, fare clic-destro sul pulsante Riproduci da un punto di ancoraggio
o Riproduci fino a un punto di ancoraggio e attivare 'opzione Selezione automatica del
punto di ancoraggio.

2. Fare clic-destro sul pulsante Riproduci I'intervallo audio e attivare 'opzione Selezione
automatica dell'intervallo.

3. Nella finestra della forma d'onda o in quella di montaggio, eseguire una delle seguenti
azioni:

Selezionare un intervallo.

Fare clic allinterno dell'area compresa tra una coppia di marker.

Fare clic su un fade-in, un fade-out o una dissolvenza incrociata.

Fare clic su un punto qualsiasi nella finestra della forma d'onda/di montaggio.

Trascinare un marker.

A seconda dell'azione effettuata, viene selezionato l'intervallo o il punto di ancoraggio piu
appropriato. Ad esempio, se si fa clic nell'area compresa tra una coppia di marker, questa
regione viene selezionata come intervallo di riproduzione.

Il righello del tempo visualizza l'intervallo o il punto di ancoraggio selezionato.

NOTA

In modalita Selezione automatica del punto di ancoraggio e Selezione automatica
dell'intervallo & ancora possibile modificare alcune opzioni relative agli intervalli o ai punti
di ancoraggio nella barra di trasporto per riprodurre un intervallo/punto di ancoraggio
diverso. Tuttavia, I'intervallo o il punto di ancoraggio vengono selezionati di nuovo appena si
ricomincia a modificarli nuovamente con il mouse.

4. Utilizzare le scorciatoie di riproduzione per avviare la riproduzione.

Per riprodurre l'intervallo audio selezionato, premere F6.
Per eseguire la riproduzione a partire da un punto di ancoraggio, premere F7.

Per eseguire la riproduzione fino a un punto di ancoraggio, premere F8.

RISULTATO

Viene riprodotto l'intervallo di selezione oppure la riproduzione viene avviata o arrestata in
corrispondenza del punto di ancoraggio. Le impostazioni di pre-roll e post-roll sono tenute in
considerazione.

98



Riproduzione
Barra di trasporto

NOTA

Un intervallo di selezione ha la priorita su qualsiasi altro intervallo. Per fare in modo che gli altri
intervalli vengano selezionati automaticamente, deselezionare l'intervallo di selezione.

Utilizzo della funzione Riproduzione automatica durante I'editing

E possibile riattivare automaticamente la riproduzione mentre si modifica l'audio con il mouse.
Questa funzione é utile ad esempio se si desidera monitorare la regolazione del bordo di una
selezione.

PROCEDIMENTO

1.

Nella barra di trasporto, fare clic-destro sul pulsante Riproduci da un punto di ancoraggio
o Riproduci fino a un punto di ancoraggio e attivare 'opzione Riproduzione automatica
durante l'editing.

Nella finestra della forma d'onda o di montaggio, definire un intervallo di selezione e tenere
premuto il pulsante del mouse.

Avwviare la riproduzione utilizzando una delle seguenti scorciatoie:

e Perriprodurre l'intervallo audio selezionato, premere F6.

e Per eseqguire la riproduzione a partire da un punto di ancoraggio, premere F7.
e Per esequire la riproduzione fino a un punto di ancoraggio, premere F8.

Trascinare il cursore verso destra o verso sinistra.

L'intervallo di selezione viene regolato e riprodotto fino al punto in cui viene rilasciato il
pulsante del mouse. Quando la riproduzione termina, viene riprodotto il nuovo intervallo di
selezione.

Salto di sezioni durante la riproduzione

Durante la riproduzione & possibile saltare automaticamente un intervallo audio selezionato. In
questo modo, e possibile ascoltare come suonerebbe un determinato materiale senza specifiche

sezioni.

PROCEDIMENTO

1. Nella barra di trasporto, attivare Salta I'intervallo.

2. Attivare le opzioni Esegui pre-roll ed Esegui post-roll.

3. Sesidesidera utilizzare la funzione Riproduci intervallo audio, attivare una delle modalita
Intervalli.

4. Aseconda della modalita Intervalli selezionata, eseguire una delle seguenti operazioni:

e Se é stata attivata l'opzione Selezione temporale, definire una selezione audio nella
finestra della forma d'onda.

e Se ¢ stata attivata l'opzione Regione tra le coppie di marker, fare clic tra una coppia di
marker.

L'intervallo audio che sara saltato viene visualizzato sul righello del tempo assieme alle
durate di pre-roll e post-roll.

99



Riproduzione

Barra di trasporto

5. Selezionare il comando Riproduci intervallo audio o premere F6.

RISULTATO
L'intervallo selezionato viene saltato durante la riproduzione.

E possibile utilizzare il preset di fabbrica per saltare delle selezioni durante la riproduzione.
Attivare I'opzione Salta l'intervallo, definire una selezione audio e premere Shift-F6.

NOTA

Questa modalita funziona anche con il pulsante Avvia la riproduzione dal cursore di modifica
se & presente una selezione temporale o se sono stati impostati dei marker di esclusione di inizio
e fine. In questo caso, le durate di pre-roll e post-roll vengono ignorate.

Riproduzione in loop

E possibile riprodurre in loop la selezione audio, se disponibile. Se non & stato definito alcun
intervallo di selezione, viene riprodotto in loop l'intero file.

I punti di loop vengono aggiornati di continuo durante la riproduzione. Se si modifica l'inizio o la
fine di un loop durante la riproduzione, il loop cambia. In questo modo & possibile ascoltare dei
punti di selezione per del materiale ritmico.

Se si crea il loop di una sezione nel montaggio audio, il loop viene riprodotto all'interno dei
limiti dell'intervallo di selezione corrente. Questo intervallo di selezione pud trovarsi su qualsiasi
traccia, anche su una traccia vuota. La posizione verticale dell'intervallo di selezione non &
rilevante ai fini della riproduzione del loop: soltanto la selezione sinistra e destra contano
realmente.

LINK CORRELATI
Loop a pag. 342

Pre-roll e post-roli

E possibile avviare la riproduzione poco prima di una specifica posizione (pre-roll) e arrestarla
poco dopo un‘altra posizione (post-roll). Questo consente, ad esempio, di avere un po’ di contesto
quando si sta ascoltando una clip.

La posizione pud essere un punto di ancoraggio o l'inizio o la fine di un intervallo. Le durate di
pre-roll e post-roll vengono visualizzate sul righello del tempo.

Per attivare le funzioni pre-roll e/o post-roll, attivare Esegui post-roll e Esegui pre-roll nella
barra del trasporto.
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Quando si fa clic-destro sul pulsante di pre-roll o di post-roll sulla barra di trasporto, & possibile
selezionare una durata di pre-roll/post-roll. Qui & anche possibile selezionare un‘opzione di
riproduzione per le funzioni di pre-roll/post-roll, nonché aprire la finestra di dialogo Durata di
pre-roll e post-roll.

Post-roll

Finestra di dialogo Durata di pre-roll e post-roll

Questa finestra di dialogo consente di definire delle durate di pre-roll e post-roll brevi, medie e
lunghe. Queste impostazioni sono globali per WaveLab Elements.

e Per aprire la finestra di dialogo Durata di pre-roll e post-roll, fare clic-destro sul pulsante
pre-roll o sul pulsante post-roll nella barra di trasporto e selezionare Modifica le durate di
pre-roll e post-roll.

v Pre-Roll and Post-Roll Times e

Leng

Scorciatoie per la riproduzione

In aggiunta ai pulsanti nella barra di trasporto, sono disponibili delle scorciatoie per controllare
la riproduzione.

Barra spaziatrice
Consente di avviare/arrestare la riproduzione. Queste scorciatoie possono essere
utilizzate anche quando la finestra della forma d'onda o di montaggio non & la finestra
attiva.

0 sul tastierino numerico
Consente di arrestare la riproduzione. Se la riproduzione viene arrestata e si preme
questa scorciatoia, il cursore di modifica si sposta sul marker di inizio riproduzione
precedente o sull'inizio della selezione (indipendentemente da quanto siano vicini), fino
al raggiungimento dell'inizio del file. Lo stesso accade quando si fa clic sul pulsante
Arresta la riproduzione sulla barra di trasporto. Queste scorciatoie possono essere
utilizzate anche nel caso in cui la finestra della forma d’onda o di montaggio non
rappresentino la finestra attiva.

Invio

Consente di avviare la riproduzione. Se viene premuto durante la riproduzione,
quest'ultima riprende dalla precedente posizione di avvio. Lo stesso accade quando
si fa clic sul pulsante Avvia la riproduzione dal cursore di modifica sulla barra di
trasporto.
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Alt-Spazio
Awvia la riproduzione a partire dalla posizione del cursore del mouse.

F6

Awvia la riproduzione dell'intervallo selezionato in base all'opzione selezionata nella
sezione Intervalli della barra di trasporto.

F7

Awvia la riproduzione dal punto di ancoraggio selezionato in base all'opzione scelta
nella sezione Punti di ancoraggio della barra di trasporto.

F8

Avwvia la riproduzione fino al punto di ancoraggio selezionato in base all'opzione scelta
nella sezione Punti di ancoraggio della barra di trasporto.

Finestra di dialogo Salva un preset della barra di trasporto

In questa finestra di dialogo, € possibile salvare una configurazione della barra di trasporto sotto
forma di preset.

e Per aprire la finestra di dialogo Salva un preset della barra di trasporto, fare clic sul campo
Preset nella barra di trasporto e selezionare Salva con nome.

% Save Transport Bar Preset X

()

Name Shortcut

cting the Preset

X Cancel

Percorso

Consente di aprire la cartella radice del preset in Esplora file/macOS Finder. Qui &
possibile creare delle sotto-cartelle per i preset.

Elenco di preset
Consente di elencare tutti i preset esistenti.

Nome
Consente di specificare un nome per il preset.
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Quando viene selezionato un preset
Questa opzione consente di assegnare un comando di riproduzione personalizzato a
una scorciatoia. Ad esempio, & possibile impostare un collegamento per riprodurre
un intervallo con un pre-roll/post-roll breve e un altro collegamento per riprodurre un
intervallo senza pre-roll/post-roll.

All'arresto della riproduzione, ripristina le impostazioni di trasporto precedenti

Se questa opzione € attivata, le impostazioni vengono riportate allo stato in cui
si trovavano prima della riproduzione. Questo & utile per attivare un turno di
riproduzione speciale e ritornare automaticamente alle impostazioni standard al
termine della riproduzione.

Modifica della posizione della barra di trasporto

E possibile posizionare la barra di trasporto in cima, al centro o in fondo alla finestra dei file.

PROCEDIMENTO

1. Nella barra del titolo dell'Editor audio o della finestra Montaggio audio, fare clic su Opzioni
di layout.

AN AUDIOEDITOR * Y 5 @ 1=

Layout Options B8

2. Nella sezione Barra di trasporto, decidere il posizionamento della barra di trasporto
selezionando una tra le opzioni In alto, Al centro, o In basso.

Nascondere la barra di trasporto

E possibile nascondere la Barra di trasporto per preservare spazio su schermo.

PROCEDIMENTO

1. Nella barra del titolo dell'Editor audio o della finestra Montaggio audio, fare clic su Opzioni
di layout.

AN\ AUDIOEDITOR ] T 2=

Layout Options |8

2. Nella sezione Barra di trasporto, selezionare Nascosto.

Carico di processamento audio

Il display Carico di processamento audio nella Barra di trasporto visualizza il carico medio
di processamento audio dei plug-in durante la riproduzione. Questo consente di monitorare il
numero di plug-in che & possibile utilizzare.

La barra verde visualizza il carico medio di processamento audio di tutti i plug-in attivi. Al 100%
e probabile che si verifichino dei salti o interruzioni del flusso audio. La barra rossa visualizza il
carico dell'ultimo materiale audio processato.

e Per attivare/disattivare la funzione Carico di processamento audio, fare clic-destro sulla
Barra di trasporto e fare clic su Carico di processamento audio.

DIDEICIEAERESEE conoomn17sssoms 1|
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Awvio della riproduzione dal righello del tempo

Avvio della riproduzione dal righello del tempo

E possibile utilizzare il righello del tempo per saltare a una determinata posizione e avviare da
quel punto la riproduzione.

e Sesifa doppio-clic sul righello del tempo, la riproduzione viene avviata da quella posizione.
La riproduzione continua finché non si fa clic su Arresta la riproduzione o fino alla fine del
file audio o del montaggio audio.

e Perimpostare una specifica posizione di riproduzione, fare clic sul righello del tempo
durante la riproduzione. E anche possibile fare clic sui righelli dei tempi di un altro file audio
o montaggio audio. Questo consente di passare velocemente dalla riproduzione di un file
audio o di un montaggio audio all'altro.

e Per avviare la riproduzione dalla posizione di un marker, premere Ctrl/Cmd e fare doppio-
clic sul marker desiderato.

LINK CORRELATI

Righello del tempo e Righello del livello a pag. 52

Riproduzione dei canali audio focalizzati

Nel corso della riproduzione, & possibile alternare la riproduzione dei cluster di canali sinistro/
destro, centrale/laterale dei file audio multicanale, o di entrambi i canali audio.

PROCEDIMENTO

1.

Nell'Editor audio, attivare I'opzione Riproduci i canali audio focalizzati.

NOTA

Se si sta utilizzando l'opzione Riproduci i canali audio focalizzati per i file audio
multicanale, i pulsanti Mute e Solo non sono disponibili.

Avviare la riproduzione.

Per alternare la riproduzione tra i diversi canali audio, eseguire una delle seguenti
operazioni:

e Perriprodurre il canale audio sinistro o centrale, fare clic sull'area superiore del righello
del livello.
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Posizione del cursore per la riproduzione del canale audio sinistro

e Perriprodurre il canale audio destro o laterale, fare clic sull'area inferiore del righello del
livello.

Posizione del cursore per la riproduzione del canale audio destro

e Perriprodurre entrambi i canali audio, fare clic sull'area centrale del righello del livello.

Posizione del cursore per la riproduzione dei canali audio sinistro e destro

e Perriprodurre un cluster di canali di un file audio multicanale, fare clic sull'area dei
controlli del cluster di canali.

e Per scorrere tra i canali audio utilizzando i comandi da tastiera, premere Tab o Tab-
Shift.

LINK CORRELATI
Righello del tempo e Righello del livello a pag. 52

105



Riproduzione
Riproduzione di file multicanale

File audio multicanale a pag. 125

Riproduzione di file multicanale

E possibile esequire la riproduzione dei file multicanale in base al sistema audio utilizzato. Se il
proprio setup non consente la riproduzione di tutti i canali audio, il file multicanale pud essere
riprodotto in stereo.

PREREQUISITI

Nella scheda Connessioni audio, specificare i bus di ingresso e di uscita e definire la periferica
che siintende utilizzare per la riproduzione dell'audio.

PROCEDIMENTO
1. Aprire un file audio multicanale nellEditor audio o nel Montaggio audio.

2. Awviare lariproduzione.

Se il proprio sistema audio & stato configurato correttamente, il file multicanale viene
riprodotto. Se il sistema audio non consente la riproduzione di tutti i canali del file
multicanale, si apre la finestra di dialogo Connessioni della periferica audio incomplete.

3. Nella finestra di dialogo Connessioni della periferica audio incomplete, eseguire una delle
seguenti operazioni:

e Per arrestare la riproduzione, fare clic su Arresta (nessuna riproduzione).

e Per aprire la scheda Connessioni audio e apportare modifiche al proprio sistema audio,
fare clic su Apri le connessioni audio.

e Per avviare la riproduzione ma silenziare tutti i canali che non possono essere riprodotti,
fare clic su Continua (alcuni canali audio verranno messi in mute).

e Perriprodurre il file audio multicanale in stereo, fare clic su Attiva lI'opzione della
Sezione Master "Mixaggio in stereo" per la riproduzione.

NOTA

Considerare la possibilita di utilizzare il plug-in MixConvert V6 nella Sezione Master
anziché mixare il file multicanale in stereo.

LINK CORRELATI

Scheda Connessioni audio a pag. 18
Apertura dei file a pag. 60

Sezione Master a pag. 284

Scrubbing della riproduzione

Lo scrubbing della riproduzione consente di trovare una posizione specifica in un file audio,
riavviando la riproduzione ripetutamente ogni volta che si fa clic e si trascina il cursore sul
righello del tempo durante la riproduzione o quando si utilizza lo strumento Riproduci.

LINK CORRELATI

Scrubbing tramite l'utilizzo dello strumento Riproduci a pag. 107
Scrubbing tramite l'utilizzo del righello del tempo a pag. 107
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Scrubbing tramite l'utilizzo dello strumento Riproduci

Lo strumento Riproduci consente di eseguire la riproduzione da qualsiasi posizione su uno o su
entrambi i canali stereo.

PROCEDIMENTO
1. Nell'Editor audio, selezionare la scheda Modifica.

2. Nella sezione Strumenti di utility, selezionare lo strumento Riproduci oppure tenere
premuto Alt.

3. Fare clic nella finestra della forma d'onda.

4. Nellafinestra della forma d’'onda, fare clic sulla posizione da cui si desidera avviare la
riproduzione.

La forma del cursore indica se viene riprodotto il canale sinistro (L) o il canale destro (R). Se si
utilizza lo strumento Riproduci a meta tra i canali, vengono riprodotti entrambi i canali.

RISULTATO

La riproduzione continua fino a che si tiene premuto il pulsante del mouse o fino al termine del
file audio. Una volta che la riproduzione € giunta a termine, il cursore si sposta alla posizione di
riproduzione di partenza.

LINK CORRELATI
Scrubbing della riproduzione a pag. 106
Preferenze di scrubbing della riproduzione a pag. 107

Scrubbing tramite l'utilizzo del righello del tempo

Durante la riproduzione, € possibile fare clic su righello del tempo per eseguirla a partire dalla
posizione selezionata.

PROCEDIMENTO

1. Awviare la riproduzione.

2. Fare clic sul righello del tempo e, tenendo il pulsante del mouse premuto, trascinare verso
sinistra o verso destra.

3. Una volta eseqguito lo scrubbing, rilasciare il pulsante del mouse.

L'audio viene riprodotto a partire dalla posizione del cursore di modifica e una piccola
sezione viene riprodotta in loop una volta.

LINK CORRELATI
Scrubbing della riproduzione a pag. 106

Preferenze di scrubbing della riproduzione

E possibile definire il comportamento dello strumento Riproduci nelle Preferenze dei file audio.

Selezionare File > Preferenze > File audio. Le opzioni che sequono sono disponibili nella sezione
Scrubbing della riproduzione della scheda Modifica:
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Finestra Timecode

e Sel'opzione Solo con lo strumento Riproduci ¢ attivata, lo scrubbing non ¢ disponibile
quando si fa clic e trascinamento sul righello del tempo durante la riproduzione.

e Limpostazione Sensibilita determina la lunghezza del loop audio che viene riprodotto una
volta quando si fa clic e trascinamento sul righello del tempo con lo strumento Riproduci.

LINK CORRELATI
Scrubbing della riproduzione a pag. 106
Scheda Modifica (Preferenze dei file audio) a pag. 411

Finestra Timecode

Questa finestra consente di visualizzare la durata registrata, il offset dei tempi rispetto a diverse
posizioni e i colori dinamici in base al contesto. Durante la riproduzione, viene visualizzata la
posizione del brano. Se non & in corso la riproduzione, viene visualizzata la posizione del cursore
di modifica.

e Per aprire la finestra Timecode, selezionare Indicatori audio > Timecode.

Menu della modalita di visualizzazione

Modifica i colori

Consente di visualizzare la finestra di dialogo Colori del timecode, nella quale &
possibile modificare la finestra Timecode.

¥ Timecode Colors e
e File Start
Times Negative Times

Background Background

Digits Digits

e Times

Use L

X Cancel

Precisione ridotta

Se questa opzione € attivata, il display del Timecode visualizza un numero inferiore di
cifre.

Tempi positivi
Se questa opzione & attivata, vengono visualizzati i valori positivi. Se & attiva anche
'opzione Tempi negativi, viene visualizzato I'offset piu vicino, negativo o positivo.
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Tempi negativi
Se questa opzione € attivata, vengono visualizzati i valori negativi. Se & attiva anche
l'opzione Tempi positivi, viene visualizzato |'offset piu vicino, negativo o positivo.
Inizio del file/Fine del file

Consente di visualizzare la posizione in relazione all'inizio e alla fine del righello del
tempo. Il formato del tempo viene visualizzato in conformita con il righello.

Visualizzazione offset

Consente di selezionare da quale posizione si desidera visualizzare 'offset. Le seqguenti
posizioni sono disponibili: cursore di modifica, inizio/fine della selezione, marker, inizio/
fine del CD, inizio/fine della clip.

Tempo registrato

Se questa opzione € attivata, la finestra Timecode consente di visualizzare il tempo
registrato quando si avvia la registrazione.

Durata della registrazione (a partire dall’'ultimo marker)

Se questa opzione € attivata, la finestra Timecode consente di visualizzare il tempo
registrato a partire dall’'ultimo marker inserito, quando si avvia la registrazione.

Scorrimento durante la riproduzione

E possibile specificare il tipo di scorrimento della visualizzazione in modalita Riproduci.

e Perimpostare la modalita di scorrimento, aprire I'Editor audio o la finestra Montaggio
audio, selezionare la scheda Vista e attivare una delle opzioni della sezione Riproduzione.

Vista statica
Consente di disattivare lo scorrimento.

La vista segue il cursore
La vista scorre in automatico in modo da mantenere visibile il cursore di riproduzione.

Scorri vista
La vista scorre in modo da mantenere centrato il cursore di riproduzione.

NOTA

In caso diinterruzioni o salti del flusso audio nel corso della riproduzione, attivare I'opzione Vista
statica.

Riproduzione nella finestra Montaggio audio

La riproduzione nella finestra Montaggio audio avviene esattamente come nell’Editor audio.
Tuttavia & necessario considerare alcuni aspetti.

Tracce in mute e in solo

E possibile mettere in mute o in solo le tracce in un montaggio audio utilizzando i rispettivi
pulsanti nell'area dei controlli delle tracce.

OPZIONI
e Nellarea dei controlli di una traccia, eseguire una delle sequenti operazioni:

e Per mettere in mute una traccia, fare clic su Mute.
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Quando una traccia € in mute, il pulsante Mute & di colore giallo.
e Per mettere in solo una traccia, fare clic su Solo.
Quando una traccia & in solo, il pulsante Solo ¢ di colore rosso.

e Per mettere in solo piu tracce, fare Ctrl/Cmd -clic sul pulsante Solo per tutte le tracce
desiderate.

e Per attivare la funzione 'Annulla solo' per una traccia, premere Ctrl/Cmd - Alt/Opt e fare
clic su Solo.

In questa modalita, la traccia non viene silenziata se si mette in solo un‘altra traccia. Fare
nuovamente clic su Solo per disattivare la funzione 'Annulla solo'.

LINK CORRELATI
Area dei controlli delle tracce a pag. 191

Riproduzione di singole clip

E possibile riprodurre una clip singola in una traccia. Le clip che si sovrappongono o le clip in
altre tracce sono messe in mute.

PROCEDIMENTO

1. Nella finestra del montaggio, fare clic-destro sulla parte inferiore della clip che si desidera
riprodurre.

2. Nel menu, selezionare una delle seguenti opzioni di riproduzione:

e Perriprodurre la clip, selezionare Riproduci clip.

e Perriprodurre la clip con il pre-roll, selezionare Riproduci la clip con il pre-roll.

Riproduzione di un intervallo di selezione di una traccia

E possibile selezionare una sezione di una clip e riprodurla. Le clip che si sovrappongono o le clip
in altre tracce sono messe in mute.

PROCEDIMENTO

1. Nella finestra di dialogo del montaggio, definire un intervallo di selezione in una clip o in una
sezione vuota di una traccia.

2. Fare clic-destro sull'intervallo di selezione e scegliere Riproduci la clip all'interno della
selezione.
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Le operazioni di modifica di file audio riguardano l'apertura, la modifica e il salvataggio dei file
audio.

LINK CORRELATI

Finestra della forma d'onda a pag. 111

Gestione dei file nell'Editor audio a pag. 125

Mix down - Renderizzazione dei file audio a pag. 151

Finestra della forma d'onda

La finestra della forma d'onda nell’Editor audio consente di visualizzare graficamente i file audio.
E qui possibile visualizzare, riprodurre e modificare singoli file audio.

La finestra della forma d'onda & composta da due viste. E possibile utilizzare una vista come
panoramica per esplorare il progetto e I'altra come vista principale per la modifica.
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A\ Track 1 AN Track 2

et g R 0
PR Dokt

Sterec 16bit 44 100Hz %

Le viste delle forme d’onda possono essere sincronizzate facendo clic su Sincronizzazione con
I'altra vista, in modo che visualizzino la stessa porzione del file audio.

trogram [ M
Ly

Spettrogramma

La scheda Spettrogramma consente di visualizzare l'intensita del livello di ciascuna area nello
spettro delle frequenze. E possibile utilizzare gli strumenti di modifica di WaveLab Elements per
modificare lo spettrogramma.

e Per aprire la visualizzazione a Spettrogramma, fare clic su Spettrogramma in fondo alla
finestra della forma d'onda.

bit F44 100Hz %
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Area dei controlli dei canali

L'area dei controlli dei canali si trova a sinistra della forma d’onda nella finestra della forma
d'onda. L'area dei controlli dei canali consente di selezionare i canali e di mettere in mute e in
solo i singoli canali dei file audio multicanale.

Area dei controlli dei canali di un file audio stereo

Area dei controlli dei canali per un cluster di canali di un file audio multicanale

Mute
Consente di mettere in mute il cluster di canali. Questo ha effetto sulla riproduzione e
non sulla renderizzazione.

Solo
Consente di mettere in solo il cluster di canali. Questo ha effetto sulla riproduzione e
non sulla renderizzazione.

Ripiega/Esplodi il cluster di canali
Consente di ripiegare ed espandere i singoli cluster di canali.

LINK CORRELATI
Finestra della forma d'onda a pag. 111
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File audio multicanale a pag. 125

Agganci magnetici nei file audio

Alcune posizioni, come i bordi di una selezione o i marker, possono essere resi magnetici. Gli
elementi trascinati possono essere agganciati a queste posizioni. In questo modo & piu semplice
posizionare in maniera precisa gli elementi.

Ad esempio, se un marker viene spostato e avvicinato a uno degli agganci magnetici, il marker
scatta in questa posizione. Viene quindi visualizzata un'etichetta con la posizione di scatto.

_ 10mn10s ms
Ll ..:qI(l. Sl
End of file

Per posizionare il cursore su una posizione magnetica, fare clic sulla linea del tempo e tenere
premuto il pulsante del mouse. Se ora si sposta il cursore, questo salta al successivo bordo
magnetico.

LINK CORRELATI
Menu Calamite a pag. 114

Menu Calamite

In questo menu a tendina & possibile specificare quali posizioni devono essere magnetiche. Se
e attivata l'opzione Scatta verso le calamite, gli elementi spostati scattano a queste specifiche
posizioni.

e Per aprire il menu a tendina Calamite, selezionare la scheda Modifica nell’Editor audio,
quindi fare clic su Calamite nella sezione Allineamento.

E possibile consentire agli elementi di agganciarsi alle sequenti posizioni:

Inizio del file/Fine del file
Gli elementi scattano all'inizio/alla fine del file quando vengono spostati vicino a queste
posizioni.

Contrassegni del righello dei tempi
Gli elementi scattano alla griglia del righello dei tempi quando vengono spostati vicino
a queste posizioni.

Marker
Gli elementi scattano alle posizioni dei marker quando vengono spostati vicino a
queste posizioni.

Bordi della selezione
Gli elementi scattano ai bordi della selezione quando vengono spostati vicino a queste
posizioni.

Cursore

Gli elementi scattano al cursore di modifica quando vengono spostati vicino al cursore
stesso.
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Punti di zero

Un punto di zero & un punto in cui la forma d’'onda attraversa l'asse di livello zero. Quando
si eseguono operazioni di modifica, come taglia, incolla o trascinamento, assicurarsi che il
materiale sia inserito a un punto di zero.

Se non si eseguono queste operazioni in corrispondenza dei punti di zero, potrebbero verificarsi
delle discontinuita nell'onda, percepite come click o pop nel suono risultante.

Attivare I'opzione Punto di zero nella scheda Modifica dell'Editor audio per assicurarsi che le
selezioni che vengono definite vengano sempre regolate in modo da iniziare e terminare in
corrispondenza del punto di zero piu vicino.

Impostazione dell'individuazione del punto di zero

E possibile fare in modo che i bordi della selezione scattino automaticamente al punto di zero
piu vicino. Nella finestra di dialogo Preferenze dei file audio, & possibile inoltre specificare
se consentire o meno lo scatto a livelli di ingrandimento elevati e definire l'intervallo di
scansionamento per l'individuazione dei punti di zero.

PROCEDIMENTO

1. Nell’Editor audio, selezionare la scheda Modifica.

2. Nella sezione Allineamento, attivare l'opzione Punto di zero.

3. Selezionare File > Preferenze > File audio.

4. Nella scheda Preferenze dei file audio, selezionare la scheda Modifica.
5

Definire le impostazioni desiderate nella sezione Aggancia selezione al punto di zero.

LINK CORRELATI
Preferenze dei file audio a pag. 411

Spostamento della posizione del cursore al punto di zero piu vicino

E possibile spostare automaticamente la posizione del cursore al punto di zero piu vicino.

PROCEDIMENTO
1. Nell'Editor audio, selezionare la scheda Vista.

2. Nella sezione Cursore, fare clic su Scatta al punto di zero.
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Le schede dell’Editor audio

Le diverse schede disponibili nell’Editor audio offrono I'accesso a una serie di strumenti di utility
e opzioni per la modifica dei file audio.

LINK CORRELATI

Scheda Visualizza (Editor audio) a pag. 116
Scheda Modifica (Editor audio) a pag. 118
Scheda Inserisci (Editor audio) a pag. 122
Scheda Processa (Editor audio) a pag. 123
Scheda Renderizza (Editor audio) a pag. 123

Scheda Visualizza (Editor audio)

W FILE © VIEW
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e NellEditor audio fare clic su Visualizza.
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Naviga

Indietro/Avanti

Consente di navigare fino alla posizione del cursore, al fattore di zoom e all'intervallo di
selezione precedenti/successivi.

Ingrandimento

Tempo
Apre un menu a tendina che consente di regolare il fattore di zoom in modo da
visualizzare l'intervallo temporale selezionato. L'opzione Ingrandimento 1:1 consente
di impostare il fattore di ingrandimento in modo tale che un pixel sullo schermo
rappresenti un campione.

Per modificare il fattore di ingrandimento, fare clic su Modifica il fattore di
ingrandimento. Si apre cosi la finestra di dialogo Fattore di ingrandimento, in cui
é possibile modificare le seqguenti impostazioni:

e L'opzione Definisci intervallo temporale consente di specificare l'intervallo
temporale da visualizzare.

e |'opzione Campioni per pixel consente di specificare il numero di campioni audio
rappresentati da ciascun pixel.

e L'opzione Pixel per campione consente di specificare il numero di pixel utilizzati
per rappresentare un singolo campione audio.
Ingrandimento
Attiva lo strumento Ingrandimento che consente di definire un intervallo temporale
sul quale viene eseguito uno zoom.
Ingrandisci la selezione

Consente di ingrandire la finestra in modo che la selezione corrente occupi l'intera
finestra del montaggio.

116



Modifica dei file audio
Le schede dell'Editor audio

Microscopio
Consente di aumentare al massimo l'ingrandimento.

Aumenta lI'ingrandimento dell’audio (10 x)/Riduci I'ingrandimento dell'audio (10 x)
Consente di aumentare/ridurre l'ingrandimento per grandi incrementi.

Visualizza tutto
Consente di ridurre al minimo l'ingrandimento.

Ingrandisci I'audio/Riduci I'ingrandimento dell'audio
Consente di aumentare/ridurre l'ingrandimento per piccoli incrementi.

Livello
Consente di regolare il fattore di ingrandimento per visualizzare solo i campioni sotto
al valore in dB selezionato.

Ottimizza I'ingrandimento verticale
Consente di modificare il fattore di ingrandimento verticale in modo che i picchi siano
chiaramente visibili. Questa regolazione & eseqguita sulla base della sezione di onda
visibile nella finestra della forma d'onda/di montaggio.

Riporta lo zoom a 0 dB
Consente di regolare il fattore di ingrandimento in modo da visualizzare i livelli audio
fino a 0 dB.

Ingrandimento verticale/Riduzione ingrandimento verticale

Consente di aumentare/ridurre I'ingrandimento delle forme d'onda con un livello pit
basso/alto.

Cursore

Sposta il cursore all'inizio del file/Sposta il cursore alla fine del file
Consente di spostare la posizione del cursore all'inizio/alla fine del file.

Marker precedente/Marker successivo
Consente di spostare il cursore al marker precedente/successivo.

Inizio della selezione/fine della selezione

Consente di spostare la posizione del cursore all'inizio/alla fine dell'intervallo temporale
selezionato.

Bordo della regione precedente/Bordo della regione successiva
Consente di spostare il cursore al bordo della regione precedente/successiva.

Scatta al punto di zero
Consente di spostare il cursore al punto di zero piu vicino.

Posizione del cursore di modifica

Consente di aprire la finestra di dialogo Posizione cursore in cui € possibile modificare
la posizione del cursore.

Scorrimento

Inizio/Fine
Visualizza l'inizio/la fine dell'audio senza spostare il cursore.

Inizio della selezione/fine della selezione
Visualizza l'inizio/la fine della selezione audio senza spostare il cursore.
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Cursore
Visualizza la posizione del cursore.

Riproduzione

Vista statica
Disattiva lo scorrimento.

La vista segue il cursore

Scorre in automatico la vista in modo da mantenere visibile il cursore di riproduzione.

Scorri vista

La vista scorre automaticamente in modo da mantenere centrato il cursore di
riproduzione.

Analisi

Analisi delle frequenze in 3D

Apre la finestra di dialogo Analisi delle frequenze in 3D in cui & possibile definire
I'intervallo di frequenze analizzato e modificare I'aspetto del grafico per I'analisi delle
frequenze in 3D.

Picchi

Ricostruisci la visualizzazione dei picchi

Solitamente, i file di picco vengono aggiornati automaticamente quando la relativa
data & antecedente a quella del file audio. Tuttavia, pud accadere che la data del file
audio sia errata e che pertanto il file di picco non venga aggiornato automaticamente.
Questa opzione consente di forzare la ricostruzione del file di picco.

Scheda Modifica (Editor audio)

e NellEditor audio fare clic su Modifica.

WwrAEE ©OviEw € eDim £ INSERT Og PROCESS B RENDER

TIME SELECTION

Sorgente

Modifica progetto

Quando si lavora su un file audio o su una clip in WaveLab Elements, & possibile aprire
in Cubase/Nuendo il relativo progetto. Questa funzione consente di correggere delle
eventuali problematiche che dovessero emergere nel corso del mixaggio e correggerle
direttamente nel file audio all'interno di Cubase/Nuendo.

La funzione Modifica progetto consente di aprire il progetto del sequencer
corrispondente del file audio.

Strumenti

Selezione temporale
Strumento di utility che consente di selezionare un intervallo temporale.
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Penna

Strumento di utility che consente di ridisegnare la forma d'onda nella finestra della
forma d'onda. Puo essere utilizzato per riparare rapidamente gli errori della forma
d’'onda.

Riproduci

Strumento di utility che consente di riprodurre il file audio alla posizione di clic.

Selezione temporale

Estendi

Apre un menu in cui & possibile selezionare le seguenti opzioni per la creazione o
I'estensione degli intervalli di selezione:

L'opzione Estendi a inizio file consente di estendere la selezione fino all'inizio del
file audio. Se non € presente alcuna selezione, ne viene creata una a partire dalla
posizione del cursore di modifica.

L'opzione Estendi a fine file consente di estendere la selezione fino alla fine del
file audio. Se non & presente alcuna selezione, ne viene creata una a partire dalla
posizione del cursore di modifica.

L'opzione Estendi fino al marker precedente consente di estendere il bordo
sinistro della selezione fino al marker piu vicino a sinistra o all'inizio del file audio.
Se non & presente alcuna selezione, ne viene estesa una fino alla posizione del
marker precedente.

L'opzione Estendi fino al marker successivo consente di estendere il bordo
destro della selezione fino al marker a destra piu vicino o fino alla fine del file
audio. Se non ¢ presente alcuna selezione, ne viene estesa una fino alla posizione
del marker successivo.

L'opzione Estendi al cursore consente di estendere la selezione fino alla posizione
del cursore di modifica.

L'opzione Dall’inizio del file al cursore consente di selezionare l'intervallo tra
I'inizio del file audio e la posizione del cursore di modifica.

Da cursore a fine file consente di selezionare l'intervallo tra la posizione del
cursore di modifica e la fine del file audio.

L'opzione Da cursore a marker precedente consente di selezionare l'intervallo tra
la posizione del cursore di modifica e il marker precedente o l'inizio del file audio.

L'opzione Da cursore a marker successivo consente di selezionare l'intervallo tra
la posizione del cursore di modifica e il marker successivo o la fine del file audio.

L'opzione Sposta la selezione verso sinistra sposta la selezione della sua intera
lunghezza verso sinistra.

L'opzione Sposta la selezione verso destra sposta la selezione della sua intera
lunghezza verso destra.

L'opzione Dalla posizione di riproduzione alla fine consente di creare un
intervallo di selezione dalla posizione di riproduzione fino alla fine della selezione o
fino alla fine del file se non & presente alcuna selezione. Se la riproduzione non &
attiva, viene utilizzata la posizione del cursore di modifica.

L'opzione Dall’inizio alla posizione di riproduzione consente di creare un
intervallo di selezione dalla posizione di riproduzione fino all'inizio della selezione o
fino all'inizio del file se non & presente alcuna selezione. Se la riproduzione non &
attiva, viene utilizzata la posizione del cursore di modifica.

119



Modifica dei file audio
Le schede dell'Editor audio

e L'opzione Raddoppia la lunghezza della selezione consente di raddoppiare la
lunghezza dell'intervallo di selezione corrente.

e L'opzione Dimezza la lunghezza della selezione consente di dimezzare la
lunghezza dell'intervallo di selezione corrente.
Alterna
Consente di attivare/disattivare la selezione audio corrente.

Tutto
Consente di selezionare l'intera forma d'onda.

Canali
Questo menu a tendina consente di cambiare la selezione del canale.
e L'opzione Estendi a tutti i canali consente di estendere l'intervallo di selezione
corrente a tutti i canali.

e L'opzione Solo canale sinistro consente di ridurre I'intervallo di selezione solo al
canale sinistro.

e L'opzione Solo canale destro consente di ridurre l'intervallo di selezione solo al
canale destro.
Regioni
Questo menu a tendina consente di selezionare un intervallo tra due marker.
e L'opzione Regione di loop consente di selezionare l'intervallo tra due marker di
loop tra i quali si trova il cursore di modifica.

e L'opzione Regione generica consente di selezionare l'intervallo tra due marker
generici tra i quali si trova il cursore di modifica.

Appunti

Taglia
Consente di tagliare l'intervallo audio selezionato e di posizionarlo negli appunti.
Copia
Consente di copiare la clip attiva o l'intervallo audio selezionato e di posizionarli negli
appunti.
Incolla
Incolla il contenuto degli appunti.
Fare clic destro su Incolla per aprire un menu a tendina che consente di selezionare un
tipo di incollaggio.
e L'opzione Sovrascrivi sostituisce I'audio alla posizione del cursore.
e L'opzione Aggiungi in fondo aggiunge l'audio da incollare dopo la fine del file.
e |'opzione Aggiungi all'inizio aggiunge l'audio da incollare prima dell'inizio del file.
e |'opzione Copie multiple apre una finestra di dialogo nella quale & possibile
inserire il numero di copie che si desidera creare.

e L'opzione Mix consente di fondere due file in uno partendo dalla selezione o, se
non presente, dalla posizione del cursore.
Se si seleziona l'opzione Mixa, si apre una finestra di dialogo che consente di
specificare il guadagno e la fase per I'audio negli appunti e nella destinazione. I
dati negli appunti vengono sempre mixati, indipendentemente dalla durata della
selezione.
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Incolla e dissolvenza incrociata
Incolla il contenuto degli appunti e crea una dissolvenza incrociata.

Fare clic destro su Incolla e dissolvenza incrociata per aprire un menu a tendina che
consente di selezionare un tipo di dissolvenza incrociata per l'operazione di incollaggio.

e L'opzione Lineare (guadagno costante) modifica il livello in maniera lineare.

e L'opzione Seno (potenza costante) modifica il livello in base a una curva di seno;
la potenza del mix rimane costante.

e L'opzione Radice quadrata (potenza costante) modifica il livello in base a una
curva della radice quadrata; la potenza del mix rimane costante.

Taglio
Ritaglia

Elimina i dati audio esterni alla selezione.
Elimina

Elimina la selezione. L'audio a destra della selezione viene spostato verso sinistra per
riempire lo spazio vuoto.

Altro

Inverti i canali stereo
Sposta l'audio dal canale sinistro a quello destro e viceversa.

Spinta
Spingi verso sinistra
Spinge la selezione audio verso sinistra.

Spingi verso destra
Spinge la selezione audio verso destra.

Allineamento

Punto di zero

Se questa opzione € attivata, l'inizio e la fine dell'intervallo di selezione scattano sempre
a un punto di zero della forma d'onda.

Se l'opzione Punto di zero ¢ attivata e si aggiungono dei marker durante la
riproduzione utilizzando i comandi da tastiera, i marker creati si agganciano al punto di
zero piu vicino nella forma d'onda.

Questa funzione si applica ai seguenti tipi di marker:
e Marker generici

e Marker delle regioni

e Marker dei loop

Scatta verso le calamite

Se questa opzione e attivata, gli elementi spostati, come ad esempio i bordi delle clip,
i bordi della selezione temporale, il cursore e i marker scattano verso gli elementi
magnetici che sono attivati nel menu a tendina Calamite.

Calamite

Questo menu a tendina consente di definire quali elementi sono magnetici.
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Scheda Inserisci (Editor audio)

W FILE

© VIEW

La scheda Inserisci consente di aggiungere marker, file audio e segnali al proprio file audio.
e Nell'Editor audio fare clic su Inserisci.

€ DT | & INSERT @ PROCESS D RENDER
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Name for End N r At End

Marker

Nome del marker
Consente di inserire il nome del marker di inizio. Se non viene inserito alcun nome,
viene usato un nome generico.

Per modificare i nomi predefiniti, aprire la finestra Marker e selezionare Funzioni >
Nomi dei marker predefiniti.

Nome diverso per il marker di fine
Se questa opzione € attivata, € possibile inserire un nome diverso per il marker di fine
nel campo Nome del marker di fine.

Se e disattivata, il nome sara identico a quello del marker di inizio.

Crea/Assegna nome a marker
Il pulsante Crea/Assegna nome a marker nell'angolo inferiore-destro della sezione
Marker consente di aprire la finestra di dialogo Crea marker. Questo consente di
creare marker e coppie di marker in corrispondenza della posizione del cursore di
modifica.

Create/Name Marker

File audio
All'inizio
Consente di inserire un file audio all'inizio del file audio attivo.

Alla fine
Consente di inserire un file audio alla fine del file audio attivo.

Al cursore
Consente di inserire un file audio alla posizione del cursore.

Segnale

Metti in mute la selezione
Sostituisce la selezione audio con una parte di silenzio.

Generatore di silenzio

Apre la finestra di dialogo Generatore di silenzio che consente di inserire del silenzio o
un suono d'ambiente in un file audio.
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Bip di censura

Apre la finestra di dialogo Bip di censura che consente di sostituire una parte in un file
audio con un suono, per coprire ad esempio una parola volgare.

LINK CORRELATI
Finestra di dialogo Generatore di silenzio a pag. 156
Finestra di dialogo Bip di censura a pag. 158

Scheda Processa (Editor audio)

La scheda Processa fornisce I'accesso agli strumenti di processamento offline.

LINK CORRELATI
Processamento offline a pag. 173

Scheda Renderizza (Editor audio)
La scheda Renderizza consente di eseguire un mix down dei file audio.

e Nell'Editor audio fare clic su Renderizza.

W FLE ©VIEW € EDIT & INSERT @ PROCESS S RENDER

In Place Name DIA church verb

Whole File

Sorgente

Il menu a tendina Sorgente consente di selezionare quale parte dell'audio processare. Sono
disponibili le seguenti opzioni:
File intero

Consente di processare e renderizzare l'intero intervallo audio.

Regione contrassegnata specifica

Consente di processare e renderizzare in un file indipendente un intervallo audio
specifico.
Specificare la regione da processare nel menu a tendina.

Risultato

Sul posto

Se questa opzione € attivata, l'intervallo audio renderizzato va a sostituire l'intervallo
audio di origine.

File senza nome
Se questa opzione € attivata, viene renderizzato un file temporaneo senza nome.

File con nome
Se questa opzione € attivata, € possibile specificare un nome per il file renderizzato.
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Uscita

Nome

Consente di inserire un nome per il file renderizzato. Facendo clic sull'icona a freccia, si
apre un menu a tendina che offre numerose opzioni per l'assegnazione automatica dei
nomi.

Posizione
Consente di selezionare una cartella di destinazione per i file renderizzati.

Formato
Apre un menu a tendina in cui € possibile selezionare un formato file.

Opzioni
A seconda della sorgente selezionata, sono disponibili diverse opzioni.

Bypass della Sezione Master

Se questa opzione € attivata, i plug-in e il guadagno della Sezione Master vengono
bypassati durante la renderizzazione.

Salva automaticamente il preset della Sezione Master

Se questa opzione € attivata, il preset della Sezione Master viene automaticamente
salvato nel file compagno del file audio quando si renderizza il file. E possibile caricare
il preset della Sezione Master utilizzando I'opzione Carica i preset della Sezione
Master che si trova nell'angolo inferiore-destro della finestra della forma d’'onda.

Aggiungi una coda del riverbero
Se questa opzione € attivata, la coda nell'audio prodotta da effetti come il riverbero
non viene inclusa nel file renderizzato.

Alcuni plug-in non sono in grado di trasferire a WavelLab Elements le informazioni
relative alla durata della coda. In tal caso, questa opzione non produce alcun effetto.
Per tali plug-in, & possibile aggiungere il plug-in Silence per inserire dei campioni extra
alla fine del file.

Copia marker

Se questa opzione € attivata, i marker che sono inclusi nell'intervallo da processare
vengono copiati nel file renderizzato.

Salta le regioni di esclusione

Se questa opzione & attivata, gli intervalli audio in mute vengono saltati e non sono
inclusi nel risultato.

Apri il file audio risultante

Se questa opzione € attivata, ciascun file renderizzato viene aperto in una nuova
finestra.

Bypassa la Sezione Master per il file audio risultante

Se questa opzione € attivata, la riproduzione del file audio risultante bypassa l'intera
Sezione Master. Questa impostazione puo essere attivata facendo clic sul pulsante che
si trova in basso a destra nella finestra della forma d’onda o di montaggio.

NOTA

Si raccomanda di attivare questa opzione, poiché in tal modo non si corre il rischio di
monitorare i nuovi file attraverso gli effetti che sono gia stati applicati ai file stessi.
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Renderizza

Avvia
Awvia il processo di renderizzazione.

LINK CORRELATI
File compagno a pag. 39

Gestione dei file nell’Editor audio

Questa sezione descrive le operazioni di modifica principali eseguibili all'interno dell'Editor
audio.

Gestione dei formati mono/stereo

WaveLab Elements & molto flessibile nella gestione del formato stereo. E possibile eseguire tutte
le operazioni di modifica in uno solo o in entrambi i canali.

File audio multicanale

Un file audio multicanale & costituito da un insieme di canali audio. Questi canali sono organizzati
in cluster di canali. Un cluster di canali rappresenta un gruppo logico di canali. Si tratta sempre di
un canale singolo o di una coppia di canali.

ESEMPIO

e Icanali anteriore sinistro/destro rappresentano un cluster di canali stereo
e I canali posteriore sinistro/destro rappresentano un cluster di canali stereo
e Il canale centrale rappresenta un cluster di canali mono

e Il canale LFE rappresenta un cluster di canali mono

I file audio multicanale e i relativi cluster di canali possono essere modificati in maniera analoga
ai file audio stereo e mono in WavelLab Elements.

Formati file multicanale supportati

Wavelab Elements supporta i file Wave multicanale con una disposizione dei canali fino a 5.1.

Disposizioni multicanale disponibili

Sono disponibili le sequenti disposizioni multicanale, da 3 fino a un massimo di 6 canali:
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3 channels

4 channels

LRC+LFE(LRC

6 channels

Editor audio multicanale

I file audio multicanale vengono visualizzati sotto forma di cluster di canali nellEditor audio.
Ciascun cluster di canali dispone di un‘area dei controlli che consente di mettere in mute, in solo
e diripiegare/espandere i cluster di canali.

Area dei controlli dei canali

LINK CORRELATI

Modifica dei file audio multicanale a pag. 127
Formati file supportati a pag. 129

Area dei controlli dei canali a pag. 113
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Modifica dei file audio multicanale

E possibile utilizzare gli strumenti di lavoro di WavelLab Elements per modificare i file audio
multicanale.

E possibile definire delle selezioni su uno o piti canali di un file audio multicanale e copiare e
incollare la selezione.

E possibile modificare uno o piu canali di un file audio multicanale utilizzando degli editor
esterni. Possono essere ad esempio selezionati 4 canali, i quali possono essere modificati in
Spectralayers.

Gli strumenti di processamento offline di WavelLab Elements sono compatibili con i file audio
multicanale.

LINK CORRELATI

Formati file supportati a pag. 129

Selezione dei canali nei file audio a pag. 32

Copia dell'audio mediante la funzione di copia e incolla a pag. 150
Strumenti della Sezione Master a pag. 286

Processamento offline a pag. 173

Processamento dei singoli cluster di canali tramite la Sezione Master

E possibile selezionare i singoli cluster di canali dei file audio multicanale per riprodurli o
renderizzarli attraverso la Sezione Master.

PROCEDIMENTO
1. Perselezionare un cluster di canali, eseguire una delle sequenti operazioni.

e Nella Sezione Master, fare clic su Selettore dei canali e selezionare un singolo cluster
di canali o Tutti i canali.
* MASTERSE

O =, Preseti

. O Al Channels

L-R

Lfe
Ls-Rs

e Nellarea dei controlli dei canali, fare doppio-clic su un cluster di canali. Per selezionare
tutti i cluster di canali, fare nuovamente doppio-clic nell'area dei controlli dei canali.
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Il cluster di canali selezionato viene visualizzato nel menu Selettore dei canali della
Sezione Master.

2. Nella Sezione Master, definire le impostazioni desiderate ed eseguire una delle sequenti
operazioni:
e Perriprodurre il cluster di canali attraverso le porte audio anteriore sinistra/destra o la
porta audio mono, avviare la registrazione.
Le porte audio possono essere configurate nella scheda Connessioni audio.

e Perrenderizzare il cluster di canali selezionato, fare clic-destro su Renderizza e
selezionare Renderizzazione sul posto.

LINK CORRELATI

Selezione dei canali nei file audio a pag. 32
Strumenti della Sezione Master a pag. 286
Processamento offline a pag. 173

Scheda Connessioni audio a pag. 18

Applicazione delle funzioni Mute e Solo ai cluster di canali

E possibile mettere in mute e in solo in maniera individuale qualsiasi cluster di canali di un file
audio multicanale.

OPZIONI
e Nellarea dei controlli dei canali, eseguire una delle seguenti operazioni:

e Per mettere in mute un cluster di canali, fare clic su Mute.

e Per mettere in solo un cluster di canali, fare clic su Solo.
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e Per mettere in solo piu cluster di canali, fare Ctrl/Cmd -clic sul pulsante Solo per tutti i
cluster di canali desiderati.

e Per attivare la funzione 'Annulla solo' per un cluster di canali, premere Ctrl/Cmd -
Alt/Opt e fare clic su Solo.

In questa modalita, il cluster di canali non viene silenziato se si mette in solo un altro
cluster. Fare nuovamente clic su Solo per disattivare la funzione 'Annulla solo'.

LINK CORRELATI
File audio multicanale a pag. 125
Area dei controlli dei canali a pag. 113

Ripiegatura ed espansione dei cluster di canali

E possibile ripiegare ed espandere in maniera individuale qualsiasi cluster di canali di un file
audio multicanale.

OPZIONI
e Nellarea dei controlli dei canali, eseguire una delle seguenti operazioni:

e Perripiegare un cluster di canali, fare clic su Ripiega/Esplodi il cluster di canali.

e Per espandere un cluster di canali, fare clic su Ripiega/Esplodi il cluster di canali.

e Perripiegare tuttii cluster di canali tranne uno, fare Ctrl/Cmd -clic su Ripiega/Esplodi il
cluster di canali per il cluster di canali che si desidera mantenere espanso.

e Perripiegare tutti i cluster di canali, fare Shift-clic su Ripiega/Esplodi il cluster di
canali per qualsiasi cluster di canali.

LINK CORRELATI
File audio multicanale a pag. 125
Area dei controlli dei canali a pag. 113

Formati file supportati
Wavelab Elements pud aprire e salvare file audio in molti formati file.

AAC/MPEG-4 (.m4a, mp4)
Advanced Audio Coding (AAC) € un codec che consente una compressione senza
perdita di qualita e uno schema di codifica per l'audio digitale.
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ADPCM - Microsoft/Dialogic (.vox)

Si tratta di un formato utilizzato prevalentemente per videogiochi e applicazioni di
telefonia. Offre un bit rate inferiore rispetto al formato PCM lineare e richiede di
conseguenza meno larghezza di banda/spazio di salvataggio.

AIFF (.aif., .aiff, .snd)

Audio Interchange File Format, uno standard definito da Apple Computers Inc. Sono
supportate le seguenti profondita in bit: 8 bit, 16 bit, 20 bit e 24 bit.

A-LAW (.alaw, .vox)
Si tratta di una tecnica di compressione e codifica audio per la telefonia, con precisione
a 8 bit. Il sistema telefonico dell'lUnione Europea utilizza la codifica A-law per la
digitalizzazione.

Ambisonics (.amb/.ambix)

Wavelab Elements € in grado di aprire e scrivere i file Ambisonics (primo ordine, 4
canali).

Ensoniq Paris (.paf)
Utilizzato dal sistema Ensoniq Paris™. Sono supportate le sequenti profondita in bit: 16
bit e 24 bit.

FLAC (.flac)
FLAC (Free Lossless Audio Codec) & un codec che consente di comprimere in maniera
lossless (senza perdita di qualita) 'audio digitale.

MPEG-1 Layer 2 (.mp2, .mpa, .mpg, .mus)
MP2 (a volte definito «<Musicam») € un formato file comune nell'industria del
broadcasting.

MPEG-1 Layer 3 (.mp3)
Si tratta del formato di compressione audio piu comune. Il vantaggio maggiore della
compressione MPEG & quello della significativa riduzione della dimensione del file, a
scapito tuttavia della qualita del suono.

NOTA

Quando si apre un file compresso MPEG in WaveLab Elements, il file viene convertito
in un file wave temporaneo. Al momento del salvataggio, il file wave temporaneo viene
nuovamente convertito in MP3.

0gg Vorbis (.ogg)
Ogg Vorbis & un formato file compresso aperto, libero da brevetti e che consente di
creare file audio molto piccoli, garantendo una qualita audio relativamente elevata.

Sound Designer II (.sd2)

Questo formato file audio viene utilizzato dalle applicazioni Digidesign (come Pro
Tools). Sono supportate le seguenti profondita in bit: 8 bit, 16 bit e 24 bit.

Sun/Java (.snd, .au)
Si tratta di un formato file audio utilizzato su computer Sun e NeXT. Sono supportate le
seguenti profondita in bit: 8 bit, 16 bit e 24 bit.

Testo/Excel (.txt)
Si tratta di una rappresentazione testuale di una forma d'onda. Salvando un file audio
come file di testo e aprendolo in un'applicazione di foglio elettronico come Excel,
é possibile visualizzarlo in forma testuale, decimale e modificare i valori campione.
Quando si apre un file di testo che rappresenta una forma d’'onda in WavelLab
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Elements, questo viene decodificato e aperto come file audio. Si tratta di file che non
sono in alcun modo compressi, i quali possono quindi presentare dimensioni molto
elevate.

Quando si utilizzano file a 64 bit in virgola mobile, il formato .txt non & completamente
di tipo lossless. Infatti non & possibile esprimere un valore a virgola mobile binario in
forma numerica decimale senza perdita di precisione.

U-LAW (.ulaw, .vox)

Si tratta di una tecnica di compressione e codifica audio supportata da telefoni
Windows e web, che utilizza una precisione a 8 bit. Il sistema telefonico degli Stati Uniti
utilizza la codifica U-law per la digitalizzazione.

Wave (.wav)

Sono supportati i seguenti valori di profondita in bit: 8 bit, 16 bit, 20 bit, 24 bit, 32 bit, 32
bit in virgola mobile e 64 bit in virgola mobile.

Wavelab Elements supporta i file Wave multicanale con una disposizione dei canali fino
a5.1.

WavPack (.wv/.wvc)

Questo formato file consente di comprimere I'audio digitale senza perdita di qualita,
inclusi i file audio a 32 bit in virgola mobile.

Windows Media Audio (.wma, .asf)
Formato compresso di Microsoft. WavelLab Elements consente di importare/esportare
audio in questo formato (solo Windows). Per importare/esportare audio in formato
surround WMA, Windows Media Player 9 o versioni successive deve essere installato
sul sistema.

RF64

Nelle Preferenze dei file audio, nella scheda File, € possibile attivare il supporto per

il formato file RF64. Se il supporto & attivato, il formato file Wave standard passa
automaticamente al formato file RF64 appena la dimensione del file supera i 2 GB,
senza alcuna interruzione o perdita di prestazioni. Si tratta di un‘opzione utile in caso di
registrazione di sessioni molto lunghe. Un file RF64 ha estensione .wav ma puo essere
aperto solo con un'applicazione che supporta lo standard RF64 se il file supera i 2 GB.

Original Sound Quality (.0sq, solo lettura)

Si tratta del formato audio compresso lossless (senza perdita di qualita) proprietario di
Wavelab.

LINK CORRELATI

Finestra di dialogo Codifica Windows Media Audio a pag. 142
Finestra di dialogo Ogg Vorbis a pag. 141

Finestra di dialogo Codifica FLAC a pag. 140

Finestra di dialogo codifica MP3 a pag. 137

Finestra di dialogo Codifica MPEG-1 Layer 2 a pag. 139

La finestra di dialogo Codifica AAC a pag. 138

File a 20 bit, 24 bit e 32 bit in virgola mobile a pag. 131

File a 20 bit, 24 bit e 32 bit in virgola mobile

Non & necessaria una scheda audio a 20 bit 0 a 24 bit per beneficiare della capacita di WavelLab
Elements di gestire file audio a 20 bit e 24 bit. Qualsiasi operazione di processamento o modifica
ai file viene eseguita sempre a piena precisione (a 64 bit in virgola mobile), anche se la piena
precisione non e supportata dalla scheda utilizzata.
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Per la riproduzione, WavelLab Elements si adatta automaticamente alla scheda installata.

Creazione di nuovi file audio

E possibile creare un file audio vuoto, ad esempio per assemblare materiale proveniente da altri
file audio.

PROCEDIMENTO
1. Selezionare File > Nuovo.
2. Selezionare File audio > Personalizzato.

3. Specificare le proprieta audio desiderate e fare clic su Crea.

Properties

el Configuration Stereo
e 44100 Hz

h 32 bit float

LINK CORRELATI
Finestra di dialogo Proprieta audio a pag. 132

Finestra di dialogo Proprieta audio

E possibile definire la configurazione dei canali, la frequenza di campionamento e la profondita in
bit di un file audio.

Queste proprieta possono essere impostate in fase di creazione di un nuovo file audio.

e Per modificare le proprieta del file audio selezionato, selezionare la scheda File e fare clic
su Info o sul pulsante Proprieta audio nella parte inferiore-destra della finestra della forma
d’'onda.

v Audio Properties X

Configurazione dei canali
Consente di selezionare il numero di canali audio.

Frequenza di campionamento
Consente di selezionare il numero di campioni audio per secondo.

Profondita in bit
Consente di selezionare I'accuratezza dei campioni nel flusso audio.

LINK CORRELATI
Scheda Info a pag. 46
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Salvataggio di un file audio

PROCEDIMENTO
1. Esequire una delle seguenti operazioni:
e Persalvare un file audio che non & mai stato salvato, selezionare File > Salva con nome.

e Per salvare un file audio gia salvato in precedenza, fare clic sul pulsante Salva o
selezionare File > Salva.

2. Nella finestra Salva con nome, specificare un nome file e una posizione.

3. Fare clic su Salva.

RISULTATO
Le funzioni annulla/ripeti possono essere utilizzate anche dopo il salvataggio.

Salvataggio in un altro formato

E possibile modificare il formato del file, la frequenza di campionamento, la profondita in bit e lo
stato stereo/mono durante il salvataggio.

PROCEDIMENTO

1. Selezionare File > Salva con nome.

2. Nella finestra Salva con nome, specificare un nome file e una posizione.
3. Fare clic sul campo Formato e selezionare Modifica.
4

Nella finestra di dialogo Formato file audio, impostare il formato del file e specificare le
proprieta.

b

Fare clic su OK.

6. Fare clic su Salva.

RISULTATO
Viene creato un nuovo file. L'operazione non influisce sul file originale.

LINK CORRELATI
Finestra di dialogo Formato file audio a pag. 133
Cambi di formato a pag. 135

Finestra di dialogo Formato file audio

In questa finestra di dialogo e possibile modificare le varie impostazioni dei file durante il
salvataggio.

e Per aprire la finestra di dialogo Formato file audio, selezionare File > Esporta e selezionare
Renderizza. Attivare quindi 'opzione File con nome, fare clic sul campo Formato e
selezionare Modifica.

E possibile aprire questa finestra di dialogo da altre posizioni in WaveLab Elements.
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v Audio File Format X

Wave (Micros

Aud at uncomp

Match Input Stream

Match Input Stream

Mat: rce File (currenth

Meta-Data = Inherit fr

efault

Tipo
Consente di selezionare un tipo di file audio. Questo parametro influisce sulle opzioni
disponibili nel menu a tendina Formato audio.

Estensione file
Consente di selezionare un’estensione file compatibile con il tipo di file corrente.

Formato audio

Consente di selezionare un formato audio compatibile con il tipo di file corrente.
Canali

Consente di specificare il numero di canali audio per i file da creare.

Sono disponibili i sequenti canali:

e Come flusso d'ingresso

e Mono

e Stereo

Frequenza di campionamento

Consente di selezionare una frequenza di campionamento per il file audio. Se si
modifica questa impostazione, viene avviata una conversione della frequenza di
campionamento.

IMPORTANTE

Utilizzare solo per le conversioni semplici. Per ottenere risultati professionali, utilizzare
il plug-in Resample e aggiungere un limiter e il dithering.

Profondita in bit
Consente di selezionare una profondita in bit per il file audio. Questa opzione &
disponibile solo per alcuni tipi di file specifici.
IMPORTANTE

La riduzione della profondita in bit & consigliata solo per conversioni semplici. Per
ottenere risultati professionali, si consiglia di aggiungere il dithering nella Sezione
Master.

Metadati

Consente di configurare i metadati salvati nel file. Questa opzione & disponibile solo
per alcuni tipi di file.
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Meta-Data = Inherit from Source File

Metadata

Wav default

Specific t nfiguration k

e Se éselezionata l'opzione Non salvare nulla, i metadati non verranno salvati nel
file.

e Se e selezionata l'opzione Eredita dal file sorgente, vengono utilizzati i metadati
del file sorgente. Se i metadati sorgente sono vuoti, vengono usati i metadati
predefiniti, se disponibili.

e Se é selezionata l'opzione Specifico per questa configurazione, € possibile
modificare i metadati o sostituirli con un preset dei metadati. Per modificare
i metadati, aprire nuovamente il menu a tendina dei metadati e selezionare
Modifica.

LINK CORRELATI
Salvataggio in un altro formato a pag. 133

Cambi di formato

Durante la modifica di frequenza di campionamento, profondita in bit e numero di canali di un
file audio, vengono eseguite diverse operazioni.
Frequenza di campionamento
Se viene specificata una nuova frequenza di campionamento, viene eseguita una
conversione della frequenza di campionamento.
Profondita in bit
Se viene specificata una diversa profondita in bit, il file € troncato a 8 bit o riempito
fino a 64 bit. Se si sta eseguendo la conversione a una profondita in bit inferiore, &
consigliato aggiungere effetti di dithering.
Mono/Stereo

Se il file viene convertito da mono a stereo, viene utilizzato lo stesso materiale in
entrambi i canali. Se la conversione avviene da stereo a mono, viene creato un mix dei
due canali.

NOTA

e Sesidesidera solo modificare la profondita in bit, & possibile farlo direttamente nella sezione
Proprieta audio della finestra di dialogo Info, quindi salvare il file audio.

e Per un mastering di alta qualita, & sconsigliato modificare la frequenza di campionamento e
il numero di canali dalla sezione Proprieta audio; utilizzare invece i plug-in e le funzioni della
Sezione Master.

Renderizzazione di una selezione sotto forma di file audio

E possibile renderizzare una selezione nel file audio aperto sotto forma di un nuovo file audio.

PROCEDIMENTO
1. Nella finestra della forma d’'onda definire un intervallo di selezione.

2. Nell'Editor audio, selezionare la scheda Renderizza.
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3. Nella sezione Sorgente, aprire il menu a tendina e selezionare Intervallo audio
selezionato.

4. Nella sezione Uscita, fare clic su Renderizza.

5. Nella sezione Sorgente, aprire il menu a tendina e selezionare Intervallo audio
selezionato.

6. Nella sezione Uscita, specificare un nome file e una posizione.

7. Aprireil menu a tendina Formato e selezionare Modifica formato singolo.

8. Nella finestra di dialogo Formato file audio, specificare il formato di uscita e fare clic su OK.

9. Nella sezione Renderizza, fare clic su Avvia.

LINK CORRELATI

Finestra della forma d'onda a pag. 111
Scheda Modifica (Editor audio) a pag. 118
Finestra di dialogo Formato file audio a pag. 133

Renderizzazione del canale sinistro/destro sotto forma di file audio

E possibile salvare individualmente ciascun canale in un file separato.

PROCEDIMENTO

1. Nell'Editor audio, selezionare la scheda Renderizza.

2. Nella sezione Uscita, specificare un nome file e una posizione.

3. Aprire il menu a tendina Formato e selezionare Modifica.

4. Nella finestra di dialogo Formato file audio, aprire il menu Canali e selezionare Canale
sinistro o Canale destro.

5. Configurare le impostazioni di uscita aggiuntive e fare clic su OK.

6. Nella sezione Renderizza, fare clic su Avvia.

LINK CORRELATI

Scheda Renderizza (Editor audio) a pag. 123
Finestra di dialogo Formato file audio a pag. 133

Creazione di preset dei formati file audio

PROCEDIMENTO

1.
2.
3.

Nella finestra di dialogo Formato file audio, specificare il formato file audio.
Aprire il menu a tendina Preset e selezionare Salva con nome.

Inserire un nome per il preset e fare clic su Salva.

LINK CORRELATI
Finestra di dialogo Formato file audio a pag. 133
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Codifica di file audio

L'audio puo essere salvato in diversi formati. Il processo di conversione dell'audio in un altro
formato ¢ definito codifica. Durante il salvataggio di file audio, € possibile specificare varie
opzioni di codifica per alcuni formati di file.

LINK CORRELATI

Finestra di dialogo codifica MP3 a pag. 137

La finestra di dialogo Codifica AAC a pag. 138

Finestra di dialogo Codifica MPEG-1 Layer 2 a pag. 139
Finestra di dialogo Codifica FLAC a pag. 140

Finestra di dialogo Ogg Vorbis a pag. 141

Finestra di dialogo Codifica Windows Media Audio a pag. 142

Finestra di dialogo codifica MP3
E possibile modificare le opzioni di codifica durante il salvataggio di un file audio MP3.

La finestra di dialogo Codifica MP3 pu0 essere aperta da molte delle posizioni che consentono
di selezionare un formato file di output. Ad esempio, aprire un file audio, selezionare File >
Salva con nome, fare clic nel campo Formato e selezionare Modifica. Nella finestra di dialogo
Formato file audio, selezionare il tipo MPEG-1 Layer 3 (MP3), fare clic nel campo Codifica e
selezionare Modifica.

B MP3 Encoding *

' OK X Cancel

Scheda Metodo

Encoder
Consente di selezionare I'encoder utilizzato (Fraunhofer o Lame).

Bit rate costante/Bit rate variabile

Il bit rate si riferisce alla quantita di dati utilizzati per codificare il segnale audio. Pit
alto e il valore, migliore sara la qualita, ma maggiore sara la dimensione del file di
output. Se si sceglie Bit rate variabile, il rate viene modificato in base alla complessita
del materiale audio.

Qualita ottima (piu lenta)/Piu veloce
Selezionare la qualita che si desidera ottenere. Piu alta € la qualita, maggiori sono le
risorse e il tempo necessari per analizzare e comprimere il segnale audio.
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NOTA

L'opzione Qualita ottima (piu lenta) puo richiedere una frequenza di campionamento
specifica per il file audio. In questo caso e se la frequenza di campionamento e diversa
da quella di ingresso, viene visualizzato un messaggio.

Scheda Avanzato
Aggiungi le informazioni relative alla durata e alla posizione di riproduzione
all'intestazione VBR

Aggiunge delle informazioni supplementari all'intestazione VBR che consentono al
dispositivo di riproduzione di stimare la durata del file MP3 e di saltare a qualsiasi
posizione temporale all'interno del file MP3 stesso. Questa opzione ¢ disponibile
solamente per I'encoder di tipo Fraunhofer.

Incorpora dei dati ausiliari per la compensazione della durata e del ritardo

Consente di incorporare dei dati ausiliari in modo che il file decodificato corrispondera
esattamente alla durata del file originale. Questa opzione ¢ disponibile solamente per
I'encoder di tipo Fraunhofer.

Le opzioni che sequono sono disponibili solamente per I'encoder Lame:

Consenti la codifica stereo dell'intensita
Consente di ridurre il bit rate, riorganizzando le informazioni di intensita tra i canali.

Specifica come Registrazione Originale
Consente di contrassegnare il file codificato come registrazione originale.

Scrivi bit privato
Si tratta di un indicatore personalizzato.
Scrivi I'indicatore di Copyright
Consente di contrassegnare il file codificato come protetto da copyright.

Scrivi Checksum
Consente alle altre applicazioni di verificare l'integrita del file.

Crea frame lunghi

Consente di risparmiare spazio scrivendo un numero inferiore di intestazioni nel file
(non compatibile con tutti i decoder).

LINK CORRELATI
Codifica di file audio a pag. 137

La finestra di dialogo Codifica AAC
E possibile modificare le opzioni di codifica durante il salvataggio di un file audio AAC.

La finestra di dialogo Codifica AAC pud essere aperta da molte delle posizioni che consentono
di selezionare un formato file di output. Ad esempio, aprire un file audio, selezionare File >
Salva con nome, fare clic nel campo Formato e selezionare Modifica. Nella finestra di dialogo
Formato file audio, selezionare il tipo AAC (Advanced Audio Coding), fare clic sul campo
Codifica e selezionare Modifica.
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I AAC Encoding X

Audio Compressi

LC (iTunes Standard)

" 0K X Cancel

Metodo di compressione audio

Consente di selezionare il metodo di compressione audio. Sono disponibili le sequenti
opzioni:

e LC (iTunes Standard) (Low Complexity AAC/AAC-LC) € un codec audio che fornisce
una qualita audio elevata anche a valori di bit rate ridotti.

e HE (High Efficiency) € un‘estensione dell'opzione Low Complexity AAC ed &
ottimizzata per applicazioni a bit-rate ridotte, ad esempio lo streaming audio.

e HE v2 (High Efficiency, Stereo Parametrico) aumenta l'efficienza della
compressione dei segnali stereo. I formati HE generano dei file audio
estremamente compressi con un suono ad elevata qualita.

Bit rate

Il bit rate (o velocita in bit) si riferisce alla quantita di dati utilizzati per codificare
il segnale audio. Piu alto € il valore, migliore sara la qualita, ma maggiore sara la
dimensione del file in uscita.

E possibile selezionare un bit rate costante nel menu a tendina Costante (CBR) o un
bit rate variabile nel menu a tendina Variabile (VBR). Se si sceglie 'opzione Variabile
(VBR), il valore viene modificato nel tempo in base alla complessita del materiale audio.

LINK CORRELATI
Codifica di file audio a pag. 137

Finestra di dialogo Codifica MPEG-1 Layer 2

E possibile modificare le opzioni di codifica durante il salvataggio di un file audio MPEG-1 Layer 2
(MP2).

La finestra di dialogo Codifica MPEG-1 Layer 2 pud essere aperta da molte delle posizioni che
consentono di selezionare un formato file di output. Ad esempio, aprire un file audio, selezionare
File > Salva con nome, fare clic nel campo Formato e selezionare Modifica. Nella finestra di
dialogo Formato file audio, selezionare il tipo MPEG-1 Layer 2, fare clic nel campo Codifica e
selezionare Modifica.
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I MPEG-1 Layer 2 Encoding X

X Cancel

Bit rate
Determina il bit rate. Il bit rate si riferisce alla quantita di dati utilizzati per codificare
il segnale audio. Piu alto € il valore, migliore sara la qualita, ma maggiore sara la
dimensione del file in uscita.

Codifica stereo

In modalita Standard, 'encoder non utilizza la correlazione tra canali. Tuttavia,
I'encoder potrebbe prendere spazio da un canale facile da codificare e usarlo per un
canale piu complicato.

In modalita Joint, I'encoder pud utilizzare la correlazione esistente tra i due canali per
aumentare il rapporto qualita/spazio.

In modalita Dual, entrambi i canali sono codificati in modo indipendente. Tale modalita
e consigliata per segnali con canali indipendenti.
Specifica come Registrazione Originale
Consente di contrassegnare il file codificato come registrazione originale.
Scrivi bit privato
Si tratta di un indicatore personalizzato.
Scrivi lI'indicatore di Copyright
Consente di contrassegnare il file codificato come protetto da copyright.

Scrivi Checksum
Consente alle altre applicazioni di verificare l'integrita del file.

Codifica dei picchi (dati ausiliari)

E necessario attivare questa opzione per garantire la compatibilita con sistemi specifici,
come ad esempio DIGAS.

LINK CORRELATI
Codifica di file audio a pag. 137

Finestra di dialogo Codifica FLAC

E possibile modificare le opzioni di codifica durante il salvataggio di un file audio FLAC.

La finestra di dialogo Codifica FLAC pud essere aperta da molte delle posizioni che consentono
di selezionare un formato file di output. Ad esempio, aprire un file audio, selezionare File >
Salva con nome, fare clic nel campo Formato e selezionare Modifica. Nella finestra di dialogo
Formato file audio, selezionare il tipo FLAC, fare clic sul campo Codifica e selezionare Modifica.
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I FLAC Encoding b4

Compression Level

Livello della compressione

Consente di specificare il livello della compressione. Maggiore & la compressione, piu
lenta risulta la codifica.

LINK CORRELATI
Codifica di file audio a pag. 137

Finestra di dialogo Ogg Vorbis
E possibile modificare le opzioni di codifica durante il salvataggio di un file audio Ogg Vorbis.

La finestra di dialogo Ogg Vorbis puo essere aperta da molte delle posizioni che consentono
di selezionare un formato file di output. Ad esempio, aprire un file audio, selezionare File >
Salva con nome, fare clic nel campo Formato e selezionare Modifica. Nella finestra di dialogo
Formato file audio, selezionare il tipo Ogg Vorbis, fare clic sul campo Codifica e selezionare
Modifica.

I Ogg Vorbis >

Bit rate medio

Se questa opzione e attivata, il bit rate medio del file resta costante durante la codifica.
Poiché la dimensione del file & proporzionale al tempo, cio facilita I'individuazione di
un determinato punto, ma puo determinare una minore qualita rispetto all'opzione Bit
rate variabile.

Bit rate variabile

Se questa opzione € attivata, il bit rate nel file variera nel corso della codifica, a
seconda della complessita del materiale. Cid pud generare un migliore rapporto
qualita/dimensione nel file risultante.

Nel campo Qualita selezionare la qualita. I valori di qualita piu bassi generano file pit
piccoli.

LINK CORRELATI
Codifica di file audio a pag. 137
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Finestra di dialogo Codifica Windows Media Audio

E possibile modificare le opzioni di codifica durante il salvataggio di un file audio Windows Media
Audio (WMA). Questa finestra di dialogo & disponibile solo su sistemi Windows.

La finestra di dialogo Windows Media Audio puo essere aperta da molte delle posizioni che
consentono di selezionare un formato file di output. Ad esempio, aprire un file audio, selezionare
File > Salva con nome, fare clic nel campo Formato e selezionare Modifica. Nella finestra

di dialogo Formato file audio, selezionare il tipo Windows Media Audio (WMA), fare clic sul
campo Codifica e selezionare Modifica.

B Windows Media Audio Encoding *

X Cancel

Encoder
Imposta gli encoder.

Frequenza di campionamento in uscita

Consente di definire la frequenza di campionamento in uscita del file codificato. Piu
alta é la frequenza di campionamento, migliore & la qualita, ma maggiore sara la
dimensione del file di output.

Profondita in bit in uscita

Consente di definire la profondita in bit in uscita del file codificato. Questo parametro
non e disponibile per tutti gli encoder.

Canali e bit rate

Gli elementi qui disponibili dipendono dal metodo di codifica selezionato e dalla
frequenza di campionamento in uscita.

VBR (Bit Rate Variabile)

Se questa opzione € attivata, il bit rate del file variera nel corso della codifica, a
seconda della complessita del materiale. Cid pud generare un migliore rapporto
qualita/dimensione nel file di output.

Nel campo Qualita selezionare la qualita. I valori di qualita piu bassi generano file pit
piccoli.

Codifica a due passaggi
Se questa opzione e attivata, viene aumentata la qualita di codifica, ma il processo
risulta due volte piu lento.

Bit rate forzato

Questa opzione ¢ disponibile quando sono attivate le opzioni VBR e Codifica a due
passaggi. Viene utilizzata per mantenere i bit rate entro i limiti in modo tale da evitare
picchi. Si tratta dell'impostazione consigliata per alcuni supporti, come CD o DVD.
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LINK CORRELATI
Codifica di file audio a pag. 137

Inserimento di file audio in un altro file audio

E possibile assemblare un file audio a partire da diversi file audio.

PROCEDIMENTO
1. Nell'Editor audio, aprire il file audio in cui si desidera inserire un altro file audio.

2. Sesiintende inserire un file audio alla posizione del cursore di modifica, assicurarsi che
'opzione Scatta verso le calamite sia attivata e che 'opzione Cursore sia attivata nel menu
a tendina Calamite.

Il cursore di modifica scatta al punto di zero piu vicino. E cosi possibile evitare le
discontinuita.

3. Selezionare la scheda Inserisci.

4. Nella sezione File audio, selezionare una delle seguenti opzioni di inserimento:
e All'inizio
e Allafine
e Al cursore

Se si seleziona Al cursore, il file audio viene separato in corrispondenza della posizione di
inserimento. La parte dopo la separazione viene spostata a destra.

5. Nel menu a tendina, selezionare il file audio che si desidera inserire.

LINK CORRELATI
Agganci magnetici nei file audio a pag. 114

Trasformazione delle selezioni in nuovi file

E possibile trasformare le selezioni in nuovi file mediante trascinamento, tramite il menu
contestuale nella finestra della forma d'onda, oppure utilizzando la scheda Renderizza
nell'Editor audio.

LINK CORRELATI

Scheda Renderizza (Editor audio) a pag. 123

Trasformazione delle selezioni in nuovi file mediante trascinamento a pag. 143
Trasformazione delle selezioni in nuovi file mediante I'utilizzo del menu a pag. 144

Trasformazione delle selezioni in nuovi file mediante trascinamento

PROCEDIMENTO
1. Definire una selezione nella finestra della forma d’onda.

2. Trascinare la selezione nella barra della scheda sopra la finestra della forma d'onda e
rilasciare il pulsante del mouse.

RISULTATO
La selezione si apre in una nuova finestra stereo.
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LINK CORRELATI
Finestra della forma d'onda a pag. 111

Trasformazione delle selezioni in nuovi file mediante l'utilizzo del menu

PROCEDIMENTO
1. Definire una selezione nella finestra della forma d'onda.
2. Fare clic-destro sulla selezione e scegliere Copia selezione in una nuova finestra.
3. Dal sotto menu, selezionare una delle seguenti opzioni:
e Duplica
e Versione stereo
e Mixdown in mono

e Mixdown in mono (sottrai il canale destro dal canale sinistro)

RISULTATO
La selezione si apre in una nuova finestra stereo o mono.

LINK CORRELATI
Finestra della forma d'onda a pag. 111

Finestra di dialogo Formato file speciale

Quando vengono aperti dei file per mezzo dell'opzione Audio sconosciuto, & possibile
specificare la modalita di interpretazione del formato file audio che si desidera aprire.

e Per aprire la finestra di dialogo Formato file speciale, selezionare File > Importa, fare clic
su Audio sconosciuto e selezionare il file che si intende aprire.

I Special File Format >
Parameters to Identify the File Contents

Sample Format Channels

© Mono

) 0

File End 0

44100 Hz

Byte Order

© Little En
Big Endian (M

Formato dei campioni
Consente di specificare la rappresentazione binaria dei campioni nel file.
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Ordine dei byte

Consente di specificare I'ordine in cui i byte devono essere interpretati. Si applica solo a
16 bit o superiore.

Canali
Consente di specificare il numero di canali audio nel file audio.

Dati da ignorare (numero di byte)

Consente di specificare il numero di byte all'inizio e alla fine del file audio che vengono
ignorati.

Frequenza di campionamento
Consente di specificare la frequenza di campionamento del file audio.

Estensione file
Consente di specificare I'estensione del nome file predefinito per il file audio. Quando si
apre il selettore dei file dopo la chiusura di questa finestra di dialogo, viene visualizzato
solo il file con tale estensione.

Conversione da stereo a mono e da mono a stereo

E possibile convertire i file audio da mono a stereo e da stereo a mono. La conversione da un file
mono a un file stereo produce un file audio contenente lo stesso materiale in entrambi i canali,
ad esempio per l'ulteriore processamento in stereo reale. La conversione da un file stereo a un
file mono mixa i canali stereo in un canale mono.

LINK CORRELATI

Conversione di una selezione da stereo a mono a pag. 145
Conversione da stereo a mono durante il salvataggio a pag. 146
Conversione di una selezione da mono a stereo a pag. 146

Conversione di una selezione da stereo a mono

PROCEDIMENTO

1. Definire una selezione stereo nella finestra della forma d'onda.
2. Selezionare File > Nuovo.

3. Selezionare File audio > Dal file corrente.

4. Selezionare una delle seguenti opzioni:

e Per mixare i canali stereo sinistro e destro quando si esegue la conversione in mono,
fare clic su Mixdown in mono.

e Per mixare il canale sinistro con l'inverso del canale destro quando si esegue la
conversione in mono, fare clic su Mixdown in mono (sottrai il canale destro dal
canale sinistro).

L'onda mono risultante contiene la differenza tra i canali. Ad esempio, in questo modo
e possibile verificare che un file wave sia realmente un file stereo e non un file mono
convertito in formato stereo.

RISULTATO
La selezione si apre in una nuova finestra mono.

LINK CORRELATI
Finestra della forma d'onda a pag. 111
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Conversione da stereo a mono durante il salvataggio

PROCEDIMENTO

1. Definire una selezione stereo nella finestra della forma d'onda.

2. Selezionare File > Salva con nome.

3. Nella finestra Salva con nome, specificare un nome file e una posizione.

4. Fare clic sul campo Formato e selezionare Modifica.

5. Nella finestra di dialogo Formato file audio che si apre, aprire il menu a tendina Canali e
selezionare una delle opzioni mono.
Ad esempio, selezionando Mono (Mix -3 dB), il file audio risultante viene attenuato di 3 dB.

6. Fareclic su OK.

7. Fareclic su Salva.

LINK CORRELATI

Finestra della forma d'onda a pag. 111
Finestra di dialogo Formato file audio a pag. 133

Conversione di una selezione da mono a stereo

PROCEDIMENTO

1. Definire una selezione mono nella finestra della forma d'onda.
2. Selezionare File > Nuovo.

3. Selezionare File audio > Dal file corrente.

4. Fareclic su Versione stereo.

5. Fareclicsu Crea.

RISULTATO

La selezione si apre in una nuova finestra stereo.

LINK CORRELATI
Finestra della forma d'onda a pag. 111

Inversione di canali in un file stereo

E possibile invertire i due canali in un file audio, cioé spostare 'audio del canale sinistro nel
canale destro e 'audio del canale destro nel canale sinistro.

Per invertire i canali dell'intero file audio nellEditor audio, selezionare la scheda Modifica e,
nella sezione Taglio, fare clic su Inverti i canali stereo.

Per invertire i canali solamente per un intervallo del file audio selezionato, definire un
intervallo di selezione nella finestra della forma d’onda, selezionare la scheda Modifica e,
nella sezione Altro, fare clic su Inverti i canali stereo.

Opzioni speciali di incollaggio

Nel menu a tendina Incolla dell'Editor audio sono disponibili delle funzioni di incollaggio
aggiuntive.
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e Per accedere a queste speciali opzioni di incollaggio, aprire I'Editor audio, selezionare la
scheda Modifica e, nella sezione Appunti, fare clic-destro su Incolla.

Sovrascrivi

Consente di sovrascrivere i dati nel file di destinazione invece di spostarli per liberare
spazio per l'audio inserito. La quantita sovrascritta varia a seconda della selezione nel
file di destinazione:

e Senon é presente alcuna selezione nel file di destinazione, viene sovrascritta una
sezione con la stessa lunghezza della selezione da incollare.

e Se é presente una selezione nel file di destinazione, la selezione da incollare
sostituisce tale selezione.

Aggiungi in fondo
Consente di aggiungere l'audio da incollare dopo la fine del file.

Aggiungi all’inizio
Consente di aggiungere l'audio da incollare prima dell'inizio del file.

Copie multiple
Consente di visualizzare una finestra di dialogo nella quale inserire il numero di copie
che si desidera creare.

Mixa
Consente di aprire la finestra di dialogo Mixaggio. In questa finestra di dialogo &
possibile fondere due file in uno a partire dalla selezione o, se non presente, dalla

posizione del cursore. E possibile specificare il guadagno per I'audio negli appunti e in
corrispondenza della destinazione.

Tutti i dati negli appunti sono sempre mixati, indipendentemente dalla lunghezza della
selezione.

Spostamento dell’'audio

E possibile riorganizzare l'ordine dell'audio in un file mediante le funzioni di trascinamento, taglio
e incollaggio.

Spostamento dell'audio mediante trascinamento

PROCEDIMENTO
1. Definire una selezione nella finestra della forma d’'onda.

2. Trascinare la selezione in una posizione esterna alla selezione nello stesso file, o in unaltra
finestra della forma d'onda.

RISULTATO
La selezione viene rimossa dalla sua posizione originale e inserita nel punto in cui viene rilasciata.

NOTA

Per annullare uno spostamento tra due file, & necessario prima annullare la funzione di
incollaggio nella finestra di destinazione, quindi annullare 'operazione di taglio nella finestra
di origine.

LINK CORRELATI
Finestra della forma d'onda a pag. 111
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Spostamento dell'audio mediante taglia e incolla

PROCEDIMENTO

1. Definire una selezione nella finestra della forma d'onda.

2. Pertagliare l'audio, eseguire una delle seqguenti operazioni:
e Nell'Editor audio, selezionare la scheda Modifica e fare clic su Taglia.
e Premere Ctrl/Cmd-X.

3. Selezionare la modalita desiderata di inserimento della selezione:

e Sesidesidera inserire I'audio, fare clic una volta sulla posizione nello stesso file 0 in un
altro.

e Per sostituire una sezione di audio, selezionarla.
4. Perincollare la selezione, eseguire una delle seqguenti operazioni:
e NellEditor audio, selezionare la scheda Modifica e fare clic su Incolla.

e Premere Ctrl/Cmd-V.

RISULTATO
La selezione viene rimossa dalla sua posizione originale e inserita nel punto in cui viene rilasciata.

NOTA

Per annullare uno spostamento tra due file, € necessario prima annullare la funzione di
incollaggio nella finestra di destinazione, quindi annullare 'operazione di taglio nella finestra
di origine.

LINK CORRELATI
Finestra della forma d'onda a pag. 111
Scheda Modifica (Editor audio) a pag. 118

Spostamento dell'audio per mezzo dei comandi di spinta

E possibile utilizzare gli strumenti di spinta verso sinistra/destra per spostare l'audio in piccoli
passaggi all'interno di un file.

PROCEDIMENTO
1. Definire una selezione nella finestra della forma d'onda.
2. Nell'Editor audio, selezionare la scheda Modifica.

3. Nella sezione Spinta, fare clic su Spingi verso sinistra o Spingi verso destra.

RISULTATO

L'audio viene spostato di un pixel. L'esatto formato dell'operazione dipende dalla grandezza
dellingrandimento. Ad esempio, se nella barra di stato viene visualizzato x1:256, la selezione
viene spostata di 256 campioni. L'audio in tale posizione viene sovrascritto dalla sezione spostata.

LINK CORRELATI

Finestra della forma d'onda a pag. 111
Scheda Modifica (Editor audio) a pag. 118
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Copia dell’audio

E possibile copiare sezioni dell'audio all'interno dello stesso file o tra vari file audio.

Gestione del materiale stereo/mono

Quando si trascinano o si copiano dei file stereo o mono in altre posizioni, la posizione di
destinazione determina il modo in cui vengono inseriti i file.

Il materiale stereo/mono & gestito nel modo sequente quando si esegue il trascinamento tra file:

Sezione trascinata

Stereo

Stereo

Mono

Forma d'onda Azione

rilasciata

Stereo

Mono

Stereo

L'audio trascinato € sempre inserito in entrambi i canali.
Viene inserito solo il canale sinistro.

Il risultato dipende solo dalla posizione di rilascio
verticale. L'azione & indicata dalla forma del cursore. E
possibile inserire la selezione in uno solo dei canali o lo
stesso materiale pud essere inserito in entrambi i canali.

Il materiale stereo/mono & gestito nel modo seguente quando si esegue I'operazione di copia e

incolla dei file:

Sezione copiata

Stereo

Mono

Stereo

Mono

Forma
d'onda
incollata

Stereo

Mono

Mono

Stereo

Azione

Se il cursore della forma d’'onda si estende in entrambi i
canali del file di destinazione, il materiale viene inserito in
entrambi i canali.

Se il cursore della forma d’onda si trova solo in

un canale, 'audio viene incollato unicamente in quel
canale. Il materiale audio proveniente dal canale sinistro
viene incollato nel canale sinistro, mentre il materiale
proveniente dal canale destro viene incollato nel canale
destro.

Viene incollato solo il canale sinistro.

Il risultato varia in base alla presenza del cursore della
forma d'onda in un canale o in entrambi. E possibile
incollare l'audio in uno solo dei canali o lo stesso
materiale puo essere inserito in entrambi i canali.
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Conflitti relativi alla frequenza di campionamento

Se si copia o sposta I'audio da una finestra a un‘altra e le frequenze di campionamento dei
due file non corrispondono, il suono copiato/spostato viene riprodotto a un‘altezza non corretta
(velocita). Il programma segnala che tale problema sta per verificarsi.

Il mixaggio delle frequenze di campionamento puo essere utilizzato come effetto, ma molto
spesso non ¢ il risultato che si desidera ottenere. Vi sono due modi per aggirare il problema:

e Convertire la frequenza di campionamento del file sorgente alla stessa frequenza del file di
destinazione prima dell'editing.

e Convertire la frequenza di campionamento del file di destinazione alla stessa frequenza del
file sorgente prima dell'aggiunta dell'audio.

Copia dell'audio mediante la funzione di copia e incolla

PROCEDIMENTO

1. Definire una selezione nella finestra della forma d'onda.

2. Utilizzare uno dei seguenti metodi di copia:
e Nell'Editor audio, selezionare la scheda Modifica e fare clic su Copia.
e Premere Ctrl/Cmd-C.

3. Selezionare la modalita desiderata di inserimento della selezione:

e Sesidesidera inserire I'audio, fare clic una volta sulla posizione nello stesso file 0 in un
altro.

e Per sostituire una sezione di audio, selezionarla.

4. Perincollare la selezione, eseguire una delle seqguenti operazioni:
e NellEditor audio, selezionare la scheda Modifica e fare clic su Incolla.
e Premere Ctrl/Cmd-V.

LINK CORRELATI
Finestra della forma d'onda a pag. 111
Scheda Modifica (Editor audio) a pag. 118

Copia dell’audio mediante trascinamento

PROCEDIMENTO
1. Definire una selezione nella finestra della forma d’'onda.

2. Fareclic al centro della selezione e trascinarla in una posizione esterna alla selezione
all'interno dello stesso file, o in un‘altra finestra della forma d'onda.

RISULTATO

La selezione viene inserita nel punto indicato. L'audio che originariamente iniziava in questo
punto viene spostato a destra.

LINK CORRELATI
Finestra della forma d'onda a pag. 111
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Mix down - Renderizzazione dei file audio

E possibile eseguire la renderizzazione di regioni di file audio o di interi file audio verso un
singolo file audio.

LINK CORRELATI
Renderizzazione nella Sezione Master a pag. 297
Renderizzazione dei file audio a pag. 151

Renderizzazione dei file audio

E possibile renderizzare i file audio verso un singolo formato file audio o in piu formati
contemporaneamente.

PREREQUISITI
Configurare il proprio file audio.

PROCEDIMENTO

1. Nell'Editor audio, selezionare la scheda Renderizza.

2. Nella sezione Sorgente, specificare quale parte del file audio si desidera renderizzare.
3. Nella sezione Risultato, attivare I'opzione File con nome.

4. Nella sezione Uscita, fare clic sul campo Formato e fare clic su Modifica.

5. Definire le impostazioni desiderate nella finestra di dialogo Formato file audio.

6. Fareclic su OK.

7. Facoltativo: definire delle impostazioni aggiuntive nella scheda Renderizza.

8. Nella sezione Renderizza, fare clic su Avvia la renderizzazione.

RISULTATO
Il file audio viene renderizzato.

LINK CORRELATI
Scheda Renderizza (Editor audio) a pag. 123
Finestra di dialogo Formato file audio a pag. 133

Modifica delle proprieta audio

E possibile modificare la frequenza di campionamento e la profondita in bit dei file audio.

La modifica di questi valori non comporta alcun tipo di processamento del file audio (a differenza
dell'utilizzo della funzione Salva con nome). Tuttavia, vengono applicate le sequenti regole:

e Se si modifica la frequenza di campionamento, il file viene riprodotto a una nuova altezza.

e Se si modifica la profondita del campione, il file viene convertito nella nuova profondita al
successivo salvataggio.

NOTA

Non é possibile annullare questa operazione. Se si salva un file a una profondita in bit inferiore, il
file viene convertito in maniera permanente.
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PROCEDIMENTO

1. Nell’Editor audio, aprire un file audio.
2. Selezionare la scheda File.

3. Fare clic su Info.
4

Nella sezione Proprieta audio, selezionare una nuova Frequenza di campionamento e/o
una nuova Profondita in bit.

5. Fare clic su Applica le modifiche.

LINK CORRELATI
Scheda Info a pag. 46

Metadati

I metadati sono costituiti da attributi che descrivono i contenuti audio, ad esempio il titolo della
traccia, l'autore, o la data di registrazione. A seconda del formato del file audio selezionato,
questi dati variano.

All'apertura di un file audio o di un montaggio audio, vengono caricati i metadati trovati nel file. E
possibile creare diversi preset dei metadati per file audio e montaggi audio. Alla creazione di un
nuovo file da un modello, tale file puo ereditare i metadati dal preset, se disponibili.

Nella finestra Metadati viene visualizzata un’anteprima dei metadati. Per visualizzare i metadati
completi di un file e poterli modificare, aprire la finestra di dialogo Metadati.

Non tutti i formati file possono salvare dei metadati. A seconda del formato file di output,
vengono salvati tutti i metadati o solo una parte di essi in un file audio. I seguenti formati file
possono contenere dei metadati:

e .wav
e .mp3
e .0gg

e .wma
o flac

e .mda
e .mp4

Per il formato MP3, sono disponibili i seguenti tipi di metadati:
e ID3v1 eID3v2, compreso supporto per immagini
NOTA

e Il formato MP4 non & compatibile con il formato ID3v2. Tuttavia, in WavelLab Elements
utilizza lo stesso editor.

e I codici dei metadati che sono seqguiti da una «(i)» indicano i campi compatibili con iTunes.
Testi e immagini sono a loro volta compatibili con iTunes.

Per il formato WAW, sono disponibili i sequenti tipi di metadati:

e RIFF
e BWEF
e Marker BWF
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e CART (standard AES, dedicato alle esigenze di trasmissione)

e ID3, compreso supporto immagini

Durante il salvataggio o la registrazione di un file audio nella finestra di dialogo Formato file
audio, e possibile specificare se non utilizzare del tutto i metadati, ereditare i metadati dal file
sorgente o modificare i metadati del file.

Meta-Data = Inherit from Source File

Specific to This Configuration k

E possibile inserire manualmente i metadati o generarli automaticamente.
Possono essere generate automaticamente le sequenti opzioni:

e Identificatore unico della sorgente (USID)
E possibile attivare I'opzione USID nella scheda Di base della scheda BWF.

e Marker del tempo (scheda CART)

Wavelab Elements include diversi preset dei metadati. Questi possono essere utilizzati come
esempi e personalizzati a seconda delle esigenze. E possibile caricare i preset di metadati dal
menu a tendina Preset dei metadati nella finestra di dialogo Formato file audio o dalla finestra
di dialogo Metadati.

LINK CORRELATI

Finestra Metadati a pag. 153

Finestra di dialogo Metadati a pag. 154

Finestra di dialogo Formato file audio a pag. 133
Preset dei metadati a pag. 155

Finestra Metadati

Nella finestra Metadati € possibile visualizzare e modificare i metadati del file aperto nella
finestra Editor audio, Montaggio audio o Processore batch.

e Per aprire la finestra Metadati, aprire la finestra Editor audio, Montaggio audio o
Processore batch e selezionare Finestre degli strumenti di utility > Metadati.

¥ Edit...

Quando si seleziona un file audio nella finestra Browser dei file, i metadati corrispondenti
vengono visualizzati nella finestra Metadati e nella sezione relativa ai metadati della scheda
Info. Quando si fa clic in un qualsiasi altro punto, la finestra Metadati visualizza i metadati del
file audio, del montaggio audio o del processo batch selezionati.

Anteprima

La finestra dell'anteprima visualizza i metadati del file audio, del montaggio audio, o
del processo batch selezionati.
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Modifica

Apre la finestra di dialogo Metadati, in cui € possibile visualizzare e modificare i
metadati completi del file selezionato.

LINK CORRELATI

Metadati a pag. 152

Finestra di dialogo Metadati a pag. 154
Modifica dei metadati a pag. 155
Finestra Browser dei file a pag. 65

Finestra di dialogo Metadati
Questa finestra di dialogo consente di definire i metadati da incorporare nel file audio.
e Per aprire la finestra di dialogo Metadati, aprire la finestra Metadati e fare clic su Modifica.

A seconda del tipo di file, i metadati vengono gestiti in maniera differente.

B Metadata e

Comment (i)
Title
Subtitle
Album

) Part of a compilation

i} Genre

Lead performer

Disc number

CK (i) Track number

Use as Default for b Files 'Load Default Untitled Tl ! X Cancel

Finestra di dialogo Metadati per file WAV

Quando si apre la finestra di dialogo Metadati per i file che si trovano nell’Editor audio, &
possibile modificare i metadati che sono salvati nel file audio. Tali metadati vengono salvati su
disco successivamente.

Quando si apre la finestra di dialogo Metadati per i file che si trovano nella finestra Montaggio
audio, & possibile modificare i metadati per i file audio che vengono creati nel corso del processo
di renderizzazione del montaggio audio. Se si esegue la renderizzazione verso i formati WAV o
MP3, i metadati verranno associati a questi file.

LINK CORRELATI

Metadati a pag. 152

Finestra Metadati a pag. 153
Modifica dei metadati a pag. 155
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Modifica dei metadati
E possibile modificare i metadati dei file audio, dei montaggi audio e dei processi batch.

PREREQUISITI
E stato aperto un file audio, un montaggio audio o un processo batch.

PROCEDIMENTO
1. Nella finestra Metadati, fare clic su Modifica.
2. Nella finestra di dialogo dei metadati, definire le impostazioni desiderate.

3. Fare clic su OK.

LINK CORRELATI

Metadati a pag. 152

Finestra Metadati a pag. 153

Finestra di dialogo Metadati a pag. 154

Preset dei metadati

Nella finestra di dialogo Metadati, & possibile salvare i preset dei metadati e applicare tali preset
ad altri file. I preset dei metadati possono essere applicati ai file WAV, MP3, MP4 e M4A.

|Use as Defaul for New wavFils | Load Default | [Untries )

L'opzione Utilizza come valore predefinito per i nuovi file .wav consente di definire un insieme
di metadati predefinito.

Quando si crea un nuovo file e non vengono aggiunti metadati, vengono applicati al file i
metadati predefiniti durante il salvataggio o la renderizzazione. Ad esempio, € possibile salvare o
registrare file WAV con metadati BWF e aggiungere automaticamente un identificatore unico del
materiale.

Per modificare il preset dei metadati predefinito, selezionare Carica i valori predefiniti e

modificare il preset.

LINK CORRELATI
Finestra di dialogo Metadati a pag. 154

Lo standard CART e i marker

Wavelab Elements legge i marker CART, se presenti, e li fonde con i marker esistenti del file.

Lo standard CART pud contenere fino a 8 marker. WaveLab Elements li salva se i relativi nomi
sono conformi allo standard CART.

Se l'opzione Genera dei marker di tempo ¢ attivata nella scheda CART della finestra di dialogo
Metadati, i marker vengono generati se almeno un campo testo CART presenta un contenuto. In
caso contrario, non & previsto l'utilizzo dei dati CART.

Per poter fondere i marker CART con i marker di un file nel corso del processo di renderizzazione,
deve essere attivata 'opzione Copia marker utilizzando la funzione Renderizza nella Sezione
Master.

LINK CORRELATI
Metadati a pag. 152
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Finestra di dialogo Metadati a pag. 154
Finestra Sezione Master a pag. 284

Finestra di dialogo Generatore di silenzio

Questa finestra di dialogo consente di inserire del silenzio in un file audio.

e Per aprire la finestra di dialogo Generatore di silenzio, selezionare la scheda Inserisci
nell’Editor audio, quindi fare clic su Generatore di silenzio.
Silence Generator n

Silence Duration

Destination

© Insert at

Qg Apply

Durata del silenzio

L'opzione Come la selezione utilizza la durata della selezione audio attiva come durata
del silenzio. Specificare la durata della sezione silenziosa nel campo valore seguente.

Bordi

L'opzione Fade-in/out consente di eseguire una dissolvenza incrociata all'inizio e alla

fine della sezione silenziosa per ottenere delle transizioni piu uniformi. Specificare la

durata della dissolvenza nel campo valore seguente.

Destinazione

e |'opzione Sostituisci la selezione consente di sostituire la selezione audio
corrente con la sezione silenziosa.

e L'opzione Inserisci al cursore consente di inserire la sezione silenziosa alla
posizione del cursore.

e L'opzione Dalla fine del file fino al cursore consente di estendere il file audio
con silenzio fino alla posizione del cursore. Attivando questa opzione viene inoltre
definita la durata del silenzio e ignorata impostazione Durata del silenzio.

LINK CORRELATI
Inserimento del silenzio a pag. 157

Sostituzione di una selezione con del silenzio

E possibile sostituire una sezione di un file audio con del silenzio.

PROCEDIMENTO

1.

2
3.
4

Nell’Editor audio, definire una selezione.
Selezionare la scheda Inserisci.
Nella sezione Segnale, fare clic su Generatore di silenzio.

Nella finestra di dialogo Generatore di silenzio, impostare la durata del silenzio su Come la
selezione e |la destinazione su Sostituisci la selezione.
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5. Fareclic su Applica.

LINK CORRELATI
Scheda Inserisci (Editor audio) a pag. 122
Finestra di dialogo Generatore di silenzio a pag. 156

Inserimento del silenzio

E possibile inserire una durata specifica di silenzio in qualsiasi posizione di un file audio.

PROCEDIMENTO
1. Nell'Editor audio, impostare il cursore nel punto in cui si desidera che il silenzio inserito
abbia inizio.

2. Selezionare la scheda Inserisci.
3. Nella sezione Segnale, fare clic su Generatore di silenzio.

4. Nella finestra di dialogo Generatore di silenzio, disattivare Come la selezione e specificare
la durata.

5. Impostare la destinazione su Inserisci al cursore.

6. Fare clic su Applica.

LINK CORRELATI
Scheda Inserisci (Editor audio) a pag. 122
Finestra di dialogo Generatore di silenzio a pag. 156

Applicazione del 'Mute' a una selezione

La funzione Silenziare la selezione sostituisce la selezione con del silenzio reale.

PROCEDIMENTO
1. Nella finestra della forma d’'onda dell’Editor audio, definire una selezione.
2. Selezionare la scheda Inserisci.

3. Nella sezione Segnale, fare clic su Silenziare la selezione.

LINK CORRELATI
Scheda Inserisci (Editor audio) a pag. 122

Sostituzione dell'audio con un suono

E possibile sostituire una parte in un file audio con un suono, per coprire ad esempio una parola
volgare.

PROCEDIMENTO

1. Nell'Editor audio, definire una selezione.

2. Selezionare la scheda Inserisci.

3. Nella sezione Segnale, fare clic su Bip di censura.
4

Nella finestra di dialogo Bip di censura, specificare la frequenza e il livello del bip di censura.
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5. Facoltativo: attivare l'opzione Dissolvenza incrociata e specificare la durata della
dissolvenza incrociata.

Viene in tal modo creata una dissolvenza incrociata all'inizio e alla fine della regione del bip
di censura.

6. Fare clic su Applica.

LINK CORRELATI
Scheda Inserisci (Editor audio) a pag. 122
Finestra di dialogo Bip di censura a pag. 158

Finestra di dialogo Bip di censura

La finestra di dialogo Bip di censura consente di definire il suono del bip di censura.

e Per aprire la finestra di dialogo Bip di censura, selezionare la scheda Inserisci nell’Editor
audio, quindi fare clic su Bip di censura nella sezione Segnale.

Bleep Censor n

Frequenza
Consente di specificare la frequenza del bip di censura.

Livello
Consente di specificare il livello del bip di censura.

Dissolvenze incrociate

Se questa opzione ¢ attivata, WavelLab Elements crea una dissolvenza incrociata
all'inizio e alla fine della regione del bip di censura per garantire una transizione piu
omogenea. E possibile specificare la durata della dissolvenza incrociata.

Preset
Questo menu a tendina consente di salvare e ripristinare i preset dei bip di censura.

LINK CORRELATI
Scheda Inserisci (Editor audio) a pag. 122
Sostituzione dell'audio con un suono a pag. 157

Ripristino delle forme d’'onda con lo strumento penna

Lo strumento Penna consente di ridisegnare la forma d’onda direttamente nella finestra della
forma d’onda. Puo essere utilizzato per riparare rapidamente gli errori della forma d'onda. Lo

strumento Penna puo essere utilizzato se la risoluzione dellingrandimento € impostata su 1:8
(un pixel sullo schermo equivale a 8 campioni) o superiore.
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e Perridisegnare la forma d'onda, selezionare lo strumento Penna nella scheda Modifica
dell’Editor audio, fare clic nella forma d’'onda, quindi disegnare la nuova forma d’'onda.

e Perridisegnare la forma d'onda di entrambi i canali nello stesso momento, premere Shift
durante il processo di disegno.

LINK CORRELATI
Scheda Modifica (Editor audio) a pag. 118
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Wavelab Elements offre una serie completa di strumenti per I'analisi dell’'audio e il rilevamento di
qualsiasi tipo di errore.

Ad esempio, & possibile utilizzare il gruppo di indicatori audio o la funzione di Analisi delle
frequenze in 3D. Sono disponibili numerosi strumenti per supportare la rilevazione di errori o
anomalie in qualsiasi campione audio.

LINK CORRELATI
Analisi delle frequenze in 3D a pag. 170
Analisi globale a pag. 160

Analisi globale

In WaveLab Elements ¢ possibile eseguire delle operazioni di analisi avanzate sull'audio

per identificare aree con proprieta specifiche. In questo modo, & possibile individuare aree
problematiche come discontinuitd o campioni contenenti clipping. E inoltre possibile verificare
informazioni generali, come l'altezza di un suono.

Se si analizza una sezione di un file audio, WavelLab Elements esegue la scansione della sezione
o del file audio ed estrae delle informazioni, le quali sono quindi visualizzate nella finestra di
dialogo. WavelLab Elements contrassegna inoltre le sezioni del file che presentano caratteristiche
specifiche, ad esempio, sezioni molto potenti o quasi silenziose. E quindi possibile navigare tra

i vari punti, impostare marker o eseguire I'ingrandimento dei marker. Nella maggior parte delle
schede, sono presenti impostazioni che determinano esattamente la modalita di esecuzione
dell'analisi. Ciascuna scheda si riferisce a una particolare area di analisi.

E possibile eseguire I'analisi globale nella finestra di dialogo Analisi globale. In questa finestra di

dialogo sono disponibili le sequenti schede che forniscono diversi tipi di analisi:

e Lascheda Picchi consente di individuare singoli campioni con valori molto elevati.

e Lascheda Intensita acustica consente di trovare sezioni con intensita elevata.

e Lascheda Altezza consente di trovare |'altezza esatta di un suono o di una sezione.

e Lascheda Extra fornisce informazioni su DC offset e profondita in bit significativa.

e Lascheda Errori consente di individuare le discontinuita e le sezioni in cui 'audio € andato in
clipping.

La maggior parte dei tipi di analisi fornisce un numero di posizioni nel file indicanti picchi,
discontinuita, ecc. Questi punti sono definiti «<hot point».

Preparazione dell’analisi globale

La finestra di dialogo Analisi globale fornisce diverse opzioni di analisi.

PROCEDIMENTO

1. Nella finestra della forma d'onda, selezionare un intervallo nel file audio che si desidera
analizzare.

Se si desidera analizzare l'intero file, premere Ctrl/Cmd-A. Se ¢ attivata I'opzione Processa
I'intero file se non & presente una selezione nella finestra di dialogo Preferenze dei file
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audio, viene automaticamente analizzato l'intero file, a condizione che non sia stata definita
alcuna selezione.

2. Nell’Editor audio, selezionare la scheda Processa.
3. Nella sezione Analisi, fare clic su Analisi globale.

4. Facoltativo: fare clic su Apri una nuova finestra di dialogo di analisi in cima alla finestra di
dialogo Analisi globale per aprire un‘altra finestra di dialogo Analisi globale.

Global Analysis

Open New Global Analysis Dialog

LINK CORRELATI
Analisi globale a pag. 160

Scelta del tipo di analisi

E possibile esequire diversi tipi di analisi. Ognuno di essi prevede una certa durata, quindi &
necessario assicurarsi che nell'analisi siano inclusi solo i tipi necessari.

Selezionare i tipi di analisi nella finestra di dialogo Analisi globale, attivandoli nelle schede
corrispondenti.

e Perincludere 'analisi dei picchi, selezionare la scheda Picchi e attivare I'opzione Trova
picchi.

e Perincludere 'analisi dellintensita acustica, selezionare la scheda Intensita acustica e
attivare I'opzione Analizza I'intensita acustica.

e Perincludere 'analisi dell'altezza, selezionare la scheda Altezza e attivare l'opzione
Individua l'altezza media.

e Perincludere 'analisi del DC Offset (rumore di massa), selezionare la scheda Extra e attivare
l'opzione Individua DC Offset.

e Perincludere 'analisi degli errori, selezionare la scheda Errori e attivare Trova le
discontinuita potenziali e/o Trova i campioni contenenti clipping.

LINK CORRELATI
Analisi globale a pag. 160

Scheda Picchi (Analisi globale)

In questa scheda & possibile regolare delle impostazioni utili per l'individuazione dei valori dei
picchi digitali nell'audio, cioé singoli campioni con valori molto elevati.

e Nellafinestra di dialogo Analisi globale, selezionare la scheda Picchi.
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44.1_16Bit-Inter]

k=
Find Peaks

Digital Peak
Left

Right

Center

Low Frequency Effects
Left Surround

Right Surround

Report Parameters

m Num

Minimum Time

Trova picchi
Consente di attivare l'analisi dei picchi.

Digitale
Consente di visualizzare il picco maggiore nella sezione analizzata. Facendo clic su
questo valore, nella sezione Numero di punti nell'angolo in basso a sinistra della
finestra di dialogo viene visualizzato il numero di picchi individuati nella selezione. E
possibile utilizzare gli hot point per spostare il cursore tra i picchi.

Al cursore
Consente di visualizzare il livello alla posizione del cursore file audio corrente al
momento dell'analisi.

Numero massimo di picchi da segnalare
Consente di limitare il numero di picchi segnalati. Ad esempio, con il valore 1 verra
segnalato solamente il picco piu elevato.

Tempo minimo tra 2 picchi

Consente di controllare la distanza tra i picchi, in modo che questi non vengano
visualizzati troppo ravvicinati. Ad esempio, impostando un valore paria 1s, si avra
sempre almeno un secondo tra i picchi segnalati.

Risultati dell’analisi

Nei campi Trova picchi vengono visualizzati il picco piu elevato all'interno della sezione
analizzata e il livello del campione alla posizione del cursore della forma d'onda al momento
dell'analisi.
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LINK CORRELATI
Analisi globale a pag. 160

Scheda Intensita acustica (Analisi globale)

In questa scheda & possibile definire una serie di impostazioni utili per trovare delle sezioni che
vengono percepite dall'orecchio umano con intensita maggiore o minore. Per trovare sezioni con
volume significativo, & necessario osservare una sezione audio di una certa lunghezza.

e Nellafinestra di dialogo Analisi globale, selezionare la scheda Intensita acustica.

Impostazioni intensita acustica

44.1_16Bit-Inter

Maximum Minimum Around Cursor

Left
Right

Center

Low Frequency Effects

Left Surround
Right Surround
Parameters
I H

-50.00 dB

Analizza l'intensita acustica
Consente di attivare I'analisi dell'intensita acustica RMS.

Media
Consente di visualizzare l'intensita acustica globale della selezione analizzata.

Massimo
Consente di visualizzare il livello della sezione con intensita acustica piu alta nella
selezione analizzata. Facendo clic su questo valore, nella sezione Numero di punti
nellangolo in basso a sinistra della finestra di dialogo viene visualizzato il numero di
sezioni con intensita acustica elevata individuate nella selezione.

Minimo
Consente di visualizzare il livello della sezione con intensita piu bassa nella selezione

analizzata. Facendo clic su questo valore, nella sezione Numero di punti nellangolo
in basso a sinistra della finestra di dialogo viene visualizzato il numero di sezioni di
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debole intensita acustica individuate nella selezione. In questo modo, vengono fornite
informazioni adeguate sul rapporto segnale-rumore (SNR) del materiale audio.
Intorno al cursore
Consente di visualizzare l'intensita acustica alla posizione del cursore del file audio al
momento dell'analisi.
Risoluzione
La lunghezza dell'audio da misurare e di cui trovare la media. Se tale valore viene
ridotto, verranno rilevati brevi passaggi di audio forte/debole. Se viene aumentato, il
suono dovra essere forte/debole per un periodo maggiore per risultare un hot point.
Soglia (per la media)
Consente di garantire che il valore medio sia calcolato correttamente per le
registrazioni contenenti delle pause. Il valore qui impostato determina una soglia sotto

la quale tutto I'audio individuato viene considerato silenzio e quindi escluso dal calcolo
del valore medio.

Numero massimo di punti di intensita acustica da riportare

Consente di limitare il numero di hot point riportati. Vengono riportati solo i punti
maggiori. Ad esempio, impostando un valore pari a 1, verra riportata solamente la
sezione a intensita piu elevata o una delle sezioni con lo stesso valore piu alto.

Tempo minimo fra 2 punti

Consente di controllare la distanza tra punti, in modo che non vengano visualizzati
troppo ravvicinati. Ad esempio, impostando un valore pari a1, si avra sempre un
secondo tra i punti segnalati.

LINK CORRELATI
Analisi globale a pag. 160

Scheda Altezza (Analisi globale)

In questa scheda é possibile regolare una serie di impostazioni utili per individuare l'altezza
media di una sezione audio.

e Nellafinestra di dialogo Analisi globale, selezionare la scheda Altezza.

44.1_16Bit-Interle

Pitch

ge Pitch

Left

Right

Center
Low Frequency Effects
Left Surround

Right Surround

Le impostazioni disponibili in questa scheda consentono di ottenere informazioni relative al pitch
shifting (trasposizione dell'altezza), ad esempio per regolare l'altezza di un suono in relazione a
un altro suono. Il riquadro di visualizzazione mostra l'altezza per ciascun canale, in Hertz (Hz)

e come semitoni e centesimi (centesimi di semitono). Poiché viene visualizzato il valore globale
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dell'intera sezione analizzata, i controlli hot point nella sezione inferiore della finestra di dialogo
non sono utilizzati in questa scheda.

Linee guida di utilizzo per la scheda Altezza:

e Il risultato corrisponde a un valore medio per l'intera selezione.
e Il metodo funziona solo con materiale monofonico, non su accordi o armonie.

e l'algoritmo presuppone che la sezione analizzata disponga di un‘altezza sufficientemente
stabile.

e Il materiale deve essere relativamente ben isolato da altri suoni.

e E preferibile analizzare la porzione di sustain di un suono piuttosto che l'attacco. L'altezza
non & solitamente stabile nel corso dell'attacco.

e Alcuni suoni sintetici possono avere un fondamentale (primo armonico) debole, disturbando
cosi l'algoritmo.

LINK CORRELATI
Analisi globale a pag. 160

Scheda Extra (Analisi globale)

In questa scheda viene visualizzato il DC offset della sezione analizzata e la Profondita in bit
apparente.

e Nellafinestra di dialogo Analisi globale, selezionare la scheda Extra.

44.1_16Bit-Interlea

Find DC Offset

DC-Offset
Left
Right
Center
Low Frequency Effects
Left Surround

Right Surround
Apparent Bit Depth: 24
La Profondita in bit apparente tenta di individuare la precisione effettiva dell'audio. Si tratta di

un'opzione utile se, ad esempio si desidera verificare se un file a 24 bit utilizza realmente i 24 bit
o se il file era stato registrato con precisione a 16 bit e successivamente portato a 24 bit.

LINK CORRELATI
Analisi globale a pag. 160

Scheda Errori (Analisi globale)

Questa scheda consente di trovare discontinuita e sezioni in cui si & verificato il clipping
dell'audio.

e Nellafinestra di dialogo Analisi globale, selezionare la scheda Errori.
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Report Parameters

um Mumber of Error Points to
Minimum Time n 2 Points to
Find Possible Glitches
Threshold 40
80 Output Format

Output Format

Numero massimo di punti di errore da riportare
Consente di limitare il numero di hot point segnalati.

Tempo massimo fra 2 punti da riportare

Consente di controllare la distanza tra punti, in modo che non vengano visualizzati
troppo ravvicinati. Ad esempio, impostando un valore pari a 1's, si avra sempre un
secondo tra i punti segnalati.

Trova le discontinuita potenziali
Consente di attivare I'analisi delle discontinuita.

e Il parametro Soglia consente di impostare il valore in base al quale una modifica
nel livello e considerata una discontinuita. Maggiore ¢ il valore, minore sara la
sensibilita del rilevamento.

e Il parametro Sensibilita € un valore di lunghezza che rappresenta il tempo in cui
la forma d’onda deve superare la soglia affinché venga rilevata una discontinuita.
Maggiore ¢ il valore, minore sara la sensibilita del rilevamento.

e Il parametro Formato di uscita consente di visualizzare il numero di occorrenze
di clipping rilevate dall'analisi. Facendo clic su questo valore viene visualizzato il
numero di clip nella sezione Numero di punti nell'angolo inferiore-sinistro della
finestra di dialogo.

NOTA

Assicurarsi che i punti rilevati dall'algoritmo rappresentino discontinuita reali.
Aumentare il fattore di ingrandimento e avviare la riproduzione per verificare se i punti
rilevati indicano realmente un problema.

Trova i campioni contenenti clipping
Consente di attivare l'analisi dei clipping.

e Il parametro Soglia consente di verificare la presenza di un determinato numero
di campioni consecutivi al valore massimo, per determinare se si & verificato il
clipping. Il valore di Soglia determina il numero esatto di campioni consecutivi che
devono essere presenti affinché il programma riporti un clipping.

e Il parametro Formato di uscita consente di visualizzare il numero di occorrenze
di clipping rilevate dal processo di analisi. Facendo clic su questo valore viene
visualizzato il numero di clip nella sezione Numero di punti nell'angolo inferiore-
sinistro della finestra di dialogo.

LINK CORRELATI
Analisi globale a pag. 160
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Individuazione degli errori

E possibile individuare gli errori nellaudio, come ad esempio discontinuita e sezioni in cui si &
verificato il clipping.

Discontinuita

e Costituiscono dei malfunzionamenti nell'audio. Le discontinuita possono verificarsi a seguito
di trasferimenti digitali problematici, operazioni di editing poco accurate, ecc. Queste
possono manifestarsi nell'audio sotto forma di «click» o «pop».

Clipping

e Un sistema digitale ha un numero finito di livelli che possono essere rappresentati
correttamente. Quando i livelli sonori registrati sono troppo elevati o il sistema non & in
grado di gestire livelli generati da processamenti digitali, viene rilevato un forte clipping che
puo essere udito come una distorsione importante.
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Forma d’‘onda seno prima e dopo il clipping.

Risultato dell’analisi

Viene qui indicato il numero di istanze di clipping e di discontinuita trovate.

Esecuzione di un’analisi globale

PREREQUISITI

Nell'Editor audio, selezionare la scheda Analizza, fare clic su Analisi globale, quindi selezionare
la scheda che si desidera includere nell'analisi.

PROCEDIMENTO

1. Nella finestra di dialogo Analisi globale, impostare i parametri.
Nella maggior parte delle schede, sono presenti impostazioni che determinano la modalita
di esecuzione dell'analisi.

2. Seviene selezionata la scheda Picchi o Intensita acustica, spostare il cursore sulla
posizione che si desidera analizzare.

Nelle schede Picchi e Intensita acustica sono indicati i valori relativi alla posizione del
cursore.

3. Fare clic su Analizza.

Risultati dell'analisi globale

A seconda del tipo di analisi, vengono restituiti uno o piu valori per 'audio analizzato.
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Per le analisi di tipo Altezza ed Extra, viene restituito un solo valore. Gli altri tipi di analisi
forniscono un numero di posizioni nel file indicanti picchi, discontinuita, ecc. Questi punti sono
definiti hot point.

LINK CORRELATI
Verifica dei risultati dell'analisi globale a pag. 168

Verifica dei risultati dell’analisi globale

I risultati dell'analisi globale sono contrassegnati con punti hot point. E possibile passare da un
punto all'altro per visualizzare i risultati dell'analisi.

PREREQUISITI

Nell'Editor audio, selezionare la scheda Analizza, fare clic su Analisi globale ed eseguire
I'analisi.

PROCEDIMENTO

1.

Nella finestra di dialogo Analisi globale, fare clic sulla scheda che rappresenta i valori che si
desidera verificare.

2. \Verificare la visualizzazione dei valori massimi/minimi nell'intera sezione analizzata.

3. Decidere quali di questi valori si desidera verificare.

4. Fare clic sul valore scelto.

5. Verificare il valore Numero di punti nella parte inferiore della finestra di dialogo.
Il valore consente di visualizzare il numero di posizioni rilevate dall'analisi.

6. Utilizzare la barra di scorrimento sotto al valore Numero di punti per scorrere tra le
posizioni trovate.
Il cursore di modifica mostra la posizione nella finestra della forma d’'onda.

7. Pervisualizzare un’altra proprieta, fare clic sulla scheda corrispondente, quindi sul pulsante
del valore.
NOTA
Il risultato dell'analisi viene salvato fino alla chiusura della finestra di dialogo o all'ulteriore
selezione di Analizza.

LINK CORRELATI

Esecuzione di un‘analisi globale a pag. 167
Creazione di marker in corrispondenza degli hot point a pag. 168

Creazione di marker in corrispondenza degli hot point

La creazione dei marker in corrispondenza degli hot point consente di semplificare la
visualizzazione dei risultati dell'analisi globale.

PREREQUISITI

Nell'Editor audio, selezionare la scheda Analizza, fare clic su Analisi globale ed eseguire
I'analisi.
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PROCEDIMENTO

1. Nella finestra di dialogo Analisi globale, selezionare il tipo di analisi per il quale si desidera
creare marker a livello degli hot point.

E possibile aggiungere i marker per un solo canale alla volta.

Find Peaks
Digital Peak At Cursor

Left

Right

2. Fare clic su Crea dei marker presso gli hot point in fondo alla finestra di dialogo Analisi
globale.

Dei marker temporanei vengono aggiunti a tutti gli hot point nel canale corrispondente.

RISULTATO

I marker sono definiti utilizzando il sequente principio: «<Numero hot point (canale)». Ad esempio,
un marker presso il terzo hot point nel canale a sinistra verra etichettato «3 (L)».

LINK CORRELATI

Esecuzione di un'analisi globale a pag. 167
Verifica dei risultati dell'analisi globale a pag. 168
Focalizzazione sugli hot point a pag. 169

Focalizzazione sugli hot point

Dopo un‘analisi globale, € possibile focalizzare la visualizzazione su un hot point specifico.

PREREQUISITI

Nell'Editor audio, selezionare la scheda Analizza, fare clic su Analisi globale ed eseguire
I'analisi.

PROCEDIMENTO

1. Utilizzare la barra di scorrimento Numero di punti per spostare I'indicatore nella posizione
in cui ci si trova.

2. Fareclic su Focus.

La finestra della forma d'onda esegue I'ingrandimento nel punto selezionato. La finestra di
dialogo Analisi globale viene ridotta nella parte inferiore.

3. Pertornare alla visualizzazione a tutto schermo della finestra di dialogo Analisi globale, fare
nuovamente clic sul pulsante Focus.

LINK CORRELATI

Esecuzione di un'analisi globale a pag. 167

Creazione di marker in corrispondenza degli hot point a pag. 168
Verifica dei risultati dell'analisi globale a pag. 168
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Analisi delle frequenze in 3D

Mediante la funzione Analisi delle frequenze in 3D, & possibile visualizzare un file audio nel
dominio delle frequenze.

Utilizzare la funzione Analisi delle frequenze in 3D per i seguenti scopi:

e Visualizzare la distribuzione dello spettro delle frequenze in un mix

e Identificare le frequenze che possono essere ridotte o enfatizzate come base per
l'equalizzazione

e Visualizzare le parti dello spettro di frequenza che sono occupate da un suono d'ambiente
che si desidera filtrare

Una visualizzazione a onda (dominio temporale) informa circa l'inizio e la fine di un suono in un
file, ma non contiene informazioni sui contenuti timbrici del file forniti invece da un grafico di
frequenza (dominio delle frequenze). Il grafico utilizzato in WaveLab Elements € spesso indicato
come un tracciato FFT (Fast Fourier Transform). Se viene selezionata una registrazione stereo,
viene analizzato un mix dei due canali.

Il controllo a rotella consente di visualizzare lo spettro delle frequenze da diversi angoli. Ad
esempio, € possibile aprire diverse finestre dell’Analisi delle frequenze in 3D, ciascuna con una
prospettiva differente. Questo consente di ottenere una migliore visualizzazione di un grafico
altrimenti troppo pieno.

v track-1.wav (0 s/ 2 mn 395 310 ms) — O *

20 Hz - 20000 Hz

LINK CORRELATI
Creazione di un grafico per 'analisi delle frequenze in 3D a pag. 170
Finestra di dialogo Opzioni dell'analisi delle frequenze in 3D a pag. 171

Creazione di un grafico per I'analisi delle frequenze in 3D

La lunghezza dell'audio selezionato influisce sull'accuratezza dell'analisi. Per selezioni brevi, il
risultato € piu dettagliato. Si consiglia di eseguire un’analisi separata dell'attacco nel quale sono
presenti la maggior parte delle variazioni drastiche.

PROCEDIMENTO

1. Nella finestra della forma d'onda, selezionare la sezione del file che si desidera analizzare.
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Analisi delle frequenze in 3D

Se non si esegue alcuna selezione, viene analizzato l'intero file audio.
2. Nell'Editor audio, selezionare la scheda Visualizza.
3. Nella sezione Analisi, fare clic su Analisi delle frequenze in 3D.

4. Per modificare i parametri dell'analisi, fare clic su Opzioni dell'analisi delle frequenze in 3D.

v track-1wav (0s/ 2 mn 395 310 ms)

3D Frequency Analysis Options

5. Regolareiparametri e fare clic su OK.

L'audio viene analizzato nuovamente.

LINK CORRELATI
Scheda Modifica (Editor audio) a pag. 118
Finestra di dialogo Opzioni dell'analisi delle frequenze in 3D a pag. 171

Finestra di dialogo Opzioni dell'analisi delle frequenze in 3D

Nella finestra delle opzioni della finestra di dialogo Analisi delle frequenze in 3D, & possibile
definire l'intervallo di frequenze analizzato e modificare l'aspetto del grafico per I'analisi delle
frequenze in 3D.

e Nellafinestra di dialogo Analisi delle frequenze in 3D, fare clic sul pulsante Opzioni
dell'analisi delle frequenze in 3D.

20 Hz - 20000 Hz B 3D Frequency Analysis Options *

m Frequel
Logarithmic Ruler (Oc
Amplitude
© Linear
Logarithmic (Decibels)
Colors

Black Background

' OK ¥ Cancel

Frequenza superiore/Frequenza inferiore
Consente di specificare la frequenza superiore/inferiore dell'intervallo.

Righello logaritmico (ottave)
Consente di dividere il righello delle frequenze in ottave con uguale spaziatura.
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Ampiezza
Selezionare se si desidera che i picchi siano proporzionali alla relativa ampiezza
(Lineare) o potenza (Logaritmico (decibel)).

Colori
Consente di definire lo schema di colori del grafico.

Sfondo
Consente di definire il colore di sfondo.

LINK CORRELATI
Analisi delle frequenze in 3D a pag. 170
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I processi offline sono utili per molti scopi e possono essere utilizzati ad esempio nel caso in cui il
computer in uso non abbia una potenza sufficiente per gestire il processamento in tempo reale o
se una determinata operazione di editing richiede piu di un passaggio per la sua esecuzione.

Dopo il processamento il file audio viene alterato permanentemente.
LINK CORRELATI

Scheda Processa a pag. 173
Applicazione del processamento a pag. 175

Scheda Processa

La scheda Processa fornisce I'accesso agli strumenti di processamento offline.
e Nell'Editor audio fare clic su Processa.

W FLE ©VIEW € EDIT & INSERT &% PROCESS S RENDER

(® Gain Ay (D) Time Stretching v _/ Pitch Bend ~

"'U Invert Phase

Livello

Guadagno

Apre la finestra di dialogo Guadagno in cui & possibile applicare un valore di guadagno
per modificare il livello di un file audio.

Inviluppo

Apre la finestra di dialogo Inviluppo in cui & possibile creare un inviluppo del livello da
poter applicare a un intervallo selezionato o a un intero file audio.

Questa opzione ¢ utile, ad esempio, se si desidera uniformare parti rumorose e
silenziose o creare fade-in/fade-out sofisticati.
Rimuovi DC offset

II DC offset in un file influisce sull'intensita acustica. L'opzione Rimuovi DC offset
consente di impostare il DC offset a zero.

Normalizzazione

Livello
Apre la finestra di dialogo Normalizzatore del livello in cui & possibile modificare il

livello di picco di un file audio.
Dissolvenze

Fade-in/Fade-out

Consente di applicare un fade-in o un fade-out. Fare clic-destro sul pulsante per aprire
il menu a tendina Curva.
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Tipi di curva
Consentono di selezionare dei preset per le curve di dissolvenza.
e L'opzione Lineare consente di modificare il livello in maniera lineare.

e L'opzione Seno (*) consente di modificare il livello in base a una curva di
seno. Quando questa impostazione viene utilizzata in una dissolvenza incrociata,
I'intensita acustica (RMS) rimane costante durante la transizione.

e L'opzione Radice quadrata (*) consente di modificare il livello in base a una
curva della radice quadrata. Quando questa impostazione viene utilizzata in
una dissolvenza incrociata, l'intensita acustica (RMS) rimane costante durante la
transizione.

e L'opzione Sinusoidale consente di modificare il livello in base a una curva
sinusoidale.

e L'opzione Logaritmico consente di modificare il livello in base a una curva
logaritmica.

e L'opzione Esponenziale consente di modificare il livello in base a una curva
esponenziale.

e |'opzione Esponenziale+ consente di modificare il livello in base a una curva
esponenziale piu pronunciata.

Tempo e altezza

Modifica della durata
Apre la finestra di dialogo Modifica della durata che consente di modificare la durata

(applicare cioé la funzione chiamata time stretching) di una selezione audio.
Pitch shifting
Apre la finestra di dialogo Pitch shifting che consente di modificare I'altezza dell'audio.

Ricampionamento

Apre la finestra di dialogo Frequenza di campionamento che consente di modificare
la frequenza di campionamento dell'audio.

Pitch Bend

Apre la finestra di dialogo Pitch Bend che consente di modificare gradualmente
I'altezza dell’'audio per mezzo di una curva di inviluppo.

Al contrario
Crea un effetto nastro al contrario.

Correzione
Nella sezione Correzione ¢ possibile scegliere tra i sequenti metodi di correzione degli errori:

e Resintesi breve é piu adatto per piccoli errori. WavelLab Elements analizza le immediate
vicinanze dell'errore per trovare il metodo di correzione piu appropriato.

e Tratto di matita morbido ¢ particolarmente adatto per piccoli click nel materiale audio.
Questo metodo corrisponde a tracciare una linea precisa con una matita morbida.
Sostituisce il campione danneggiato con un tratto di matita.

Loop

Regolatore

Apre la finestra di dialogo Regolatore del loop che consente di modificare i punti di
inizio e di fine del loop ed eseguire una dissolvenza incrociata ai bordi del loop.
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Uniformatore del timbro
Apre la finestra di dialogo Uniformatore del timbro del loop che consente di creare

dei loop a partire da suoni non ottimali per 'esecuzione in loop.
Analisi

Analisi globale
Apre la finestra di dialogo Analisi globale in cui & possibile analizzare i picchi,

I'intensita acustica, I'altezza, il DC offset e gli errori nel file audio.
Altro

Inverti fase
Capovolge il segnale.

Applicazione del processamento

Il processamento puo essere applicato a una selezione o a un file intero. Per il processamento di
alcune operazioni € necessario l'intero file.

NOTA

Se ¢ attivata l'opzione Processa l'intero file se non & presente una selezione nella scheda
Modifica delle Preferenze dei file audio, viene automaticamente processato l'intero file se non
€ stata eseguita alcuna selezione.

PROCEDIMENTO

1. Definire una selezione nella finestra della forma d'onda.

2. Nell'Editor audio, selezionare la scheda Processa.

3. Selezionare il tipo di processamento che si desidera applicare.
4

Se si apre una finestra di dialogo, definire le proprie impostazioni e fare clic su Applica per
renderizzare l'effetto ottenuto in un file.

LINK CORRELATI
Finestra della forma d'onda a pag. 111

Finestra di dialogo Guadagno

In questa finestra di dialogo & possibile applicare un guadagno per modificare il livello di un file
audio.

e Per aprire la finestra di dialogo Guadagno, selezionare la scheda Processa nell’Editor audio
e fare clic su Guadagno nella sezione Livello.

Gain n
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Finestra

Fare clic su Individua il valore di picco corrente per ottenere un rapporto sul livello di picco
della selezione audio o dell'intero file (in caso non sia presente alcuna selezione). Questa
funzione é utile per calcolare ad esempio, di quanto € possibile aumentare il guadagno
complessivo di un file senza che si verifichi il clipping (superando gli 0 dB).

Questo processore consente anche di aggiungere un clipping. Il clipping si verifica quando
il guadagno viene aumentato fino al punto in cui si produce una distorsione. Anche se
generalmente questo non e I'effetto voluto, un clipping moderato pud aggiungere un po’ di
punch al suono, ad esempio per accentuare I'attacco di una batteria.

di dialogo Normalizzatore del livello

In questa finestra di dialogo, € possibile modificare il livello di picco di un file audio.

e Per aprire la finestra di dialogo Normalizzatore del livello, selezionare la scheda Processa
nell’Editor audio e fare clic su Livello nella sezione Normalizzazione.

Level Normalizer n

Peak Level

0.000 dB

Stereo Link

Mix to Mono

Maximum

%7

Livello di picco
Inserire il livello di picco (in dB) che si desidera assegnare alla selezione audio.

Stereo Link
Consente di applicare il guadagno a entrambi i canali.

Mix to Mono

Consente di mixare il canale sinistro e destro. Il file mono risultante presentera il livello
di picco specificato. Questo assicura un mix senza clipping.

Individua il valore di picco corrente

Consente di creare un report sul livello di picco della selezione audio o dell'intero file (in
caso non sia presente alcuna selezione).

Normalizzatore dell'intensita acustica

E possibile utilizzare il Normalizzatore dell'intensita acustica per ottenere un valore di
intensita acustica specifico.

L'aumento dell'intensita acustica a un valore specifico pud provocare il clipping. Per risolvere
questo problema, é possibile inserire nel processamento un limitatore di picco (plug-in Peak
Master). Il Normalizzatore dell'intensita acustica aumenta l'intensita acustica e allo stesso
tempo limita i picchi nel segnale, se necessario, per raggiungere il valore desiderato.

Questo processo avviene in piu passaggi: per prima cosa viene eseguita I'analisi e in seguito la
renderizzazione finale.
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LINK CORRELATI
Finestra di dialogo Normalizzatore dell'intensita acustica a pag. 177

Finestra di dialogo Normalizzatore dell'intensita acustica

In questa finestra di dialogo, & possibile specificare I'intensita acustica di un file.

Loudness Normalizer n

ieve | - 23.00 LUFS
is References
Reference: Loudnes ntire File ¥ O True Peaks v

Peak Limiter (Using the Plug-in "PeakMaster”) Pre-P

v I

Warn If L

ault Setti

Intensita acustica (EBU R-128)

Intensita acustica da ottenere

Se risulta impossibile ottenere il valore di intensita acustica con una semplice modifica
positiva del guadagno, & necessario applicare un limitatore che eviti il clipping.

Specificare qui il valore di intensita acustica che si desidera ottenere. In base allo
standard EBU R-128, il livello consigliato per le trasmissioni & -23 LUFS.

Se si specifica un valore maggiore, potrebbe essere necessario un guadagno al di fuori
delle normali capacita del limitatore. Questo puo produrre una certa distorsione.

Si consiglia di utilizzare la funzione Statistiche dopo aver specificato un valore di
intensita acustica. In questo modo si pud conoscere il valore del guadagno necessario
e se occorre applicare la limitazione di picco. Se & necessaria una limitazione forte, &
possibile che la qualita audio peggiori. In questi casi viene visualizzato un messaggio di
allerta dopo l'applicazione del processamento e viene offerta all'utente la possibilita di
annullare l'operazione.

Ottieni il valore di intensita acustica dalla selezione audio
Consente di impostare I'Intensita acustica da ottenere sul valore di intensita acustica
media rilevata nel file o nella selezione audio.

Riferimento

Questo menu a tendina consente di selezionare un riferimento: I'intensita acustica
dell'intero file (raccomandazione EBU R-128), la sezione audio di 3 secondi piu forte in
media (Parte superiore dell'intervallo dell'intensita acustica) o la sezione audio di 3
secondi piu forte in assoluto (Intensita acustica a breve termine massima).

Picchi
In questo menu a tendina, selezionare se WavelLab Elements deve limitare i valori in
campioni (Picchi digitali) o i valori analogici ricostruiti (Picchi reali).
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Limitatore di picco

Livello di picco massimo

Specifica il livello di picco massimo dell’'audio risultante. Piu basso ¢ il valore, inferiore
sara l'intensita acustica.

Morbidezza
Influenza il modo in cui opera il peak master. Un'impostazione elevata massimizza
l'effetto dell'intensita acustica percepita, ma puo conferire una leggera ruvidezza al
suono.

Modificare questo parametro in modo da ottimizzare il bilanciamento tra la qualita
sonora e l'effetto che si desidera ottenere.

Opzioni di pre-processamento

Rimuovi DC offset

II DC offset nel file influisce sul calcolo dell'intensita acustica. L'opzione Rimuovi DC
offset consente di impostare il DC offset a zero. Si consiglia di tenere attivata questa
opzione.

Tentativi/Analisi

Tolleranza (+/-)

Se il parametro Intensita acustica da ottenere richiede una limitazione del picco,
viene ridotta anche l'intensita acustica di alcuni gradi. E impossibile calcolare in
anticipo questo valore e quindi applicarlo automaticamente alla modifica di guadagno.
Vengono invece effettuati diversi passaggi di simulazione per trovare il miglior
guadagno possibile. Questa opzione consente di definire con precisione il risultato che
si desidera ottenere.

Numero massimo di passaggi
WavelLab Elements esegue il numero di passaggi necessario per garantire la precisione
che si desidera ottenere. Utilizzare questa opzione per specificare il numero massimo
di passaggi da eseguire.

Compressione dei picchi autorizzata

Poiché una compressione eccessiva peggiora la qualita audio, € possibile specificare
un limite per la compressione applicata. Questo valore pud essere impostato tra -1 e
-20 dB. Si consiglia di tenere su livelli bassi I'Intensita acustica da ottenere per avere
risultati migliori in fase di renderizzazione.

Allerta se non ottenuto

Se questa opzione € attivata, I'utente viene avvertito se il processo di normalizzazione
non soddisfa il valore di intensita acustica da ottenere/la precisione desiderati.

Statistiche
Apre una finestra che riporta una serie di informazioni sul file da processare. Vengono
visualizzati il DC offset, il valore di intensita acustica e il livello di picco correnti,
nonché il guadagno necessario per ottenere l'intensita acustica desiderata. Viene
inoltre notificato se € necessario applicare una limitazione.

LINK CORRELATI

Normalizzatore dell'intensita acustica a pag. 176
Standard dell'intensita acustica EBU R-128 a pag. 40

178



Processamento offline
Finestra di dialogo Inviluppo

Finestra di dialogo Inviluppo

In questa finestra di dialogo, & possibile creare un inviluppo del livello da applicare a un intervallo
selezionato o a un intero file audio. Questa opzione ¢ utile, ad esempio, se si desidera uniformare
parti rumorose e silenziose o creare fade-in o fade-out particolarmente sofisticati.

e Per aprire la finestra di dialogo Inviluppo, selezionare la scheda Processa nell’Editor audio
e fare clic su Inviluppo nella sezione Livello.

Envelope n

21-106_stereo_PCM-192k_MAGNIFICAT_D4.flac [Decoded]

Untitled

Nella finestra di dialogo viene visualizzata una forma d’onda con una curva di inviluppo
(inizialmente una linea dritta). Sul righello verticale & indicato il livello in dB, su quello orizzontale
e indicata la linea temporale.

Sono disponibili le seguenti opzioni:

e Annulla l'ultima operazione

e Ripeti l'ultima operazione annullata

e Deseleziona i punti di inviluppo

e Elimina i punti di inviluppo selezionati

e Reinizializza i punti di inviluppo selezionati
e Reinizializza lI'intero inviluppo

e Inverti l'inviluppo lungo I'asse orizzontale

e Invertila sequenza temporale dell'inviluppo

e Inverti lo smussamento dell'inviluppo

Operazioni di base dell'inviluppo

Aggiungendo dei punti alla curva di inviluppo € possibile creare una curva di inviluppo che
modifica il volume del materiale nel tempo. Quando si punta il mouse sulla visualizzazione o
si sposta un punto, la posizione corrente e la modifica del livello vengono mostrate nel campo
sopra alla visualizzazione.

e Per aggiungere un punto, fare doppio-clic sulla curva di inviluppo.
e Per selezionare un punto, cliccarci sopra.

e Per selezionare piu punti, fare clic e trascinare il rettangolo di selezione o cliccarci sopra
tenendo premuto Ctrl/Cmd.

e Per spostare un punto, cliccarci sopra e trascinarlo. Se & stato selezionato piu di un punto,
tutti i punti vengono spostati.
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Per spostare verso l'alto o verso il basso l'intera curva, fare clic sulla curva di inviluppo ed
eseguire un trascinamento verso l'alto o verso il basso.

Per spostare verticalmente i segmenti della curva, premere Ctrl/Cmd, fare clic sul segmento
desiderato ed eseguire un trascinamento verso l'alto o verso il basso.

Per spostare orizzontalmente due punti, premere Shift, fare clic sul segmento della curva
compreso tra i due punti e trascinare verso sinistra o verso destra.

Per spostare verticalmente due punti, premere Ctrl/Cmd, fare clic sul segmento della curva
compreso tra i due punti e trascinare verso l'alto o verso il basso.

Dissolvenze nei file audio

Un fade-in rappresenta un incremento graduale di livello, un fade-out un decremento graduale.

E possibile creare le dissolvenze selezionando un singolo tipo di dissolvenza per ciascun fade-in/
fade-out.

Creazione di fade-in e fade-out

PROCEDIMENTO

1. Definire una selezione nella finestra della forma d'onda.

2. Nell'Editor audio, selezionare la scheda Processa.

3. Aseconda del fatto che si desideri creare un fade-in o un fade-out, selezionare una delle

seguenti opzioni nella sezione Dissolvenza:
e Per applicare il tipo di dissolvenza predefinito, fare clic sulle icone Fade-in o Fade-out.

e Per selezionare un altro tipo di dissolvenza, fare clic su Fade-in o Fade-out sotto la
rispettiva icona. Dal menu a tendina, selezionare il tipo di dissolvenza che si desidera
creare.

Applicazione di dissolvenze semplici

La funzione Dissolvenza semplice consente di applicare in maniera rapida un fade-in o un
fade-out predefiniti a un file audio tramite una scorciatoia da tastiera.
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La forma della dissolvenza viene regolata utilizzando le impostazioni Fade-in e Fade-out
all'interno della sezione Dissolvenze della scheda Processa.

PROCEDIMENTO

1.

2.

Nell'Editor audio, definire una delle seguenti selezioni:
e Dall'inizio del file audio fino al punto in cui si desidera far terminare il fade-in.

e Dalla posizione in cui si desidera far iniziare il fade-out fino alla fine del file audio.

Fare clicsu Ctrl/Cmd-D.

Dissolvenze incrociate

Una dissolvenza incrociata & una dissolvenza graduale tra due suoni, dei quali a uno viene
applicato il fade-in e all'altro il fade-out. E possibile creare automaticamente una dissolvenza
incrociata quando si incolla una sezione audio in un‘altra.

Creazione di dissolvenze incrociate

Il materiale a cui generalmente si applica una dissolvenza incrociata puo trovarsi in due diverse
sezioni dello stesso file audio o in due diversi file audio.

PROCEDIMENTO

1.

Nella finestra della forma d'onda, selezionare la sezione del file a cui si desidera applicare il
fade-in.

2. Selezionare la scheda Modifica.
3. Nella sezione Appunti, fare clic su Copia.
4. Selezionare la sezione a cui si desidera applicare il fade-out.

La lunghezza di questa selezione determina la lunghezza effettiva della dissolvenza

incrociata e viene visualizzata nella barra di stato. Le sezione pud essere all'interno del file

audio selezionato o in un‘altra finestra della forma d'onda. Tuttavia, la selezione non puo
essere piu lunga della selezione appena copiata.

5. Aseconda del fatto che si desideri creare un fade-in o un fade-out, selezionare una delle
seguenti opzioni nella sezione Appunti:

e Per applicare il tipo di dissolvenza incrociata predefinita, fare clic sull'icona Incolla con
dissolvenza incrociata.

e Per selezionare un altro tipo di dissolvenza incrociata, fare clic su Incolla con
dissolvenza incrociata sotto I'icona della dissolvenza incrociata. Dal menu a tendina,
selezionare il tipo di dissolvenza incrociata che si desidera creare.

RISULTATO

La dissolvenza incrociata viene creata. Qualsiasi materiale che originariamente si trovava dopo
la selezione nel file nel quale si incolla viene spostato in modo che venga a trovarsi dopo il
materiale incollato.

Qualsiasi materiale in eccesso nella selezione copiata viene visualizzato dopo la dissolvenza a
pieno livello.
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NOTA

Se entrambi i file dispongono gia di sezioni a pieno livello nell'area della dissolvenza incrociata
(ad esempio, se entrambi i file sono stati normalizzati), si possono verificare clipping e
distorsione. Se cio accade, ridurre 'ampiezza di entrambi i file di un valore compreso tra3 e

6 dB e riprovare.

DOPO IL COMPLETAMENTO DI QUESTA OPERAZIONE
Riprodurre il file e regolare la dissolvenza incrociata, se necessario.

LINK CORRELATI
Opzioni della funzione Incolla e dissolvenza incrociata a pag. 182

Opzioni della funzione Incolla e dissolvenza incrociata

Queste opzioni consentono di selezionare un tipo di dissolvenza incrociata da incollare.

e Selezionare la scheda Modifica nell’Editor audio e fare clic su Incolla e dissolvenza
incrociata nella sezione Appunti.

Lineare (guadagno costante)
Il livello cambia in maniera lineare.

Seno (potenza costante)

Il livello cambia in base a una curva di seno, la potenza del mix rimane costante.

Radice quadrata (potenza costante)

Il livello cambia in base a una curva della radice quadrata, la potenza del mix rimane
costante.

Inversione di fase

L'inversione della fase capovolge il segnale. Questa funzione si utilizza solitamente per riparare
una registrazione stereo se uno dei canali € stato registrato non in fase con laltro.

Inversione della fase audio

PROCEDIMENTO

1. Facoltativo: se si desidera invertire la fase all'interno di un intervallo di tempo specifico,
creare un intervallo di selezione nella finestra della forma d'onda.

2. Nell’Editor audio, selezionare la scheda Processa.

3. Nella sezione Altro, fare clic su Inverti fase.

Inversione dell’'audio

E possibile invertire un file audio o una parte di esso, come se la riproduzione avvenisse al
contrario.

PROCEDIMENTO

1. Facoltativo: se si desidera invertire un intervallo di tempo specifico del file audio, creare un
intervallo di selezione nella finestra della forma d'onda.
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2. Nell’Editor audio, selezionare la scheda Processa.

3. Nella sezione Tempo e altezza, fare clic su Inverti.

DC Offset

Un DC offset si verifica quando & presente una componente di corrente continua (DC) troppo
elevata nel segnale. Questo accade solitamente a causa di un'incompatibilita tra tipi diversi di
apparecchiature di registrazione.

Un DC offset & problematico per le sequenti ragioni:

e Influenza la posizione di zero crossing.

e Alcune opzioni di processamento non offrono risultati ottimali se eseguite su file che
presenta un DC offset.

Rimozione del DC Offset

PROCEDIMENTO
1. Nell'Editor audio, aprire il file audio nel quale si desidera verificare e rimuovere il DC offset.
2. Selezionare la scheda Processa.

3. Nella sezione Livello, fare clic su Rimuovi DC offset.

Si apre una finestra di dialogo dove & indicato il valore del DC offset nel file audio. E inoltre
possibile creare un intervallo di selezione nella finestra della forma d'onda e selezionare
questa opzione per visualizzare il DC offset solo nell'intervallo di selezione specificato.

NOTA

Questa funzione deve essere applicata a file interi, poiché il problema normalmente &
presente nell'intera registrazione.

4. Fare clic su OK per rimuovere il DC offset.

Modifica della durata

Consente di modificare la durata di una registrazione mantenendo costante la sua altezza.

Grazie alla funzione di modifica della durata (chiamata anche time stretching) € possibile
allungare o accorciare il materiale audio. Questa funzione nella maggior parte dei casi viene
utilizzata per far coincidere la durata di una sezione audio con altro materiale. E possibile
selezionare il materiale di cui si desidera modificare la durata e utilizzare le opzioni nella finestra
di dialogo Modifica della durata per trovare un fattore di stiramento. Pud essere specificata la
durata o il tempo, a seconda del contesto e della situazione.

NOTA

Wavelab Elements utilizza la tecnologia ZPlane per la funzione di modifica della durata ad
elevata qualita.

LINK CORRELATI
Finestra di dialogo Modifica della durata a pag. 184
Limitazioni alla funzione di modifica della durata a pag. 185
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Finestra di dialogo Modifica della durata

In questa finestra di dialogo, & possibile modificare la durata di una selezione audio, solitamente
senza modificarne l'altezza. E possibile portare una selezione a una determinata durata (in
minuti, secondi e millisecondi), tempo (in bpm) o fattore di stiramento (come percentuale).

e Per aprire la finestra di dialogo Modifica della durata, selezionare la scheda Processa
nell'Editor audio e fare clic su Modifica della durata nella sezione Tempo e altezza.

Time Stretching n

Source (Audic tion) Result
Duratic Target Duration

Edit Tempo Standard Quality ¥

Target Tempo

Target Stretc

Sorgente (selezione audio)

Durata

Se l'opzione Modifica tempo ¢ attivata, & possibile modificare il tempo della sorgente
audio. Il numero di misure e movimenti, nonché il fattore di compressione/stiramento
vengono aggiornati automaticamente.

Se l'opzione Modifica misure & attivata, & possibile definire il numero di misure e
movimenti e il tempo in chiave per la sorgente audio. Viene in tal modo aggiornato
automaticamente il tempo della sorgente e il fattore di compressione/stiramento.

Risultato

Durata di destinazione
Se questa opzione € attivata, viene modificata la durata della sorgente audio.

Tempo di destinazione
Se questa opzione € attivata, viene modificato il tempo della sorgente audio. Per
questa operazione, € necessario specificare il tempo o il numero di misure e battiti
originale.

Fattore di stiramento temporale di destinazione
Indica l'entita delle modifiche della durata. Questo parametro si aggiorna
automaticamente quando si modificano gli altri parametri, ma & anche possibile
attivare questa opzione per modificarlo manualmente.

Reinizializza
Consente di riportare il fattore di stiramento temporale al 100% (nessuno stiramento).

Metodo

Mantieni altezza note

Se questa opzione € attivata, l'altezza del materiale audio rimane invariata quando si
modifica il tempo. Se questa opzione non ¢ attiva, l'altezza varia in proporzione alla
modifica del tempo.
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Menu a tendina Precisione

Consente di privilegiare la precisione della durata o la precisione dell'altezza durante lo
spostamento dell'altezza.

e L'opzione Privilegia la precisione della durata preserva la durata dell'audio
originale.

e L'opzione Privilegia la precisione dell'altezza pud dare come risultato una durata
dell'audio leggermente diversa dopo la modifica dell'altezza (pitch shifting).

LINK CORRELATI
Modifica della durata a pag. 183

Limitazioni alla funzione di modifica della durata

La modifica della durata (time stretching) & un'operazione di elaborazione digitale dei segnali
(DSP - Digital Signal Processing) piuttosto complessa, che influisce sempre sulla qualita del suono
in una certa misura.

e Per il parlato, valori ricompresi entro un intervallo di £30% garantiscono buoni risultati.
e Per la musica con piu strumenti, provare a limitare l'intervallo a +10%.

e Per materiale sensibile, ad esempio un solo di piano, provare a limitare l'intervallo a +3%.

LINK CORRELATI
Modifica della durata a pag. 183

Pitch Shift

L'opzione Pitch Shift consente di rilevare e modificare 'altezza di un suono, influendo o meno
sulla sua lunghezza. Questa funzione ¢ utile, ad esempio, per correggere una nota vocale stonata
in una registrazione dal vivo o per regolare I'altezza di un campione di grancassa e adattarlo a
una determinata canzone.

LINK CORRELATI
Finestra di dialogo Pitch shifting a pag. 185

Finestra di dialogo Pitch shifting
In questa finestra di dialogo € possibile modificare I'altezza di un suono.

e Per aprire la finestra di dialogo Pitch shifting, selezionare la scheda Processa nell'Editor
audio e fare clic su Pitch shifting nella sezione Tempo e altezza.
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Pitch Shift

Pitch Shifting n

Untitled

Finestra di dialogo Pitch shifting per i file audio

Trasposizione

Semitoni

Consente di specificare I'entita del cambio di altezza in semitoni.

Centesimi

Consente di specificare I'entita del cambio di altezza in centesimi.

Trova altezza corrente della selezione audio
Analizza l'altezza dell'audio selezionato e la visualizza sotto questo pulsante. Questa
opzione & disponibile solamente per i file audio.

In base all'altezza attuale, viene calcolato lo spostamento necessario per ottenere la
nota successiva

Fare clic per regolare automaticamente i parametri di Trasposizione in base all'altezza
rilevata e all'altezza specificata nel campo valore sotto a questo pulsante. Questa
opzione & disponibile solamente per i file audio.

Campo Altezza
Consente di specificare l'altezza risultante.

Metodo

Mantenimento della lunghezza
Consente di specificare in che misura la lunghezza della selezione ¢ influenzata
dall'operazione:
e Conun valore del 100%, la lunghezza dell'audio rimane invariata.

e Conun valore pari a 0%, il programma si comporta come un registratore a nastro
quando si varia la velocita del nastro. Ad esempio, se si aumenta l'altezza di
un’‘ottava, la lunghezza dell'audio viene dimezzata.

Per ampie trasposizioni, piu basso & il valore inserito, migliore sara la qualita
dell'effetto.

Menu a tendina Precisione
Consente di privilegiare la precisione della durata o la precisione dell'altezza durante lo
spostamento dell'altezza.

e Se éselezionata l'opzione Privilegia la precisione della durata e il parametro
Mantenimento della lunghezza ¢ impostato al 100%, I'audio risultante dopo lo
spostamento dell'altezza ha la stessa durata dell'audio sorgente.
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e Se éselezionata l'opzione Privilegia la precisione dell'altezza, I'audio risultante
dopo lo spostamento dell'altezza potrebbe presentare una durata leggermente
diversa rispetto allaudio sorgente.

Correggi formanti

Se questa opzione € attivata, la modifica dell'altezza di materiale vocale offre un
risultato piu realistico. Se si processa del materiale non vocale, &€ necessario lasciare
questa opzione non attivata, perché essa utilizza un algoritmo di processamento
leggermente piu lento.

NOTA

Questo algoritmo potrebbe produrre un notevole aumento di livello del segnale.

LINK CORRELATI
Pitch Shift a pag. 185

Pitch Bend

Pitch Bend consente di modificare I'altezza di un suono nell'arco del tempo.

Questa funzione puo essere utilizzata per creare il classico effetto di interruzione del nastro o per
miscelare il tempo/l'altezza di una traccia con il tempo/l'altezza di un‘altra.

Nella finestra di dialogo Pitch Bend ¢ possibile disegnare la curva di inviluppo che l'altezza
deve seqguire. Lo scostamento dell'altezza viene visualizzato sul righello verticale dell'inviluppo;
I'intervallo degli effetti dell'inviluppo puo essere regolato. I valori di altezza positivi producono
suoni con un‘altezza superiore e una durata inferiore, i valori negativi producono suoni con
un’'altezza inferiore e una durata superiore.

LINK CORRELATI
Finestra di dialogo Pitch Bend a pag. 187

Finestra di dialogo Pitch Bend

In questa finestra di dialogo, & possibile modificare gradualmente l'altezza di un suono
utilizzando una curva di inviluppo.

e Per aprire la finestra di dialogo Pitch Bend, selezionare la scheda Processa nell’Editor audio
e fare clic su Pitch Bend nella sezione Tempo e altezza.
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Pitch Bend

=15

Range

+1.00 =

Untitled

?

Track Awav

(Semitones)

Inviluppo del pitch bend

Consente di modificare la curva di inviluppo per variare l'altezza di un suono. Per
aggiungere un punto di inviluppo, fare doppio-clic sulla curva. E quindi possibile
trascinare i punti di inviluppo per personalizzare l'inviluppo del pitch bend.

Le seguenti opzioni per la modifica degli inviluppi sono disponibili sopra il display
dell'inviluppo del pitch bend:

Annulla l'ultima operazione

Ripeti l'ultima operazione annullata
Deseleziona i punti di inviluppo

Elimina i punti di inviluppo selezionati
Reinizializza i punti di inviluppo selezionati
Reinizializza I'intero inviluppo

Inverti I'inviluppo lungo l'asse orizzontale
Inverti la sequenza temporale dell'inviluppo

Inverti lo smussamento dell'inviluppo

Estensione (semitoni)

Consente di specificare l'intervallo massimo in semitoni per la modifica dell'altezza.
Quando si modifica questo valore, questo viene indicato nel righello verticale.

LINK CORRELATI
Pitch Bend a pag. 187

Ricampionamento

E possibile modificare la frequenza di campionamento di una registrazione. Questa funzione &
utile se il file che si desidera utilizzare in un sistema audio € stato registrato a una frequenza di
campionamento non supportata dal sistema stesso.

NOTA

e La conversione della frequenza di campionamento da una frequenza bassa a una piu alta
non migliora la qualita del suono. Le frequenze alte che sono andate perse non possono
essere ripristinate tramite conversione.
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e Sesiesegue il ricampionamento verso una frequenza inferiore, il materiale ad alta frequenza
viene perso. Pertanto, una conversione a una frequenza inferiore e poi a una superiore porta
di nuovo a un peggioramento della qualita del suono.

NOTA

Se si utilizza il plug-in Resampler nella modalita di qualita Alta per modificare la frequenza di
campionamento, si ottiene la stessa qualita prodotta utilizzando l'opzione Ricampionamento
dell’Editor audio. Tuttavia, questo si verifica soltanto se la frequenza di campionamento nella
finestra di dialogo Frequenza di campionamento ¢ presente tra i valori del Resampler,

nel menu a tendina Frequenza di campionamento. Se si seleziona una frequenza di
campionamento personalizzata, viene utilizzato un altro algoritmo. Questo produce una qualita
inferiore di quella che si puo ottenere tramite il plug-in Resampler.

LINK CORRELATI
Conversione di una frequenza di campionamento a pag. 189

Conversione di una frequenza di campionamento

La funzione di ricampionamento consente di convertire la frequenza di campionamento di un file
audio in un‘altra frequenza di campionamento.

NOTA

La conversione della frequenza di campionamento viene applicata sempre all'intero file.

PROCEDIMENTO
1. Nell'Editor audio, selezionare la scheda Processa.
2. Nella sezione Tempo e altezza, fare clic su Ricampionamento.

3. Nella finestra di dialogo Frequenza di campionamento, selezionare una frequenza di
campionamento dal menu a tendina.

D Sample Rate *

Audio Fi

44100

W OK X Cancel

4. Fare clic su OK.

LINK CORRELATI
Ricampionamento a pag. 188
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Il montaggio audio rappresenta un ambiente di editing non distruttivo multitraccia che consente
di organizzare, modificare, riprodurre e registrare le clip audio.

Il termine 'non distruttivo' indica che quando si elimina o si modifica una parte di un file audio,
I'audio non viene eliminato o modificato in maniera permanente. Al contrario, un set di puntatori
consente di tenere traccia delle modifiche, in modo da poterle annullare.

Le funzioni di editing non distruttivo includono effetti basati su clip e tracce, automazione di
volume e panorama, nonché funzioni di creazione di dissolvenze e dissolvenze incrociate.

I montaggio audio rappresenta un utilissimo strumento per la creazione di CD audio, per il
mastering, per la realizzazione di lavori multimediali, per la produzione di spot radiofonici, ecc.

Terminologia di base

I montaggi audio possono contenere fino a 3 tracce audio mono o stereo e una traccia video. E
possibile utilizzarli per strutturare il proprio lavoro in senso grafico.

In una traccia audio, € possibile inserire un numero qualsiasi di clip. Le clip rappresentano dei
contenitori per I'audio e includono varie impostazioni e funzioni come le curve di volume e
panorama, le dissolvenze, ecc.

Una clip contiene un riferimento a un file audio sorgente nell'hard disk, nonché alle posizioni di
inizio e di fine nel file; le clip sono quindi in grado di riprodurre sezioni dei file audio sorgente. Un
numero qualsiasi di clip puo fare riferimento allo stesso file sorgente.

LINK CORRELATI

Finestra di montaggio a pag. 190

Creazione dei montaggi audio a pag. 207
Assemblaggio del montaggio audio a pag. 212
Modifica delle clip a pag. 224

Finestra di montaggio

La finestra del montaggio rappresenta la sezione del programma in cui viene assemblato il
montaggio audio. E qui possibile visualizzare, riprodurre e modificare i montaggi audio.

La finestra del montaggio offre una rappresentazione grafica delle tracce e delle clip.
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LINK CORRELATI
Schede del montaggio audio a pag. 196
Area dei controlli delle tracce a pag. 191

Area dei controlli delle tracce

L'area dei controlli delle tracce offre una serie di impostazioni e opzioni che riguardano
ad esempio la modifica dell'ordine delle tracce, I'applicazione dello stato di Mute e Solo e
I'assegnazione delle tracce. Ciascun tipo di traccia dispone di controlli dedicati.

E possibile scorrere tra le tracce e ridimensionarle.

L'area dei controlli delle tracce per le tracce mono e stereo

In cima all'area dei controlli delle tracce sono disponibili le seguenti opzioni:

Aggiungi una traccia
Consente di aggiungere una traccia al montaggio audio.

Navigatore

Apre un pannello che mostra una vista panoramica dell'intero montaggio audio e
consente una piu rapida navigazione al suo interno.

Per modificare la dimensione del pannello Navigatore, fare clic-destro sul pannello e
selezionare Navigatore piccolo, Navigatore medio o Navigatore grande.

191



Montaggio audio
Finestra di montaggio

LINK CORRELATI

Area dei controlli delle tracce stereo e mono a pag. 192
Area dei controlli delle tracce video a pag. 194

Finestra di montaggio a pag. 190

Area dei controlli delle tracce stereo e mono

L'area dei controlli delle tracce stereo e mono consente ad esempio di attivare lo stato di Mute
e Solo per le tracce, aggiungere gli effetti delle tracce, specificare le opzioni di assegnazione,
monitorare il segnale in ingresso e abilitare (armare) le tracce alla registrazione.

Opzioni

L'area dei controlli delle tracce per le tracce mono e stereo

Opzioni dell’area dei controlli delle tracce

Nome della traccia

Consente di modificare il nome della traccia. Fare doppio-clic sul nome della traccia per
aprire la finestra di dialogo Nome della traccia nella quale & possibile immettere un
nome per la traccia.

Blocca
Disabilita tutte le forme di modifica sulla traccia.

Mute
Consente di mettere in mute la traccia.

Solo
Consente di riprodurre in solo la traccia.

Effetti

Consente di aprire il menu a tendina Effetti in cui € possibile selezionare gli effetti per
la traccia. Un'icona evidenziata indica che una traccia presenta degli effetti delle tracce.

Bus di ingresso/Assegnazione dei canali di uscita

Consente di selezionare il Bus di ingresso, 'Assegnazione dei canali di uscita e la
finestra di dialogo Assegnazione delle tracce. Quando si passa il puntatore del mouse
sopra il pulsante, una descrizione comando visualizza le opzioni di assegnazione
selezionate.

Ingresso audio
Consente di selezionare l'ingresso audio per la registrazione.
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Registra
Per poter eseguire una registrazione, & necessario abilitare alla registrazione (armare)
le tracce corrispondenti. Se si fa clic sulla freccia, sono disponibili le seguenti opzioni:

Proprieta del file per la registrazione: apre una finestra di dialogo che consente di
specificare il nome, la posizione e la risoluzione in bit del file audio che si intende
registrare.

Se l'opzione Arresta quando la posizione di registrazione raggiunge l'ultimo
marker ¢ attivata, la registrazione viene arrestata quando la posizione di registrazione
raggiunge l'ultimo marker visibile del montaggio. I marker nascosti non vengono
tenuti in considerazione. E possibile creare e spostare I'ultimo marker nel corso della
registrazione. Questa opzione € globale per tutti i montaggi audio.

Se l'opzione Arresta quando la posizione di registrazione raggiunge il marker
successivo ¢ attivata, la registrazione viene arrestata quando la posizione di
registrazione raggiunge il successivo marker visibile del montaggio. I marker nascosti
non vengono tenuti in considerazione. Questa opzione & globale per tutti i montaggi
audio.

Ducker attiv./disatt.
Consente di attivare o disattivare la funzione di ducking. E possibile selezionare
successivamente la traccia di voce modulatrice e regolare le impostazioni.

Sorgente
Apre il menu Tracce modulatrici che consente di selezionare la traccia da utilizzare per
il ducking.

Impostazioni del ducker

Apre il plug-in Ducker che consente di modificare le impostazioni di ducking per la
regolazione dell'effetto.

Modifica l'altezza di tutte le tracce

La parte inferiore-sinistra dell'area dei controlli delle tracce consente di modificare
I'altezza di tutte le tracce contemporaneamente. Fare clic e trascinamento per
modificare l'altezza.

Modifica I'altezza della traccia attiva

La parte inferiore-centrale dell'area dei controlli delle tracce consente di modificare
I'altezza della traccia attiva. Fare clic e trascinamento per modificare I'altezza.

Modifica I'altezza della traccia attiva e della traccia sotto

La parte inferiore-destra dell’area dei controlli delle tracce consente di modificare
I'altezza della traccia attiva e della traccia sotto. Fare clic e trascinamento per
modificare l'altezza.

Indicatore di picco delle tracce
L'indicatore di picco delle tracce mostra il livello del volume per le tracce audio. Questo
indicatore si trova sul lato destro dell'area dei controlli delle tracce.

Menu a tendina Traccia
Questo menu a tendina contiene tutte le opzioni relative alla traccia.

e Per aprire il menu a tendina Traccia, fare clic-destro nell'area dei controlli della traccia.

Aggiungi una traccia
Aggiunge una traccia sotto la traccia attiva.
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Suddividi in tracce mono sinistra/destra

Consente di convertire la traccia stereo in due tracce mono che rappresentano i canali
sinistro e destro di una traccia stereo. Questa operazione non altera in alcun modo il
materiale audio.

Rimuovi la traccia
Consente di rimuovere la traccia attiva.

Visualizza i controlli di ducking
Attiva i controlli di ducking nell'area dei controlli delle tracce.
Menu Impostazioni delle tracce

e Per aprire il menu Impostazioni delle tracce, fare clic sulla freccia in giu nella parte
inferiore-centrale dell'area dei controlli delle tracce.

Zoom avanti

Mostra la traccia attiva all'altezza massima disponibile.

Zoom indietro
Visualizza il maggior numero di tracce possibile.

Sposta la traccia verso I'alto/Sposta la traccia verso il basso
Consente di spostare la traccia attiva verso l'alto o verso il basso.

Colore della traccia

Consente di aprire un sotto menu in cui & possibile selezionare un colore per la traccia
attiva.

LINK CORRELATI

Modalita supplementari per 'aggiunta degli effetti a pag. 258
Ducking delle tracce a pag. 243

Indicatore di picco delle tracce a pag. 196

Area dei controlli delle tracce a pag. 191

Finestra di dialogo Assegnazione delle tracce a pag. 222

Area dei controlli delle tracce video

L'area dei controlli delle tracce video consente ad esempio di attivare/disattivare le miniature e
visualizzare/nascondere i numeri dei fotogrammi del video. Sotto la traccia video, la traccia audio
corrispondente presenta le stesse opzioni delle tracce mono e stereo.
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Opzioni

Nome della traccia
Consente di modificare il nome della traccia. Fare doppio-clic sul nome della traccia per
aprire la finestra di dialogo Nome della traccia nella quale € possibile immettere un
nome per la traccia.

Blocca
Disabilita tutte le forme di modifica sulla traccia.

Visualizza le miniature
Consente di attivare/disattivare le miniature della traccia video.

Visualizza i numeri dei fotogrammi
Consente di visualizzare ciascuna miniatura con il numero di fotogramma video
corrispondente.

Modifica I'altezza di tutte le tracce

La parte inferiore-sinistra dell'area dei controlli delle tracce consente di modificare
I'altezza di tutte le tracce contemporaneamente. Fare clic e trascinamento per
modificare l'altezza.

Modifica l'altezza della traccia attiva

La parte inferiore-centrale dell'area dei controlli delle tracce consente di modificare
I'altezza della traccia attiva. Fare clic e trascinamento per modificare l'altezza.

Modifica I'altezza della traccia attiva e della traccia sotto

La parte inferiore-destra dell'area dei controlli delle tracce consente di modificare
I'altezza della traccia attiva e della traccia sotto. Fare clic e trascinamento per
modificare l'altezza.

Menu a tendina Traccia
Questo menu a tendina contiene tutte le opzioni relative alla traccia.

e Per aprire il menu a tendina Traccia, fare clic-destro nell'area dei controlli della traccia.

Aggiungi una traccia
Consente di aggiungere una traccia sotto la traccia attiva.

Rimuovi la traccia
Consente di eliminare la traccia attiva.

Menu Impostazioni delle tracce

e Per aprire il menu Impostazioni delle tracce, fare clic sulla freccia in giu nella parte
inferiore-centrale dell'area dei controlli delle tracce.
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Zoom avanti
Mostra la traccia attiva all'altezza massima disponibile.

Zoom indietro
Visualizza il maggior numero di tracce possibile.

Sposta la traccia verso l'alto/Sposta la traccia verso il basso
Consente di spostare la traccia attiva verso l'alto o verso il basso.

LINK CORRELATI
Area dei controlli delle tracce stereo e mono a pag. 192
Area dei controlli delle tracce a pag. 191

Indicatore di picco delle tracce

L'indicatore di picco delle tracce visualizza il livello del volume per il canale sinistro e destro delle
tracce stereo. Questo indicatore si trova nel lato destro dell'area dei controlli delle tracce nella
finestra Montaggio audio.

L'indicatore di picco delle tracce offre una panoramica di quali tracce stanno riproducendo l'audio
e a quale livello approssimativo. La barra di sinistra mostra il livello del volume del canale stereo
sinistro, mentre la barra di destra mostra il livello del volume del canale stereo destro.

LINK CORRELATI
Area dei controlli delle tracce stereo e mono a pag. 192

Schede del montaggio audio

Le diverse schede disponibili nella finestra Montaggio audio offrono 'accesso a una serie

di strumenti di utility e opzioni per la modifica dei montaggi audio. Ad esempio, e possibile
modificare le curve di inviluppo e le dissolvenze nelle clip, definire delle impostazioni di zoom,
analizzare I'audio e renderizzare il montaggio audio.
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Scheda Visualizza (Montaggio audio)

W FILE

© VIEW

e Nel Montaggio audio fare clic su Visualizza.

€ enit & INSERT / FADE [\ ENVELOPE 5 RENDER

144 Bbl 8 144 Bbl

b2 S I

Naviga

Indietro/Avanti

Consente di navigare fino alla posizione del cursore, al fattore di zoom e all'intervallo di
selezione precedenti/successivi.

Ingrandimento

Ingrandimento

Attiva lo strumento Ingrandimento che consente di definire un intervallo temporale
sul quale viene eseguito uno zoom.

Tempo
Apre un menu a tendina che consente di regolare il fattore di zoom in modo da
visualizzare l'intervallo temporale selezionato. L'opzione Ingrandimento 1:1 consente
di impostare il fattore di ingrandimento in modo tale che un pixel sullo schermo
rappresenti un campione.

Per modificare il fattore di ingrandimento, fare clic su Modifica il fattore di
ingrandimento. Si apre cosi la finestra di dialogo Fattore di ingrandimento, in cui
é possibile modificare le seguenti impostazioni:

e L'opzione Definisci intervallo temporale consente di specificare l'intervallo
temporale da visualizzare.

e L'opzione Campioni per pixel consente di specificare il numero di campioni audio
rappresentati da ciascun pixel.

e L'opzione Pixel per campione consente di specificare il numero di pixel utilizzati
per rappresentare un singolo campione audio.

Ingrandisci la selezione

Consente di ingrandire la finestra in modo che la selezione corrente occupi I'intera
finestra del montaggio.

Microscopio
Consente di aumentare al massimo l'ingrandimento.

Visualizza tutto
Consente di ridurre al minimo l'ingrandimento.

Visualizza l'intera clip
Consente di regolare la vista per la visualizzazione della clip attiva.

Aumenta lI'ingrandimento dell’audio (10 x)/Riduci I'ingrandimento dell'audio (10 x)
Consente di aumentare/ridurre l'ingrandimento per grandi incrementi.

Ingrandisci I'audio/Riduci I'ingrandimento dell'audio
Consente di aumentare/ridurre l'ingrandimento per piccoli incrementi.
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Ingrandimento verticale/Riduzione ingrandimento verticale
Consente di aumentare/ridurre I'ingrandimento delle forme d'onda con un livello pit
basso/alto.

Livello
Consente di regolare il fattore di ingrandimento per visualizzare solo i campioni sotto
al valore in dB selezionato.

Riporta lo zoom a 0 dB

Consente di regolare il fattore di ingrandimento in modo da visualizzare i livelli audio
finoa 0 dB.

Cursore

Sposta il cursore all'inizio del file/Sposta il cursore alla fine del file
Consente di spostare la posizione del cursore all'inizio/alla fine del file.

Marker precedente/Marker successivo
Consente di spostare il cursore al marker precedente/successivo.

Inizio della selezione/fine della selezione

Consente di spostare la posizione del cursore all'inizio/alla fine dell'intervallo temporale
selezionato.

Bordo della regione precedente/Bordo della regione successiva
Consente di spostare il cursore al bordo della regione precedente/successiva.

Posizione del cursore di modifica

Consente di aprire la finestra di dialogo Posizione cursore in cui € possibile modificare
la posizione del cursore.

Bordo della clip precedente/Bordo della clip successiva
Consente di spostare il cursore al bordo della clip precedente/successiva.

Scorrimento

Inizio/Fine
Visualizza l'inizio/la fine dell'audio senza spostare il cursore.

Inizio della selezione/fine della selezione
Visualizza l'inizio/la fine della selezione audio senza spostare il cursore.

Cursore
Visualizza la posizione del cursore.

Riproduzione

Vista statica
Disattiva lo scorrimento.

La vista segue il cursore
Scorre in automatico la vista in modo da mantenere visibile il cursore di riproduzione.

Scorri vista

La vista scorre automaticamente in modo da mantenere centrato il cursore di
riproduzione.
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Clip
Color
Consente di applicare un colore alla clip attiva.

Tracce

Visualizza piu tracce/Visualizza meno tracce

Consente di modificare il numero di tracce che vengono visualizzate nella finestra di
montaggio.

Focalizza sulla traccia precedente/Focalizza sulla traccia successiva
Imposta il focus sulla traccia precedente/successiva.

LINK CORRELATI
Schede del montaggio audio a pag. 196

Scheda Modifica (Montaggio audio)

e Nel Montaggio audio fare clic su Modifica.

WHAE ©VEW € EDIT & INSERT  FADE [\ ENVELOPE 3 RENDER

Sorgente

Modifica la sorgente
Apre il file audio sorgente della clip nellEditor audio.

Modifica il progetto di Cubase
Apre il progetto di Cubase relativo alla clip.

Appunti

Taglia
Consente di tagliare l'intervallo audio selezionato e di posizionarlo negli appunti.

Copia
Consente di copiare la clip attiva o l'intervallo audio selezionato e di posizionarli negli
appunti.

Incolla
Incolla il contenuto degli appunti.

Suddividi

Dividi alle parti silenziose
Consente di dividere il file in modo che ciascuna sezione non silenziosa diventi una
regione separata. Se si seleziona questa opzione, & possibile specificare la durata
minima della regione, la durata minima di una sezione silenziosa e il livello del segnale
da considerare come silenzio.
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Rimozione

Elimina la clip selezionata/Elimina l'intervallo selezionato

Consente di eliminare la parte della clip che si trova all'interno dell'intervallo di
selezione nella traccia attiva e sposta la sezione destra della clip verso sinistra per
riempire lo spazio vuoto.

Se non é selezionato alcun intervallo, le clip selezionate vengono eliminate.

Ripercussione

Nessuno
Disattiva la funzione di spostamento automatico.

Traccia

Se questa opzione € attivata e si sposta orizzontalmente una clip, vengono spostate
anche tutte le clip nella traccia attiva che si trovano a destra della clip modificata.
Questa funzione si applica anche in caso di spostamento o ridimensionamento delle
clip e quando viene inserita o incollata piu di una clip contemporaneamente.

Globale

Se questa opzione € attivata e si sposta orizzontalmente una clip, vengono spostate
anche tutte le clip su tutte le tracce che si trovano a destra della clip modificata. Questa
opzione viene presa in considerazione in caso di spostamento o ridimensionamento
delle clip e quando viene inserita o incollata piu di una clip nello stesso momento.

Allineamento

Scatta verso le calamite
Se questa opzione ¢ attivata, gli elementi spostati, come ad esempio i bordi delle clip,
i bordi della selezione temporale, il cursore e i marker scattano verso gli elementi
magnetici che sono attivati nel menu a tendina Calamite.

Calamite
Questo menu a tendina consente di definire quali elementi sono magnetici.

Clip

Modalita 'il video segue le modifiche'
Se questa opzione € attivata, il video nella finestra Video seque automaticamente ogni
modifica apportata. Questo consente di vedere in maniera istantanea la posizione nel
video in cui & in corso l'operazione di modifica.

Mute
Consente di mettere in mute la clip attiva.

Cue-point

Questo menu a tendina consente di regolare una serie di impostazioni relative ai
cue-point.

e L'opzione Imposta al cursore consente di impostare il cue-point in una posizione
fissa dall'inizio della clip.

e L'opzione Imposta alla posizione dello spazio vuoto predefinito consente di
impostare il cue-point due secondi prima dell'inizio della clip.

e L'opzione Segue il punto di fine del fade-in consente di impostare il cue-point in
corrispondenza del punto di fine del fade-in.
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e L'opzione Segue il punto di inizio del fade-out consente di impostare il cue-point
in corrispondenza del punto di inizio del fade-out.

e Sel'opzione Cue-point di fine personalizzato ¢é attivata, € possibile impostare il
cue-point di fine in corrispondenza di una posizione personalizzata rispetto alla
fine della clip. Questa opzione consente di modificare singolarmente lo spazio
vuoto per ciascuna clip.

Se questa opzione e disattivata, viene utilizzato uno spazio predefinito di due
secondi.

e L'opzione Offset della fine apre la finestra di dialogo Offset del cue-point di fine
in cui & possibile impostare il cue-point di fine in una posizione personalizzata
rispetto alla fine della clip.

LINK CORRELATI
Modifica dei file sorgente delle clip a pag. 236
Clip e cue-point a pag. 235

Scheda Inserisci (Montaggio audio)

e Nel Montaggio audio fare clic su Inserisci.

WHAE ©O©VIEW € T & INSERT  FADE [\ ENVELOPE 3 RENDER

v

Marker

Nome del marker
Consente di inserire il nome del marker di inizio. Se non viene inserito alcun nome,
viene usato un nome generico.

Per modificare i nomi predefiniti, aprire la finestra Marker e selezionare Funzioni >
Nomi dei marker predefiniti.

Nome diverso per il marker di fine
Se questa opzione € attivata, € possibile inserire un nome diverso per il marker di fine
nel campo Nome del marker di fine.

Se é disattivata, il nome sara identico a quello del marker di inizio.

Crea/Assegna nome a marker
Il pulsante Crea/Assegna nome a marker nell'angolo inferiore-destro della sezione
Marker consente di aprire la finestra di dialogo Crea marker. Questo consente di
creare marker e coppie di marker in corrispondenza della posizione del cursore di
modifica.

& INSERT 7 FADE [\ ENVEL

Create/Name Marker
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Importa

File audio

Consente di selezionare uno o piu file audio da inserire in corrispondenza della
posizione del cursore di modifica nella traccia attiva.

File video

Consente di selezionare un file video da inserire in corrispondenza della posizione del
cursore di modifica nella traccia video. Se il montaggio audio non contiene una traccia
video, ne viene creata una.

Scheda Dissolvenza (Montaggio audio)

e Nel Montaggio audio fare clic su Processa.

WFALEE ©VIEW € EDIT & INSERT DE [\ ENVELOPE 2 RENDER

20 ms - /™ Free Qverlaps

fault Fades in N

Modifica

Fade-in/Fade-out
Consentono di alternare le impostazioni di fade-in e di fade-out.

Ingrandimento

Zoom sull'intervallo della dissolvenza

Consente di regolare la vista in modo da visualizzare la parte del fade-in/fade-out della
clip attiva.

Forma

Tipi di curva
Consentono di selezionare dei preset per le curve di dissolvenza.

e L'opzione Lineare consente di modificare il livello in maniera lineare.

e L'opzione Seno (*) consente di modificare il livello in base a una curva di
seno. Quando questa impostazione viene utilizzata in una dissolvenza incrociata,
I'intensita acustica (RMS) rimane costante durante la transizione.

e L'opzione Radice quadrata (*) consente di modificare il livello in base a una
curva della radice quadrata. Quando questa impostazione viene utilizzata in
una dissolvenza incrociata, l'intensita acustica (RMS) rimane costante durante la
transizione.

e L'opzione Sinusoidale consente di modificare il livello in base a una curva
sinusoidale.

e L'opzione Logaritmico consente di modificare il livello in base a una curva
logaritmica.

e L'opzione Esponenziale consente di modificare il livello in base a una curva
esponenziale.

e |'opzione Esponenziale+ consente di modificare il livello in base a una curva
esponenziale piu pronunciata.
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Tempo

Tempo di dissolvenza
Consente di specificare un tempo di fade-in/fade-out per la clip.

Applica i tempi di dissolvenza
Consente di applicare i tempi di fade-in/fade-out della clip specificati.

Opzioni

Sovrapposizioni
Questo menu a tendina consente di impostare il comportamento di esecuzione
automatica delle dissolvenze incrociate.

e Sel'opzione Nessuna dissolvenza incrociata automatica é attivata, non vengono
eseguite dissolvenze incrociate automatiche quando le clip si sovrappongono.

e Sel'opzione Sovrapposizioni libere ¢ attivata, vengono create delle dissolvenze
incrociate automatiche quando una clip si sovrappone a un‘altra clip sulla
stessa traccia. La lunghezza della sovrapposizione determina la lunghezza della
dissolvenza incrociata.

Crea delle dissolvenze predefinite nelle nuove clip

Se viene attivata questa opzione, tutte le nuove clip otterranno la lunghezza e la forma
di fade-in e fade-out predefinite. Per le clip che vengono create tramite divisione di una
clip, viene utilizzata solo la durata delle dissolvenze predefinite.

LINK CORRELATI
Schede del montaggio audio a pag. 196

Scheda Inviluppo (Montaggio audio)

e Nel Montaggio audio fare clic su Inviluppo.

WHAE ©VIEW € T & INSERT / FADE [\ ENVELOPE 3 RENDER

Pan
Constant Power (+3 dB | -)

VISIBILTY

Selettore

Tipo di inviluppo
Consente di impostare il tipo di inviluppo. A seconda del tipo selezionato, sono
disponibili diverse opzioni. Sono disponibili le seguenti opzioni:
e Nascondi tutto nasconde tutti gli inviluppi.

e Volume/Dissolvenze visualizza solamente l'inviluppo del volume/delle
dissolvenze.

e Panorama visualizza solamente l'inviluppo del panorama. Nel menu sotto, &
possibile selezionare una legge di ripartizione stereo.
Legge del pan-pot
Consente di selezionare una legge di ripartizione stereo. Questa opzione ¢ disponibile

solamente se & selezionato Panorama come tipo di inviluppo. Sono disponibili le
seguenti leggi di ripartizione stereo:

e Attenuazione del canale (0 dB/mute)
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e Potenza costante (+3 dB/mute)
e Enfatizzazione del canale (+4,5 dB/mute)

e Enfatizzazione del canale (+6 dB/mute)

Ingrandimento

Zoom sull'intervallo dell'inviluppo
Consente di regolare la vista per la visualizzazione dell'inviluppo attivo della clip attiva.

Livello

Reinizializza tutto
Consente di riportare l'inviluppo alla sua forma neutrale.

Limitaa 0dB

Consente di sostituire i segmenti tra i punti di fade-in e fade-out con un segmento
singolo neutrale.

Ducking

Consente di visualizzare la finestra di dialogo Impostazioni di ducking. Questa
finestra di dialogo consente di creare degli effetti di ducking tra le clip su due tracce
adiacenti in cui il livello o l'effetto in mandata di una clip vengono modificati ogni volta
che nellaltra traccia sono presenti delle clip.

Metti in mute la selezione
Aggiunge dei punti di inviluppo del livello e crea una curva per mettere in mute la
selezione portando il livello a zero con tempi di caduta e risalita predefiniti di 20 ms.
Alza la selezione

Aggiunge dei punti di inviluppo del livello e crea una curva per aumentare il livello
audio della selezione con tempi di caduta e risalita di 20 ms. E possibile trascinare il
segmento creato verso l'alto e verso il basso per regolare il livello.

LINK CORRELATI

Inviluppi per le clip a pag. 237

Schede del montaggio audio a pag. 196
Leggi di ripartizione stereo a pag. 242

Scheda Renderizza (Montaggio audio)

La scheda Renderizza consente di eseguire un mix down dei montaggi audio verso dei file audio.

e Nel Montaggio audio fare clic su Renderizza.

WwrAE O©ViEw € epim & INSERT / FADE [\ ENVELOPE =S RENDER

Name | Audio 1|

Whole Montage

Sorgente

Menu a tendina Sorgente

Il menu a tendina Sorgente consente di selezionare quale parte del montaggio audio
processare. Sono disponibili le sequenti opzioni:
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Montaggio intero
Consente di processare e renderizzare l'intero intervallo audio.

Traccia attiva

Processa e renderizza la traccia attiva, dall'inizio della prima clip fino alla fine dell'ultima
clip. Le clip in mute non vengono renderizzate.

Regione contrassegnata specifica
Consente di processare e renderizzare in un file indipendente un intervallo audio
specifico.
Specificare la regione da processare nel menu a tendina.

Risultato

cD
Consente di scrivere un CD a partire dal montaggio audio.

File senza nome
Se questa opzione € attivata, viene renderizzato un file temporaneo senza nome.

File con nome
Se questa opzione € attivata, € possibile specificare un nome per il file renderizzato.

Uscita

Nome

Consente di inserire un nome per il file renderizzato. Facendo clic sull'icona a freccia, si
apre un menu a tendina che offre numerose opzioni per l'assegnazione automatica dei
nomi.

Posizione
Consente di selezionare una cartella di destinazione per i file renderizzati.

Formato
Apre un menu a tendina in cui e possibile selezionare un formato file.

Opzioni
A seconda della sorgente selezionata, sono disponibili diverse opzioni.

Bypass della Sezione Master

Se questa opzione € attivata, i plug-in e il guadagno della Sezione Master vengono
bypassati durante la renderizzazione.

Aggiungi una coda del riverbero
Se questa opzione € attivata, la coda nell'audio prodotta da effetti come il riverbero
non viene inclusa nel file renderizzato.
Alcuni plug-in non sono in grado di trasferire a WavelLab Elements le informazioni
relative alla durata della coda. In tal caso, questa opzione non produce alcun effetto.
Per tali plug-in, & possibile aggiungere il plug-in Silence per inserire dei campioni extra
alla fine del file.

Copia marker

Se questa opzione € attivata, i marker che sono inclusi nell'intervallo da processare
vengono copiati nel file renderizzato.
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Apri il file audio risultante

Se questa opzione € attivata, ciascun file renderizzato viene aperto in una nuova
finestra.

Bypassa la Sezione Master per il file audio risultante

Se questa opzione € attivata, la riproduzione del file audio risultante bypassa l'intera
Sezione Master. Questa impostazione puo essere attivata facendo clic sul pulsante che
si trova in basso a destra nella finestra della forma d'onda o di montaggio.

NOTA

Si raccomanda di attivare questa opzione, poiché in tal modo non si corre il rischio di
monitorare i nuovi file attraverso gli effetti che sono gia stati applicati ai file stessi.

Renderizza

Avvia

Awvia il processo di renderizzazione.

LINK CORRELATI
Schede del montaggio audio a pag. 196
Scheda Renderizza per la Sezione Master a pag. 300

Percorso del segnale nel montaggio audio

Il segnale audio passa attraverso le diverse sezioni di WaveLab Elements in un determinato

modo.

1. Vengono letti i campioni audio.

2. Inviluppo delle clip

3. Effetto delle clip

4. Panorama delle clip

5. Guadagno individuale delle clip (finestra CD)

6. Leclip sono mixate nello slot della traccia (ad esempio, clip sovrapposte).
7. Effetti della traccia

8. Impostazioni del livello della traccia

9. Ognitraccia viene mixata in un bus stereo.

-
e

11.

Il canale stereo viene processato mediante i plug-in dell'uscita del montaggio.

Il bus stereo viene inviato all'ingresso della Sezione Master.

Percorso del segnale nella Sezione Master

LA

I canali/la frequenza di campionamento possono cambiare in ciascuno slot del plug-in.
Indicatori della Sezione Master

Pannello Effetto di finalizzazione/Dithering nella Sezione Master

Indicatori audio indipendenti

Riproduzione o renderizzazione del formato file
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Creazione dei montaggi audio

E possibile creare dei nuovi montaggi audio vuoti dotati di proprieta personalizzate.

PROCEDIMENTO

1. Selezionare File > Nuovo.

2. Selezionare Montaggio audio > Personalizzato.

3. Specificare la frequenza di campionamento del montaggio audio.
4. Fareclicsu Crea.

RISULTATO

Il montaggio audio viene creato.

LINK CORRELATI
Proprieta del montaggio audio a pag. 209
Creazione di montaggi audio da un file audio a pag. 207

Creazione di montaggi audio da un file audio

E possibile creare un montaggio audio a partire da un file audio o da una selezione temporale in
un file audio.

PROCEDIMENTO

1.

Nell'Editor audio, aprire il file audio a partire dal quale si desidera creare un nuovo
montaggio audio.

2. Facoltativo: se si desidera aprire una specifica parte del file audio in un nuovo montaggio
audio, definire una selezione temporale nel file audio.
3. Fare clic-destro sulla scheda del file audio.
4. Selezionare Crea un montaggio audio > Dal file audio corrente.
5. Nella finestra di dialogo Crea un montaggio audio da un file audio, eseguire una delle
seguenti operazioni:
e Per aprireil file audio in un nuovo montaggio audio, selezionare File intero.
e Per aprire in un nuovo montaggio audio la selezione temporale definita nel file audio,
selezionare Selezione temporale corrente.
6. Facoltativo: eseguire una delle sequenti operazioni:
e Perimportare i marker del file audio nel nuovo montaggio audio, attivare I'opzione
Importa i marker.
e Perdividere il file audio in corrispondenza dei marker delle regioni generici, attivare
l'opzione Dividi ai marker delle regioni generici.
7. Fareclic su OK.
RISULTATO

Il file audio si apre in un nuovo montaggio audio.

LINK CORRELATI
Finestra di dialogo Crea un montaggio audio da un file audio a pag. 208

207



Montaggio audio
Creazione dei montaggi audio

Finestra di dialogo Crea un montaggio audio da un file audio

In questa finestra di dialogo € possibile specificare se aprire il file audio o una selezione
temporale all'interno di un file audio sotto forma di un nuovo montaggio audio. E anche possibile
specificare se importare i marker nel nuovo montaggio audio ed eseguire una suddivisione in
corrispondenza di determinati marker.

Per aprire la finestra di dialogo Crea un montaggio audio da un file audio, eseguire una delle
seguenti operazioni:

e Fare clic-destro sulla scheda di un file audio e selezionare Crea un montaggio audio > Dal
file audio corrente.

e Aprire un file audio nell’Editor audio, selezionare File > Nuovo > Dal file corrente,
selezionare Dal file audio corrente e fare clic su Crea.

I Create Audio Montage from Audio File X

Import

© Whole File

File intero
Se questa opzione € attivata, il file audio viene aperto in un nuovo montaggio audio.

Selezione temporale corrente

Se questa opzione € attivata, la selezione temporale definita nel file audio viene aperta
in un nuovo montaggio audio.

Importa i marker

Se questa opzione € attivata, i marker all'interno del file audio vengono importati nel
nuovo montaggio audio.

Dividi ai marker di una regione generica

Se questa opzione ¢ attivata e il file audio contiene dei marker delle regioni generici,
il file viene suddiviso in corrispondenza delle posizioni dei marker quando viene
importato in un nuovo montaggio audio. L'audio al di fuori dei bordi dei marker viene
rimosso.

LINK CORRELATI
Creazione di montaggi audio da un file audio a pag. 207

Modalita alternative di creazione di nuovi montaggi audio
Sono disponibili diversi modi per creare un nuovo montaggio audio.

e Importando delle tracce CD audio in un montaggio audio
e Convertendo dei file wave in un montaggio audio
e Duplicando dei montaggi audio

e Premendo Ctrl/Opt e trascinando una scheda di un montaggio nella barra delle schede

LINK CORRELATI
Duplicati dei montaggi audio a pag. 209
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Duplicati dei montaggi audio

E possibile duplicare i montaggi audio in vari modi. Questa funzionalita consente di creare
rapidamente dei nuovi montaggi audio utilizzando le stesse proprieta e gli stessi file audio dei
montaggi audio precedentemente creati.

Sono disponibili le sequenti varianti dei duplicati dei montaggi audio:

Vuoto (con le stesse proprieta)

Crea un nuovo montaggio audio con le impostazioni dei canali e la frequenza di
campionamento del montaggio audio originale, senza alcuna clip.

Duplicato esatto (usando gli stessi file audio)
Crea un duplicato esatto del montaggio audio originale e consente alle nuove clip di
fare riferimento ai file audio originali. Il montaggio audio duplicato utilizza le stesse
impostazioni dei canali e la stessa frequenza di campionamento del montaggio audio
originale.
Questa funzione é utile se si desidera creare diverse versioni del montaggio audio,
ad esempio per provare differenti variazioni. Tuttavia, eventuali modifiche o processi
applicati ai file audio veri e propri si rifletteranno in tutti i montaggi audio.
E anche possibile premere Ctrl/Cmd, trascinare una scheda e rilasciarla sulla barra
delle schede per creare un duplicato esatto di un montaggio audio.

LINK CORRELATI
Duplicazione dei montaggi audio a pag. 209

Duplicazione dei montaggi audio

PROCEDIMENTO

1. Aprire il montaggio audio che si desidera duplicare.

2. Nella finestra Montaggio audio, selezionare la scheda File.

3. Selezionare Nuovo > Montaggio audio > Dal file corrente.

4. Nella sezione Dal montaggio audio corrente, selezionare una delle seguenti opzioni:
e Vuoto (con le stesse proprieta)
e Duplicato esatto (usando gli stessi file audio)

5. Fare clic su Crea.

RISULTATO
Un duplicato del montaggio audio si apre in una nuova scheda.

LINK CORRELATI
Duplicati dei montaggi audio a pag. 209

Proprieta del montaggio audio

Nelle Proprieta del montaggio audio € possibile definire la configurazione dei canali (mono,
stereo, surround, Ambisonics) e la frequenza di campionamento del montaggio audio.

Per aprire le impostazioni relative alla frequenza di campionamento per il montaggio audio
selezionato, eseguire una delle seqguenti operazioni:
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Selezionare la scheda File e fare clic su Info.

Fare clic sul pulsante Proprieta del montaggio audio nella parte inferiore-destra della
finestra del montaggio. Si apre in tal modo la finestra di dialogo Proprieta del montaggio
audio.

Nelle Proprieta del montaggio audio ¢ possibile specificare le sequenti impostazioni per il
montaggio audio selezionato:

Modalita

Consente di selezionare le seguenti modalita dei canali per il montaggio audio.
e Mono
e Stereo

e Surround

e Ambisonics

Canali

Consente di definire il numero di canali audio e la relativa configurazione all'uscita del
montaggio audio. Questa funzionalita & disponibile solamente in modalita Surround e
Ambisonics.

Frequenza di campionamento

Consente di selezionare la frequenza di campionamento per il montaggio audio.

Modifica della frequenza di campionamento dei montaggi audio

E possibile modificare la configurazione dei canali dei montaggi audio nella finestra di dialogo
Frequenza di campionamento.

PROCEDIMENTO

1. Nella parte inferiore-destra della finestra del montaggio, fare clic sul pulsante Proprieta del
montaggio audio.

2. Nella finestra di dialogo Frequenza di campionamento, selezionare una nuova frequenza di
campionamento.

3. Fareclicsu OK.

LINK CORRELATI

Proprieta del montaggio audio a pag. 209

Opzioni di importazione per i montaggi audio

E possibile importare file audio, file video e tracce CD audio nel proprio montaggio audio.

Le seguenti opzioni di importazione sono disponibili nella sezione Importa della scheda
Inserisci all'interno della finestra Montaggio audio:

Per importare dei file audio, fare clic su File audio e selezionare i file audio da importare in
corrispondenza della posizione del cursore di modifica sulla traccia attiva.

Se si importa un singolo file audio, si apre il menu a tendina Incolla. In questo menu &
possibile specificare il modo in cui la clip deve essere inserita, decidere se 'operazione ha
effetto sulle clip esistenti, ecc.

Se si importano piu file audio, si apre la finestra di dialogo Inserisci i file audio. In questa
finestra & possibile specificare dove inserire i file.
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e Perimportare dei file video, fare clic su File video e selezionare il file video da importare
in corrispondenza della posizione del cursore di modifica nella traccia video. Se non &
disponibile alcuna traccia video, ne viene creata una.

Per avere accesso alle seguenti opzioni di importazione, selezionare File > Importa.

e Perimportare dei file audio, fare clic su Aggiungi file al montaggio, selezionare i file audio
da importare e fare clic su Importa.

e Per aprire i file audio che presentano un formato sconosciuto, fare clic su Audio
sconosciuto. Attraverso la finestra di dialogo Formato file speciale, & possibile specificare
la modalita di interpretazione del formato file audio che si desidera aprire.

e Perimportare delle tracce CD da un CD audio, fare clic su CD audio. Tramite la finestra di
dialogo Importa CD audio, scegliere |le tracce CD da estrarre.

LINK CORRELATI
Frequenze di campionamento non conformi durante l'inserimento di file audio a pag. 219
Finestra di dialogo Formato file speciale a pag. 144

Riferimenti non validi ai file audio

Un montaggio audio & costituito da dei riferimenti a uno o piu file audio. Questi riferimenti
possono risultare non validi se si spostano ad esempio i file audio in un‘altra posizione sull'hard
disk. WaveLab Elements individua i riferimenti non validi e consente di specificare delle nuove
posizioni file o di sostituire il file audio mancante con un altro file audio.

LINK CORRELATI
Riparazione dei riferimenti non validi ai file audio a pag. 211
Finestra di dialogo File mancanti a pag. 212

Riparazione dei riferimenti non validi ai file audio

Quando si apre un montaggio audio contenente dei riferimenti non validi ai file audio, si apre
automaticamente la finestra di dialogo File mancanti.

PROCEDIMENTO

1. Nella finestra di dialogo File mancanti, selezionare i riferimenti ai file audio mancanti che si
intende riparare.

2. Nel campo Dove cercare, specificare la posizione file del nuovo riferimento al file audio.

3. Facoltativo: attivare l'opzione Cerca nelle sotto-cartelle per includere le sotto cartelle nella
ricerca.

4. Eseguire una delle seguenti operazioni:

e Perfarein modo che WavelLab Elements cerchi automaticamente i file audio aventi lo
stesso nome dei file mancanti, fare clic su Trova i file che hanno lo stesso nome.

Nel campo Seleziona un sostituto, selezionare i nuovi riferimenti ai file audio e fare clic
su OK.

e Per selezionare i file audio per la sostituzione dei file mancanti, fare clic su Sostituisci i
file selezionati con, selezionare i nuovi file e fare clic su Apri.

LINK CORRELATI
Finestra di dialogo File mancanti a pag. 212
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Finestra di dialogo File mancanti

Questa finestra di dialogo viene visualizzata quando, all'apertura di un montaggio audio, alcuni
file audio a cui esso fa riferimento non possono essere individuati. E possibile cercare i file o
selezionare dei sostituti.

I Missing Files in C:\Wavelab\Audic\Track A.mon *

Missing original files, select one or more Select All
File Name Original Path erties
Tr \ b\Audio 1 kHz
Tre T kHz
Trz i

ch Sub-Fo
a

Select a Replacement

File Name Properties

X Abort

File di origine mancanti

Sono qui elencati i file che non e possibile individuare. Ogni file pud essere sostituito da
un file esistente. Per cercare sostituti a piu file, selezionare i file e specificare un nuovo
percorso nel campo Dove cercare.

Un file con un segno di spunta verde € associato a un sostituto valido. Un file con un
segno di spunta rosso non € ancora associato a un sostituto valido, ma sono disponibili
possibili sostituti nella parte inferiore di questa finestra di dialogo.

Trova i file che hanno lo stesso nome
Questa opzione consente a WavelLab Elements di individuare tutti i file con lo stesso
nome nella cartella specificata nel campo Dove cercare.

Sostituisci i file selezionati con
Consente di sostituire i file mancanti con un singolo file specifico.

Reinizializza
Consente di rimuovere tutti i possibili sostituti dei file mancanti selezionati.

Dove cercare
Consente di specificare una posizione di ricerca dei file. Fare clic su Trova i file che
hanno lo stesso nome per avviare la ricerca.

Elenco dei sostituti

Consente di elencare i file che possono essere utilizzati come sostituti. E inoltre
possibile trascinare un file nell'elenco da Esplora file/macOS Finder.

Assemblaggio del montaggio audio

Il montaggio audio viene assemblato aggiungendo tracce e clip.
LINK CORRELATI

Tracce a pag. 213
Clip a pag. 215
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Tracce

Le tracce rappresentano la struttura utilizzata per organizzare le clip. E possibile aggiungere
tracce mono, tracce stereo e tracce video.

e Letracce mono e stereo consentono di aggiungere delle clip a un montaggio audio.

e Le tracce video consentono di aggiungere dei video a un montaggio audio.

LINK CORRELATI
Traccia video a pag. 364
Aggiunta di tracce a pag. 213

Aggiunta di tracce

E possibile aggiungere tracce stereo, tracce mono e tracce video.

PROCEDIMENTO
1. Eseguire una delle seguenti operazioni:

e Nellafinestra Montaggio audio, fare clic su + in cima all'area dei controlli delle tracce.

=
3

1
Add Track
=
Tell me more i

e Fare clic-destro nell'area dei controlli delle tracce per aprire il menu a tendina Traccia e
selezionare Aggiungi una traccia.

2. Selezionare il tipo di traccia che si desidera aggiungere al proprio montaggio audio.

LINK CORRELATI

Tracce a pag. 213

Area dei controlli delle tracce a pag. 191
Spostamento delle tracce nell’'elenco tracce

E possibile spostare le tracce verso l'alto o verso il basso nell'elenco tracce.

OPZIONI
e Nellafinestra Montaggio audio, selezionare una traccia e trascinarla verso I'alto o verso il
basso nell'elenco tracce.

e Infondo all'area dei controlli delle tracce, fare clic sulla freccia in giu e selezionare Sposta la
traccia verso l'alto o Sposta la traccia verso il basso.
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LINK CORRELATI
Tracce a pag. 213
Area dei controlli delle tracce a pag. 191

Ridimensionamento delle tracce

E possibile ridimensionare liberamente l'altezza e la larghezza delle tracce.

Sono disponibili diversi modi per ridimensionare l'altezza e la larghezza delle tracce, in base al
punto dell'area dei controlli di ciascuna traccia in cui si fa clic e trascinamento.

OPZIONI
e Per modificare I'altezza di tutte le tracce contemporaneamente, fare clic e trascinamento
sulla parte inferiore-sinistra dell'area dei controlli di una delle tracce.

e Per modificare I'altezza della traccia attiva, fare clic e trascinamento sulla parte inferiore-
centrale dell’'area dei controlli della traccia.

e Per modificare I'altezza della traccia attiva e della traccia sotto di essa in maniera
proporzionale, fare clic e trascinamento sulla parte inferiore-destra dell'area dei controlli
della traccia.

LINK CORRELATI
Tracce a pag. 213
Area dei controlli delle tracce a pag. 191

Rimozione di tracce

Rimuovere una traccia con clip provoca anche la rimozione delle clip. Tuttavia, i file audio a cui si
riferiscono le clip non vengono influenzati.

PROCEDIMENTO

e Fare clic-destro nell'area di controllo della traccia che si desidera rimuovere e fare clic su
Rimuovi la traccia.

LINK CORRELATI
Tracce a pag. 213
Area dei controlli delle tracce a pag. 191

Blocco e sblocco delle tracce

E possibile bloccare le tracce per impedirne lo spostamento, la modifica o I'eliminazione
accidentale.

e Per bloccare una traccia, fare clic sul pulsante Blocca della traccia nell'area di controllo.

e Per sbloccare una traccia, fare nuovamente clic sul pulsante Blocca.
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LINK CORRELATI
Tracce a pag. 213
Area dei controlli delle tracce a pag. 191

Suddividere le tracce stereo in tracce mono

E possibile suddividere le tracce stereo in tracce mono di tipo sinistra/destra o centrale/laterale.
Si tratta di una divisione virtuale che non influisce sui file audio né comporta la creazione di nuovi
file.

PROCEDIMENTO

e Nellafinestra Montaggio audio, fare clic-destro nell'area dei controlli della traccia che si
desidera dividere e selezionare Suddividi in tracce mono sinistra/destra.

RISULTATO

La traccia viene divisa. Se sono presenti delle clip nella traccia, i due lati stereo sono ora clip
separate ed e possibile spostarle e modificarle in maniera indipendente.

Le tracce mono vengono automaticamente raggruppate e possono essere spostate e
ridimensionate solo insieme.

LINK CORRELATI
Area dei controlli delle tracce a pag. 191

I file audio inseriti nei montaggi audio vengono rappresentati come clip. Una clip contiene un
riferimento a un file audio sorgente nell’hard disk, comprese le relative posizioni di inizio e di
fine nel file, curve del volume e del panorama, dissolvenze, ecc. Questo consente alle clip di
riprodurre piccole porzioni dei relativi file audio sorgente.

Un numero qualsiasi di clip pud fare riferimento allo stesso file sorgente. Poiché una clip fa
riferimento solo al file sorgente originale, non contiene dati audio. Un numero qualsiasi di clip
puo fare riferimento allo stesso file sorgente.

E inoltre possibile utilizzare inviluppi ed effetti sulle clip.

E possibile visualizzare le clip del montaggio audio attivo nella finestra CD.

3 clip in una traccia

LINK CORRELATI
Modifica delle clip a pag. 224

Inserimento di file audio nei montaggi audio

Quando si inseriscono dei file audio nei montaggi audio, i file audio sono rappresentati come
clip. I file audio possono essere inseriti nei montaggi audio in vari modi.
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LINK CORRELATI

Clip a pag. 215

Inserimento di file audio nei montaggi audio mediante trascinamento a pag. 216

Inserimento di file audio nei montaggi audio tramite il menu contestuale a pag. 216

Inserimento dei file audio nei montaggi audio utilizzando la funzione di copia e incolla a pag. 216
Inserimento di file audio nei montaggi audio tramite Esplora file/macOS Finder a pag. 217
Inserimento di file audio nei montaggi audio utilizzando la finestra del browser dei file a pag. 217
Inserimento delle regioni dei file audio nei montaggi audio mediante trascinamento a pag. 218
Inserimento dei file audio nei montaggi audio mediante copia da altri montaggi audio a pag. 218
Inserimento di file audio stereo in tracce mono o viceversa a pag. 218

Inserimento di file audio nei montaggi audio mediante trascinamento

E possibile trascinare un file audio o una sezione di un file audio dalla finestra della forma d'onda
alla finestra del montaggio per inserirli nel montaggio audio.

PROCEDIMENTO
1. Nella finestra della forma d'onda dell'Editor audio, eseguire una delle seguenti operazioni:
2. Esequire una delle sequenti operazioni:

e Per aggiungere il file audio intero nel montaggio audio, trascinare la scheda del file sulla
scheda di un montaggio audio e rilasciarla su una traccia.

e Per aggiungere una parte del file audio nel montaggio audio, selezionare la parte audio
che si intende aggiungere, trascinarla nella scheda del montaggio audio e rilasciarla su
una traccia.

RISULTATO
Viene creata una clip, il cui nome é relativo al file originale.

LINK CORRELATI
Finestra della forma d'onda a pag. 111
Finestra di montaggio a pag. 190

Inserimento di file audio nei montaggi audio tramite il menu contestuale

Il menu contestuale della finestra del montaggio consente di inserire dei file audio nei montaggi
audio.

PROCEDIMENTO
1. Nella finestra del montaggio, fare clic-destro su un‘area vuota di una traccia.

2. Nel menu a tendina, fare clic su Inserisci i file audio e selezionare il file audio che si
desidera inserire nella traccia.

RISULTATO
Viene creata una clip, il cui nome é relativo al file originale.

Inserimento dei file audio nei montaggi audio utilizzando la funzione di copia e
incolla

E possibile copiare e incollare un file audio o una sezione di un file audio dalla finestra della
forma d'onda alla finestra del montaggio per inserirli nel montaggio audio.
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PROCEDIMENTO

1. Nella finestra della forma d'onda dell’Editor audio, selezionare la sezione audio a cui si
desidera che la clip faccia riferimento.

2. Selezionare la scheda Modifica e fare clic su Copia, oppure premere Ctrl/Cmd-C.

3. Nella finestra del montaggio, selezionare la traccia nella quale si desidera inserire la clip.

La posizione di inserimento della clip & indicata dal cursore di modifica.

4. Selezionare la scheda Modifica e fare clic su Incolla, oppure premere Ctrl/Cmd-V.

RISULTATO
Viene creata una clip, il cui nome é relativo al file originale.

Inserimento di file audio nei montaggi audio tramite Esplora file/macOS Finder

E possibile copiare e incollare un file audio da Esplora file/macOS Finder alla finestra del
montaggio per inserirlo nel montaggio audio.

PROCEDIMENTO

1. In Esplora file/macOS Finder, selezionare un file audio e premere Ctrl/Cmd-C.

2. Nella finestra del montaggio, impostare il cursore di modifica alla posizione in cui si desidera
inserire la clip.

3. Selezionare la scheda Modifica e fare clic su Incolla, oppure premere Ctrl/Cmd-V.

RISULTATO
Viene creata una clip, il cui nome é relativo al file originale.

Inserimento di file audio nei montaggi audio utilizzando la finestra del browser

dei file

E possibile trascinare un file audio dalla finestra Browser dei file alla finestra del montaggio per
inserirlo nel montaggio audio.

NOTA

E inoltre possibile eseguire questa operazione in Esplora file/macQS Finder.

PROCEDIMENTO
1. Selezionare Finestre degli strumenti di utility > Browser dei file.

2. Nella finestra Browser dei file, selezionare i file audio ai quali si desidera che la clip faccia
riferimento, quindi trascinarli su una traccia.

RISULTATO
Viene creata una clip, il cui nome é relativo al file originale.

LINK CORRELATI
Finestra Browser dei file a pag. 65
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Inserimento delle regioni dei file audio nei montaggi audio mediante
trascinamento

Se in un file audio sono state definite delle regioni, & possibile trascinarle dalla finestra Browser
dei file a una traccia.

PROCEDIMENTO

1. Selezionare Finestre degli strumenti di utility > Browser dei file.

2. Nella finestra Browser dei file, selezionare il file audio da cui si desidera inserire le regioni
dei marker nel montaggio audio.

Nella parte destra della finestra Browser dei file, la sezione delle regioni audio mostra
le regioni dei marker del file selezionato. Questa sezione & nascosta per impostazione
predefinita. Per visualizzare la sezione delle regioni audio, selezionare un file audio
contenente i marker e fare clic su Visualizza le regioni audio.

This file contains audio regions

&l Show Audio Regions

3. Trascinare una qualsiasi regione nella traccia.

RISULTATO
Viene creata una clip, il cui nome & relativo al file originale.

LINK CORRELATI
Finestra Browser dei file a pag. 65

Inserimento dei file audio nei montaggi audio mediante copia da altri montaggi

audio

Se & stato aperto piu di un montaggio audio, € possibile eseguire la copia da un montaggio audio
a un altro, mediante trascinamento o copia e incolla.

PROCEDIMENTO

1. Inun montaggio audio, selezionare le clip che si intende inserire in un altro montaggio
audio.

2. Esequire una delle sequenti operazioni:

e Trascinare la clip sulla scheda di un altro montaggio audio e rilasciarla su una traccia.

e Fareclicsu Ctrl/Cmd-C. Aprire un altro montaggio audio e posizionare il cursore di
modifica alla posizione in cui si desidera inserire la clip. Fare clic su Ctrl/Cmd-V.

Inserimento di file audio stereo in tracce mono o viceversa

Quando si inserisce un file audio stereo in una traccia mono & possibile decidere di creare
automaticamente una traccia stereo o suddividere il file stereo in due tracce mono.
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Inserimento di file audio stereo in tracce mono

I Insert Audio File b

reo Track  Split on Mono Tracks X Cancel

Quando si inserisce un file audio stereo in una traccia mono, sono disponibili le seguenti opzioni
nella finestra di dialogo Inserisci file audio:

Crea una traccia stereo
Crea una traccia stereo e inserisce il file audio stereo.

Dividi sulle tracce mono

Suddivide il file audio stereo su due tracce mono. Se la traccia sotto la prima traccia &
gia una traccia mono, questa traccia viene utilizzata per il secondo file mono. Se non &
presente una seconda traccia mono, viene creata automaticamente una traccia mono.

Inserimento di file audio mono in tracce stereo

I Insert Audio File b

cannot b

Create Mono Track X Cancel

Quando si inserisce un file audio mono in una traccia stereo, & possibile selezionare I'opzione
Crea una traccia mono per creare automaticamente una traccia mono sotto la traccia stereo e
inserire qui il file audio mono.

LINK CORRELATI
Inserimento di file audio nei montaggi audio a pag. 215

Frequenze di campionamento non conformi durante l'inserimento di

file audio

Quando si inseriscono file audio con una frequenza di campionamento diversa dalle frequenze
di campionamento del montaggio audio, WavelLab Elements puo0 creare e riutilizzare versioni
ri-campionate dei file.

Le versioni ri-campionate dei file vengono create nella sotto cartella Data della cartella del
montaggio. Il nome del file & il nome del file originale con la nuova frequenza di campionamento
come suffisso. Se il file ri-campionato esiste gia, non viene ricreato. E inoltre possibile attivare
l'opzione Ricrea i file ri-campionati nella finestra di dialogo Frequenze di campionamento non
conformi.

Viene cosi creato un file a 32 bit a virgola mobile senza alcun processo di dithering.

LINK CORRELATI
Finestra di dialogo Frequenze di campionamento non conformi a pag. 219

Finestra di dialogo Frequenze di campionamento non conformi

Questa finestra di dialogo viene aperta quando si inserisce un file audio con una diversa
frequenza di campionamento rispetto alla frequenza di campionamento del montaggio audio.
Questo consente di creare una copia ricampionata del file audio.
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I Mismatched Sample Rates X
n the audio montage.

e of the audic montage: 22 050 Hz

Sample Rate Name

Recreate Resampled Files

W 0K X Cancel

Ricrea i file ricampionati
Se questa opzione ¢ attivata ed & disponibile un file ricampionato, viene ricreato. In
caso contrario, viene utilizzata la versione esistente. Attivare questa opzione se il file
audio originale é stato modificato e si desidera ricrearne la versione ricampionata.

Operazioni multicanale nel montaggio audio

Nei montaggi audio € possibile aprire i file audio multicanale. Ciascuna traccia di un file audio
multicanale & organizzata in cluster di canali. Un cluster di canali rappresenta un gruppo logico di
canali. Si tratta sempre di un canale singolo o di una coppia di canali.

E possibile aggiungere dei plug-in ai singoli cluster di canali.

La disposizione dei canali del montaggio audio deve essere compatibile con i canali del file
multicanale. E possibile ad esempio aprire un file audio 5.1 o un file stereo in una disposizione
dei canali del montaggio audio 5.1 0 7.1. Non é tuttavia possibile aprire un file audio 5.1 in una
disposizione dei canali stereo.

Per poter utilizzare WavelLab Elements per i file audio multicanale, & necessario disporre di una
scheda audio/interfaccia dotata di ingressi e uscite multiple. E necessario inoltre configurare un
driver ASIO nella scheda Connessioni audio e specificare la modalita di connessione dei canali di
ingresso/uscita interni all'unita audio.

LINK CORRELATI
Scheda Connessioni audio a pag. 18

Configurazione multicanale

E possibile configurare il numero di canali da utilizzare per ciascun montaggio audio.
Le configurazioni selezionabili variano in base a diversi fattori:

e Il numero di uscite disponibili nella scheda audio. Se sono presenti solo 4 uscite nella scheda,
e possibile utilizzare solo formati surround con 4 canali o meno.

e Sesidecide o meno di mixare il montaggio audio in un formato surround. In caso negativo,
selezionare ad esempio la modalita Multi mono quando si lavora con i file Ambisonics.

e l'utilizzo a cui & destinato il mix surround finale. Ad esempio, se si desidera che il mix sia
compatibile con il formato surround 5.1, selezionare la modalita Surround 5.1 (L R C LFE Ls
Rs).

Tutte le configurazioni multicanale vengono assegnate internamente ai canali surround in
Wavelab Elements. Questo implica che i canali passino attraverso la Sezione Master e quindi
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raggiungano la scheda audio, oppure che vengano renderizzati in un file multicanale o in un
insieme di file mono/stereo.

LINK CORRELATI
Modalita surround nei montaggi audio a pag. 221

Modalita surround nei montaggi audio

Se si sta utilizzando la modalita Surround per un montaggio audio, & possibile scegliere tra
diverse configurazioni multicanale.

Nella scheda Info del montaggio audio, selezionare Surround. Nel menu a tendina Disposizione
sono disponibili le sequenti disposizioni multicanale:

3 channels

LR=+LFE (L

4 channels

LRC+LFE (LR

6 channels

LINK CORRELATI
Scheda Info a pag. 46

Assegnazione dei canali delle tracce ai canali di uscita

Quando si seleziona una configurazione multicanale, &€ necessario creare e assegnare
manualmente i canali delle tracce ai canali di uscita surround.

PROCEDIMENTO

1. Nella finestra Montaggio audio, fare clic su Assegnazione dei canali di uscita nell'area dei
controlli di una traccia audio e selezionare Assegnazione delle tracce.
Ciascuna traccia dispone di una propria finestra di dialogo Assegnazione delle
tracce. E possibile avere piu finestre di dialogo Assegnazione delle tracce aperte
contemporaneamente.

2. Nella finestra di dialogo Assegnazione delle tracce, assegnare ciascun canale della traccia a
un canale di uscita attivando i canali corrispondenti.
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Track Routing n

Right Channel Is

A/ Rs

I canali disponibili variano a seconda della configurazione dei canali selezionata.

3. Fare clic su OK.

RISULTATO

Se ¢ stato selezionato un formato surround, € possibile inviare un canale della traccia a diversi o
a tutti i canali di uscita surround.

LINK CORRELATI
Finestra di dialogo Assegnazione delle tracce a pag. 222
Area dei controlli delle tracce a pag. 191

Finestra di dialogo Assegnazione delle tracce

In questa finestra di dialogo € possibile definire a quali canali di uscita del montaggio vengono
inviati i canali delle tracce nel montaggio audio. I canali disponibili variano a seconda della
configurazione dei canali selezionata.

e Per aprire la finestra di dialogo Assegnazione delle tracce, nella finestra Montaggio audio
fare clic su Assegnazione dei canali di uscita nell'area dei controlli di una traccia audio e
selezionare Assegnazione delle tracce.
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Track Routing n

Right Surround

Rs

Low Pass Filtering of the LFE Channel

120Hz 3

Il canale audio in alto @ inviato a

Consente di selezionare a quali uscite audio del montaggio audio viene inviato il canale
sinistro della traccia.

Il canale audio in basso é inviato a

Consente di selezionare a quali uscite audio del montaggio audio viene inviato il canale
destro della traccia.

Guadagno

Ciascun canale dispone di un cursore del guadagno. Questa funzionalita consente di
definire delle impostazioni di guadagno separate per ogni canale.

Filtraggio passa-basso del canale LFE

Se viene selezionata un’uscita LFE, puo essere applicato un filtro passa-basso (12 dB/
ottava) al segnale della traccia in modo che possano passare solo le basse frequenze. E
possibile regolare la frequenza di cutoff del filtro.

Svincola i fader
Consente di regolare i fader individualmente o tutti insieme.

Se il pulsante Svincola i fader & disattivato, lo spostamento di un fader implica lo
spostamento degli altri fader, dello stesso valore. L'attivazione del pulsante Svincola i
fader consente di regolare il guadagno dei canali in maniera individuale.

LINK CORRELATI

Area dei controlli delle tracce a pag. 191
Assegnazione dei canali delle tracce ai canali di uscita a pag. 221
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Configurazioni multicanale nella Sezione Master

La Sezione Master si riordina automaticamente all'avvio della riproduzione di un montaggio
audio multicanale. E possibile riordinare la Sezione Master senza avviare la riproduzione
facendo clic su Riordina nel menu Impostazioni in cima alla Sezione Master.

I canali di uscita della configurazione canali selezionata vengono visualizzati nella Sezione
Master, con un fader di livello e un indicatore di clip per ciascun canale di uscita.

Master Level

I.
oo
=
=

LINK CORRELATI
Sezione Master a pag. 284

Monitoraggio di un mixdown stereo di configurazioni multicanale

Nella Sezione Master & possibile monitorare un mixdown stereo di una configurazione
multicanale. Questa funzione consente ad esempio di ascoltare 'anteprima delle impostazioni
di un mixdown stereo per un progetto surround.

PROCEDIMENTO
1. Nella Sezione Master, aprire il pannello Livello master.
2. Sotto l'indicatore master, fare clic su Processamento dei canali audio.

3. Selezionare Mixaggio in stereo.

Effetti master e montaggi audio multicanale

La gestione degli effetti per un montaggio audio multicanale & simile a quella eseguita in caso
di lavoro in modalita stereo. Tuttavia, non tutti i plug-in supportano operazioni multicanale. In
questo caso, viene visualizzato un avviso quando si tenta di inserirli.

Modifica delle clip

Tutte le clip sono visualizzate nella finestra CD. In questa finestra & possibile modificare e
riordinare le clip, nonché trascinarle nel montaggio audio.

La clip attiva viene evidenziata nell'elenco delle clip.
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LINK CORRELATI
Clip a pag. 215
Finestra CD a pag. 265

Selezione delle clip

E possibile modificare in un’unica operazione piu clip selezionate.

e Per selezionare una clip e deselezionare tutte le altre clip selezionate, fare doppio-clic
sull'area inferiore della clip.

e Per selezionare una clip, fare clic sopra di essa. Le clip selezionate sono visualizzate con
colori diversi.

e Per selezionare piu clip, fare Ctrl/Cmd -clic sulle clip desiderate.
e Per selezionare un intervallo di clip, cliccarci sopra tenendo premuto Shift.

e Per selezionare diverse clip adiacenti, fare doppio-clic sull'area superiore di una clip e, dopo il
secondo clic, eseguire un trascinamento per selezionare le clip adiacenti.

LINK CORRELATI

Intervalli di selezione nei montaggi audio a pag. 225
Menu Clip attiva a pag. 229

Confronto tra clip attive e clip non attive

Una clip attiva & rappresentata dalla clip selezionata, dalla clip sulla quale & stato fatto clic,
o dall'ultima clip modificata. E possibile attivare una sola clip alla volta. Per impostazione
predefinita, la clip attiva si distingue grazie a un'etichetta con il nome evidenziato. Alcune
funzioni possono essere processate solamente sulla clip attiva.

Clip attiva (a sinistra) e clip non attiva (a destra)

e Per aprire il menu Clip attiva, fare clic-destro su una clip.

LINK CORRELATI
Selezione delle clip a pag. 225

Intervalli di selezione nei montaggi audio

Un intervallo di selezione € un‘area selezionata in una traccia. L'intervallo di selezione puo
trovarsi interamente o parzialmente all'interno di una clip o in una sezione vuota della traccia. E
possibile definire degli intervalli di selezione su una o piu tracce.

e Per definire un intervallo di selezione, fare clic sull'area superiore di una traccia ed eseguire
un trascinamento verso sinistra o destra su una o piu tracce.

Gli intervalli di selezione sono utili per i sequenti scopi:

e Per modificare le clip tagliando o cancellando la selezione, oppure troncando la clip in
corrispondenza della selezione stessa.

e Per creare una nuova clip trascinando l'intervallo di selezione in un‘altra traccia.
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Per aprire una finestra del montaggio con l'intervallo di selezione dal file audio sorgente,
trascinando l'intervallo di selezione nell’Editor audio.

Per riprodurre solo l'intervallo di selezione, I'intero montaggio audio o solo la clip con la
parte di clip che si interseca.

Per eseguire la riproduzione in loop all'interno della selezione attivando il loop e
selezionando la modalita Loop nella barra di trasporto.

Creazione e modifica degli intervalli di selezione nei montaggi audio

E possibile ridimensionare, creare, spostare e rimuovere gli intervalli di selezione.

Per creare un intervallo di selezione in un‘area vuota in una traccia, fare clic e trascinare con
il mouse. La posizione di inizio/fine e la lunghezza dell'intervallo vengono visualizzate nella
linea info.

Per creare un intervallo di selezione all'interno di una clip, fare clic e trascinare con il mouse
nell'area superiore della clip. La posizione di inizio/fine e la lunghezza dell'intervallo vengono
visualizzate nella linea info.

Per creare un intervallo di selezione dell'area tra due marker, fare doppio-clic tra i marker.

Per creare un intervallo di selezione da una coppia di marker di regione, premere Shift e
fare doppio-clic sul marker di inizio o di fine. Nella finestra Marker, & inoltre possibile fare
doppio-clic sul campo Lunghezza di un marker di regione.

Per creare un intervallo di selezione da una traccia CD, aprire la finestra CD e fare doppio-clic
sul numero a sinistra della traccia corrispondente.

Per ridimensionare un intervallo di selezione, fare Shift-clic ed eseguire un trascinamento
verso sinistra o destra, oppure fare clic e trascinare i bordi dell'intervallo di selezione.

Per spostare un intervallo di selezione, premere Ctrl/Cmd e Shift, quindi trascinarlo verso
sinistra o destra.

Per deselezionare un intervallo di selezione, fare clic in un punto qualsiasi nel montaggio
audio o premere Esc.

LINK CORRELATI
Finestra Marker a pag. 308
Finestra CD a pag. 265

Riorganizzazione delle clip

E possibile modificare liberamente I'ordine delle clip nella finestra di montaggio.

Modifica dell'ordine delle clip nei montaggi audio mediante trascinamento

Nella finestra CD, & possibile riordinare le clip trascinandole in un‘altra posizione all'interno
dell'elenco.

PROCEDIMENTO

1.
2.

Aprire la finestra CD.

Nell'elenco delle clip, trascinare una clip in un‘altra posizione nell'elenco.

E possibile spostare piu di una clip nello stesso momento selezionando piu clip e
trascinandole. Se viene selezionata piu di una clip, tutte le clip comprese tra la clip
selezionata piu a sinistra e quella piu a destra vengono spostate.
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Linea info

LINK CORRELATI
Finestra CD a pag. 265

Nella linea info situata nella parte inferiore della finestra Montaggio audio ¢ possibile
visualizzare i risultati ottenuti quando si fa clic con il pulsante del mouse con o senza i tasti
di modifica, a seconda della posizione del cursore.

L L RN A A NN

enu 1 Chang d point (o - T o |

Nella linea info vengono utilizzati i seguenti simboli:

Singolo clic

Indica l'azione prodotta dalla selezione.
Doppio clic

Indica l'azione prodotta dal doppio-clic.
Clic destro

[ ")

Indica che & possibile fare clic-destro per visualizzare un menu. Il nome del menu viene
visualizzato a destra del simbolo.

Ctrl/Cmd -clic

Indica che & possibile fare Ctrl/Cmd -clic per attivare una funzione supplementare.

Alt-clic

Indica che & possibile fare Alt-clic per attivare una funzione supplementare.

Shift-clic

Indica che € possibile fare Shift -clic per attivare una funzione supplementare.

Trascinamento verso l'alto/verso il basso

Indica l'azione prodotta dalla selezione e dal trascinamento verso l'alto o verso il basso.

Trascinamento verso sinistra/destra
Indica l'azione prodotta dalla selezione e dal trascinamento verso destra o verso
sinistra.
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Trascinamento in qualsiasi direzione

Indica l'azione prodotta dalla selezione e dal trascinamento di un elemento in qualsiasi
direzione nel montaggio audio.

Trascinamento al di fuori del montaggio audio

X

Indica l'azione prodotta dalla selezione e dal trascinamento di un elemento fuori dal
montaggio audio.

Spostamento/Ridimensionamento delle clip o modifica dei valori degli inviluppi

Indica che si stanno spostando o ridimensionando clip oppure modificando valori di
inviluppo, ad esempio.

Tasti di modifica combinati

Indica che € possibile utilizzare tasti di modifica combinati.

Agganci magnetici nei montaggi audio

Alcune posizioni, come i marker o l'inizio e la fine di una clip, possono essere definite come
magnetiche. Gli elementi trascinati possono essere agganciati a queste posizioni. In questo
modo e piu semplice posizionare in maniera precisa gli elementi.

Quando ad esempio una clip viene spostata o ridimensionata e i relativi bordi o cue-point
si avvicinano ai bordi magnetici, la clip scatta in questa posizione. Viene quindi visualizzata
un'etichetta con la posizione di scatto.

Start of Audic Montage
nlLe T

Per posizionare il cursore su una posizione magnetica, fare clic sulla linea del tempo e tenere
premuto il pulsante del mouse. Quando ora si sposta il cursore in senso verticale, questo salta al
successivo bordo magnetico.

Attivazione della funzione di scatto verso le calamite

Per utilizzare la funzione degli agganci magnetici, € necessario attivare I'opzione Scatta verso le
calamite.

PROCEDIMENTO
1. Nella finestra Montaggio audio, selezionare la scheda Modifica.

2. Nella sezione Allineamento, attivare 'opzione Scatta verso le calamite.

LINK CORRELATI
Agganci magnetici nei montaggi audio a pag. 228
Scheda Modifica (Montaggio audio) a pag. 199

228



Montaggio audio
Modifica delle clip

Menu contestuali delle clip

E possibile visualizzare numerose funzioni di modifica delle clip mediante i menu contestuali
delle clip. A seconda del punto in cui si fa clic-destro sulla clip, sono disponibili diversi menu
contestuali.

1 Sezione Fade-in
Consente di aprire il menu a tendina Fade-in in cui & possibile modificare il fade-in.
2 Un'area qualsiasi di una clip
Consente di aprire il menu a tendina Clip attiva in cui & possibile modificare la clip attiva.
3 Sezione Sustain
Consente di aprire il menu a tendina Inviluppo in cui & possibile modificare l'inviluppo.
4 Sezione Fade-out

Consente di aprire il menu a tendina Fade-out in cui € possibile modificare il fade-out.

LINK CORRELATI
Menu Clip attiva a pag. 229
Menu Clip attiva

Il menu a tendina Clip attiva consente di modificare e riprodurre la clip attiva con o senza
pre-roll.

e Per aprire il menu a tendina Clip attiva, fare clic-destro su una clip.
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Modifica i plug-in
Consente di aprire la finestra dei plug-in che sono applicati alla clip attiva. E inoltre
possibile fare clic-destro sul nome della clip e selezionare un plug-in per aprire la
finestra corrispondente.

Modifica la sorgente
Apre il file audio sorgente nell’Editor audio.

Modifica il progetto di Cubase/Nuendo
Apre il progetto del file audio in Cubase/Nuendo.

Questa funzione consente di correggere delle eventuali problematiche che dovessero
emergere nel corso del mixaggio e correggerle direttamente nel file audio all'interno di
Cubase/Nuendo.

Visualizza l'intera clip
Consente di regolare la vista per la visualizzazione della clip attiva.

Riproduci clip
Riproduce la clip attiva.

Riproduci la clip con il pre-roll
Riproduce la clip attiva con il pre-roll.

Riproduci la clip all'interno della selezione

Riproduce l'intervallo audio selezionato. Le clip che si sovrappongono o le clip in altre
tracce vengono messe in mute.

Dividi al cursore

Consente di dividere la clip attiva in corrispondenza della posizione del cursore di
modifica. E anche possibile eseguire la divisione alla posizione del cursore mediante
doppio-clic sul cursore di modifica oppure premendo S.

Taglia
Consente di tagliare la clip attiva e di posizionarla negli appunti. E quindi possibile
incollarla in un‘altra posizione in una traccia del montaggio audio.

Copia

Consente di copiare la clip attiva e di posizionarla negli appunti.
Elimina

Elimina la clip attiva.

LINK CORRELATI

Modifica dei file sorgente delle clip a pag. 236

Cubase/Nuendo come editor esterno per Wavelab Elements a pag. 373
Menu contestuali delle clip a pag. 229

Spostamento e applicazione delle dissolvenze incrociate alle clip

E possibile lasciare che le clip si sovrappongano ad altre clip, oppure le si pud spostare o creare
delle dissolvenze tra di esse.

LINK CORRELATI
Spostamento delle clip a pag. 231
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Spostamento delle clip
E possibile trascinare una clip o tutte le clip selezionate in un‘altra posizione.
NOTA

La configurazione dei canali della clip deve coincidere con quella della traccia di destinazione.

PROCEDIMENTO
1. Nella finestra del montaggio, selezionare le clip che si desidera spostare.

2. Fare clic sull'area della clip e trascinare le clip in qualsiasi direzione.

Durante il trascinamento, la posizione di inizio corrente della clip viene visualizzata nella
linea info.

LINK CORRELATI
Spostamento e applicazione delle dissolvenze incrociate alle clip a pag. 230

Opzioni per lo spostamento e la dissolvenza incrociata delle clip

Sono disponibili varie opzioni utili per eseguire le operazioni di spostamento e dissolvenza
incrociata delle clip.

Ripercussione

La funzione Ripercussione consente di determinare se le clip sulla destra vengono spostate
quando si sposta una clip. Le opzioni di ripercussione sono disponibili nella scheda Modifica
della finestra Montaggio audio.

Traccia

Se questa opzione € attivata e si sposta orizzontalmente una clip, vengono spostate
anche tutte le clip nella traccia attiva che si trovano a destra della clip modificata.
Questa funzione si applica anche in caso di spostamento o ridimensionamento delle
clip e quando viene inserita o incollata pit di una clip contemporaneamente.

Globale
Se questa opzione € attivata e si sposta orizzontalmente una clip, vengono spostate
anche tutte le clip su tutte le tracce che si trovano a destra della clip modificata. Questa
opzione viene presa in considerazione in caso di spostamento o ridimensionamento
delle clip e quando viene inserita o incollata piu di una clip nello stesso momento.
Nessuno

Disattiva la funzione Ripercussione. Di conseguenza, vengono spostate solamente le
clip selezionate.

Dissolvenze incrociate

Le seguenti opzioni relative alle dissolvenze incrociate sono disponibili nella scheda Dissolvenza
della finestra Montaggio audio all'interno della sezione Opzioni.

Sovrapposizioni

Questo menu a tendina consente di impostare il comportamento di esecuzione
automatica delle dissolvenze incrociate.

e Sel'opzione Nessuna dissolvenza incrociata automatica ¢ attivata, non vengono
esequite dissolvenze incrociate automatiche quando le clip si sovrappongono.
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e Sel'opzione Sovrapposizioni libere ¢ attivata, vengono create delle dissolvenze
incrociate automatiche quando una clip si sovrappone a un‘altra clip sulla
stessa traccia. La lunghezza della sovrapposizione determina la lunghezza della
dissolvenza incrociata.

Opzioni

e Sel'opzione Crea delle dissolvenze predefinite nelle nuove clip ¢ attivata, tutte
le nuove clip otterranno la lunghezza e la forma di fade-in e fade-out predefinite.
Per le clip che vengono create tramite divisione di una clip, viene utilizzata solo la
durata delle dissolvenze predefinite.

LINK CORRELATI
Scheda Modifica (Montaggio audio) a pag. 199
Scheda Dissolvenza (Montaggio audio) a pag. 202

Clip sovrapposte
E possibile spostare le clip in modo che si sovrappongano.
Tenere presente quanto segue:

e Le tracce nel montaggio audio sono polifoniche, ovvero ogni traccia puo riprodurre diverse
clip sovrapposte nello stesso momento. Le clip sovrapposte sono trasparenti e consentono
quindi di visualizzare le clip sottostanti e le relative forme d'onda.

e Sono disponibili delle opzioni relative alle dissolvenze incrociate che regolano in maniera
automatica le curve di inviluppo del livello quando si sovrappongono delle clip.

Duplicazione delle clip

E possibile duplicare rapidamente una o piu clip mediante trascinamento. I duplicati delle clip
possono essere spostati in altre posizioni nella stessa traccia, in un‘altra traccia o in un altro
montaggio audio.

NOTA

La configurazione dei canali della clip deve coincidere con quella della traccia di destinazione.

PROCEDIMENTO
1. Nella finestra di montaggio, selezionare una o piu clip.

2. Fare clic sull'area superiore e trascinare le clip in un‘altra posizione nella stessa traccia, in
un’altra traccia, o in un‘altra scheda del montaggio audio.

"y

Il cursore cambia a indicare che ci si trova nell'area superiore delle clip.

Durante il trascinamento, una linea punteggiata indica la posizione in cui verra posizionata la
prima delle clip copiate. La posizione € indicata anche sulla linea info.

Vengono tenute in considerazione le impostazioni dell'opzione Ripercussione che possono
essere definite nella scheda Modifica della finestra Montaggio audio.

232



Montaggio audio
Modifica delle clip

LINK CORRELATI
Scheda Modifica (Montaggio audio) a pag. 199

Ridimensionamento delle clip

In questo contesto, il ridimensionamento indica generalmente lo spostamento dei punti di inizio
e di fine di una clip. Questo consente di rivelare una parte variabile del file audio originale.

Per ridimensionare una clip, fare clic sul bordo sinistro o destro della clip e spostare il punto di
inizio/fine a sinistra o a destra. Non ¢ possibile trascinare il bordo di una clip oltre il punto di
inizio o di fine del file audio al quale fa riferimento.

Se si preme Alt durante il ridimensionamento, tutte le clip selezionate vengono ridimensionate
dello stesso valore.

Indicatore di clip ridimensionata

Quando si ridimensiona una clip, viene visualizzato un piccolo triangolo nell'angolo superiore
sinistro o destro della clip, a seconda che si ridimensioni I'inizio o la fine della clip. Questo
indicatore & utile per trovare e correggere gli errori, ad esempio quando si taglia una parte
eccessiva della clip e risulta mancante l'inizio o la fine dell'audio.

Clip prima e dopo il ridimensionamento. L'indicatore nell'angolo in alto a destra mostra che la clip & stata
ridimensionata.

Quando si passa il puntatore del mouse sopra l'indicatore della clip ridimensionata, una
descrizione comando mostra la lunghezza dell'audio prima/dopo la clip. L'unita di tempo
visualizzata dipende dall'unita di tempo del righello del tempo.

Audio Length After the Clip
_ 65472 ms
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LINK CORRELATI
Opzioni per lo spostamento e la dissolvenza incrociata delle clip a pag. 231

Divisione delle clip

E possibile dividere le clip per trasformare una clip in due clip indipendenti. Le due clip
presentano lo stesso nome e le stesse impostazioni. Gli inviluppi e le dissolvenze incrociate
vengono convertiti in modo che le due clip siano riprodotte come se fossero un'unica clip.

PREREQUISITI

Decidere se si desidera creare automaticamente delle dissolvenze incrociate tra la clip sinistra
e destra. Per attivare/disattivare questa opzione, selezionare la scheda Dissolvenza e attivare/
disattivare Crea delle dissolvenze predefinite nelle nuove clip nella sezione Opzioni.

PROCEDIMENTO
1. Nella finestra del montaggio, fare clic sulla posizione in cui si desidera dividere la clip.

2. Spostare il cursore del mouse nella posizione del cursore di modifica nell'area in cima della
clip.
Il cursore diventa a forma di forbici.

3. Fare doppio-clic.

RISULTATO
La clip viene divisa in due.

LINK CORRELATI
Finestra di dialogo Dividi clip alle parti silenziose a pag. 234

Finestra di dialogo Dividi clip alle parti silenziose
E possibile rimuovere le parti silenziose delle clip e creare una nuova clip nella posizione di taglio.

e Per aprire la finestra di dialogo Dividi clip alle parti silenziose, selezionare la scheda
Modifica nella finestra Montaggio audio e fare clic su Dividi presso le parti silenziose
nella sezione Suddividi.

Lunghezza minima della clip

Consente di impostare la lunghezza minima delle regioni risultanti dopo la divisione. Le
sezioni non silenziose piu brevi rispetto a questa lunghezza non vengono divise.

Silenzio minimo tra le regioni

Consente di impostare la lunghezza minima di una regione silenziosa. Le regioni
silenziose piu brevi di questa lunghezza non creeranno delle regioni divise.

Il silenzio é definito come un segnale inferiore a (RMS)
Consente di impostare il livello soglia per I'individuazione del silenzio. Il livelli al di sotto
di questo valore sono considerati silenzio.
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Rilevamento automatico del livello (analisi a 2 fasi, piu lenta)

Se questa opzione € attivata, il file viene analizzato e automaticamente diviso dove
Wavelab Elements rileva del silenzio. Il file viene letto due volte.

Separa le clip risultanti con uno spazio fisso
Se questa opzione € attivata, le clip risultanti vengono separate le une dalle altre di 2
secondi. Se questa opzione & disattivata, gli spazi vuoti tra le clip risultanti vengono
determinati dalla lunghezza del silenzio rimosso.

Eliminazione di parti delle clip all'interno degli intervalli di selezione

L'eliminazione di una parte di una clip all'interno di un intervallo di selezione comporta la
rimozione dell'intervallo selezionato e lo spostamento della sezione destra della clip verso
sinistra per riempire lo spazio vuoto.

PROCEDIMENTO
1. Nella finestra di montaggio, selezionare un intervallo in una clip.
2. Selezionare la scheda Modifica.

3. Nella sezione Rimozione, fare clic su Elimina l'intervallo selezionato.

RISULTATO

L'intervallo selezionato viene eliminato e la sezione destra della clip viene spostata verso sinistra
per riempire lo spazio vuoto.

Eliminazione delle clip

L'eliminazione delle clip non comporta l'eliminazione del file audio a cui le clip fanno riferimento.

PROCEDIMENTO
e Eseguire una delle seguenti operazioni:
e Fare clic-destro su una clip e selezionare Elimina.

e Selezionare una clip e premere Canc.

Per assicurarsi che non sia presente alcun intervallo di selezione, premere Esc.

Clip e cue-point

Un cue-point € un marker di posizione definito che appartiene a una clip. Esso puo essere
posizionato all'interno o all'esterno della clip. I cue-point sono visualizzati come linee verticali
punteggiate.

Quando si sposta una clip, i rispettivi cue-point sono magnetici verso qualsiasi bordo, marker o
posizione. Sono possibili diversi utilizzi:

e Impostare il cue-point in una posizione rilevante nell'audio per allineare la clip con altre clip,
ecc.
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e Impostare il cue-point prima dell'inizio di una clip per posizionare le clip in una riga con spazi
predefiniti.

e Impostare il cue-pointin corrispondenza del punto di fade-in o di fade-out di una clip per
mantenere le lunghezze delle dissolvenze definite durante I'esecuzione di una dissolvenza
incrociata.

NOTA

Ogni clip pud presentare solo un cue-point. Se si seleziona un‘altra opzione di inserimento cue-
point, il cue-point viene spostato in una nuova posizione.

LINK CORRELATI
Aggiunta dei cue-point a pag. 236

Aggiunta dei cue-point

E possibile aggiungere un cue-point per ciascuna clip.

PROCEDIMENTO

1. Nel montaggio audio, fare clic sulla posizione della clip in cui si desidera impostare un
cue-point.

2. Selezionare la scheda Modifica.
3. Nella sezione Clip, aprire il menu a tendina Cue point.
4. Selezionare una delle seguenti opzioni:
e Imposta al cursore
e Imposta alla posizione dello spazio vuoto predefinito
e Segue il punto di fine del fade-in
e Segue il punto di inizio del fade-out

5. Facoltativo: selezionare Cue point di fine personalizzato e specificare un cue-point di fine
personalizzato.

LINK CORRELATI
Clip e cue-point a pag. 235
Scheda Modifica (Montaggio audio) a pag. 199

Gestione dei file sorgente delle clip

Nell'Editor audio e possibile modificare i file utilizzati nel montaggio audio corrente.

LINK CORRELATI
Modifica dei file sorgente delle clip a pag. 236

Modifica dei file sorgente delle clip

La modifica del montaggio audio potrebbe richiedere il processamento o la modifica dei file
audio correnti a cui fanno riferimento le clip.

Utilizzare uno dei sequenti metodi per modificare il file sorgente di una clip:
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e Fare clic-destro sulla clip che si desidera modificare e selezionare Modifica la sorgente.
Il file sorgente della clip si apre nellEditor audio. Modificare la clip, salvarla e tornare al
montaggio audio.

e Fare doppio-clic sulla clip e trascinarla nell'elenco delle schede o nell'Editor audio.
Tenere presente quanto segue:

e Tutte le modifiche eseguite in questo modo hanno effetto sul file audio sorgente e quindi su
tutte le clip che utilizzano il file audio, comprese le clip in altri montaggi audio.

e E possibile annullare/ripristinare tutte le modifiche nei file audio, anche dopo il salvataggio
dei file. Tali modifiche si riflettono immediatamente in tutti i montaggi audio aperti.

e Sesiutilizza File > Salva con nome per salvare il file audio sorgente con un nome diverso,
tutti i montaggi audio aperti che si riferiscono al file fanno ora riferimento al nuovo file.

Inviluppi per le clip

Per le clip allinterno di un montaggio audio, & possibile creare degli inviluppi per il volume e le
dissolvenze e per il panorama.

E possibile creare una curva dellinviluppo del livello indipendente per automatizzare il livello, per
creare dissolvenze e dissolvenze incrociate e per mettere in mute sezioni delle clip.

E inoltre possibile disegnare inviluppi di panorama per automatizzare le impostazioni di
panorama per le clip. Per le clip mono, il panorama gestisce la posizione sinistra/destra nel
campo stereo. Per le clip stereo, il panorama imposta il bilanciamento sinistro/destro.

E possibile modificare le impostazioni di inviluppo nella finestra Inviluppo o facendo clic-destro
su una curva di inviluppo. A seconda che si faccia clic sulla parte del fade-in, del fade-out o del
sustain, il menu delle impostazioni conterra opzioni differenti.

LINK CORRELATI
Scheda Inviluppo (Montaggio audio) a pag. 203

Inviluppi del livello

Per impostazione predefinita, in tutte le clip viene visualizzata una curva di inviluppo del livello.
L'inviluppo & costituito da tre parti: la parte del fade-in, la parte del sustain e la parte del fade-
out.

I punti sul lato destro e sinistro della curva sono i punti di giunzione di fade-in e fade-out che
separano le parti di dissolvenza dalla parte di sustain. I punti di colore grigio all'inizio di un
fade-in e alla fine di un fade-out consentono di visualizzare piccole dissolvenze anche quando si
utilizza il massimo fattore di ingrandimento.
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La curva di inviluppo indica se sono stati definiti punti, fade-in o fade-out. Oltre a essere
visualizzati nella curva, i cambi nell'inviluppo del livello si riflettono anche nella forma d'onda.

LINK CORRELATI
Inviluppi per le clip a pag. 237

Selezionare gli inviluppi

E possibile selezionare gli inviluppi di volume/dissolvenza e gli inviluppi del panorama.

PROCEDIMENTO
1. Nella finestra di montaggio, selezionare una clip.
2. Selezionare la scheda Inviluppo.

3. Nella sezione Selettore, aprire il menu a tendina Tipo di inviluppo e definire se si desidera
modificare l'inviluppo di tipo Volume/Dissolvenze o I'inviluppo del Panorama.

LINK CORRELATI
Inviluppi per le clip a pag. 237
Scheda Inviluppo (Montaggio audio) a pag. 203

Nascondere le curve di inviluppo

Per impostazione predefinita, gli inviluppi vengono visualizzati in tutte le clip. E possibile
nascondere tali inviluppi. Tuttavia, gli inviluppi nascosti sono ancora attivi.

PROCEDIMENTO
1. Nella finestra di montaggio, selezionare una clip.
2. Selezionare la scheda Inviluppo.

3. Nella sezione Selettore, aprire il menu a tendina Tipo di inviluppo e selezionare Nascondi
tutto.

LINK CORRELATI
Inviluppi per le clip a pag. 237
Scheda Inviluppo (Montaggio audio) a pag. 203

Modifica dell'inviluppo di una clip

I punti della curva consentono di creare curve di volume, di panorama e di dissolvenza per una
clip. E possibile modificare la curva di inviluppo aggiungendo e spostando i punti della curva.

LINK CORRELATI
Modifica delle curve di inviluppo a pag. 240

Aggiunta dei punti curva degli inviluppi

E possibile aggiungere uno o pil punti curva degli inviluppi.

OPZIONI
e Per aggiungere un punto curva, fare doppio-clic sulla curva di inviluppo.
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Se si tiene premuto il pulsante del mouse dopo aver fatto doppio-clic sulla curva di inviluppo,
€ possibile spostare il punto curva in un‘altra posizione.
e Per aggiungere punti curva multipli entro un intervallo di selezione, eseguire una delle

seguenti operazioni:

e Per aggiungere tre punti curva, definire un intervallo di selezione e fare doppio-clic sulla
curva di inviluppo all'interno dell'intervallo.
Viene in tal modo creato un punto curva all'inizio e alla fine della selezione e un punto
curva alla posizione di clic. Se I'intervallo di selezione contiene gia un punto curva e si fa
doppio-clic sulla curva di inviluppo, vengono creati due punti curva.

e Per aggiungere quattro punti curva con due punti curva all'inizio della selezione e due
punti curva alla fine, definire un intervallo di selezione, fare clic sulla curva di inviluppo
ed eseguire un trascinamento verso 'alto o verso il basso.

Questo ha effetto solamente se l'intervallo di selezione non contiene alcun punto curva.
La distanza tra il primo e il secondo e tra il terzo e l'ultimo punto curva & di 20 ms per
impostazione predefinita.

e Per aggiungere quattro punti curva che abbiano uguale distanza tra loro, definire un
intervallo di selezione, premere Ctrl/Cmd, fare clic sulla curva di inviluppo ed eseguire
un trascinamento verso l'alto o verso il basso.

Questo ha effetto solamente se l'intervallo di selezione non contiene alcun punto curva.

e Per aggiungere quattro punti curva, dove i due punti curva al centro abbiano una
distanza tra loro maggiore rispetto alla distanza con il primo e l'ultimo punto curva,
definire un intervallo di selezione, premere Ctrl/Cmd - Alt, fare clic sulla curva di
inviluppo ed eseguire un trascinamento verso 'alto o verso il basso.

Questo ha effetto solamente se l'intervallo di selezione non contiene alcun punto curva.

LINK CORRELATI
Inviluppi per le clip a pag. 237
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Modifica delle curve di inviluppo a pag. 240

Modifica delle curve di inviluppo

Molte delle operazioni di modifica utilizzate solitamente nel contesto del sistema operativo del
computer in uso possono essere applicate quando si modificano le curve degli inviluppi. Inoltre,
viene applicato un numero di procedure specifiche.

OPZIONI

Per eliminare un punto della curva, fare doppio-clic sul punto della curva. Il punto della curva
tra le parti di sustain e dissolvenza dell'inviluppo non puo essere eliminato.

Per selezionare piu punti curva, tenere premuto Ctrl/Cmd e fare clic sui punti desiderati.

Per selezionare un intervallo di punti, fare Alt-clic e trascinamento per creare un rettangolo
di selezione.

Per eliminare piu punti della curva, selezionarli, fare clic-destro su uno dei punti e
selezionare Elimina i punti selezionati.

Per spostare tutti i punti selezionati, fare clic su uno dei punti selezionati e trascinare.

Per aumentare o diminuire il valore di due punti della curva consecutivi, fare Ctrl/Cmd -clic
sul segmento tra i punti ed eseguire un trascinamento verso l'alto o verso il basso.

Per modificare la posizione temporale di due punti della curva consecutivi, fare Shift -clic sul
segmento tra i punti ed eseguire un trascinamento verso destra o verso sinistra.

Per aumentare o diminuire l'intera curva di inviluppo, assicurarsi che non sia selezionato
alcun punto della curva, fare clic sulla curva di inviluppo e trascinare verso l'alto o verso il
basso. Non trascinare un segmento delimitato dai punti selezionati.

Per regolare gli inviluppi in tutte le clip selezionate, tenere premuto Alt e trascinare
qualsiasi curva di inviluppo verso l'alto o verso il basso. Si tratta di un modo rapido per
regolare contemporaneamente il livello o il panorama di piu clip e anche per regolare
insieme entrambi i lati di un inviluppo stereo.

Per spostare verticalmente un punto di fade-in/fade-out, fare Ctrl/Cmd -clic ed eseguire un
trascinamento.

Per modificare contemporaneamente il livello o la durata di fade-in/out di piu inviluppi,
selezionare le clip che si desidera modificare, premere Alt e modificare I'inviluppo con il
mouse.

LINK CORRELATI
Inviluppi per le clip a pag. 237
Aggiunta dei punti curva degli inviluppi a pag. 238

Reinizializzazione delle curve di inviluppo

E possibile riportare i punti della curva al livello predefinito di 0 dB.

OPZIONI

Per riportare un singolo punto a 0 dB, selezionare il punto desiderato, cliccarci sopra col
tasto destro del mouse e selezionare Reinizializza i punti selezionati.

Per riportare l'intera curva di inviluppo alle impostazioni predefinite, fare clic-destro sulla
curva di inviluppo e selezionare Riporta il livello a 0 dB.

LINK CORRELATI
Modifica dell'inviluppo di una clip a pag. 238
Inviluppi per le clip a pag. 237
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Aumentare i livelli di una selezione

E possibile aumentare il livello dell'audio con tempi di risalita e caduta specifici (impostati per
impostazione predefinita a 20 ms) e regolare quindi il livello.

PROCEDIMENTO

1. Nella finestra di montaggio, all'interno di una clip selezionare l'intervallo per la sezione della
quale si desidera aumentare il livello.

2. Fare clic-destro sulla curva di inviluppo e selezionare Alza il livello della selezione con
I'inviluppo.
Il livello dell'intervallo di selezione viene aumentato.

3. Fare clic sullinviluppo dell'intervallo di selezione e trascinare verso l'alto o verso il basso per
regolare il livello.

LINK CORRELATI
Modifica dell'inviluppo di una clip a pag. 238

Mettere in mute degli intervalli selezionati delle clip

E possibile mettere in mute (silenziare) un intervallo selezionato riducendo il volume a -144 dB.

Le sezioni silenziate (in mute) non vengono influenzate quando si trascina la curva di inviluppo
verso l'alto o verso il basso.

PROCEDIMENTO

1. Allinterno della finestra di montaggio, in una clip selezionare un intervallo per la sezione che
si desidera mettere in mute.

2. Fare clic-destro sulla curva di inviluppo e selezionare Metti in mute la selezione con
I'inviluppo.

RISULTATO
La sezione & in mute. Vengono applicati un fade-in e un fade-out di 20 ms alla sezione silenziata.

LINK CORRELATI
Modifica dell'inviluppo di una clip a pag. 238
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Modifica del livello complessivo degli inviluppi delle clip

La curva di inviluppo predefinita non contiene alcun punto di inviluppo del livello, ma & possibile
utilizzarla per modificare il livello complessivo della clip.

PROCEDIMENTO
1. Nella finestra di montaggio, posizionare il cursore del mouse sulla curva di inviluppo.

Il cursore del mouse viene visualizzato con la forma di un cerchio con due frecce che
puntano verso l'alto e verso il basso.

Volume Envelope

2. Fareclic e trascinare la curva verso l'alto o verso il basso per modificare il livello di inviluppo
della clip.

LINK CORRELATI
Modifica dell'inviluppo di una clip a pag. 238

Leggi di ripartizione stereo

La potenza della somma dei canali diminuisce di circa 3 dB se un segnale € posizionato
completamente a destra o a sinistra, rispetto allo stesso segnale posizionato al centro. E possibile
compensare questo fattore con le leggi di ripartizione stereo (o leggi del pan-pot).

Si consiglia di provare le diverse leggi fino a trovare quella che si adatta meglio alle proprie
esigenze. Le leggi di ripartizione stereo possono essere impostate per le tracce, le clip e l'uscita
del montaggio.

e Perimpostare le leggi di ripartizione stereo per le clip, utilizzare il menu a tendina Legge
del pan-pot nella scheda Inviluppo della finestra del Montaggio audio, oppure il menu a
tendina e la manopola Legge del pan-pot nella finestra dell'Inspector.

e Perimpostare le leggi di ripartizione stereo per le tracce e l'uscita del montaggio, utilizzare il
menu a tendina Legge del pan-pot e la maniglia nella finestra dellInspector.

Sono disponibili le sequenti leggi di ripartizione stereo:

Attenuazione del canale (0 dB/mute)

Questa legge non compensa la perdita di potenza. Se un segnale & posizionato
completamente a sinistra o a destra, la potenza della somma dei canali diminuisce
di circa 3dB.

Potenza costante (+ 3 dB/mute)

Si tratta della legge predefinita. Indipendentemente dalla posizione del panorama, la
potenza della somma dei canali rimane costante.

Enfatizzazione del canale (+ 4,5 dB/mute)

Se viene selezionata questa legge e un segnale & posizionato completamente a sinistra
o0 a destra, la potenza della somma dei canali & superiore rispetto a un segnale
posizionato al centro.

242



Montaggio audio
Ducking delle tracce

Enfatizzazione del canale (+ 6 dB/mute)
Se viene selezionata questa legge e un segnale & posizionato completamente a sinistra
o0 a destra, la potenza della somma dei canali € superiore rispetto a un segnale
posizionato al centro. E esattamente quello che avviene con I'opzione precedente, ma
con enfatizzazione di potenza ancora maggiore.

LINK CORRELATI
Scheda Inviluppo (Montaggio audio) a pag. 203
Finestra dellInspector a pag. 250

Ducking delle tracce

Il ducking consente di controllare il livello di una traccia audio con un‘altra traccia audio.

In genere, il ducking viene utilizzato per attenuare il livello di una traccia audio contenente
musica o dei suoni d'ambiente, ogni volta che & presente un segnale in una traccia vocale
correlata. La traccia contenente la musica & chiamata traccia carrier, mentre la traccia contenente
la registrazione vocale € chiamata traccia modulatrice.

E possibile selezionare piu tracce vocali come tracce modulatrici per una traccia carrier. E anche
possibile applicare il ducking alle tracce modulatrici, ad esempio per dare priorita a una traccia
vocale su un‘altra traccia.

LINK CORRELATI
Applicazione del ducking per le tracce a pag. 243
Impostazioni del ducker per le tracce a pag. 244

Applicazione del ducking per le tracce

PREREQUISITI

Si hanno due tracce audio e si desidera attenuare il livello di una di esse ogni volta che nell'altra
traccia e presente un segnale.

PROCEDIMENTO

1. Nella finestra del montaggio, selezionare la traccia carrier, cioe la traccia contenente la
musica.

2. Fare clic-destro nell'area dei controlli della traccia carrier e fare clic su Visualizza i controlli
di ducking.

3. Nell'area dei controlli della traccia carrier, attivare Ducker attiv./disatt.

4. Fare clic su Sorgente per aprire il menu Tracce modulatrici e selezionare una o piu tracce
modulatrici, cioe le tracce contenenti la registrazione vocale.
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5. Riprodurre il montaggio audio.

Il volume della traccia musicale viene ridotto ogni volta che la traccia vocale contiene un
segnale.
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6. Facoltativo: fare clic su Impostazioni del ducker per aprire il plug-in Ducker e modificare le
impostazioni di ducking per regolare con precisione l'effetto.

7. Facoltativo: se si stanno utilizzando pit tracce modulatrici, € anche possibile applicare a
queste il ducking.

LINK CORRELATI

Aggiunta di tracce a pag. 213

Area dei controlli delle tracce stereo e mono a pag. 192
Impostazioni del ducker per le tracce a pag. 244

Impostazioni del ducker per le tracce

Le impostazioni del Ducker consentono di configurare l'effetto ducking per le tracce.

e Per aprire le impostazioni del Ducker, attivare il pulsante Ducker attiv./disatt. nell'area dei
controlli delle tracce e fare clic su Impostazioni del ducker.

Bypassa effetto
Se questa opzione € attivata, il Ducker viene bypassato durante la riproduzione.

Bypass Effect

Shortcut: Alt+B

} Tell me more

Preset
Consente di salvare e caricare dei preset di ducking.

Music Attenuation
Consente di specificare la riduzione del livello che viene applicata alla traccia musicale

(carrier).
Voice Threshold

Consente di impostare la soglia del livello della traccia vocale (modulatrice) che attiva il
ducking. Se il livello della traccia vocale supera la soglia, il livello della traccia musicale
(carrier) viene ridotto.

244



Montaggio audio
Dissolvenze e dissolvenze incrociate nei montaggi audio

Attenuation Hold Time
Quando il livello della traccia vocale scende al di sotto della soglia impostata, il
parametro Attenuation Hold Time determina il tempo in cui il livello della traccia
carrier rimane ridotto prima di iniziare a risalire nuovamente fino al proprio livello
originale.

Music Fade-Out

Determina il tempo impiegato dal livello musicale per passare da 0 dB al livello Music
Attenuation impostato.

Music Fade-In
Determina il tempo dopo il quale il livello risale al valore originale quando il livello della
traccia vocale (modulatrice) scende al di sotto del valore Voice Threshold impostato e
dopo il valore Attenuation Hold Time specificato.

LINK CORRELATI
Ducking delle tracce a pag. 243
Area dei controlli delle tracce stereo e mono a pag. 192

Dissolvenze e dissolvenze incrociate nei montaggi audio

Un fade-in rappresenta un incremento graduale di livello, un fade-out un decremento graduale.
Una dissolvenza incrociata & una dissolvenza graduale tra due suoni, dei quali a uno viene
applicato il fade-in e all'altro il fade-out.

LINK CORRELATI
Creazione delle dissolvenze nelle clip a pag. 245

Creazione delle dissolvenze nelle clip

Per impostazione predefinita, in tutte le clip vengono visualizzati i punti di giunzione di fade-in e
fade-out. Questi possono essere trascinati orizzontalmente per creare un fade-in o un fade-out
per una clip.

E possibile aggiungere dei punti di inviluppo a una dissolvenza proprio come avviene con gli
inviluppi del livello.

e Per creare un fade-in, fare clic sul punto di fade-in all'inizio di una clip e trascinarlo verso
destra.

e Per creare un fade-out, fare clic sul punto di fade-out alla fine di una clip e trascinarlo verso
sinistra.

e Per creare un fade-in o un fade-out in corrispondenza di una specifica posizione temporale,
utilizzare l'opzione Applica i tempi di dissolvenza nella scheda Dissolvenza. Inserire il
valore temporale desiderato nel campo del tempo e fare clic su Applica i tempi di
dissolvenza.

e Per spostare verticalmente un punto di fade-in/fade-out, premere Ctrl/Cmd durante il
trascinamento.

e Perregolare i punti di fade-in/fade-out in tutte le clip selezionate contemporaneamente,
tenere premuto Alt e trascinare un punto di fade-in/fade-out verso l'alto o verso il basso. Si
tratta di un modo rapido per regolare contemporaneamente le dissolvenze di piu clip.

e Per creare una dissolvenza incrociata, spostare una clip su un‘altra clip. Una dissolvenza
incrociata viene creata automaticamente al punto di giunzione.
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La curva di fade-in/fade-out risultante viene visualizzata nella clip e la dissolvenza viene inoltre
riflessa nella forma d'onda. Se si posiziona il mouse sul punto di fade-in, la durata di fade-in viene
visualizzata in secondi e millisecondi, mentre il volume & indicato in dB.

Fade In
65992 ms [0 dB]

LINK CORRELATI
Dissolvenze e dissolvenze incrociate nei montaggi audio a pag. 245
Scheda Dissolvenza (Montaggio audio) a pag. 202

Menu Fade-in e Fade-out

In questi menu, & possibile selezionare diversi preset delle curve di dissolvenza e altre opzioni
relative alle dissolvenze.

e Per aprire il menu a tendina Fade-in o Fade-out, fare clic-destro sui punti di fade-in o di
fade-out.
Zoom sull'intervallo del fade-in/Zoom sull’intervallo del fade-out

Consente di regolare la vista in modo da visualizzare principalmente la parte del fade-
in/fade-out della clip attiva.

Lineare
Modifica il livello in maniera lineare.

Seno (*)
Consente di modificare il livello in base al primo quarto di periodo della curva di seno.
Quando questa impostazione viene utilizzata in una dissolvenza incrociata, l'intensita
acustica (RMS) rimane costante durante la transizione.

Radice quadrata (*)

Consente di modificare il livello in base alla curva della radice quadrata. Quando questa
impostazione viene utilizzata in una dissolvenza incrociata, I'intensita acustica (RMS)
rimane costante durante la transizione.
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Sinusoidale
Consente di modificare il livello in base a mezzo periodo della curva di seno.

Logaritmico
Consente di modificare il livello in maniera logaritmica.

Esponenziale
Consente di modificare il livello in maniera esponenziale.

Esponenziale+
Consente di modificare il livello in maniera fortemente esponenziale.

LINK CORRELATI
Dissolvenze e dissolvenze incrociate nei montaggi audio a pag. 245
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Applicazione di dissolvenze predefinite alle nuove clip

Tutte le nuove clip importate o registrate nel montaggio audio assumono la lunghezza e la forma
predefinite del fade-in/fade-out se I'opzione Crea delle dissolvenze predefinite nelle nuove clip
e attivata. In questo caso, vengono utilizzate le forme delle dissolvenze incrociate predefinite.
Questo si applica inoltre alle clip create mediante la divisione di altre clip.

PROCEDIMENTO
1. Aprire un montaggio audio e selezionare la scheda Dissolvenza.
2. Nella sezione Opzioni, aprire il menu a tendina Opzioni.

3. Attivare l'opzione Crea delle dissolvenze predefinite nelle nuove clip.

LINK CORRELATI
Dissolvenze e dissolvenze incrociate nei montaggi audio a pag. 245
Scheda Dissolvenza (Montaggio audio) a pag. 202

Modifica delle dissolvenze incrociate

E possibile creare dissolvenze incrociate con lunghezze e forme indipendenti per le curve di
fade-in e di fade-out.

La dissolvenza incrociata automatica predefinita € lineare. Questo tipo di dissolvenza utilizza la
stessa forma e le stesse lunghezze di dissolvenza per il fade-in e per il fade-out. Si applicano le
seguenti regole:

e Unadissolvenza incrociata include fade-in e fade-out.

e E possibile modificare le curve di fade-in e di fade-out nelle dissolvenze incrociate
esattamente come avviene per le dissolvenze semplici.

e Perridimensionare in maniera simmetrica la durata della dissolvenza incrociata, premere
Shift, fare clic sull'area della dissolvenza incrociata e trascinare a destra e a sinistra.

e Perridimensionare in maniera simmetrica la regione della dissolvenza incrociata, premere
Ctrl/Cmd, fare clic sull'area della dissolvenza incrociata e trascinare a destra e a sinistra.

e Quando si sposta una clip in modo che questa si sovrapponga a un‘altra per creare una
dissolvenza incrociata e nessuna clip presenta un dissolvenza definita nella sovrapposizione,
viene creata una dissolvenza incrociata predefinita.

e Quando si sposta una clip con una curva di dissolvenza definita in modo che questa si
sovrapponga a un‘altra clip che non presenta una dissolvenza definita, la clip non spostata
assume automaticamente la stessa forma della dissolvenza della clip spostata, con la
compensazione delllampiezza. Questo si applica solo se la lunghezza di fade-out della clip
non spostata & impostata a zero.

e Seentrambe le clip presentano delle diverse curve di dissolvenza definite, viene creata una
dissolvenza asimmetrica.
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LINK CORRELATI
Opzioni per lo spostamento e la dissolvenza incrociata delle clip a pag. 231

Effetti per le tracce, per le clip e per I'uscita del montaggio

E possibile aggiungere i plug-in degli effetti VST a singole clip, tracce o all'uscita di un montaggio
audio. Gli effetti delle clip interessano solo le singole clip, gli effetti delle tracce tutte le clip in una
traccia, mentre gli effetti dell'uscita di un montaggio audio I'intero montaggio.

Nel montaggio audio possono essere utilizzati i plug-in VST 2 e VST 3. Ciascuna clip, traccia e
uscita di un montaggio possono essere processati in maniera indipendente da un massimo di
otto plug-in di effetti VST.

Gli effetti vengono configurati nel modo seguente:

e Come effetti in insert, dove I'intero materiale audio viene processato per mezzo degli effetti.

e Come effetti in mandata (modalita di divisione), dove il bilanciamento tra il suono non
processato e il livello di mandata dell'effetto pud essere controllato dalle curve di inviluppo
dell'effetto (solo effetti delle clip e specifici plug-in VST 2).

Un’'icona davanti al nome della clip indica che gli effetti sono applicati alla clip.

Passando sopra al nome di una clip vengono visualizzati gli effetti utilizzati per la clip.

Clip 1

Clip effects:
StereoDelay

NOTA

e Solo gli effetti delle clip per le clip attive nella posizione di riproduzione corrente consumano
potenza della CPU. Gli effetti delle tracce e dell'uscita del montaggio sono sempre attivi.

e La prima volta che viene riprodotto un montaggio audio dopo l'apertura o la copia, il
programma deve caricare in memoria tutti gli effetti. Se gli effetti sono numerosi, puo essere
udito un breve silenzio prima dell'inizio della riproduzione.

e  Gli effetti utilizzati per le tracce devono supportare I'audio stereo, anche se la traccia audio &
mono.

LINK CORRELATI

Aggiunta di effetti alle tracce, alle clip o all'uscita del montaggio a pag. 257
Effetti di output del montaggio a pag. 250

Finestra dell'Inspector a pag. 250
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Effetti di output del montaggio

E possibile aggiungere degli effetti di output a un montaggio audio. Mentre la Sezione Master &
condivisa da tutti i montaggi audio, gli effetti di output sono locali in ciascun montaggio. Questo
consente di ottenere un progetto totalmente integrato, senza necessita di utilizzare la Sezione
Master.

Gli effetti di output sono posizionati all'uscita del montaggio audio.
NOTA

Se si desidera utilizzare un plug-in di dithering, posizionarlo all'uscita del montaggio.

LINK CORRELATI
Aggiunta di effetti alle tracce, alle clip o all'uscita del montaggio a pag. 257
Finestra dellInspector a pag. 250

Finestra dell'Inspector

In questa finestra € possibile aggiungere i plug-in degli effetti alle tracce, alle clip e all'uscita del
montaggio e definire le impostazioni di panorama e guadagno.

e Per aprire la finestra dell'Inspector, aprire un montaggio audio e selezionare Finestre degli
strumenti di utility > Inspector.

250



Montaggio audio
Effetti per le tracce, per le clip e per l'uscita del montaggio

% O® Track 1

Clean
o

DeHummer

Enhance

Exciter

=]

b

Montage Effects

Menu
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Clip/Traccia/Uscita

In cima all'Inspector, € possibile decidere di visualizzare e modificare i plug-in per le clip, le
tracce, o l'uscita del montaggio nella finestra dell'Inspector.

Colore della clip/Colore della traccia

Consente di specificare un colore per la forma d'onda della clip o della traccia
selezionata.

Seleziona una clip/Seleziona una traccia
Consente di selezionare una clip o una traccia.
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Modifica il nome della clip/Modifica il nome della traccia

Consente di specificare un nome per la clip o la traccia selezionate.
Visibilita dei pannelli

Consente di visualizzare o nascondere i pannelli nella finestra dell'Inspector.

= INSPECTOR

Clip Effects

Sono disponibili le seguenti opzioni:
e Se é stata selezionata l'opzione Clip, sono presenti le opzioni Visualizza Effetti del
montaggio e Visualizza Guadagno.

e Se ¢ stata selezionata l'opzione Traccia, sono presenti le opzioni Visualizza
Pulizia, Visualizza Miglioramento, Visualizza Effetti del montaggio e Visualizza
Guadagno.

e Se é stata selezionata l'opzione Uscita, sono presenti le opzioni Visualizza Effetti
del montaggio e Visualizza Guadagno.

Pulizia (Solo per le tracce)

Il pannello Pulizia contiene un DeHummer, un DeNoiser e un DeEsser per rimuovere suoni
indesiderati dall'audio in tempo reale.
Ripiega/Esplodi il pannello di pulizia
Consente di ripiegare o esplodere il pannello Pulizia.
Bypassa tutti gli effetti qui visualizzati
Consente di bypassare il processamento di tutti gli effetti nel corso della riproduzione e
della renderizzazione.
DeHummer

L'effetto DeHummer consente di ridurre ronzii e interferenze causati da una cattiva
messa a terra o dall'utilizzo di apparecchiature di registrazione poco affidabili. Cid
avviene mediante la rimozione delle frequenze corrispondenti dall'audio.

Sono disponibili i seqguenti parametri:
e Reduction consente di specificare l'entita della riduzione dei ronzii.

e Listen consente di ascoltare il segnale che é stato rimosso dal materiale audio. Cio
permette di verificare che siano state rimosse le porzioni corrette di audio.

e Ivalori 50 Hz e 60 Hz consentono di rimuovere il rumore armonico con una
frequenza fondamentale a 50 o 60 Hz. Queste frequenze di disturbo possono
essere causate ad esempio da un rumore elettrico dovuto a una cattiva
schermatura delle apparecchiature di registrazione.

DeNoiser

Il modulo DeNoiser consente di rimuovere il rumore dal materiale audio, ad esempio
un suono d'ambiente.

Sono disponibili i seguenti parametri:

e Reduction consente di specificare l'entita della riduzione del rumore.
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e Listen consente di ascoltare il segnale che ¢ stato rimosso dal materiale audio
originale. Cid permette di verificare che siano state rimosse le porzioni corrette di
audio.

DeEsser

L'effetto DeEsser rappresenta un compressore che riduce le sibilanti eccessive,
principalmente per le registrazioni vocali.

E possibile ad esempio utilizzarlo quando un posizionamento estremamente
ravvicinato dei microfoni e I'equalizzazione portano a situazioni in cui il suono
complessivo & buono, ma con delle sibilanti indesiderate.

Quando si registra una voce, il DeEsser va generalmente posizionato nella catena
del segnale dopo il preamplificatore microfonico e prima di un compressore/

limiter. Questo impedisce al compressore/limiter di limitare inutilmente le dinamiche
complessive del segnale.

Sono disponibili i sequenti parametri:

e Reduction consente di specificare 'entita della riduzione delle sibilanti.

e Listen consente di ascoltare il segnale che e stato rimosso dal materiale audio
originale. Cid consente di verificare che siano state rimosse le porzioni corrette di
audio.

e Character consente di specificare la frequenza su cui viene applicato il DeEsser.
Un valore ridotto del parametro Character viene ad esempio utilizzato spesso per
le voci maschili. Valori piu elevati si applicano generalmente a voci femminili o voci
bianche dal registro piu alto.

e Lindicatore Reduction visualizza l'entita con cui sta operando il DeEsser.

Miglioramento (Solo per le tracce)

Il pannello Miglioramento contiene gli effetti Voice Exciter, Reverb, EQ e Maximizer che
consentono di aumentare la chiarezza, I'espressione e la profondita del materiale audio in tempo
reale.
Ripiega/Esplodi il pannello di miglioramento

Consente di ripiegare o esplodere il pannello Miglioramento.

Bypassa tutti gli effetti qui visualizzati
Consente di bypassare il processamento di tutti gli effetti nel corso della riproduzione e
della renderizzazione.

Voice Exciter

L'effetto Voce Exciter consente di aggiungere delle armoniche superiori e aumentare
la chiarezza e l'intelligibilita delle proprie registrazioni vocali.

Sono disponibili i seguenti parametri:
e Amount consente di specificare I'entita dell'effetto.
e Clarity consente di aumentare la chiarezza e l'intelligibilita delle proprie

registrazioni vocali.

Reverb
L'effetto Reverb aggiunge ampiezza e spazialita alle registrazioni che risultano senza
vigore.
Sono disponibili i seguenti parametri:

e Size consente di specificare la dimensione della stanza.
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e Mix consente di definire il bilanciamento tra il segnale originale e il segnale
processato.

EQ
L'EQ a tre bande consente di ridurre o enfatizzare gli intervalli di frequenze Low, Mid e
High. Un filtro Low Cut supplementare consente di tagliare le basse frequenze sotto i
30 Hz per una chiarezza ancora maggiore.

Le bande di equalizzazione presentano le seguenti specifiche:

e Low: low-shelf, frequenza 250 Hz, 12 dB/ottava
e Mid: peak, frequenza 1.500 Hz, Q 1, 12 dB/ottava
e Hi: high-shelf, frequenza 5.000 Hz, 12 dB/ottava

Maximizer

L'effetto Maximizer consente di aggiungere volume e spinta alle registrazioni,
mantenendo sempre il segnale sotto il livello di -1 dB. Il potenziometro Optimize
consente di specificare I'entita di compressione che viene applicata.

Effetti del montaggio
Il pannello Effetti del montaggio consente di aggiungere e gestire gli effetti plug-in.

Ripiega/Esplodi il pannello degli effetti
Consente di ripiegare/esplodere il pannello degli Effetti.

Le seguenti opzioni sono disponibili nel menu a tendina Menu:

Rimuovi i plug-in selezionati
Consente di rimuovere i plug-in selezionati dall'elenco degli Effetti del montaggio.

Rimuovi tutti i plug-in
Consente di rimuovere tutti i plug-in dall'elenco degli Effetti del montaggio.

Copia
Consente di copiare il plug-in selezionato e le relative impostazioni negli appunti.

Copia tutto
Consente di copiare tutti i plug-in e le relative impostazioni negli appunti.

Incolla (inserisci)

Consente di inserire il plug-in che & stato copiato negli appunti prima del primo
slot selezionato. Se non e selezionato nessuno slot, il plug-in viene inserito alla fine
dell'elenco dei plug-in.

Incolla (sostituisci)
Consente di sostituire il plug-in selezionato con il plug-in copiato negli appunti. Se non
é stato aggiunto alcuno slot, ne viene creato uno nuovo.
Chiudi tutte le finestre
Consente di chiudere tutte le finestre dei plug-in relative a questo montaggio audio.
Mappa dei plug-in
Consente di aprire la finestra di dialogo Mappa dei plug-in nella quale vengono
visualizzati tutti i plug-in utilizzati nel montaggio audio, nonché le clip e le tracce che li
utilizzano.
Aggiungi effetto
Consente di aggiungere un effetto.
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Le seguenti opzioni sono disponibili nella barra degli strumenti del pannello Effetti del
montaggio:

Copia
Consente di copiare il plug-in selezionato e le relative impostazioni negli appunti.

Incolla

Consente di inserire il plug-in che & stato copiato negli appunti prima del primo
slot selezionato. Se non e selezionato alcuno slot, il plug-in viene inserito alla fine
dell'elenco dei plug-in.

Rimuovi i plug-in selezionati
Consente di rimuovere i plug-in selezionati dall'elenco degli Effetti del montaggio. E
possibile fare Ctrl/Cmd -clic sui plug-in per selezionare i plug-in da rimuovere.
Rimuovi tutti i plug-in
Consente di rimuovere tutti i plug-in dall'elenco degli Effetti del montaggio.

Elenco degli effetti

Nell'elenco degli effetti sono visualizzati i plug-in degli effetti della clip, della traccia o dell'uscita
del montaggio selezionati. Nell'elenco, & possibile sostituire i plug-in degli effetti, variarne
I'ordine e modificarne la Coda.

Montage Effects
Menu |-|_“_‘| e 4

| StereoDeloy T

Coda

Se si fa clic sulla freccia a sinistra del nome del plug-in, & possibile specificare il valore
della coda per il plug-in.

Alcuni effetti, come il riverbero e il delay, producono delle code nell'audio. Questo
significa che il suono dell'effetto prosegue dopo il termine del suono della clip. Ad
esempio, se si aggiunge dell'eco a una clip senza specificare un valore di coda, I'effetto
dell’eco viene messo in mute al termine della clip. Configurare la lunghezza della coda
in modo da consentire il decadimento naturale dell'effetto. Se si aggiunge un altro
plug-in alla clip che produce anch’esso una coda, non & necessario impostare un valore
di coda separato per questo plug-in, a meno che si desideri sommare il decadimento.
La lunghezza totale della coda per la clip corrisponde alla somma della coda di ciascun
plug-in. Limpostazione massima della coda € 30 secondi.

Nome dell’effetto

Fare clic sul nome dell'effetto per aprire la finestra degli effetti corrispondente.
Facendo clic-destro sul nome di un effetto & possibile aprire il menu Plug-in in cui
selezionare un nuovo effetto.

Latenza

Se un plug-in presenta una latenza, il rispettivo valore viene visualizzato accanto al
nome del plug-in.

Montage Effects

Menu |-|_“_‘| & £

| Compressor 2ms] @
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Preset
Consente di salvare e ripristinare i preset dei plug-in.

Opzioni degli effetti

Apre il menu Plug-in in cui € possibile selezionare un nuovo plug-in e rimuovere il
plug-in esistente.

Bypassa effetto

Bypassa il plug-in durante la riproduzione e, in maniera opzionale, durante la
renderizzazione. Il segnale & ancora processato dal plug-in, ma non viene inserito nel
flusso udibile.

Guadagno

In questa sezione, & possibile modificare le impostazioni di Guadagno e Panorama per ciascuna
clip e per ciascuna traccia. E anche possibile impostare il guadagno globale per l'uscita del
montaggio.

Ripiega/Esplodi il pannello del guadagno
Consente di ripiegare o esplodere il pannello Guadagno.

Reimposta il guadagno a 0 dB
Consente di riportare il guadagno a 0 dB.

Guadagno
Consente di impostare il guadagno per gli effetti.

Se si seleziona Uscita in cima alla finestra dell'Inspector, & possibile impostare il
guadagno globale per il montaggio audio attivo.

Effetti pre/post (solo uscita del montaggio audio)

Consente di applicare il guadagno prima o dopo l'uscita del montaggio, in base
allimpostazione definita per il parametro Effetti pre/post. Effetti pre & impostazione
predefinita.

Intervallo del guadagno
Consente di incrementare la precisione del cursore. Se il guadagno attivo € al di fuori
di un determinato intervallo di guadagno, non & possibile selezionare I'intervallo del
guadagno.

Blocca il fader
Se questa opzione € attivata, non & possibile modificare il fader con il mouse.

Quadrante del panorama (solo clip e tracce)
Consente di impostare il panorama per gli effetti delle clip e delle tracce.

Reimposta il panorama al centro (solo clip e tracce)
Riporta il panorama alla posizione centrale.

Modalita di panorama (solo clip e tracce)
Consente di selezionare una modalita di panorama diversa da 0 dB o mute per
compensare un calo di dB quando il segnale & posizionato completamente a sinistra o
a destra.

LINK CORRELATI

Leggi di ripartizione stereo a pag. 242

Preset a pag. 81

Visualizzare/nascondere i pannelli nella finestra dell'Inspector a pag. 257
Inviluppi per le clip a pag. 237
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Visualizzare/nascondere i pannelli nella finestra dell'Inspector

E possibile visualizzare o nascondere i pannelli nella finestra dell'Inspector per focalizzarsi
esclusivamente sui pannelli desiderati.

PROCEDIMENTO

1. Nella finestra dellInspector, selezionare la sezione per la quale si intende modificare le
impostazioni di visibilita dei pannelli. Le sezioni disponibili sono Clip o Traccia.

2. Fareclic su Visibilita dei pannelli.
= INSPECTOR

| 1|I If"ill :
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Clip Qutput

\ =%
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Clip Effects tage Effects

3. Selezionare i pannelli che si desidera visualizzare. Sono disponibili le seguenti opzioni:

e Visualizza Effetti del montaggio consente di visualizzare/nascondere il pannello
Effetti.

e Visualizza Guadagno consente di visualizzare/nascondere il pannello Guadagno.

LINK CORRELATI
Finestra dell'Inspector a pag. 250

Aggiunta di effetti alle tracce, alle clip o all'uscita del montaggio

E possibile aggiungere i plug-in degli effetti a ogni traccia e clip del montaggio audio, nonché
all'uscita del montaggio audio stesso.

LINK CORRELATI

Aggiunta degli effetti dalla finestra dellInspector a pag. 257

Modalita supplementari per 'aggiunta degli effetti a pag. 258

Rimozione degli effetti dalle tracce, dalle clip o dall'uscita del montaggio a pag. 258

Aggiunta degli effetti dalla finestra dell'Inspector

PROCEDIMENTO
1. Aprire un montaggio audio.
2. Nella finestra dell'Inspector, fare clic su Clip, Traccia o Uscita.

3. Nel pannello degli Effetti, fare clic-destro su uno slot degli effetti e selezionare un plug-in.

RISULTATO
Il plug-in selezionato si apre in una finestra.

NOTA

E possibile aggiungere dei plug-in durante la riproduzione. Tuttavia, se si aggiunge un plug-in
con latenza maggiore di zero, & consigliabile interrompere e avviare nuovamente la riproduzione
per evitare discrepanze temporali. Inoltre, un ridotto numero di plug-in VST pud modificare la
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latenza in base alle impostazioni dei parametri. In tal caso, assicurarsi di interrompere e riavviare
la riproduzione dopo aver modificato la latenza.

LINK CORRELATI
Finestra dell'Inspector a pag. 250
Effetti per le tracce, per le clip e per I'uscita del montaggio a pag. 249

Modalita supplementari per I'aggiunta degli effetti

Gli effetti possono essere aggiunti non solo nella finestra dell'Inspector, ma anche tramite I'area
di controllo delle tracce e la finestra della forma d'onda.

e Per aggiungere un effetto a una traccia, fare clic su Aggiungi effetto nell'area di controllo di
una traccia stereo o mono e selezionare un effetto dal menu.

e Per aggiungere un effetto a una clip nella finestra di montaggio, fare clic-destro sul nome
della clip, selezionare Aggiungi effetto, quindi scegliere un effetto dal menu.

4+ Add Effect A

LINK CORRELATI

Area dei controlli delle tracce stereo e mono a pag. 192

Finestra dell'Inspector a pag. 250

Effetti per le tracce, per le clip e per I'uscita del montaggio a pag. 249

Rimozione degli effetti dalle tracce, dalle clip o dall'uscita del
montaggio

PROCEDIMENTO
1. Aprire un montaggio audio.

2. Nella finestra dellInspector, specificare dove si desidera rimuovere gli effetti selezionando
Clip, Traccia o Uscita.

3. Nel pannello Effetti del montaggio, eseguire una delle sequenti operazioni:

e Perrimuovere un effetto, fare clic-destro sull'effetto desiderato e selezionare Rimuovi
plug-in.

e Perrimuovere tutti gli effetti, fare clic su Menu e selezionare Rimuovi tutti i plug-in.

RISULTATO
L'effetto viene rimosso dallo slot degli effetti.

LINK CORRELATI

Aggiunta di effetti alle tracce, alle clip o all'uscita del montaggio a pag. 257
Finestra dell'Inspector a pag. 250
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Modifica dell'ordine degli effetti

L'ordine degli effetti nell'elenco determina l'ordine di processamento.

PROCEDIMENTO
1. Aprire un montaggio audio.

2. Nella finestra dell'Inspector, all'interno dell'elenco degli effetti, trascinare l'effetto che si
desidera spostare in un‘altra posizione.

LINK CORRELATI
Effetti per le tracce, per le clip e per l'uscita del montaggio a pag. 249
Finestra dellInspector a pag. 250

Copia delle impostazioni degli effetti nelle tracce, nelle clip o
nell'uscita del montaggio

E possibile copiare un effetto e le relative impostazioni di una traccia, di una clip o dell'uscita di
un montaggio in altre tracce, clip o nell'uscita dello stesso montaggio o di un altro.

PROCEDIMENTO
1. Aprire un montaggio audio.
2. Nella finestra dellInspector, eseguire una delle seguenti operazioni:

e Selezionare l'effetto dal quale si desidera copiare le impostazioni e selezionare Menu >
Copia.
e Fare clic-destro sull'effetto dal quale si desidera copiare le impostazioni e selezionare
Copia.
e Per copiare tutti gli effetti e le relative impostazioni, fare clic su Menu > Copia tutto.
3. Esequire una delle sequenti operazioni:
e Perincollare le impostazioni in un nuovo slot, selezionare Menu > Incolla (inserisci).

e Per sostituire un effetto esistente, selezionarlo e scegliere Menu > Incolla (sostituisci).

LINK CORRELATI
Effetti per le tracce, per le clip e per l'uscita del montaggio a pag. 249
Finestra dellInspector a pag. 250

Annullamento delle modifiche agli effetti

E possibile annullare/ripristinare le modifiche alle impostazioni degli effetti. Tuttavia, WavelLab
Elements registra le modifiche solamente quando si chiude la finestra dei plug-in o si seleziona
un‘altra scheda nella finestra stessa.

PROCEDIMENTO

1. Nella finestra dei plug-in, fare clic su un‘altra finestra per annullare il focus del plug-in del
quale si desidera annullare le impostazioni.

2. Tornare al plug-in del quale si desidera annullare le impostazioni.

3. Nella barra di comando della finestra Montaggio audio, fare clic su Annulla o su Ripeti.
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Effetti per le tracce, per le clip e per l'uscita del montaggio

Configurazione del panorama e del guadagno per gli effetti

E possibile impostare il Panorama e il Guadagno degli effetti in maniera individuale per ciascuna
clip e per ciascuna traccia.

PROCEDIMENTO
1. Aprire un montaggio audio.
2. Nella finestra dell'Inspector, fare clic su Clip o su Traccia.

3. Regolare il Panorama e il Guadagno.

Per le clip, il parametro Guadagno viene applicato post-effetto.

0.00 dB

Impostazioni di guadagno per le clip

LINK CORRELATI

Finestra dell'Inspector a pag. 250

Effetti per le tracce, per le clip e per I'uscita del montaggio a pag. 249
Configurazione del guadagno globale per gli effetti a pag. 260

Configurazione del guadagno globale per gli effetti

E possibile impostare un guadagno globale per gli effetti di output del montaggio audio e
applicarlo prima o dopo di essi.

PROCEDIMENTO
1. Aprire un montaggio audio.
2. Nella finestra dell'Inspector, fare clic su Uscita.

3. Nel pannello Guadagno, regolare il guadagno globale.
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Effetti per le tracce, per le clip e per l'uscita del montaggio

0.00 dB

Impostazioni di guadagno per gli effetti di uscita del montaggio

4. Fare clic su Effetti pre/post per applicare il guadagno globale prima o dopo gli effetti di
uscita del montaggio audio.

Guadagno globale prima degli effetti di uscita del montaggio

Guadagno globale dopo gli effetti di uscita del montaggio

Se si utilizza un plug-in di dithering, impostare il guadagno su pre-master.

LINK CORRELATI
Finestra dell'Inspector a pag. 250
Effetti per le tracce, per le clip e per I'uscita del montaggio a pag. 249

Finestre dei plug-in per i montaggi audio

Nelle finestre dei plug-in per i montaggi audio, € possibile visualizzare i plug-in degli effetti
utilizzati per una traccia, per una clip o per l'uscita del montaggio.

15.00 kHz 15.00 kHz

U]

O steinberg

Finestra dei plug-in singola
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Montaggio audio

Effetti per le tracce, per le clip e per l'uscita del montaggio

Quando si aggiunge un nuovo plug-in a una traccia, a una clip o a un’uscita del montaggio,

la finestra dei plug-in si apre automaticamente. Nella finestra dei plug-in, gli effetti vengono
visualizzati in una catena di plug-in predefinita. Per modificare l'ordine di processamento degli
effetti, & possibile trascinare ciascun effetto in una nuova posizione nella catena.

Catena di plug-in

Se l'opzione Utilizza la finestra della catena di plug-in ¢ attivata nel menu a tendina
Impostazioni della Sezione Master, gli effetti del file audio attivo vengono visualizzati
in una catena di plug-in nella parte superiore della finestra dei plug-in.

E possibile fare clic-destro sulla scheda di un plug-in o su una scheda vuota per
selezionare un nuovo plug-in per lo slot.

Bypassa effetto

Se questa opzione € attivata, il plug-in viene bypassato durante la riproduzione e la
renderizzazione. Tuttavia, bypassando gli effetti viene comunque consumata potenza
della CPU durante la riproduzione. Fare inoltre riferimento a: Bypass e disabilitazione
degli effetti a confronto

Attiva/disattiva lI'effetto

Se si disattiva un plug-in, questo viene escluso sia dalla riproduzione, sia dalla
renderizzazione. Fare inoltre riferimento a: Bypass e disabilitazione degli effetti a
confronto

Preset

Consente di visualizzare un menu in cui € possibile caricare o salvare preset per il
plug-in.

LINK CORRELATI

Apertura della finestra dei plug-in a pag. 262

Finestre dei plug-in per la Sezione Master a pag. 289
Bypass e disabilitazione degli effetti a confronto a pag. 290

Apertura della finestra dei plug-in

E possibile aprire la finestra dei plug-in da diverse posizioni del programma.

Per aprire la finestra dei plug-in dalla finestra dell'Inspector, fare clic su un plug-in
nell'elenco degli Effetti.

Per aprire la finestra dei plug-in dalla finestra della Sezione Master, fare clic su un plug-in
nell'elenco degli Effetti.

Per aprire la finestra dei plug-in per una clip dalla finestra del montaggio, fare clic-destro
sulla clip e selezionare Modifica i plug-in.

|:r-— |; |
PR O ST L

Active Clip

= Edit Plug-ins.

3

"\ Edit Source

E inoltre possibile fare clic-destro sul nome della clip e selezionare un plug-in.
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Montaggio audio
Effetti per le tracce, per le clip e per l'uscita del montaggio

Effects
Distortion

L3

e Per aprire la finestra dei plug-in per una traccia, fare clic sul pulsante Effetti della traccia
nell'area dei controlli delle tracce e selezionare un plug-in.

LINK CORRELATI

Finestre dei plug-in per i montaggi audio a pag. 261
Finestra dellInspector a pag. 250

Finestra Sezione Master a pag. 284

Menu Clip attiva a pag. 229

Area dei controlli delle tracce a pag. 191

Aggiunta degli effetti dalla finestra dei plug-in

Gli effetti che vengono aggiunti a una clip, a una traccia o all'uscita del montaggio nella finestra
dellInspector vengono automaticamente visualizzati nella finestra dei plug-in. Tuttavia, & anche
possibile aggiungere degli effetti a una traccia o a una clip direttamente dalla finestra dei plug-in.

PROCEDIMENTO

1. Aprire la finestra dei plug-in per la clip, la traccia o l'uscita del montaggio a cui si desidera
aggiungere un effetto.

2. Nella finestra dei plug-in, fare clic su Aggiungi un plug-in.

h

3. Selezionare un effetto dal menu.
L'effetto viene aggiunto alla fine della catena dei plug-in.

4. Facoltativo: se si desidera spostare l'effetto aggiunto nella catena di plug-in, trascinarlo in
un‘altra posizione.

Cambio degli effetti dalla finestra dei plug-in

PROCEDIMENTO

1. Aprire la finestra dei plug-in per la clip, la traccia o I'uscita del montaggio per cui si desidera
cambiare un effetto.

2. Fare clic sullicona del menu dei plug-in e selezionare un nuovo effetto dal menu.
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Montaggio audio

Effetti per le tracce, per le clip e per l'uscita del montaggio

4> gl 5101

L3

y Distortion =+
Plug-in Menu

[

3. Facoltativo: se si desidera spostare l'effetto modificato in una finestra della catena di plug-in,
trascinarlo in un‘altra posizione.
LINK CORRELATI

Finestre dei plug-in per i montaggi audio a pag. 261
Aggiunta degli effetti dalla finestra dei plug-in a pag. 263

Scorrimento tra gli effetti delle tracce, delle clip e dell'uscita del montaggio
nelle finestre dei plug-in

Nelle finestre dei plug-in, € possibile scorrere tra le catene degli effetti delle clip, delle tracce e
dell'uscita del montaggio.

e Per selezionare un effetto nella finestra dei plug-in, fare clic sul rispettivo nome.

e Per scorrere tra le clip del montaggio audio attivo e visualizzarne i relativi effetti, utilizzare le
icone freccia sinistra e destra.

e Per scorrere tra le tracce del montaggio audio attivo e visualizzarne i relativi effetti, utilizzare
le icone freccia in su e in giu.
BE Mext Track

e Quando si utilizza un’unica finestra dei plug-in per le clip e le tracce di un montaggio audio, &
possibile alternare i plug-in della clip attiva o della traccia che contiene la clip attiva facendo
clic sulle icone Visualizza i plug-in della clip o Visualizza i plug-in della traccia.

¥ Show Clip Plug-ins

B Show Track Plug-ins

e Per bloccare una finestra dei plug-in, attivare Blocca la finestra. Se questa opzione ¢ attivata
e si seleziona un’altra traccia o clip, viene visualizzata un‘altra finestra dei plug-in. Se questa
opzione & disattivata e si seleziona un‘altra traccia o clip, gli effetti vengono visualizzati nella
stessa finestra dei plug-in.
44 > )
E-tEreu::I:]El.a'-,-k 5 i

B Lock Window
LINK CORRELATI

Finestre dei plug-in per i montaggi audio a pag. 261

Chiusura di tutte le finestre dei plug-in

PROCEDIMENTO

1.
2.

Aprire un montaggio audio.

Selezionare Finestre degli strumenti di utility > Inspector.
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Montaggio audio
Finestra CD

3. Nella finestra dell'Inspector, selezionare Menu > Chiudi tutte le finestre.

LINK CORRELATI
Finestra dellInspector a pag. 250

Finestra CD

La finestra CD consente di visualizzare le clip del montaggio audio attivo e di scrivere il
montaggio audio su un CD audio.

NOTA

Ciascuna clip contenuta nel montaggio audio corrisponde a una traccia CD presente nella
finestra CD.

E inoltre possibile regolare le pause tra le clip, verificare la conformita agli standard Red Book,
aggiungere e modificare CD-Text e aggiungere codici ISRC e UPC/EAN. Quando si seleziona una
clip nella finestra del montaggio, la clip corrispondente viene evidenziata nella finestra CD.

e Per aprire la finestra CD, aprire un montaggio audio e selezionare Finestre degli strumenti
di utility > CD.

)
CD Select Qv I & EEE

) Srce  Name X Pause Length Pre-Gain Post-Gain ISRC CD-Text Comment

1M AN T

2 ekl

3L AN TrackC
41 AN Track D

Elenco tracce
Riproduci pre-roll
113
Riproduce la traccia corrispondente a partire dall'inizio con un valore di pre-roll.
E anche possibile premere Alt e fare clic su Riproduci pre-roll per riprodurre la traccia
corrispondente dall'inizio con un breve valore di pre-roll.
Riproduci
Ll
Riproduce la traccia corrispondente a partire dall'inizio.
E possibile tenere premuto Ctrl/Cmd e fare doppio-clic sul triangolo di un marker di
inizio traccia CD per avviare la riproduzione dalla posizione del marker.
Nome
Consente di visualizzare il nome della traccia. Per modificare il nome, fare doppio-clic
sulla cella corrispondente e inserire un nuovo valore.
FX
Consente di visualizzare I'eventuale utilizzo di effetti da parte della clip corrispondente.

Pausa
Mostra le pause tra due tracce.
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Finestra CD

Avvia
Mostra la posizione di inizio della traccia.
Fine
Mostra la posizione di fine della traccia.
Lunghezza
Consente di visualizzare la durata temporale dalla posizione di inizio della traccia CD

fino alla fine corrispondente o al marker di giunzione.

Guadagno-pre
Consente di impostare il guadagno pre-effetto per la clip.

Guadagno-post
Consente di impostare il guadagno post-effetto per la clip.

ISRC
Consente di inserire un codice ISRC. Per modificare il codice, fare doppio-clic sulla cella
corrispondente e inserire un nuovo valore.

CD-Text
Consente di specificare il CD-Text. Per modificare il CD-Text, fare doppio-clic sulla cella
corrispondente e inserire un nuovo valore.

Commento
Consente di inserire un commento facendo doppio-clic su una cella.

Menu CD

Scrivi CD Audio

Apre la finestra di dialogo Scrivi CD Audio o DDP da cui € possibile avviare la scrittura
di un CD o di un DDP.

Verifica la conformita del CD

Consente di verificare che le impostazioni per il montaggio audio siano conformi allo
standard Red Book.

Regola le pause fra le clip

Apre una finestra di dialogo in cui € possibile regolare le pause tra le clip. Sono
disponibili le seguenti opzioni:

e Imposta pausa specifica

e Arrotonda le pause esistenti al secondo piu vicino

Modifica CD-Text

Apre la finestra di dialogo Editor del CD-Text che consente di inserire del testo
descrittivo per le tracce scritte su CD.

NOTA

Questa opzione ¢ disponibile solamente se & stata selezionata la modalita Stereo nelle
Proprieta del montaggio audio.

Assegna codice UPC/EAN

Apre la finestra di dialogo Codice UPC/EAN in cui & possibile assegnare un codice
UPC/EAN a una clip.
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Montaggio audio
Esecuzione del mixdown - la funzione Renderizza

Segui la riproduzione

Se questa opzione € attivata e si riproduce un montaggio audio, una barra verde
accanto al nome della traccia CD indica la traccia CD in corso di riproduzione.

Menu Seleziona

Questo menu consente di selezionare le clip. Sono disponibili le sequenti opzioni:

e Seleziona tutte le clip

e Seleziona le clip che si trovano prima del cursore (sulla traccia selezionata)

e Seleziona le clip che si trovano dopo il cursore (sulla traccia selezionata)

e Deseleziona tutte le clip

LINK CORRELATI
Finestra di dialogo Editor del CD-Text a pag. 333

Creazione di tracce CD audio dalle clip

E possibile utilizzare l'opzione Verifica la conformita del CD per verificare se il montaggio audio
& pronto per la scrittura su CD audio.
PREREQUISITI

Assicurarsi che il montaggio audio contenga il materiale che si desidera inserire nel CD audio. Le
tracce CD devono avere una lunghezza di almeno 4 secondi.

PROCEDIMENTO

1. Ascoltare 'anteprima delle tracce nella finestra CD e apportare le eventuali correzioni
necessarie.

2. Facoltativo: nella finestra CD, selezionare CD > Verifica la conformita del CD.

e Seviene visualizzato un messaggio di allerta, apportare le necessarie correzioni e
verificare nuovamente la conformita del CD.

e Se non compaiono messaggi, il montaggio audio & pronto per essere scritto su un CD
audio.

LINK CORRELATI
Finestra CD a pag. 265

Esecuzione del mixdown - la funzione Renderizza

La funzione Renderizza consente di eseguire il mixdown dell'intero montaggio audio o di una
regione, in un singolo file audio.

E necessario eseguire un mixdown per produrre un file audio da un montaggio audio.

LINK CORRELATI
Renderizzazione nella Sezione Master a pag. 297

Renderizzazione dei montaggi audio in file audio

E possibile esequire la renderizzazione di regioni di montaggi audio o di interi montaggi audio
verso un singolo file audio.
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Montaggio audio
Meta-normalizzatore dell'intensita acustica

PREREQUISITI
Configurare il montaggio audio.

PROCEDIMENTO

Nella finestra Montaggio audio, selezionare la scheda Renderizza.

Nella sezione Sorgente, specificare quale parte del file audio si desidera renderizzare.
Nella sezione Risultato, attivare I'opzione File con nome.

Nella sezione Uscita, fare clic sul campo Formato e fare clic su Modifica.

Definire le impostazioni desiderate nella finestra di dialogo Formato file audio.

Fare clic su OK.

Facoltativo: definire delle impostazioni aggiuntive nella scheda Renderizza.

© N o U » wWw N =

Nella sezione Renderizza, fare clic su Avvia la renderizzazione.

RISULTATO
Il montaggio audio viene renderizzato.

LINK CORRELATI
Esecuzione del mixdown - la funzione Renderizza a pag. 267
Finestra di dialogo Formato file audio a pag. 133

Meta-normalizzatore dell'intensita acustica

Questo strumento & un componente di mastering fondamentale per garantire che tutti i brani
abbiano la stessa intensita acustica e per impedirne il clipping. Esso consente di regolare
I'intensita acustica di ciascuna clip nel montaggio audio in modo che presentino tutte lo stesso
valore. E inoltre possibile regolare l'intensita acustica del mixdown del montaggio audio, oltre
all'intensita acustica dell'uscita della Sezione Master.

Questo strumento opera sui guadagni. Non ha alcun effetto sui file audio di riferimento né
utilizza alcun compressore audio.

Se non & possibile modificare I'intensita acustica in una particolare clip senza produrre clipping,
il livello delle altre clip viene ridotto in modo che tutte le clip raggiungano comunque lo stesso
valore di intensita acustica. Questo non accade se & selezionata l'opzione Ignora i picchi nel
menu a tendina Picchi all'interno della finestra di dialogo Meta-normalizzatore dell'intensita
acustica.

Per evitare problemi di clipping a livello della Sezione Master, & possibile limitare I'uscita del
mixdown del montaggio audio prima che questo entri nella Sezione Master e/o limitare l'uscita
della Sezione Master stessa.

NOTA

e Il percorso audio nel montaggio audio utilizza un processamento a virgola mobile a 64 bit. E
quindi possibile sovraccaricarlo, ad esempio mediante livelli superiori a 0 dB nelle clip, senza
provocare fenomeni di clipping nel percorso del segnale. L'unica sezione del percorso audio
che puo introdurre clipping & quella di uscita della Sezione Master o del montaggio audio.
Entrambi i problemi possono essere risolti per mezzo del Meta-normalizzatore dell'intensita
acustica.
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Meta-normalizzatore dell'intensita acustica

e Poiché l'intensita acustica richiede diversi secondi di audio per essere calcolata in maniera
corretta, questo strumento non andrebbe utilizzato con clip molto brevi (inferiori ai 3
secondi).

Finestra di dialogo Meta-normalizzatore dell'intensita acustica

In questa finestra di dialogo € possibile regolare I'Intensita acustica di ciascuna clip nei montaggi
audio, in modo da assegnare loro lo stesso valore. E inoltre possibile regolare l'intera uscita.

e Per aprire la finestra di dialogo Meta-normalizzatore dell'intensita acustica, selezionare la
scheda Modifica nella finestra Montaggio audio e fare clic su Meta-normalizzatore nella
sezione Intensita acustica.

Opzioni Clip, Uscita della Sezione Master e Uscita del montaggio audio

e Sel'opzione Clip € attivata, le impostazioni relative al guadagno di tutte le clip nel montaggio
audio sono regolate singolarmente, cosi da consentirne la riproduzione allo stesso valore di
intensita acustica.

e Selopzione Uscita del montaggio audio ¢ attivata, il guadagno del montaggio audio viene
modificato in modo che il mixdown del montaggio audio corrisponda a un valore di intensita
acustica specifico.

e Sel'opzione Uscita della Sezione Master ¢ attivata, il guadagno della Sezione Master viene
regolato in modo che il mixdown del montaggio audio che viene processato attraverso tutti
i plug-in della Sezione Master corrisponda a un valore di intensita acustica specifico. Il
montaggio audio stesso non viene modificato da questa operazione.

Menu di corrispondenza dellintensita acustica
Consente di selezionare se l'uscita del montaggio audio deve corrispondere a un valore
di intensita acustica specifico. Sono disponibili le sequenti opzioni:
e Non modificare I'intensita acustica
e Fai corrispondere alla clip con intensita acustica maggiore (solo per le clip)
e Ottieni l'intensita acustica della clip attiva (solo per le clip)
e Equalizzai livelli di picco (solo per le clip)

Il picco piu elevato viene utilizzato come riferimento.

Menu dei picchi
Selezionare se & necessario che WavelLab Elements limiti i valori dei campioni (picchi
digitali) o ignori i picchi.

Picco massimo

Consente di determinare il valore di picco massimo che non deve essere superato.

Forza la stessa intensita acustica
Se € selezionata l'opzione Limita i picchi reali o Limita i picchi digitali, alcune
clip potrebbero non raggiungere il guadagno necessario per l'intensita acustica di
riferimento. In tal caso, attivare I'opzione Forza la stessa intensita acustica per
ridurre l'intensita acustica della clip utilizzata come riferimento, in modo da ottenere la
stessa intensita acustica in tutte le clip.
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Finestra Note

Opzioni aggiuntive

Escludi gli effetti del montaggio audio
Se questa opzione € attivata, gli effetti del montaggio audio non vengono presi in
considerazione quando si utilizza il Meta-normalizzatore dell'intensita acustica.

Questa opzione ha effetto anche sui parametri Pre-guadagno e Post-guadagno nella
finestra CD.

e Se l'opzione Escludi gli effetti del montaggio audio ¢ attivata, il Meta-
normalizzatore dell'intensita acustica modifica il valore di Pre-guadagno delle
clip.

e Se l'opzione Escludi gli effetti del montaggio audio & disattivata, il Meta-
normalizzatore dell'intensita acustica modifica il valore di Post-guadagno delle
clip.

Solamente le clip selezionate

Se questa opzione € attivata, solo le clip selezionate vengono processate con il Meta-
normalizzatore dell'intensita acustica.

Finestra Note

Questa finestra consente di inserire delle note relative alla sessione del montaggio audio
corrente.

e Per aprire la finestra Note, aprire un montaggio audio e selezionare Finestre degli
strumenti di utility > Note.

NOTES
Segoe Ul

E possibile inserire del testo direttamente in questa finestra e utilizzare i controlli dell'editor di
testo HTML standard per formattare il testo, aggiungere immagini ed elenchi. Le note vengono
salvate con il montaggio audio.

Importazione di CD audio

E possibile importare i file dei CD audio. Il CD audio importato si apre sotto forma di un
montaggio audio.

PROCEDIMENTO
1. Selezionare File > Importa.
2. Fare clic su CD audio.

3. InEsplora file/macOS Finder, selezionare il file CD audio semplificato che si desidera
importare e fare clic su Importa.

RISULTATO

Il CD audio importato si apre sotto forma di un nuovo montaggio audio senza titolo che contiene
tutte le tracce audio salvate al suo interno.
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Registrazione

E possibile registrare I'audio nellEditor audio e nella finestra Montaggio audio.

Possono essere utilizzati i sequenti metodi di registrazione:

Nell'Editor audio & possibile registrare i file con opzioni multiple tramite la finestra di
dialogo Registrazione.

e Nellafinestra Montaggio audio & possibile registrare piu tracce di un montaggio audio
contemporaneamente.

e Epossibile eseguire la registrazione mentre si ascoltano gli effetti quando si esegue il
monitoraggio del segnale in ingresso.

LINK CORRELATI

Registrazione nell’Editor audio a pag. 271
Finestra di dialogo Registrazione a pag. 272

Registrazione nell’Editor audio

Prima di avviare la registrazione, configurare la finestra di dialogo Registrazione.

PROCEDIMENTO

1. Nell'Editor audio, fare clic sul pulsante Registra o premere * sul tastierino numerico.
Si apre la finestra di dialogo Registrazione.

2. Nella sezione File da creare della finestra di dialogo Registrazione, aprire il menu a tendina
e definire se si desidera registrare un file con nome o un file temporaneo.

3. Selezionare un nome per il file e la relativa posizione di salvataggio.

4. Selezionare il formato audio eseguendo una delle seqguenti operazioni:
e Fare clic sul pulsante freccia giu per selezionare un formato audio predefinito.
e Fare clic sul formato audio per visualizzare la finestra di dialogo Formato file audio,

quindi fare clic su OK.

5. Selezionare se si desidera registrare su un file audio o su una traccia del montaggio audio,
tramite una delle seguenti opzioni:
e Creauna nuova finestra del file audio
e Aggiungi al file audio attivo
e Aggiungi alla traccia attiva del montaggio

6. Scegliere se si desidera visualizzare il Livello o il display dello Spettro nel corso della
registrazione.

7. Facoltativo: definire eventuali impostazioni supplementari nella sezione Opzioni e nelle
schede Opzioni e Valori.

8. Fare clic su Registra per avviare la registrazione.

Se é stata selezionata una delle opzioni di avvio automatico, la registrazione entra in
modalita Pausa e vi resta finché non vengono soddisfatti i criteri di avvio automatico.
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Registrazione
Registrazione nell'Editor audio

Lo sfondo della finestra di dialogo Registrazione diventa rosso per indicare una
registrazione in corso.

9. Facoltativo: mettere in pausa la registrazione facendo clic sul pulsante Pausa.

10. Facoltativo: rilasciare i marker durante la registrazione facendo clic sui pulsanti di rilascio dei
marker.

11. Una volta completata la registrazione, fare clic su Arresta.

12. Facoltativo: se si desidera registrare un‘altra sessione, fare di nuovo clic su Registra.

LINK CORRELATI
Finestra di dialogo Registrazione a pag. 272

Finestra di dialogo Registrazione

In questa finestra di dialogo, & possibile modificare le impostazioni di registrazione e avviare la
registrazione di un file audio.

Per aprire la finestra di dialogo Registrazione, eseguire una delle seguenti operazioni:
e Aprire 'Editor audio e fare clic su Registra nella barra di trasporto.

e Inaltre aree di lavoro, fare Alt/Opt-clic su Registra nella barra di trasporto.

e Nellafinestra Montaggio audio, premere Alt/Opt-R.
Recording n

File to Create

Named File ¥ Auto Number From Auto-Start if Sound Detected

MName track-1 Xxw @ Auto-Start at Given Time

Locatio einberg\Music

.o 14 100 ' 16 bit Auto-5top

Create New Audio File Window Auto-P:

Settings  Reset Audio Monitoring

Il Pause

Pulsanti principali
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Elimina
Consente di arrestare la registrazione ed eliminare tutto cid che & stato registrato fino
ad ora.

Arresta
Consente di arrestare la registrazione.

Pausa
Consente di mettere in pausa la registrazione.
Registra

Consente di avviare la registrazione. A seconda delle opzioni di registrazione, la
modalita Pausa & attivata o meno.

Scheda Metodo

In questa scheda, € possibile definire le opzioni di avvio, arresto e messa in pausa automatici
della registrazione. E possibile selezionare un dispositivo di ingresso e scegliere di avviare una
registrazione in un momento specifico oppure arrestarla dopo una determinata durata.

Method

File to Create Options

Temporary File ¥ rt if Sound Detected
Given Time
Duration

Create New Audio File Window

File da creare
Consente di specificare se si desidera registrare un file temporaneo da salvare
successivamente o se registrare un file con un nome e una posizione specifici.
Numero automatico da
Se questa opzione € attivata e si registrano piu file, vengono aggiunti dei numeri
crescenti ai nomi dei file.
Nome
Il nome del file da scrivere, senza percorso. Quando si digita, vengono visualizzati tutti i
file presenti nella cartella selezionata che iniziano con le stesse lettere. Per visualizzare
tutti i file nella cartella selezionata, fare clic sull'icona elenco.
Posizione
Consente di specificare la cartella nella quale si desidera salvare la registrazione.

Formato file audio
Consente di visualizzare la finestra di dialogo Formato file audio, nella quale e
possibile impostare il formato del file.

Posizione della registrazione
Consente di specificare la posizione in cui 'audio viene registrato:

e Se éselezionata l'opzione Crea una nuova finestra del file audio, 'audio viene
registrato in una nuova finestra.

e Se éselezionata l'opzione Aggiungi al file audio attivo, I'audio viene registrato
nella finestra del file audio attivo alla posizione del cursore di modifica. Se non
esiste alcun file audio, ne viene creato uno nuovo.
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e Se éselezionata l'opzione Aggiungi alla traccia attiva del montaggio, I'audio
viene registrato in un montaggio audio esistente alla posizione del cursore di
modifica. Se non esiste alcun montaggio audio, ne viene creato uno nuovo.

Avvio automatico se viene rilevato il suono
Se questa opzione € attivata, la registrazione inizia quando il livello dellingresso audio
supera il livello di soglia specificato nella scheda Valori.

Avvio automatico a un tempo specifico
Se questa opzione € attivata, la registrazione avra inizio a un determinato orario.
Specificare l'orario nella scheda Valori.

Arresto automatico dopo la durata indicata
Se questa opzione € attivata, la registrazione si arresta automaticamente dopo la
durata specificata nella scheda Valori.

Arresto automatico in caso di silenzio
Se questa opzione € attivata, la registrazione si arresta automaticamente quando il
livello dell'ingresso audio scende al di sotto di un livello soglia specifico e vi rimane per
una specifica durata. Specificare il livello e la durata nella scheda Valori.

Pausa automatica in caso di silenzio

Se questa opzione € attivata, la registrazione viene messa in pausa automaticamente
quando il livello dell'ingresso audio scende al di sotto di un livello soglia specificato e vi
rimane per una specifica durata. Specificare il livello e la durata nella scheda Valori.

Scheda Opzioni

In questa scheda, € possibile definire delle impostazioni aggiuntive per il processo di
registrazione.

ng in Audio File

After Recording, it Cursor to the End

Attiva il monitoraggio all'apertura della finestra di registrazione

Se questa opzione € attivata, il monitoraggio e attivo quando si apre la finestra di
dialogo Registrazione. Se ¢ disattivata, gli indicatori e il monitoraggio audio vengono
visualizzati quando si preme Registra o si attiva la funzione Monitora.

Aggiungi dei marker all'inserimento di una registrazione in un file audio

Se questa opzione ¢ attivata e viene inserita una registrazione all'interno di un file
audio, vengono aggiunti dei marker all'interno dei nuovi campioni.

Dopo la registrazione, sposta il cursore di modifica alla fine

Se questa opzione € attivata, il cursore di modifica viene spostato alla fine della
registrazione.

Scheda Valori

In questa scheda, € possibile definire dei valori per diverse opzioni di registrazione.
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Auto-5Start on Sound Recording Programming
Threshold ( -36 dB Start
Record Previous Samples 500 ms Duration

Silence Detection

Thresho Pause Memory

ilence Duration Required

Avvio automatico al segnale sonoro - Soglia (RMS)
Consente di specificare il livello sonoro che attiva la registrazione.

Avvio automatico al segnale sonoro - Registra campioni precedenti

Consente di includere una breve sezione audio prima del punto di inizio, ad
esempio per catturare degli attacchi. Questo ha effetto solamente se I'opzione Avvio
automatico se viene rilevato il suono é attivata.

Rilevamento del silenzio - Soglia (RMS)/Durata del silenzio necessaria

Questo € il valore soglia utilizzato per le opzioni Arresto automatico in caso

di silenzio e Crea automaticamente dei marker ai punti silenziosi. Esso viene
utilizzato insieme allimpostazione Durata silenzio richiesta per fare in modo che
la registrazione venga arrestata o venga aggiunto un marker se il livello di ingresso
rimane al di sotto del valore soglia per la durata specificata.

Programmazione della registrazione - Inizio
Consente di specificare l'orario di avvio della registrazione se I'opzione Avvio
automatico a un tempo specifico & attivata.

Programmazione della registrazione - Durata
Consente di specificare la durata della registrazione se l'opzione Arresto automatico
dopo la durata indicata é attivata.

Programmazione della registrazione - Domani
Se questa opzione ¢ attivata, € possibile specificare un orario per il giorno successivo (a
partire dalla mezzanotte).

Memoria della pausa

Si tratta del buffer di sicurezza che viene utilizzato in combinazione con il pulsante
Pausa. Quando si riprende la registrazione, questo buffer viene utilizzato per
ripristinare una breve sezione dell'audio antecedente alla disattivazione del pulsante
Pausa. In questo modo, & possibile riprendere la registrazione anche se & stato
disattivato il pulsante Pausa leggermente in ritardo.

Display dell'indicatore

¥ Settings  Rese Aonitoring

Recorded Time:

Disk Capacity:
Marker Name

Livello/Spettro
Specifica se viene visualizzato I'Indicatore di livello o o Spettrometro.
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Impostazioni

Se & selezionata l'opzione Livello, questo pulsante apre la finestra di dialogo
Impostazioni dell'indicatore di livello, in cui & possibile personalizzare le
impostazioni dell'indicatore.

Se & selezionata l'opzione Spettro, si apre un menu a tendina in cui & possibile
selezionare i livelli audio che devono essere visualizzati dall'indicatore. Per la
visualizzazione dello Spettro sono disponibili le sequenti impostazioni:

e Restringi ai livelli audio elevati

e Includii livelli audio medi

e Includii livelli audio bassi

Reinizializza
Consente di reinizializzare i valori di picco.

Monitoraggio audio
Se questa opzione € attivata, ingresso audio viene inviato anche alle porte di uscita.

Pulsanti dei marker
Consentono di impostare i marker nel corso della registrazione.

Nome del marker successivo
Consente di modificare il nome del marker successivo da inserire.

LINK CORRELATI

Finestra di dialogo Formato file audio a pag. 133

Indicatore di livello e Spettrometro per le registrazioni a pag. 276
Finestra di dialogo Impostazioni dell'indicatore di livello a pag. 320

Indicatore di livello e Spettrometro per le registrazioni

Nella parte inferiore della finestra di dialogo Registrazione si trova un display dell'indicatore.
Questo display e utile per verificare il livello di ingresso e lo spettro delle frequenze del segnale in
ingresso.

E possibile attivare gli indicatori audio inserendo la spunta nella casella di controllo
Monitoraggio audio. Questa operazione avviene automaticamente se 'opzione Attiva il
monitoraggio all'apertura della finestra di registrazione ¢ attivata nella scheda Opzioni della
finestra di dialogo Registrazione.

Per reinizializzare gli indicatori, fare clic sul pulsante Reinizializza.

Indicatore di livello

NellIndicatore di livello, le barre orizzontali indicano il livello di picco (barre esterne) e
I'intensita acustica media (VU, barre interne) di ciascun canale. Vengono anche visualizzati i valori
numerici. Quando si fa clic sul pulsante Impostazioni, si apre la finestra di dialogo Impostazioni
indicatore di livello/panorama.

Spettrometro

Lo Spettrometro consente di visualizzare un diagramma a barre, che fornisce una
rappresentazione grafica continua dello spettro delle frequenze. Dal menu a tendina
Impostazioni € possibile scegliere se restringere la rappresentazione ai livelli audio elevati o
se includere anche i livelli bassi e medi.
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LINK CORRELATI
Finestra di dialogo Registrazione a pag. 272

Indicatore della capacita del disco

Questo indicatore collocato nella parte inferiore della finestra di dialogo Registrazione indica
approssimativamente lo spazio disponibile nell’hard disk specificato nella sezione File da creare
o nell'hard disk selezionato per i file temporanei.

NOTA

Quando sull’'hard disk & disponibile uno spazio inferiore a 30 secondi, I'indicazione della capacita
del disco viene visualizzata in rosso.

LINK CORRELATI
Finestra di dialogo Registrazione a pag. 272

Registrazione nella finestra Montaggio audio

A seconda della periferica ASIO collegata, WavelLab Elements rileva automaticamente i bus di
ingresso disponibili e crea i bus di ingresso stereo e mono nella sezione Connessioni audio.

LINK CORRELATI

Scheda Connessioni audio a pag. 18

Assegnazione automatica dei bus di ingresso per la registrazione (solo per le periferiche ASIO) a
pag. 277

Assegnazione manuale dei bus di ingresso per la registrazione a pag. 278

Registrazione con le proprieta automatiche dei file a pag. 278

Registrazione con le proprieta dei file personalizzate a pag. 279

Registrazione su piu tracce a pag. 280

Assegnazione automatica dei bus di ingresso per la registrazione
(solo per le periferiche ASIO)

Prima di poter awvviare la registrazione, € necessario assegnare dei bus di ingresso. Se si
sta utilizzando una periferica ASIO, come ad esempio un'interfaccia Steinberg UR, vengono
automaticamente create le porte di ingresso.

NOTA

Se non si utilizza una periferica ASIO, i bus di ingresso devono essere assegnati manualmente.

PROCEDIMENTO

1. Collegare la propria periferica al computer e avviare WavelLab Elements.
2. Selezionare File > Preferenze > Connessioni audio.

3. Fare clic su Registrazione.
4

Assicurarsi che la propria periferica ASIO sia selezionata nel menu Periferica audio.

I bus di ingresso vengono assegnati automaticamente.

b

Creare un montaggio audio.

6. Creare una traccia mono o stereo.
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7. Nellarea dei controlli delle tracce, fare clic su IN e selezionare il bus di ingresso per ciascuna
traccia.

RISULTATO
Wavelab Elements € pronto per la registrazione.

LINK CORRELATI

Assegnazione manuale dei bus di ingresso per la registrazione a pag. 278
Registrazione con le proprieta automatiche dei file a pag. 278
Registrazione con le proprieta dei file personalizzate a pag. 279
Registrazione su piu tracce a pag. 280

Scheda Connessioni audio a pag. 18

Area dei controlli delle tracce a pag. 191

Assegnazione manuale dei bus di ingresso per la registrazione
Prima di poter avviare la registrazione, & necessario assegnare dei bus di ingresso.
NOTA

Se si sta utilizzando una periferica ASIO, come ad esempio un’interfaccia Steinberg UR, vengono
automaticamente creati i bus di ingresso.

PROCEDIMENTO
1. Collegare la propria periferica al computer e avviare WavelLab Elements.
Selezionare File > Preferenze > Connessioni audio.

2

3. Fareclic su Registrazione.

4. Nellelenco dei Bus, selezionare il bus che si intende utilizzare per la registrazione.
5

Facoltativo: per aggiungere piu bus, fare clic su Aggiungi bus e assegnare altri bus di
ingresso.

6. Nella colonna Porta della periferica, assegnare le porte di ingresso.

RISULTATO
Wavelab Elements € pronto per la registrazione.

LINK CORRELATI

Assegnazione automatica dei bus di ingresso per la registrazione (solo per le periferiche ASIO) a
pag. 277

Scheda Connessioni audio a pag. 18

Registrazione con le proprieta automatiche dei file a pag. 278
Registrazione con le proprieta dei file personalizzate a pag. 279
Registrazione su piu tracce a pag. 280

Registrazione con le proprieta automatiche dei file

La registrazione con le proprieta automatiche dei file rappresenta il modo piu rapido per avviare
la registrazione nella finestra Montaggio audio.
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Il nome del file da registrare viene generato automaticamente. Il file registrato viene salvato
nella cartella dati del montaggio audio attivo. La risoluzione in bit del file registrato & la stessa
definita per i file temporanei.

PROCEDIMENTO

1. Nella finestra del montaggio, selezionare una traccia e fare clic alla posizione da cui si
desidera avviare la registrazione.

2. Nella barra di trasporto, fare clic su Registra.
3. Peravviare la registrazione, selezionare un bus di ingresso nel menu Ingresso audio.
4. Eseguire una delle seguenti operazioni:

e Per arrestare la registrazione, fare clic su Arresta nella barra di trasporto.

e Per arrestare e rimuovere la registrazione, fare Ctrl/Cmd -clic su Arresta nella barra di
trasporto. In questo modo il file registrato viene eliminato.

LINK CORRELATI

Assegnazione manuale dei bus di ingresso per la registrazione a pag. 278

Assegnazione automatica dei bus di ingresso per la registrazione (solo per le periferiche ASIO) a
pag. 277

Area dei controlli delle tracce a pag. 191

Finestra di dialogo Proprieta del file per la registrazione a pag. 281

Registrazione con le proprieta dei file personalizzate

Quando si esegue una registrazione nella finestra Montaggio audio, & possibile specificare il
nome, la posizione e la risoluzione in bit del file che si intende registrare.

PROCEDIMENTO

1. Nella finestra del montaggio, selezionare una traccia e fare clic alla posizione da cui si
desidera avviare la registrazione.

2. Nell'area dei controlli della traccia, fare clic su Ingresso audio e selezionare un bus di
ingresso.

3. Fare clic-destro su Registra e fare clic su Proprieta del file per la registrazione.

Record

Shertcut: Ctrl+:

4. Nella finestra di dialogo Proprieta del file per la registrazione, definire le impostazioni
desiderate e fare clic su Abilita la traccia per la registrazione.

La traccia € ora pronta per la registrazione.
5. Nella barra di trasporto, fare clic su Registra.
6. Esequire una delle sequenti operazioni:
e Per arrestare la registrazione, fare clic su Arresta nella barra di trasporto.

e Per arrestare e rimuovere la registrazione, fare Ctrl/Cmd -clic su Arresta nella barra di
trasporto. In questo modo il file registrato viene eliminato.
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LINK CORRELATI

Assegnazione manuale dei bus di ingresso per la registrazione a pag. 278

Assegnazione automatica dei bus di ingresso per la registrazione (solo per le periferiche ASIO) a
pag. 277

Area dei controlli delle tracce a pag. 191

Finestra di dialogo Proprieta del file per la registrazione a pag. 281

Registrazione su piu tracce

E possibile esequire una registrazione su piu tracce di un montaggio audio
contemporaneamente.

PREREQUISITI
Sono stati assegnati dei bus di ingresso per la registrazione.

PROCEDIMENTO

1. Nella finestra del montaggio, fare clic alla posizione da cui si desidera avviare la
registrazione.

2. Facoltativo: fare clic su Monitoraggio per monitorare il segnale in ingresso e regolarne il
livello.

3. Esequire una delle seguenti operazioni:

e Sesidesidera registrare dei file audio con le proprieta automatiche, fare clic su Registra
nell'area dei controlli delle tracce e selezionare un bus di ingresso.

Record

Shertcut: Ctrl+:

e Per specificare il nome del file, la posizione e la risoluzione in bit dei file audio
da registrare, fare clic-destro su Registra e fare clic su Proprieta del file per la
registrazione. Nella finestra di dialogo Proprieta del file per la registrazione, definire
le impostazioni desiderate e fare clic su Abilita la traccia per la registrazione.

La traccia € ora pronta per la registrazione.

4. Facoltativo: ripetere il passaggio 3 per tutte le tracce sulle quali si intende eseguire la
registrazione.

5. Nella barra di trasporto, fare clic su Registra per avviare la registrazione.
6. Eseguire una delle seguenti operazioni:
e Per arrestare la registrazione, fare clic su Arresta nella barra di trasporto.

e Per arrestare la registrazione di una singola traccia durante la registrazione
contemporanea di piu tracce, fare clic su Registra nell'area dei controlli della traccia
desiderata.

e Per arrestare e rimuovere la registrazione, fare Ctrl/Cmd -clic su Arresta nella barra di
trasporto. In questo modo il file registrato viene eliminato.

LINK CORRELATI

Assegnazione manuale dei bus di ingresso per la registrazione a pag. 278

Assegnazione automatica dei bus di ingresso per la registrazione (solo per le periferiche ASIO) a
pag. 277
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Area dei controlli delle tracce a pag. 191
Finestra di dialogo Proprieta del file per la registrazione a pag. 281

Finestra di dialogo Proprieta del file per la registrazione

Questa finestra di dialogo consente di specificare il nome file, la posizione e la risoluzione in bit
della traccia che si intende registrare.

e Per aprire la finestra di dialogo Proprieta del file per la registrazione, nell'area di controllo
delle tracce fare clic-destro su Registra e fare clic su Proprieta del file per la registrazione.

I File Properties for Recording *

ile Pro

Name Track1
Location
lio File in the Montage Data Folder

32 bit float ¥

¥ Cancel  Record Enable Track

Proprieta automatiche dei file

Se questa opzione € attivata, il nome del file da registrare viene generato
automaticamente. Il file registrato viene salvato nella cartella dati del montaggio audio
attivo. La risoluzione in bit del file registrato & la stessa definita per i file temporanei.

Proprieta dei file personalizzate

Se questa opzione € attivata, e possibile specificare il nome file e la posizione per il file
audio da registrare.

Scrivi il file audio nella cartella dati del montaggio
Se questa opzione € attivata, il file audio registrato viene salvato nella cartella dati
del montaggio audio. Per specificare una cartella personalizzata, disattivare questa
opzione.

Risoluzione in bit
Consente di specificare la risoluzione in bit del file audio da registrare.

LINK CORRELATI
Registrazione nella finestra Montaggio audio a pag. 277

Monitoraggio in ingresso

Eseguire il monitoraggio in ingresso significa ascoltare il segnale in entrata dopo che questo
ha viaggiato attraverso gli effetti nel corso delle operazioni preparatorie della registrazione
o durante la registrazione stessa. Questo consente di ascoltare I'effetto che la propria
configurazione di WaveLab Elements ha sul segnale in ingresso.

A seconda della catena di effetti, dell'unita hardware audio e dei driver utilizzati, il segnale
monitorato puo presentare una certa latenza.

E possibile decidere di monitorare il segnale che passa attraverso il montaggio audio e i relativi
effetti, oppure pud essere utilizzato il Monitoraggio diretto. Quest'ultimo consente di ascoltare
direttamente il segnale in ingresso prima che venga inviato attraverso WavelLab Elements e i
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relativi effetti. Il Monitoraggio diretto ha una latenza inferiore rispetto al monitoraggio del
segnale in ingresso. Per impostazione predefinita & attivato il Monitoraggio diretto.

LINK CORRELATI
Monitoraggio del segnale in ingresso a pag. 282
Monitoraggio diretto a pag. 282

Monitoraggio del segnale in ingresso

Il monitoraggio del segnale in ingresso consente di monitorare il segnale che passa attraverso il
montaggio audio e i relativi effetti.

PREREQUISITI
Sono stati configurati i bus di ingresso audio.

PROCEDIMENTO
1. Aprire un montaggio audio e configurare i propri effetti.

2. Nell'area dei controlli della traccia che si intende monitorare, fare clic su Seleziona l'ingresso
audio e selezionare un ingresso audio.

3. Fare clic su Monitora.

RISULTATO

E possibile monitorare il segnale in ingresso.
NOTA

Il segnale monitorato viene ritardato in relazione al valore di latenza, il quale dipende dalla
catena di effetti, dall'unita hardware audio e dai driver utilizzati.

LINK CORRELATI
Area dei controlli delle tracce a pag. 191
Registrazione nella finestra Montaggio audio a pag. 277

Monitoraggio diretto

PREREQUISITI
Sono stati configurati i bus di ingresso audio.

PROCEDIMENTO
1. Aprire un montaggio audio.

2. Nell'area dei controlli della traccia che si intende monitorare, fare clic su Seleziona l'ingresso
audio e selezionare un ingresso audio.

3. Fare clic-destro su Monitora e attivare 'opzione Monitoraggio diretto.

RISULTATO

E possibile monitorare i livelli in ingresso delle tracce audio.

LINK CORRELATI
Registrazione nella finestra Montaggio audio a pag. 277
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Inserimento dei marker durante la registrazione

Durante la registrazione, & possibile fare clic sui pulsanti dei marker per aggiungere dei marker
al file registrato.

PROCEDIMENTO
1. Aprire la finestra di dialogo Registrazione.

2. Facoltativo: se si desidera assegnare un nome ai marker inseriti anziché utilizzare dei marker
generici, inserire il nome desiderato nel campo Nome del marker successivo.

3. Definire le impostazioni desiderate e avviare la registrazione.
4. Selezionare il tipo di marker che si intende inserire.

e Perinserire un marker generico numerato, fare clic sul pulsante di colore giallo o
premere Ctrl/Cmd-M.

e Perinserire dei marker generici numerati di inizio e fine regione, fare clic sui pulsanti
bianchi, oppure premere Ctrl/Cmd-L/Ctrl/Cmd-R.

RISULTATO
Un marker viene rilasciato ogni volta che si fa clic sul pulsante marker.

NOTA

Se si inseriscono due o piu marker di inizio regione in una riga senza nessun marker di fine
regione in mezzo, viene mantenuto solo l'ultimo di tali marker di inizio. La stessa regola vale per i
marker di fine regione.

LINK CORRELATI
Finestra di dialogo Registrazione a pag. 272
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La Sezione Master rappresenta il blocco finale nel percorso del segnale prima dell'invio
dell'audio all’hardware, a un file o agli indicatori audio. Questa € la sezione in cui & possibile
regolare i livelli master, aggiungere gli effetti, esequire il ricampionamento e applicare il
dithering.

Le impostazioni e gli effetti della Sezione Master vengono tenuti in considerazione nei seguenti
casi:
e Quando siriproduce un file audio nella finestra della forma d'onda.

e Quando siriproduce un montaggio audio.

Si noti che gli effetti della Sezione Master sono globali e hanno effetto su tutte le clip e le
tracce in un montaggio audio.

e Quando si utilizza la funzione Renderizza.

e Quando si masterizza un CD a partire da un montaggio audio.

LINK CORRELATI
Finestra Sezione Master a pag. 284
Renderizzazione nella Sezione Master a pag. 297

Finestra Sezione Master

In questa finestra € possibile applicare i plug-in degli effetti, regolare il livello master, applicare il
dithering e renderizzare il file audio o il montaggio audio.

e Per aprire la finestra Sezione Master, selezionare Finestre degli strumenti di utility >
Sezione Master.
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Finestra Sezione Master

MASTERSECTION
O =, Preseti
Effects

Peak Master

Resampling
44100 Hz

Master Level
0dB 0dB 0dB 0dB 0dB 0dB

Final Effect / Dithering

La Sezione Master ¢ costituita dai seguenti pannelli:

o Effetti
e Ricampionamento
o Livello master

o Effetto di finalizzazione/Dithering

LINK CORRELATI

Pannello Effetti a pag. 287

Pannello di ricampionamento a pag. 291

Pannello Livello Master a pag. 293

Pannello Effetto di finalizzazione/Dithering a pag. 294

Percorso del segnale

I pannelli nella finestra Sezione Master corrispondono ai blocchi di processamento della Sezione
Master.

Il segnale passa attraverso questi blocchi, dall'alto verso il basso:

1. Audio da Wavelab Elements

2. Effetti
La modifica dell'ordine degli slot degli effetti influenza il percorso del segnale.
Ricampionamento

4. Livello master

Effetto di finalizzazione/Dithering

Gli indicatori audio monitorano il segnale tra il pannello Effetto di finalizzazione/Dithering
e 'hardware audio o il file su disco.
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6. Hardware audio o file su disco

Nella Sezione Master il segnale passa attraverso tutti i plug-in, anche se alcuni di questi si
trovano in stato di solo. Il suono, infatti, non & influenzato da questo perché i plug-in in mute
vengono bypassati dal flusso del processo di riproduzione.

LINK CORRELATI
Finestra Sezione Master a pag. 284

Strumenti della Sezione Master

Gli strumenti e le opzioni che si trovano in cima alla finestra della Sezione Master consentono di
regolare diverse impostazioni prima della renderizzazione del file, di regolare le impostazioni di
bypass e di decidere se il segnale della riproduzione passa o meno attraverso la Sezione Master.

MASTERSECTION

Bypassa la Sezione Master

Se questa opzione ¢ attivata, la Sezione Master viene ignorata durante la
riproduzione. Il processo di renderizzazione su file tiene comunque ancora in
considerazione tutti i plug-in.

Selettore dei canali

E possibile selezionare un singolo cluster di canali o tutti i cluster di canali di

un file audio multicanale. Se si seleziona un singolo cluster di canali, questo pud
essere renderizzato tramite 'opzione Renderizzazione sul posto in fondo alla Sezione
Master, oppure € possibile riprodurre il cluster di canali attraverso le porte audio
anteriore sinistra/destra o la porta audio mono. Le porte audio possono essere
configurate nella finestra di dialogo Connessioni audio.

= 4 Preset1

Eff: O Al Channels

Preset
Consente di salvare e richiamare i preset della Sezione Master. Il menu a tendina
Preset offre una serie di opzioni aggiuntive per salvare e caricare banchi ed effetti
predefiniti.

Reinizializza la Sezione Master
Rimuove tutti gli effetti attivi dagli slot e imposta I'uscita master a 0 dB.

Impostazioni
Apre il menu a tendina Impostazioni in cui € possibile definire una serie di

impostazioni per la Sezione Master.
Menu a tendina Impostazioni

Nascondi le finestre dei plug-in quando la Sezione Master non é visibile

Se questa opzione € attivata, le finestre dei plug-in vengono nascoste quando la
Sezione Master non é visibile.
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Visualizza i controlli dei plug-in nella finestra dei plug-in
Se questa opzione € attivata, i controlli dei plug-in vengono visualizzati nelle finestre
dei plug-in.

Utilizza la finestra della catena di plug-in

Consente di visualizzare tutti i plug-in aperti nella finestra dei plug-in come schede, il
che consente di spostarsi rapidamente tra i plug-in.

La finestra dei plug-in si sposta con la Sezione Master

Se questa opzione € attivata, quando si sposta la Sezione Master fluttuante si
spostano anche le finestre dei plug-in.

Ripristina l'ultima configurazione al prossimo avvio

Se questa opzione € attivata, la configurazione dei plug-in e le posizioni dei fader nella
Sezione Master vengono ripristinati al successivo avvio di WavelLab Elements.

Visibilita delle sezioni
Consente di visualizzare o nascondere le sezioni della Sezione Master.

Riordina
Riordina la Sezione Master in base alla frequenza di campionamento e alla
configurazione del canale del file audio attivo. Il bus interno della Sezione Master e
tutti i plug-in attivi vengono configurati di conseguenza.

Questa operazione viene eseguita automaticamente prima della riproduzione o della
renderizzazione. Talvolta & utile riordinare manualmente la Sezione Master perché
alcuni plug-in non accettano un segnale mono o stereo come ingresso, oppure

una determinata frequenza di campionamento. In questo caso, facendo clic sul
pulsante si viene informati degli eventuali problemi prima della riproduzione o della
renderizzazione.

Questa operazione non produce alcun effetto se la riproduzione € gia in corso o se non
& presente alcun file audio attivo.

LINK CORRELATI

Pannello Effetto di finalizzazione/Dithering a pag. 294
Finestra Sezione Master a pag. 284

Salvataggio dei preset della Sezione Master a pag. 302
Scheda Connessioni audio a pag. 18

Pannello Effetti

Questo pannello della Sezione Master consente di aggiungere fino a 8 effetti plug-in in serie e di
gestirne l'utilizzo.

E possibile richiudere/espandere o visualizzare/nascondere completamente il pannello Effetti.

e Perrichiudere/espandere il pannello Effetti, cliccarci sopra.

e Pervisualizzare/nascondere il pannello Effetti, fare clic-destro sull'intestazione di un
pannello e attivare/disattivare l'opzione Visualizza Effetti.

Effects

Ripiega/esplodi il pannello
Consente di espandere o richiudere il pannello.
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Bypassa tutti gli effetti
Consente di bypassare il processamento di tutti gli effetti nel corso della riproduzione e
durante la renderizzazione.
Aggiungi effetto
Consente di aggiungere un effetto a uno slot effetti vuoto.
Nomi dei plug-in degli effetti
Una volta che & stato aggiunto un plug-in a uno slot, € possibile fare clic sul nome del
plug-in per aprire e chiudere la finestra corrispondente.
Menu a tendina Preset
Consente di salvare e richiamare le impostazioni dei preset. Il menu a tendina Preset
offre una serie di opzioni aggiuntive per salvare e caricare banchi ed effetti predefiniti.
Menu a tendina Opzioni degli effetti
Consente di caricare un altro effetto nello slot degli effetti. Sono inoltre disponibili le
seguenti opzioni:
e |'opzione Rimuovi plug-in consente di rimuovere |'effetto dallo slot.

e Le opzioni Disponi tutti i plug-in verso il basso/Disponi tutti i plug-in verso
I'alto consentono di spostare gli effetti in un‘altra posizione.

e Sel'opzione Attivo e attivata, l'effetto e attivo. Se 'opzione Attivo e disattivata,
I'effetto viene escluso dalla riproduzione e dalla renderizzazione.

Solo (bypass)
Mette in solo il plug-in.

Bypassa effetto

Bypassa il plug-in durante la riproduzione e, in maniera opzionale, durante la
renderizzazione. Il segnale € ancora processato dal plug-in, ma non viene inserito nel
flusso udibile.

LINK CORRELATI
Finestra Sezione Master a pag. 284

Formati dei plug-in degli effetti supportati

Wavelab Elements supporta i plug-in specifici per WaveLab Elements, i plug-in VST 2 e i plug-in
VST 3.

Plug-in specifici di WaveLab Elements

In WavelLab Elements sono inclusi alcuni plug-in specifici, come ad esempio Resampler.

Plug-in VST

Il formato dei plug-in VST di Steinberg e supportato da programmi e plug-in di numerosi
produttori. WaveLab Elements include solo alcuni plug-in VST. Altri plug-in possono essere
acquistati separatamente da Steinberg o altri produttori.

Configurazione degli effetti

Il numero di effetti disponibili nel pannello Effetti dipende dal numero e dal formato dei plug-in
installati.
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Effects

Per selezionare un effetto plug-in per uno slot nel pannello Effetti, fare clic sullo slot
e selezionare l'effetto desiderato dal menu a tendina. Dopo aver selezionato un effetto,
quest'ultimo si attiva automaticamente e viene visualizzato il relativo pannello di controllo.

Per disattivare un effetto, fare clic-destro sul rispettivo slot e disattivare 'opzione Attivo. Per
attivare l'effetto, attivare nuovamente l'opzione Attivo.

Per rimuovere un effetto plug-in, fare clic-destro sul rispettivo slot e selezionare Rimuovi
plug-in dal menu a tendina.

Per visualizzare/nascondere la finestra di un plug-in, fare clic sul rispettivo slot.

Per mettere in solo un effetto, fare clic sul rispettivo pulsante Solo (bypass). Questo
consente di controllare soltanto il suono di tale effetto. E possibile anche bypassare gli effetti
tramite i relativi pannelli di controllo.

Per modificare l'ordine degli slot e quindi anche l'ordine in cui il segnale passa attraverso gli
effetti, fare clic su uno slot e trascinarlo in una nuova posizione.

LINK CORRELATI
Pannello Effetti a pag. 287
Finestra Sezione Master a pag. 284

Finestre dei plug-in per la Sezione Master

Nelle finestre dei plug-in della Sezione Master & possibile definire le impostazioni per gli effetti
plug-in della Sezione Master.

Per visualizzare la finestra di un plug-in, fare clic sul rispettivo slot nel pannello Effetti della
Sezione Master.

Catena di plug-in

Se l'opzione Utilizza la finestra della catena di plug-in ¢ attivata nel menu a tendina
Impostazioni della Sezione Master, gli effetti del file audio attivo vengono visualizzati
in una catena di plug-in nella parte superiore della finestra dei plug-in.

E possibile fare clic-destro sulla scheda di un plug-in o su una scheda vuota per
selezionare un nuovo plug-in per lo slot.

Bypassa effetto

Se questa opzione € attivata, il plug-in viene bypassato durante la riproduzione e la
renderizzazione. Tuttavia, bypassando gli effetti viene comunque consumata potenza
della CPU durante la riproduzione. Fare inoltre riferimento a: Bypass e disabilitazione
degli effetti a confronto

Solo (bypass)

Mette in solo il plug-in.
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Renderizzazione sul posto

Processa l'audio sul posto. I plug-in bypassati sono esclusi dal processamento e viene
eseguita una dissolvenza incrociata ai bordi dell'audio renderizzato.

Attiva/disattiva l'effetto
Se si disattiva un plug-in, questo viene escluso sia dalla riproduzione, sia dalla

renderizzazione. Fare inoltre riferimento a: Bypass e disabilitazione degli effetti a
confronto

Preset
Consente di visualizzare un menu in cui € possibile caricare o salvare preset per il
plug-in.

LINK CORRELATI

Finestra Sezione Master a pag. 284

Pannello Effetti a pag. 287

Preset dei plug-in degli effetti a pag. 291

Finestre dei plug-in per i montaggi audio a pag. 261
Bypass e disabilitazione degli effetti a confronto a pag. 290

Bypass e disabilitazione degli effetti a confronto

Per disattivare gli effetti, & possibile bypassarli o disabilitarli. Esiste tuttavia una differenza tra
bypassare e disabilitare gli effetti per quanto riguarda il processamento in tempo reale, la
renderizzazione e il comportamento in riproduzione.

Bypassare gli effetti Disabilitazione degli effetti
Cosa accade al processamento | Non & possibile sentire L'effetto non viene caricato e
in tempo reale quando si I'effetto, ma il processamento | non consuma potenza della
bypassa un effetto rispetto continua in background e CPU.
a quando l'effetto viene consuma potenza della CPU.
disabilitato?
Cosa accade al processo di L'effetto non viene caricato e | L'effetto non viene caricato e
renderizzazione quando si non consuma potenza della non consuma potenza della
bypassa un effetto rispetto CPU. CPU.
a quando l'effetto viene
disabilitato?
Cosa accade quando si attiva/ | La riproduzione continua Possono verificarsi piccole
disattiva la funzione di bypass |senza errori o interruzioni. interruzioni.
rispetto a quando si abilita/
disabilita I'effetto durante la
riproduzione?

LINK CORRELATI
Finestre dei plug-in per la Sezione Master a pag. 289
Finestre dei plug-in per i montaggi audio a pag. 261
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Preset dei plug-in degli effetti

Wavelab Elements viene fornito con una selezione di preset di fabbrica per i plug-in degli effetti
inclusi. E possibile utilizzarli cosi come sono oppure come punto di partenza per le proprie
impostazioni personali.

I plug-in di terze parti possono disporre di propri preset di fabbrica. Per accedere ai preset
relativi a un effetto, fare clic sul pulsante Preset nella rispettiva finestra del pannello di controllo
oppure sul pulsante Preset del rispettivo slot degli effetti. Le funzioni disponibili dipendono dal
tipo di plug-in.

Presets

LINK CORRELATI
Preset a pag. 81
Preset per i plug-in VST 2 a pag. 291

Preset per i plug-in VST 2

I plug-in VST 2 hanno una propria gestione dei preset.

Quando si fa clic sul pulsante Preset per questo tipo di effetti, viene visualizzato un menu a
tendina con le seguenti opzioni:
Carica banco/Salva banco
Consente di caricare e salvare set di preset completi. Il formato file & compatibile con
Cubase.
Carica banco predefinito/Salva banco predefinito
Consente di caricare il set predefinito di preset o di salvare il set corrente di preset
come banco predefinito.
Carica effetto/Salva effetto
Consente di caricare o salvare un preset. Questo formato &€ compatibile anche con
Cubase.
Modifica nome del programma corrente
Consente di definire un nome per il preset.

Elenco dei preset
Consente di selezionare uno dei preset caricati.

LINK CORRELATI
Preset dei plug-in degli effetti a pag. 291

Pannello di ricampionamento

Questo pannello della Sezione Master consente di ricampionare il segnale. Mediante I'utilizzo
del plug-in Resampler € possibile verificare i picchi prima del guadagno master e degli indicatori
audio e prima dell'applicazione delle funzioni di limiting e dithering.

E possibile richiudere/espandere o visualizzare/nascondere completamente il pannello
Ricampionamento.

e Perrichiudere/espandere il pannello Ricampionamento, cliccarci sopra.
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e Pervisualizzare/nascondere il pannello Ricampionamento, fare clic-destro sull'intestazione
di un pannello e attivare/disattivare 'opzione Visualizza Ricampionamento.

Resampling D]

Ripiega/esplodi il pannello
Consente di espandere o richiudere il pannello.

Attivato/Disattivato
Attiva/disattiva l'effetto di ricampionamento.

Usa la frequenza di campionamento preferita

Se questa opzione & attivata, il ricampionamento coincide con il valore di frequenza di
campionamento specificato come frequenza di campionamento preferita nella scheda
Connessioni audio.

NOTA

La frequenza di campionamento viene utilizzata solamente per la riproduzione. Questo
consente di riprodurre delle frequenze di campionamento non supportate dalla
propria periferica audio.

Menu Frequenza di campionamento
Consente di selezionare una frequenza di campionamento.

LINK CORRELATI
Scheda Connessioni audio a pag. 18
Finestra Sezione Master a pag. 284

Frequenza di campionamento del driver audio

La frequenza di campionamento del driver audio & visualizzata nella parte inferiore-destra della
finestra della Sezione Master. La frequenza di campionamento viene mostrata una volta avviata
la riproduzione o la registrazione.

Il valore rappresenta la frequenza di campionamento del file audio o del montaggio audio
riprodotti, o la frequenza di campionamento impostata nel plug-in Resampler nella Sezione
Master.

r

ERSECTION
O =, Preseti

Effects

Resampling

44100 Hz
Master Level

Final Effect / Dithering

LINK CORRELATI
Pannello di ricampionamento a pag. 291
Finestra Sezione Master a pag. 284
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Pannello Livello Master

Questo pannello della Sezione Master consente di controllare il livello master del file audio
attivo.

Master Level
0dE 0dB

1
-
1]

Fader

I fader del pannello Livello master regolano il livello di uscita finale. Utilizzare i fader per
ottimizzare il livello del segnale che viene inviato all'hardware audio.

NOTA

E importante evitare il clipping, specialmente durante il mastering. Il clipping & segnalato da
appositi indicatori della Sezione Master.

Indicatori audio

Gli indicatori di livello della Sezione Master visualizzano il livello del segnale prima del dithering
o di qualsiasi altro plug-in che & stato applicato dopo il fader master.

Utilizzare questi indicatori per ottenere una panoramica dei livelli dei segnali. I campi numerici
sopra i fader consentono di visualizzare i livelli di picco per ciascun canale. Gli indicatori di picco
diventano rossi appena il segnale produce clipping. Nel caso in cui cio si verificasse, si consiglia di
fare quanto segue:

e Abbassare ifader.

e Fare clic-destro sugli indicatori di clipping e selezionare Reinizializza picchi per
reinizializzarli.

e Riprodurre nuovamente la sezione fino a che non si presenta pit alcun problema di clipping.

Impostazioni

Processamento dei canali audio
Consente di mixare o filtrare i canali audio. Sono disponibili le seqguenti opzioni:

e Se é selezionata l'opzione Canali predefiniti, il flusso audio non viene modificato.

e Mixaggio in mono mixa i canali stereo in canali mono.

Svincola i fader
Consente di regolare i fader individualmente o tutti insieme.
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Se il pulsante Svincola i fader & disattivato, lo spostamento di un fader implica lo
spostamento dell'altro fader, dello stesso valore. L'attivazione del pulsante Svincola i
fader consente di correggere un bilanciamento stereo non corretto regolando il livello
dei canali singolarmente.

Se si bilanciano i fader con il pulsante Svincola i fader attivato e poi si disattiva di
nuovo il pulsante Svincola i fader, & possibile regolare il livello complessivo senza
modificare l'offset dei livelli tra i canali.

Gli offset dei fader non vengono mantenuti alla fine dell'intervallo di movimento o una
volta che il pulsante del mouse viene rilasciato.

Blocca i fader

Consente di bloccare i fader. La posizione dei fader bloccati non puo essere modificata
con il mouse. Sono comunque possibili altri metodi di modifica, ad esempio utilizzando
i controlli remoti o le scorciatoie.

LINK CORRELATI
Finestra Sezione Master a pag. 284

Mixaggio dei canali stereo verso dei canali mono

Nella Sezione Master & possibile mixare i canali sinistro e destro di una traccia stereo verso
due canali mono. L'opzione Mixa in mono ¢ utile per verificare la compatibilita mono dei mix
stereo, ecc. In questo caso, il livello di uscita viene automaticamente ridotto di -6 dB per evitare il

clipping.

PROCEDIMENTO

1. Nel pannello Livello master della Sezione Master, fare clic su Processamento dei canali
audio.

2. Selezionare Mixaggio in mono.

NOTA

Se l'opzione Mixa in mono ¢ attivata, l'indicatore del pannello Livello master si illumina
anche se il livello master non viene regolato. Questo consente di evitare che l'opzione
Mixaggio in mono rimanga attivata accidentalmente.

3. Per applicare le impostazioni, renderizzare il file.

LINK CORRELATI
Pannello Livello Master a pag. 293

Pannello Effetto di finalizzazione/Dithering

Questo pannello della Sezione Master consente di aggiungere un effetto di finalizzazione e di
dithering al segnale prima del suo invio all’hardware audio o del suo salvataggio come file su
disco.

E possibile richiudere/espandere o visualizzare/nascondere completamente il pannello Effetti di
finalizzazione/Dithering.

e Perrichiudere/espandere il pannello Effetti di finalizzazione/Dithering, cliccarci sopra.

e Per visualizzare/nascondere il pannello Effetti di finalizzazione/Dithering, fare clic-destro
sullintestazione di un pannello e attivare/disattivare 'opzione Visualizza Effetti di
finalizzazione/Dithering.
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Dithering

Final Effect / Dithering H

Ripiega/esplodi il pannello
Consente di espandere o richiudere il pannello.

Bypassa tutti gli effetti
Consente di bypassare gli effetti nel pannello Effetto di finalizzazione/Dithering.

Menu a tendina Preset

Consente di salvare e richiamare le impostazioni dei preset. Il menu a tendina Preset
offre una serie di opzioni aggiuntive per salvare e caricare banchi ed effetti predefiniti.

Menu a tendina Opzioni degli effetti
Consente di caricare un altro effetto nello slot degli effetti. Sono inoltre disponibili le
seguenti opzioni:

e L'opzione Rimuovi plug-in consente di rimuovere |'effetto dallo slot.

e Le opzioni Disponi tutti i plug-in verso il basso/Disponi tutti i plug-in verso
I'alto consentono di spostare gli effetti in un‘altra posizione.

e L'opzione Dithering interno consente di aggiungere un dithering interno nello
slot degli effetti.

e Sel'opzione Attivo ¢é attivata, I'effetto & attivo. Se I'opzione Attivo & disattivata,
I'effetto viene escluso dalla riproduzione e dalla renderizzazione.

Bypassa effetto
Bypassa il plug-in durante la riproduzione e, in maniera opzionale, durante la
renderizzazione. Il segnale & ancora processato dal plug-in, ma non viene inserito nel
flusso udibile.

LINK CORRELATI
Finestra Sezione Master a pag. 284

Il dithering € una tecnica che prevede l'aggiunta di piccole quantita di rumore a un segnale
per ridurre la soglia di udibilita della distorsione di basso livello in una registrazione digitale.
Una piccola quantita di rumore casuale viene aggiunta al segnale analogico prima della fase di
campionamento, riducendo l'effetto degli errori di quantizzazione.

Aggiungendo un tipo speciale di rumore a un livello estremamente basso, gli errori di
quantizzazione vengono minimizzati. Il rumore aggiunto puo essere percepito come un sibilo
continuo di livello molto basso sovrapposto alla registrazione. Tale disturbo € appena percettibile
ed e comunque preferibile alla distorsione che si produrrebbe altrimenti. L'opzione Noise
Shaping dei plug-in di Dithering interno consente di filtrare questo rumore in un‘area di
frequenza a cui I'orecchio umano € meno sensibile.

In WavelLab Elements, il dithering viene applicato quando si riduce il numero di bit in

una registrazione, ad esempio quando lo si porta da 24 a 16 bit, e quando si applica il
processamento. E possibile scegliere tra l'algoritmo di dithering interno di WaveLab Elements,
I'algoritmo Lin Dither One, oppure qualsiasi plug-in di dithering esterno.

NOTA

Il dithering andrebbe sempre applicato dopo la fase dei fader del bus di uscita e dopo qualsiasi
tipo di processamento audio.
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LINK CORRELATI
Plug-in di dithering a pag. 296

Plug-in di dithering

Wavelab Elements & dotato di un plug-in interno di dithering e del plug-in Lin Dither One. E
comunque possibile aggiungere anche altri plug-in di dithering.

e Per selezionare e attivare un plug-in di dithering nella Sezione Master, fare clic sullo slot dei
plug-in nel pannello Effetto di finalizzazione/Dithering e selezionare una delle opzioni dal
menu a tendina.

e Per disattivare il plug-in di dithering, aprire il menu a tendina Effetto di finalizzazione/
Dithering e selezionare Rimuovi plug-in.

Aggiunta di altri plug-in al pannello Effetto di finalizzazione/Dithering

Se si desidera utilizzare un altro plug-in di dithering al posto di quello interno, & possibile
aggiungere il plug-in desiderato al pannello Effetto di finalizzazione/Dithering.

NOTA

Gli indicatori audio nella Sezione Master monitorano il segnale prima del pannello Effetto di
finalizzazione/Dithering. Per evitare il clipping, controllare I'indicatore di livello/panorama e
regolare il livello di uscita del plug-in, se disponibile.

PROCEDIMENTO
1. Selezionare File > Preferenze > Plug-in.
2. Selezionare la scheda Organizza.

3. Individuare il plug-in che si desidera aggiungere al pannello Effetto di finalizzazione/
Dithering nell'elenco e attivare la rispettiva casella di controllo nella colonna Fin/Dith.

RISULTATO

Il plug-in e disponibile nel menu a tendina del pannello Effetto di finalizzazione/Dithering

e puo essere inserito dopo i fader del Livello master. Il plug-in & ancora disponibile per la
selezione come effetto pre-master se la voce corrispondente nella colonna Effetto della finestra
di dialogo Preferenze dei plug-in & attivata.

Quando applicare il dithering

Di norma, il dithering va applicato quando si converte un file audio verso una precisione
inferiore. Uno dei casi tipici &€ ad esempio quando si prepara un file audio a 24 bit per il mastering
su CD, che utilizza il formato a 16 bit.

Tuttavia, anche se si sta riproducendo o renderizzando un file a 16 bit o a 24 bit alla medesima
precisione, risulta necessario applicare il dithering nel caso si stia utilizzando un qualsiasi tipo di
processamento in tempo reale in WavelLab Elements. Questo perché WavelLab Elements opera
con una precisione interna a 64 bit (in virgola mobile) per garantire la massima qualita audio. Cid
significa che ogni volta che si esegue un qualsiasi tipo di processamento, i dati audio vengono
trattati a tale precisione, invece che alla risoluzione originale di 16 bit o 24 bit, rendendo cosi
necessario l'utilizzo del dithering.

Esempi di processamento in tempo reale: regolazione dei livelli audio, applicazione e regolazione
degli effetti, mixaggio di due o piu clip in un montaggio audio, ecc. L'unico caso in cui un file a
16 bit viene riprodotto alla precisione di 16 bit & quando I'esecuzione avviene senza dissolvenze
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o effetti e con i fader del Livello master impostati su 0,00 (nessuna regolazione di livello -
indicatore del livello master disattivato).

Bypassare la Sezione Master

Per impostazione predefinita, la Sezione Master & attiva. E possibile tuttavia bypassarla in
maniera individuale per ciascun file, oppure globalmente.

e Per bypassare la Sezione Master per singoli file audio o montaggi audio, attivare il pulsante
Bypassa la Sezione Master in fondo alla finestra della forma d'onda/del montaggio.

Bypass Master Section

Aono 16 bit £ *,

e Per bypassare globalmente la Sezione Master, attivare il pulsante Bypassa la Sezione
Master che si trova nella parte superiore-sinistra della Sezione Master stessa.
MASTERSECTION

O =, Preseti

3

5] Bypass Master Section

LINK CORRELATI
Finestra Sezione Master a pag. 284

Renderizzazione nella Sezione Master

Se si renderizzano gli effetti utilizzando la funzione Renderizza della Sezione Master, questi
diventano parte permanente di un file. In questo modo, anziché eseqguire tutto il processamento
in tempo reale durante la riproduzione, € possibile salvare I'output audio in un file su disco.

La scrittura dei segnali in uscita della Sezione Master in un file su disco consente di applicare il
processamento della Sezione Master a un file audio o di eseguire il mixdown di un montaggio
audio con un file audio.

La renderizzazione pu0 avere diversi utilizzi:

e Mixare un montaggio audio completo con un file audio.

e Processare un file e salvarlo in un nuovo file audio, inclusi gli effetti della Sezione Master,
il dithering e le altre impostazioni. E possibile selezionare il formato del nuovo file audio.
Questo consente, ad esempio, di creare un file MP3 e aggiungere degli effetti allo stesso
tempo.

e Processare una o piu regioni di un file audio sul posto o su nuovi file.

LINK CORRELATI
Finestra Sezione Master a pag. 284

Renderizzare i file

PREREQUISITI
E stato configurato un file audio o un montaggio audio.

PROCEDIMENTO

1. Regolare le impostazioni nella Sezione Master.
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Renderizzazione nella Sezione Master

Nella parte inferiore della Sezione Master, fare clic sul pulsante Renderizza.
Definire le proprie impostazioni di renderizzazione.

Nella sezione Risultato, attivare I'opzione File con nome.

Fare clic sul campo Formato e selezionare Modifica formato.

Definire le proprie impostazioni nella finestra di dialogo Formato file audio e fare clic su OK.

N o un s wN

Dopo aver configurato il processo di renderizzazione, fare clic su Avvia.

RISULTATO
Il file viene renderizzato.

NOTA

E possibile eseguire contemporaneamente numerose operazioni di renderizzazione utilizzando
file diversi.

LINK CORRELATI
Finestra di dialogo Formato file audio a pag. 133
Creazione di preset dei formati file audio a pag. 136

Renderizzazione sul posto

Nell'Editor audio & possibile processare una sezione di un file audio o l'intero file audio. Questo
rappresenta un modo estremamente rapido per processare numerose sezioni audio in un file
audio o per testare l'effetto di plug-in diversi su un file audio.

E possibile selezionare la funzione Renderizzazione sul posto nelle seguenti posizioni del
programma:

e Nella scheda Renderizza dell’Editor audio.

Per avviare la renderizzazione sul posto, fare clic su Avvia.

EDIT . INSERT % PROCESS =B RENDER

© InPlace I._IJ 9

Unnamed File
Start

e Nella Sezione Master, fare clic-destro su Renderizza e selezionare Renderizzazione sul
posto.

e Nella barra dei comandi della finestra di un plug-in

Render in Place

Quando si seleziona la funzione Renderizzazione sul posto dalla scheda Renderizza, € possibile
definire delle impostazioni di renderizzazione aggiuntive nel menu a tendina Opzioni. Quando

si seleziona la funzione Renderizzazione sul posto dalla Sezione Master o dalla finestra di un
plug-in, le sequenti impostazioni di renderizzazione sono sempre attive:

e Fade-in/out ai bordi

e  Escludiiplug-in bypassati
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NOTA

Una volta che una sezione audio € stata processata, non vengono eseguiti bypass automatici dei
plug-in o della Sezione Master.

ESEMPIO
Un esempio di utilizzo della funzione di renderizzazione sul posto:

Si supponga che si stia cercando di pulire e restaurare un file e si disponga di 3 plug-in preferiti,
ad esempio 3 diversi plug-in di declicker. Si desidera ora utilizzare quello che offre i risultati

migliori.

1. Caricare tutti e 3 i plug-in nella Sezione Master.

2. Selezionare una regione, mettere in solo il plug-in #1 e riprodurre la regione.

3. Metterein solo il plug-in #2 e riprodurre la regione.

4. Mettere in solo il plug-in #3 e riprodurre la regione.

5. Mettere in solo il plug-in che ha prodotto gli effetti piu soddisfacenti all'ascolto e fare clic su

Renderizzazione sul posto, oppure premere Alt-A.

LINK CORRELATI
Scheda Renderizza per la Sezione Master a pag. 300
Renderizzazione di una selezione audio sul posto a pag. 299

Renderizzazione di una selezione audio sul posto

E possibile renderizzare i plug-in di una sezione di file audio o I'intero file audio.

PREREQUISITI

Nell'Editor audio ¢ stato aperto il file audio che si desidera renderizzare ed é stata configurata la
Sezione Master.

PROCEDIMENTO

1. Facoltativo: se si desidera utilizzare soltanto alcuni plug-in della Sezione Master, mettere in
solo i plug-in scelti.

2. Nella finestra della forma d'onda, selezionare la sezione audio che si desidera processare.
3. Selezionare la scheda Renderizza.

4. Nella sezione Sorgente, aprire il menu a tendina Sorgente e selezionare Intervallo audio
selezionato.

5. Nella sezione Risultato, attivare I'opzione Sul posto.

6. Nella sezione Opzioni, aprire il menu a tendina e definire le impostazioni di renderizzazione
desiderate.

7. Nella sezione Renderizza, fare clic su Avvia.

RISULTATO
La sezione audio o il file audio viene processato.

LINK CORRELATI
Renderizzazione sul posto a pag. 298
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Scheda Renderizza per la Sezione Master

Questa scheda consente di selezionare quali parti di un file audio renderizzare e in quale
formato.

e Per aprire la scheda Renderizza, fare clic su Renderizza in fondo alla Sezione Master.
Source

Whole File

Result

Per la renderizzazione dei file audio e dei montaggi audio sono disponibili le sequenti opzioni:

Sorgente

e L'opzione Intervallo audio selezionato consente di processare e renderizzare
l'intervallo audio selezionato.

e L'opzione Regione specifica consente di processare e renderizzare un intervallo
audio specificato utilizzando i marker delle regioni. Nel menu a tendina accanto a
questa opzione, selezionare la regione che si desidera renderizzare.

Sul posto

Se questa opzione € attivata, l'intervallo audio renderizzato va a sostituire l'intervallo
audio sorgente. Questa opzione & disponibile solamente per i file audio.

File senza nome
Se questa opzione ¢ attivata, il nome del file € senza titolo.

File con nome
Se questa opzione € attivata, e possibile specificare un nome per il file renderizzato.

Nome

Inserire un nome per il file renderizzato. Facendo clic sull'icona a freccia, si apre un
menu che offre numerose opzioni di assegnazione nomi automatica.

Posizione
Consente di selezionare una cartella per il file renderizzato.

Formato
Apre un menu in cui € possibile selezionare il formato file.

Bypass della Sezione Master

Se questa opzione & attivata, i plug-in e il guadagno della Sezione Master vengono
bypassati durante la renderizzazione.

Fade-in/out ai bordi

Se questa opzione € attivata, viene eseguita una dissolvenza ai bordi dell'intervallo
audio quando si crea un nuovo file, oppure una dissolvenza incrociata con l'audio
adiacente se l'intervallo audio viene processato sul posto.
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Aggiungi una coda del riverbero

Se questa opzione & attivata, la coda nell'audio prodotta da effetti come il riverbero
viene inclusa nel file renderizzato.

Alcuni plug-in non sono in grado di fornire una durata della coda a WavelLab Elements.
In tal caso, questa opzione non produce alcun effetto. Per tali plug-in, & possibile
aggiungere il plug-in Silenzio per inserire campioni extra alla fine del file.

Copia marker
Se questa opzione € attivata, i marker che sono inclusi nell'intervallo da processare
vengono copiati nel file renderizzato.

Salta le regioni di esclusione

Se questa opzione € attivata, gli intervalli audio che sono contrassegnati come in mute
vengono saltati e non sono inclusi nel risultato.

Apri il file audio risultante

Se questa opzione € attivata, ciascun file renderizzato viene aperto in una nuova
finestra.

Bypassa la Sezione Master per il file audio risultante

Se questa opzione € attivata, la riproduzione del file audio risultante bypassa l'intera
Sezione Master dopo la renderizzazione. Questa impostazione puo essere attivata
facendo clic sul pulsante che si trova in basso a destra nella finestra della forma d'onda
o di montaggio.

NOTA

Si consiglia di attivare questa opzione per evitare di monitorare due volte questo nuovo
file attraverso gli effetti quando sono stati applicati degli effetti a un file.

Scheda Renderizza per i file audio
Le opzioni seguenti della scheda Renderizza sono esclusive per la renderizzazione dei file audio.

Sorgente
L'opzione File intero processa e renderizza l'intero file.

Sul posto
Se questa opzione € attivata, l'intervallo audio renderizzato va a sostituire l'intervallo
audio di origine.

Scheda Renderizza per i montaggi audio

L'opzione seguente della scheda Renderizza & esclusiva per la renderizzazione dei montaggi
audio.

Sorgente
L'opzione Montaggio intero processa e renderizza I'intero montaggio audio.

Preset della Sezione Master

E possibile salvare tutte le impostazioni definite nella Sezione Master sotto forma di preset e
caricare i preset successivamente.

LINK CORRELATI
Salvataggio dei preset della Sezione Master a pag. 302
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Caricamento dei preset della Sezione Master a pag. 303

Salvataggio dei preset della Sezione Master

E possibile salvare tutte le impostazioni definite nella Sezione Master sotto forma di preset.
Sono inclusi i processori utilizzati, le impostazioni applicate per ciascuno di essi e le opzioni di
dithering.

PROCEDIMENTO
1. Configurare la Sezione Master.
2. Fare clic su Preset in cima alla Sezione Master e selezionare Salva con nome.

3. Facoltativo: nella finestra di dialogo Salva il preset della Sezione Master, fare clic sul nome
del percorso, inserire un nome e fare clic su OK per creare una nuova sotto cartella nella
cartella dei preset della Sezione Master.

4. Inserire un nome per il preset nel campo Nome.
5. Selezionare le opzioni che si desidera salvare nel preset.

6. Fare clic su Salva.

LINK CORRELATI
Finestra di dialogo Salva il preset della Sezione Master a pag. 302
Caricamento dei preset della Sezione Master a pag. 303

Finestra di dialogo Salva il preset della Sezione Master

In questa finestra di dialogo, e possibile salvare una configurazione della Sezione Master come
preset e definire quali parti della Sezione Master corrente includere nel preset.

e Per aprire la finestra di dialogo Salva il preset della Sezione Master, fare clic su Preset in
cima alla Sezione Master e selezionare Salva con nome.

v Save Master Section Preset e

Shortcut

Name | Preset E!l

ng the Preset

Final E

X Cancel

s
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Preset della Sezione Master

Posizione

Consente di aprire la cartella radice del preset in Esplora file/macOS Finder. E qui
possibile creare delle sotto-cartelle per il salvataggio dei preset.

Elenco di preset
Consente di elencare tutti i preset esistenti.

Nome
Consente di specificare il nome del preset da salvare.

Salva i plug-in degli effetti
Se questa opzione € attivata, i plug-in degli effetti vengono salvati con il preset.

Salva le impostazioni di ricampionamento
Se questa opzione € attivata, le impostazioni di ricampionamento vengono salvate con
il preset.

Salva le impostazioni della Sezione Master

Se questa opzione € attivata, le impostazioni del Livello Master vengono salvate con il
preset.

Salva l'effetto di finalizzazione/dithering

Se questa opzione € attivata, I'effetto di finalizzazione/il plug-in di dithering viene
salvato con il preset.

LINK CORRELATI
Salvataggio dei preset della Sezione Master a pag. 302

Caricamento dei preset della Sezione Master

E possibile caricare un preset della Sezione Master salvato in precedenza e un preset della
Sezione Master salvato temporaneamente.

Aprire il menu a tendina Preset che si trova in cima alla finestra della Sezione Master.

e Per caricare un preset precedentemente salvato nella cartella Presets\Master Section,

selezionare un preset dal menu a tendina Preset.

e Per caricare un preset da una qualsiasi posizione, selezionare Carica preset, selezionare il

preset desiderato e fare clic su Apri.

e Per caricare un preset salvato temporaneamente, aprire il sotto menu Ripristina e
selezionare un preset.

LINK CORRELATI
Finestra di dialogo Carica i preset della Sezione Master a pag. 303

Finestra di dialogo Carica i preset della Sezione Master

In questa finestra di dialogo, € possibile specificare quali parti di un preset salvato della Sezione

Master caricare all'apertura.

e Per aprire la finestra di dialogo Carica i preset della Sezione Master, fare clic su Preset in

cima alla Sezione Master e selezionare Carica preset.

Questa finestra di dialogo si apre solamente se é attivata nel menu a tendina Preset della

Sezione Master. Aprire il menu a tendina Preset in cima alla Sezione Master e attivare l'opzione

Apri la finestra delle opzioni quando si seleziona un preset.
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v Load Master Section Preset X
MName: Preset 1

M L

Insert Effect Plug-i

Final Effect / Di

Show All Plug-ins

' OK X Cancel

%7

Ora, quando si ripristina un preset salvato temporaneamente o si apre un preset salvato, viene
visualizzata una finestra di dialogo con le seguenti opzioni:
Nome

Consente di visualizzare il nome del preset.

Carica/Sostituisci i plug-in degli effetti
Se questa opzione € attivata, i plug-in degli effetti attivi vengono rimossi e i nuovi
plug-in vengono inseriti dallo slot superiore.
Inserisci il plug-in degli effetti dallo slot focalizzato (mantieni i plug-in esistenti)
Se questa opzione € attivata, i plug-in degli effetti correnti vengono mantenuti e tutti i
nuovi plug-in vengono inseriti a partire dallo slot superiore.
Carica/Sostituisci le impostazioni di ricampionamento
Se questa opzione € attivata, vengono reinizializzate le impostazioni di
ricampionamento attuali e vengono caricate tutte le nuove impostazioni.
Carica/Reinizializza le impostazioni del livello master
Se questa opzione € attivata, vengono reinizializzate le impostazioni correnti del Livello
master e vengono caricate tutte le nuove impostazioni.
Carica/Sostituisci effetto di finalizzazione/plug-in di dithering
Se questa opzione € attivata, I'effetto di finalizzazione/il plug-in di dithering corrente
viene rimosso e viene caricato il nuovo plug-in.
Opzioni Visibilita dei plug-in
Consente di decidere se visualizzare/nascondere tutti i plug-in o se ripristinare
solamente i plug-in che erano visibili al momento del salvataggio del preset. Sono
disponibili le seguenti opzioni:
e Visualizza tutti i plug-in
e Nascondi tutti i plug-in

e Ripristina la visibilita salvata dei plug-in

LINK CORRELATI
Caricamento dei preset della Sezione Master a pag. 303

Menu a tendina Preset della Sezione Master

Questo menu a tendina varie opzioni per il salvataggio, la gestione e il ripristino dei preset della
Sezione Master.
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Monitoraggio delle operazioni in background

e Per aprire il menu a tendina Preset, fare clic sul pannello dei preset che si trova in cima alla
Sezione Master.

r

MASTERSECTION

O =, Preset2

Salva
Consente di salvare le modifiche apportate a un preset esistente.

Salva con nome

Consente di aprire una finestra di dialogo in cui & possibile specificare un nome e una
posizione per il preset.

Organizza i preset

Consente di aprire la cartella Sezione Master in Esplora file/macOS Finder, in cui &
possibile rinominare o eliminare dei preset.

Carica preset

Consente di caricare un preset della Sezione Master tramite Esplora file/macOS Finder.
Questa funzione é utile, ad esempio, se si desidera caricare un preset fornito da
un’‘altra fonte e che non si trova quindi nella cartella radice predefinita.

Apri la finestra delle opzioni quando si seleziona un preset

Se questa opzione € attivata, quando si seleziona un preset viene visualizzata una

finestra di dialogo che consente di scegliere come caricare il preset selezionato.
Salvataggio temporaneo

Consente di selezionare uno degli slot per salvare temporaneamente un preset.
Ripristina

Consente di ripristinare un preset salvato in precedenza.

Elenco dei preset salvati
Elenca i preset salvati nella cartella Preset della Sezione Master.

LINK CORRELATI
Preset della Sezione Master a pag. 301

Monitoraggio delle operazioni in background

Durante la renderizzazione e possibile monitorare il processo in corso e mettere in pausa o
annullare delle operazioni.

Una barra di stato sotto la finestra della forma d'onda e la finestra del montaggio visualizza il
progresso del processo di renderizzazione corrente. E possibile annullare o mettere in pausa la
renderizzazione utilizzando i pulsanti corrispondenti.

[l l [Bapsed: 6.4/ Remaining: 3.45]

LINK CORRELATI
Preferenze globali a pag. 405

Annullamento delle attivita in background

E possibile annullare i processi di renderizzazione in esecuzione in background.
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Interruzioni del flusso audio

PROCEDIMENTO
e Eseguire una delle seguenti operazioni:
e Nella barra di stato, fare clic su Annulla.

[ l [Elapsed: 645/ Remaining: 34|

e Premere Alt/Opt-. sulla tastiera del computer.

LINK CORRELATI
Monitoraggio delle operazioni in background a pag. 305

Interruzioni del flusso audio

Le interruzioni del flusso audio (dropout) si verificano, nella maggior parte dei casi, quando il
computer non dispone della potenza di elaborazione sufficiente per gestire tutti i processori di
effetti utilizzati.

Per evitare delle interruzioni del flusso audio, provare ad eseguire le seguenti operazioni:

e Utilizzare un numero inferiore di effetti.

e Provare arenderizzare il processo anziché eseguirlo in tempo reale. In seguito, gestire il file
processato senza applicare alcun effetto. Le interruzioni del flusso audio non si verificano
mai quando si renderizza verso un file.

e Non processare alcun file in background.

Se nemmeno seguendo i suggerimenti indicati viene risolto il problema, controllare le
impostazioni della scheda audio utilizzata. Potrebbe essere necessario regolare le impostazioni
del buffer audio. Se si verifica un dropout durante un processo di masterizzazione in tempo
reale, si consiglia di procedere a una nuova masterizzazione. Interrompere la riproduzione, fare
clic sullindicatore del dropout per reinizializzarlo e riprovare.
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I marker consentono di salvare e assegnare dei nomi a posizioni specifiche all'interno di un file. I
marker sono utili per I'esecuzione di operazioni di modifica e per la riproduzione.

I marker possono essere ad esempio utilizzati per:

e Indicare cue-point o posizioni in tempo assoluto.

e Evidenziare sezioni problematiche.

e Separare visivamente le tracce.

e Impostare il cursore della forma d'onda in una specifica posizione.
e Selezionare tutto il contenuto audio tra due posizioni.

e Riprodurre in loop le sezioni di un file audio.
Non c’@ alcun limite alla quantita di marker che & possibile inserire in un file.

NOTA

Le funzioni disponibili nella finestra Marker sono le stesse per i file audio e per i montaggi audio.
Tuttavia, la finestra Marker relativa ai montaggi audio offre una serie di opzioni supplementari
relative alle clip.

LINK CORRELATI

Tipi di marker a pag. 307
Finestra Marker a pag. 308
Creazione dei marker a pag. 310

Tipi di marker

E possibile utilizzare diversi tipi di marker per raggiungere rapidamente determinate posizioni.
Sono disponibili i seguenti tipi di marker:

Marker generici

Consentono, ad esempio, di individuare delle posizioni e selezionare tutto il contenuto
audio tra due punti. I marker generici possono essere creati nel corso della
registrazione.

Marker di inizio e fine delle regioni
Definiscono i punti di inizio e fine per regioni generiche. I marker di inizio e fine delle
regioni possono essere creati durante la registrazione e vengono utilizzati a coppie.
Marker di inizio e fine dei loop

Vengono utilizzati per definire i punti di un loop e sono necessari per accedere alle
funzioni di modifica dei loop nella scheda Processa dell'Editor audio. I marker di inizio
e fine dei loop sono collegati alla modalita Loop nel corso della riproduzione audio.
Questi marker sono utili per la modifica e la creazione di loop prima del trasferimento
di un suono in un campionatore. I marker di loop vengono utilizzati in coppia.
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Finestra Marker

In questa finestra, & possibile creare, modificare e utilizzare dei marker mentre si lavora su un file
audio o su un montaggio un audio.

e Per aprire la finestra Marker, aprire un file audio o un montaggio audio e selezionare
Finestre degli strumenti di utility > Marker.

MARKERS

Functions  Display

d) Name Length
11ee1l 0s {4m
11kl
11ee1l
11ee1l
11ee1l
11ekll
11ee1l
11ee1l
112 1]

10 1Iell

Finestra Marker per i montaggi audio

Elenco dei marker

La finestra Marker contiene un elenco di tutti i marker del file attivo assieme ai relativi dettagli e
controlli. E possibile creare e modificare degli indicatori di modifica dall'elenco dei marker.
Numeri dei marker

Facendo clic sul numero di un marker la forma d'onda scorre fino a individuare il

marker corrispondente.

Riproduci pre-roll
113

Riproduce I'audio a partire dalla posizione del marker con un valore di pre-roll.

E anche possibile premere Alt e fare clic su Riproduci pre-roll per eseguire la

riproduzione dalla posizione del marker con un breve valore di pre-roll.
Riproduci

kil

Riproduce l'audio a partire dalla posizione del marker.

Tipo di marker
Visualizza il tipo di marker. Per modificare il tipo di marker, fare clic sull'icona del
marker e selezionare un altro tipo di marker dall'elenco pop-up.
Nome
Consente di visualizzare il tipo di marker. Per modificare il nome, fare doppio-clic sulla
cella corrispondente e inserire un nuovo nome.
Tempo
Consente di visualizzare la posizione del marker sul righello dei tempi. Per modificare
la posizione, fare doppio-clic sulla cella corrispondente e inserire un nuovo valore.
Canali

Visualizza i canali sui quali si trovano i marker. E possibile fare clic sul canale per
specificare un altro canale per il marker o selezionare Imposta per tutti i canali per
impostare il marker per tutti i canali.
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Durata
Consente di visualizzare la durata temporale tra la posizione di partenza del marker e il
marker di fine corrispondente.

e Per eseguire un ingrandimento sulla regione compresa tra un marker di inizio e
uno di fine, fare clic sulla cella corrispondente nella colonna Lunghezza.

e Per selezionare la regione compresa tra un marker di inizio e uno di fine, fare
doppio-clic sulla cella corrispondente nella colonna Lunghezza. Questa funzione &
disponibile solamente per i marker nell’Editor audio.

Blocca

Consente di bloccare i marker. Il blocco dei marker impedisce che essi vengano
accidentalmente trascinati su una nuova posizione nella finestra della forma d'onda
o in quella di montaggio. Per bloccare un marker, inserire la spunta nel box
corrispondente.

Clip di riferimento (disponibile solo per i marker nella finestra Montaggio audio)

Un marker puo essere attaccato al bordo sinistro o destro di una clip e alla sua forma
d’onda. Quando si sposta una clip, il marker corrispondente si sposta di conseguenza.
La colonna della clip di riferimento visualizza il nome della clip.

Offset (disponibile solo per i marker nella finestra Montaggio audio)
Consente di visualizzare la distanza tra il marker e il punto di riferimento.

Menu Funzioni

A seconda del fatto che sia aperto I'Editor audio o il Montaggio audio, sono disponibili diverse
opzioni. Le seguenti opzioni sono disponibili per i file audio e i montaggi audio:
Seleziona tutto

Consente di selezionare tutti i marker nell'elenco dei marker.

Inverti gli stati di selezione
Inverte gli stati di selezione di tutti i marker.

Deseleziona tutto
Consente di deselezionare tutti i marker.

Elimina i marker selezionati
Consente di eliminare tutti i marker selezionati.

Nomi dei marker predefiniti

Apre la finestra di dialogo Nomi dei marker predefiniti in cui & possibile selezionare i
nomi predefiniti per ciascun tipo di marker.

Personalizza la barra dei comandi

Consente di visualizzare una finestra di dialogo in cui & possibile personalizzare menu e
scorciatoie correlate ai marker.

Le opzioni del menu Funzioni che seguono sono disponibili solamente per i file audio:

Seleziona nell'intervallo di tempo

Consente di selezionare i marker che si trovano nell'intervallo di selezione all'interno
della finestra della forma d’'onda.

Le opzioni del menu Funzioni che seguono sono disponibili solamente per i montaggi audio:
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Vincola i marker selezionati all'inizio della clip attiva
Consente di vincolare la posizione del marker all'inizio della clip attiva. Quando l'inizio
della clip si sposta, si sposta anche il marker.

Vincola i marker selezionati alla fine della clip attiva
Consente di vincolare la posizione del marker alla fine della clip attiva. Quando la fine
della clip si sposta, si sposta anche il marker.

Scollega i marker selezionati dalla relativa clip associata
Rende la posizione del marker relativa all'inizio del montaggio audio.

Segui la riproduzione
Se questa opzione € attivata e si riproduce dell'audio, una barra verde accanto al nome
del marker indica l'ultimo marker riprodotto.

Blocca il marker selezionato
Consente di bloccare il marker selezionato. Se questa opzione € attivata, il marker non
puod essere spostato o eliminato.

Legame completo alla clip
Collega dei marker a una clip in modo che vengano copiati o eliminati quando la clip
stessa viene copiata o eliminata.

Personalizza la barra dei comandi
Apre la finestra di dialogo Personalizza i comandi, contenente una serie di opzioni per

nascondere o visualizzare dei pulsanti specifici della barra dei comandi.
Menu Visualizzazione

Utilizzare il menu Visualizzazione per determinare i tipi di marker visualizzati nell'elenco dei
marker e sulla linea temporale.

Creazione dei marker

E possibile creare dei marker nella finestra della forma d'onda e nella finestra del montaggio in
modalita arresto o durante la riproduzione. E possibile creare dei marker specifici se si sa gia
cosa si desidera contrassegnare, oppure creare dei marker generici.

PROCEDIMENTO
1. Eseguire una delle sequenti operazioni:
e Awviare la riproduzione.

e Nellafinestra della forma d'onda/di montaggio, spostare il cursore nella posizione in cui
si desidera inserire il marker.

2. Esequire una delle sequenti operazioni:

e Nell’Editor audio o nella finestra Montaggio audio, selezionare la scheda Inserisci e
fare clic su un'icona marker nella sezione Marker.

e Nell'Editor audio o nella finestra Montaggio audio, selezionare la scheda Inserisci e
fare clic su Crea/Assegna nome a marker nell'angolo inferiore-destro della sezione
Marker. Si apre in tal modo la finestra di dialogo Crea marker che consente di creare
diversi tipi di marker e coppie di marker in corrispondenza della posizione del cursore di
modifica o dell'intervallo di selezione.

e Fare clic-destro nella parte superiore del righello dei tempi e selezionare un marker dal
menu contestuale.
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e Premere Insert. In questo modo viene creato un marker generico.

Per visualizzare i comandi da tastiera per altri tipi di marker, fare clic-destro sopra la
linea del tempo della finestra della forma d'onda o del montaggio.

3. Facoltativo: per impostare un marker per un singolo canale, fare clic sul nome del canale
nella colonna Canale della finestra Marker e selezionare il canale per il quale si desidera
impostare il marker.

LINK CORRELATI

Finestra della forma d'onda a pag. 111
Finestra di montaggio a pag. 190

Finestra Marker a pag. 308

Scheda Inserisci (Montaggio audio) a pag. 201
Scheda Inserisci (Editor audio) a pag. 122
Eliminazione dei marker a pag. 313

Finestra di dialogo Crea marker a pag. 311

Finestra di dialogo Crea marker

Questa finestra di dialogo consente di creare diversi tipi di marker e coppie di marker in
corrispondenza della posizione del cursore di modifica o dell'intervallo di selezione.

e Per aprire la finestra di dialogo Crea marker, fare clic su Crea/Assegna nome a marker
nell'angolo inferiore-destro della sezione Marker nella scheda Inserisci dell'Editor audio o
della finestra Montaggio audio.

Different Name for End Marker

Create Marker n

Nome
Consente di inserire il nome del marker. Se si lascia vuoto questo campo, viene creato
un nome generico.

Nome predefinito

Se questa opzione a destra del campo Nome é attivata, WavelLab Elements suggerisce
un nome generico.

Name

"-.-'1'3 rker
Type

Tipo
Consente di specificare il tipo di marker da generare.
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Alterna i marker di inizio/fine

Se questa opzione € attivata e si crea un marker di inizio, viene selezionato il marker di
fine corrispondente, e viceversa.

Crea e chiudi
Crea il marker e chiude la finestra di dialogo Crea marker.

Crea
Crea il marker senza chiudere la finestra di dialogo Crea marker.

LINK CORRELATI
Creazione dei marker a pag. 310
Scheda Inserisci (Editor audio) a pag. 122

Creazione di marker all'inizio e alla fine della selezione

E possibile contrassegnare una selezione, ad esempio per la riproduzione in loop o la revisione.

PROCEDIMENTO

1. Nella finestra della forma d'onda o nella finestra di montaggio, definire un intervallo di
selezione.

2. Eseguire una delle seguenti operazioni:

e Nell'Editor audio o nella finestra Montaggio audio, selezionare la scheda Inserisci e
selezionare una coppia di marker nella sezione Marker.

e Nella finestra della forma d’onda, creare un intervallo di selezione, cliccarci sopra col
tasto destro e selezionare la coppia di marker.

e Nellafinestra della forma d’onda o nella finestra di montaggio, definire un intervallo di
selezione, fare clic-destro sopra il righello dei tempi e selezionare la coppia di marker.

LINK CORRELATI

Finestra della forma d'onda a pag. 111
Finestra di montaggio a pag. 190

Scheda Inserisci (Montaggio audio) a pag. 201
Scheda Inserisci (Editor audio) a pag. 122

Duplicazione dei marker

La duplicazione dei marker & un sistema rapido per creare un marker da un marker esistente.

PROCEDIMENTO

e Nella finestra della forma d'onda o in quella di montaggio, tenere premuto Shift, fare clic su
un marker e trascinare.

LINK CORRELATI
Finestra della forma d'onda a pag. 111
Finestra di montaggio a pag. 190

312



Marker

Eliminazione dei marker

Eliminazione dei marker

I marker possono essere eliminati nella finestra della forma d’onda o nella finestra del
montaggio e nella finestra Marker.

LINK CORRELATI
Eliminazione dei marker nella finestra della forma d'onda/di montaggio a pag. 313
Eliminazione dei marker nella finestra dei marker a pag. 313

Eliminazione dei marker nella finestra della forma d'onda/di

montaggio

PROCEDIMENTO

Per eliminare i marker nella finestra della forma d’onda o del montaggio, eseguire una delle
seguenti operazioni:

e Nellafinestra della forma d'onda/del montaggio, fare clic-destro su un marker e
selezionare Elimina.

e Trascinare e rilasciare l'icona di un marker verso l'alto, fuori dal righello del tempo.

LINK CORRELATI

Eliminazione dei marker a pag. 313
Finestra della forma d'onda a pag. 111
Finestra di montaggio a pag. 190

Eliminazione dei marker nella finestra dei marker

Questa opzione ¢ utile se il progetto dispone di molti marker o se il marker che si desidera
eliminare non & visibile nella finestra della forma d'onda/di montaggio.

PROCEDIMENTO

1.

Nella finestra Marker, selezionare uno o piu marker.

E possibile selezionare anche Funzioni > Seleziona tutto.

2. Fare clic su Elimina i marker selezionati, oppure selezionare Funzioni > Elimina i marker
selezionati.
LINK CORRELATI

Finestra Marker a pag. 308
Eliminazione dei marker a pag. 313

Spostamento dei marker

E possibile regolare le posizioni dei marker nella finestra della forma d'onda e nella finestra del
montaggio.

PROCEDIMENTO

Nella finestra della forma d'onda/di montaggio, trascinare un marker su una nuova posizione
del righello dei tempi.
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Navigazione tra i marker

Se l'opzione Scatta verso le calamite ¢ attivata, il marker scatta alla posizione del cursore o
all'inizio/fine di una selezione o forma d'onda.

LINK CORRELATI

Finestra della forma d'onda a pag. 111

Finestra di montaggio a pag. 190

Righello del tempo e Righello del livello a pag. 52

Navigazione tra i marker

E possibile passare al marker precedente o a quello successivo utilizzano i relativi pulsanti.

e Per saltare al marker precedente/successivo, selezionare la scheda Visualizza e, nella
sezione Cursore, fare clic su Sposta il cursore al marker precedente/Sposta il cursore
al marker successivo.

e Perimpostare un cursore della forma d’'onda nella posizione di un marker, nella finestra
della forma d'onda o in quella di montaggio, fare doppio-clic sul triangolo di un marker.

LINK CORRELATI
Marker a pag. 307

Nascondere i marker di un tipo specifico

Per avere una migliore vista d'insieme & possibile nascondere determinati tipi di marker.

PROCEDIMENTO
1. Nella finestra Marker, selezionare Visualizzazione.

2. Disattivare i tipi di marker che si desidera nascondere.
E possibile rendere nuovamente visibili i marker attivando il tipo di marker corrispondente.

LINK CORRELATI
Finestra Marker a pag. 308

Conversione del tipo di un singolo marker

E possibile convertire marker di un tipo in marker di un altro tipo.

PROCEDIMENTO
1. Nella finestra Marker, fare clic sullicona del marker che si desidera convertire.

2. Seleziona un nuovo tipo di marker dall'elenco.

LINK CORRELATI
Finestra Marker a pag. 308

Come rinominare i marker

E possibile modificare il nome dei marker.
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e Perrinominare un marker nella finestra della forma d’onda o in quella di montaggio, fare
clic-destro su un marker, selezionare Rinomina e inserire un nuovo nome.

e Perrinominare un marker nella finestra Marker, fare doppio-clic sul nome di un marker
nella colonna Nome e inserire un nuovo nome.

e Per modificare i nomi predefiniti, nella finestra Marker, selezionare Funzioni > Nomi dei
marker predefiniti.

LINK CORRELATI
Finestra Marker a pag. 308
Finestra di dialogo Nomi dei marker predefiniti a pag. 315

Finestra di dialogo Nomi dei marker predefiniti

In questa finestra di dialogo, & possibile specificare i nomi dei marker predefiniti.

e Per aprire la finestra di dialogo Nomi dei marker predefiniti, aprire la finestra Marker e
selezionare Funzioni > Nomi dei marker predefiniti.

v Default Marker Names x

w Generic Marker

Default Name for This Mark:

Markerl

X Cancel

%7

Tipo di marker

Consente di selezionare il tipo di marker per il quale si intende specificare un nome
predefinito.

Nome predefinito per questo tipo di marker
Consente di specificare il nome predefinito per il tipo di marker selezionato.

LINK CORRELATI
Finestra Marker a pag. 308
Come rinominare i marker a pag. 314

Selezionare i marker

Sono disponibili diversi modi per selezionare i marker.

e Nella finestra della forma d’onda o in quella di montaggio, fare clic su un marker.
e Nella finestra Marker, fare clic su una cella. Viene selezionato il marker corrispondente.

e Utilizzare Ctrl/Cmd o Shift per selezionare piu marker.

Lo sfondo dellicona del marker cambia, a indicare la selezione.

| wﬂ""]‘ﬁiﬂ'

LINK CORRELATI
Finestra della forma d'onda a pag. 111
Finestra di montaggio a pag. 190
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Finestra Marker a pag. 308

Selezione dell’audio tra i marker

E possibile selezionare I'audio tra due marker adiacenti o tra due marker qualsiasi. Questo
consente di selezionare una sezione che ¢ stata contrassegnata.

e Per selezionare l'audio tra due marker adiacenti, fare doppio-clic sullo spazio compreso tra i
due marker nella finestra della forma d'onda o di montaggio.

e Per selezionare piu regioni tra due marker adiacenti, fare doppio-clic sullo spazio compreso
tra i due e dopo il secondo clic trascinare per selezionare le regioni adiacenti.

e Per selezionare l'audio compreso tra una coppia di marker di regione, tenere premuto Shift
e fare doppio-clic sul marker di una regione.

e Per estendere la selezione fino alla fine di una regione di un marker, nella finestra della
forma d’onda/di montaggio tenere premuto Shift e fare doppio-clic sulla regione del marker
che si desidera selezionare.

e Per aprire la finestra Marker e visualizzare ulteriori informazioni su un marker specifico,
tenere premuto Alt e fare doppio-clic su un marker.

LINK CORRELATI

Finestra della forma d'onda a pag. 111
Finestra di montaggio a pag. 190
Finestra Marker a pag. 308

Associazione di marker a clip nel montaggio audio

Nella finestra Montaggio audio ¢ possibile vincolare i marker alle clip. Se si esegue questa
operazione, il marker rimane nella stessa posizione in relazione all'inizio/fine della clip, anche se
quest'ultima viene spostata o ridimensionata nel montaggio audio.

Le opzioni per vincolare tra loro le clip e i marker sono disponibili nel menu Funzioni della
finestra Marker o facendo clic-destro su un marker nella finestra Montaggio audio.

Quando un marker € associato a un elemento della clip, il nome & preceduto da un carattere blu.

LINK CORRELATI
Finestra Marker a pag. 308

Come vengono salvate le informazioni relative ai marker

Wavelab Elements utilizza i file MRK come modalita per il salvataggio di informazioni relative
ai marker, indipendenti dal formato file. Tuttavia, per rendere le informazioni sui marker
interscambiabili tra diverse applicazioni, WaveLab Elements salva le informazioni anche nelle
intestazioni dei file wave.

Questo consente di accelerare il processo di salvataggio dei file, nel caso in cui sia stata
modificata solo l'impostazione di un marker. Tuttavia, cio € possibile solo nel caso in cui
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l'opzione Scrivi i marker nell'intestazione dei file WAV (formato RIFF/BWF) ¢ disattivata nelle
Preferenze dei file audio nella scheda File. Per impostazione predefinita, vengono creati dei file
MRK e vengono archiviate le informazioni nelle intestazioni dei file Wave.

e Quando siimporta un file per la prima volta, tutti i punti dei loop vengono importati e
visualizzati come marker di loop.

e Quando sisalva un file nel formato wave, i punti dei loop vengono salvati sia come parte del
file vero e proprio, sia nel file MRK.

e Quando si apre un file che include dei marker che sono stati aggiunti in WaveLab Elements
e dei marker aggiunti in un‘altra applicazione, in WavelLab Elements vengono visualizzati tutti
questi marker.

LINK CORRELATI

Marker a pag. 307
Scheda File (Preferenze dei file audio) a pag. 413
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Analisi e misura dell’audio

Wavelab Elements contiene un'ampia varieta di indicatori audio che & possibile utilizzare per il
monitoraggio e l'analisi dell’'audio. Gli indicatori possono essere utilizzati per monitorare l'audio
durante la riproduzione, la renderizzazione e la registrazione. Inoltre & possibile utilizzarli per
analizzare le sezioni audio una volta che la riproduzione ¢ stata arrestata.

LINK CORRELATI
Finestre degli indicatori audio a pag. 318
Impostazioni degli indicatori audio a pag. 318

Finestre degli indicatori audio

Wavelab Elements contiene un'ampia varieta di indicatori audio che & possibile utilizzare per il
monitoraggio e l'analisi dell'audio. Gli indicatori possono essere utilizzati per monitorare l'audio
durante la riproduzione, la renderizzazione e la registrazione. Inoltre e possibile utilizzarli per
analizzare le sezioni audio una volta che la riproduzione & stata arrestata.

E possibile accedere alle finestre degli indicatori tramite il menu Indicatori audio. E possibile
visualizzare solamente un’istanza di ciascun indicatore audio.

L'asse della maggior parte degli indicatori audio puo essere ruotato per visualizzare la grafica in
senso orizzontale o verticale. Per alcuni indicatori & inoltre possibile modificare e personalizzare i
parametri tramite una finestra di dialogo delle impostazioni.

LINK CORRELATI
Analisi e misura dell'audio a pag. 318
Ancoraggio e disancoraggio delle finestre degli strumenti di utility e degli indicatori a pag. 48

Apertura e chiusura delle finestre degli indicatori audio

E possibile chiudere tutte le finestre degli indicatori audio non necessarie per il proprio progetto.

e Per aprire una finestra di un indicatore audio, selezionare Indicatori audio e selezionare
uno degli indicatori disponibili.

e Per chiudere una finestra di un indicatore audio ancorata, fare clic-destro sulla rispettiva
scheda e selezionare Nascondi.

e Per chiudere una finestra di un indicatore audio non ancorata, fare clic sul rispettivo pulsante
X.

LINK CORRELATI
Finestre degli indicatori audio a pag. 318

Impostazioni degli indicatori audio

E possibile configurare la maggior parte degli indicatori audio nelle finestre di dialogo delle
impostazioni corrispondenti. Ad esempio, € possibile deciderne il comportamento, la scala e il
colore.
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Reinizializzazione degli indicatori audio

e Per visualizzare la finestra di dialogo delle impostazioni per uno strumento di analisi misura,
selezionare Funzioni > Impostazioni.

e Per verificare i risultati dopo aver modificato le impostazioni senza chiudere la finestra di
dialogo delle impostazioni, fare clic su Applica.

e Per chiudere la finestra di dialogo delle impostazioni e annullare tutte le modifiche applicate,
anche se in precedenza si é fatto clic sul pulsante Applica, fare clic su Annulla.

LINK CORRELATI
Finestre degli indicatori audio a pag. 318

Reinizializzazione degli indicatori audio

E possibile reinizializzare i valori visualizzati da alcuni indicatori audio, ad esempio dallIndicatore
di livello.

PROCEDIMENTO

e Nella finestra degli indicatori audio, fare clic su Reinizializza, oppure selezionare Funzioni >
Reinizializza.

RISULTATO
Tutti i valori e gli indicatori numerici degli indicatori vengono reinizializzati.

LINK CORRELATI
Finestre degli indicatori audio a pag. 318

Indicatore di livello

L'Indicatore di livello visualizza il picco e il livello medio di intensita acustica/decibel del file
audio considerato.

e Per aprire I'Indicatore di livello, selezionare Indicatori audio > Indicatore di livello.

Functions ¢ O |€

Indicatori di livello

L'Indicatore di livello riporta il livello di picco e il valore di intensita acustica medio nella
seguente modalita:

e Gliindicatori di livello di picco riportano i livelli di picco di ciascun canale tramite grafici e
valori numerici.

e IVU-meter misurano il valore di intensita acustica medio (RMS) di ciascun canale. Questi
indicatori sono dotati di funzionalita integrate quali inerzia e variazioni dell'intensita acustica
medie in un arco di tempo definito dall'utente. Se si sta monitorando la riproduzione o
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Indicatore di livello

I'ingresso audio, & possibile visualizzare due linee verticali che sequono ciascuna barra del
VU-meter. Queste linee indicano la media dei valori RMS minimi piu recenti (linea sinistra)
e la media dei valori RMS massimi piu recenti (linea destra). Sulla sinistra, viene visualizzata
la differenza tra i valori medi minimi e massini. In questo modo si ottiene una panoramica
dell'intervallo dinamico del materiale audio.

I valori di intensita acustica e picco massimo vengono visualizzati a destra delle barre degli
indicatori. I numeri tra parentesi a destra dei valori di picco massimo indicano quante volte
si verifica il clipping (picchi del segnale a 0 dB). I valori compresi tra 1 e 2 sono accettabili,
ma se si ottiene un numero superiore, € necessario abbassare il livello master per evitare la
distorsione digitale.

I livelli di registrazione devono essere configurati in modo che il clipping si verifichi di rado.
Se il livello master & troppo elevato la qualita del suono e la risposta di frequenza vengono
compromessi a livelli di registrazione alti, con effetti di clipping indesiderati. Se il livello
impostato ¢ troppo basso, i livelli di rumore possono essere elevati in relazione al principale
suono registrato.

LINK CORRELATI
Finestra di dialogo Impostazioni dell'indicatore di livello a pag. 320

Finestra di dialogo Impostazioni dell'indicatore di livello

Nella finestra di dialogo Impostazioni dell'indicatore di livello & possibile definire il
comportamento, la scala e il colore degli indicatori audio.

Per aprire la finestra di dialogo Impostazioni dell'indicatore di livello, aprire la finestra
Indicatore di livello e selezionare Funzioni > Impostazioni.

Sezione Indicatore di picco

Balistica - Velocita di rilascio

Determina la velocita con cui l'indicatore del livello di picco decade dopo un picco.

Balistica - Tempo di mantenimento dei picchi

Determina quanto a lungo il valore di picco rimane visualizzato. Il picco pud
essere visualizzato come linea o come numero. Se I'indicatore & troppo corto, viene
visualizzata solo la linea.

Zona superiore/Zona mediana/Zona inferiore

I pulsanti colorati consentono di selezionare i colori per le zone inferiore, mediana e
superiore dell'indicatore di livello. E possibile definire I'ntervallo per le zone superiore e
mediana modificando i valori corrispondenti.

Sezione VU-Meter (Intensita acustica)

VU-Meter (Intensita acustica)

Consente di attivare/disattivare il VU-meter.

Balistica - Risoluzione

Consente di impostare il tempo utilizzato per determinare l'intensita acustica. Piu
piccolo ¢ il valore, piu il VU-Meter si comporta come l'indicatore di picco.

Balistica - Inerzia dell'intervallo

Consente di impostare il tempo utilizzato per determinare le linee dei valori minimo e
massimo recenti, determinando quindi la rapidita di risposta alle variazioni di intensita
acustica.
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Analizzatore di fase

Sezione Colori globali

In questa sezione ¢ possibile selezionare i colori per lo sfondo dell'indicatore, i contrassegni
(unita di scala) e le linee della griglia.

Sezione Intervallo globale (Picco e VU-Meter)

In questa sezione, & possibile specificare il valore minimo e massimo dell'intervallo del livello
visualizzato.

LINK CORRELATI
Indicatore di livello a pag. 319

Analizzatore di fase

L'’Analizzatore di fase indica la relazione di fase e ampiezza tra due canali stereo.

e Per aprire 'Analizzatore di fase, selezionare Indicatori audio > Analizzatore di fase.

PHASESCOPE

Functions

Lettura dell’analizzatore di fase
L'Analizzatore di fase funziona come descritto di sequito:

e Una linea verticale indica un segnale mono perfetto (i canali sinistro e destro sono uguali).

e Unalinea orizzontale indica che il canale sinistro e lo stesso del canale destro, ma con una
fase invertita.

e Una forma quasi rotonda indica un segnale stereo ben bilanciato. Se la forma propende
verso un lato, cid significa che & presente piu energia nel canale corrispondente.

e Un cerchio perfetto indica un‘onda sinusoidale su un canale e la stessa onda sinusoidale
ruotata di 45° sull'altro lato.

e Solitamente, piu la forma assomiglia a un filo e piu il segnale & basso; piu la forma sembra
spruzzata sullo schermo e pit nel segnale sono presenti frequenze elevate.

Indicatore della correlazione di fase

L'indicatore della correlazione di fase nella parte inferiore della visualizzazione funziona come
descritto di sequito:

e Lalineaverde indica la correlazione di fase corrente, le due linee rosse i valori minimo e
massimo recenti.

e Conun segnale mono, l'indicatore indica +1: cid significa che entrambi i canali sono
perfettamente in fase.
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Spettroscopio

e Selindicatore indica -1 significa che i due canali sono uguali ma I'uno € invertito rispetto
all'altro.

e Solitamente, per un buon mix, I'indicatore dovrebbe indicare un valore tra 0 e +1.

Impostazioni dell’Analizzatore di fase

Nella finestra di dialogo Impostazioni dell’Analizzatore di fase ¢ possibile definire il
comportamento, la scala e il colore degli indicatori.

e Per aprire la finestra di dialogo Impostazioni dell’Analizzatore di fase, aprire la finestra
Analizzatore di fase e selezionare Funzioni > Impostazioni.

Sfondo
Fare clic per modificare il colore dello sfondo.

Visualizzazione 2D
Consente di regolare il colore per la griglia e il segnale della visualizzazione in 2D.

Dimensione automatica (massimizza)

Se questa opzione € attivata, le dimensioni della visualizzazione sono ottimizzate in
modo da adattarsi a quelle della finestra.

Visualizzazione della correlazione

Qui é possibile selezionare i colori degli elementi presenti nella visualizzazione
dell'indicatore della correlazione di fase e regolare il tempo di mantenimento dei picchi
per l'indicatore massimo e minimo.

Numero di campioni da visualizzare

Questa impostazione agisce sulla lunghezza della spirale della fase, e quindi
sulla densita della visualizzazione. Per materiale audio con elevate frequenze di
campionamento potrebbe essere necessario aumentare questo valore.

Spettroscopio

Lo Spettroscopio visualizza una rappresentazione grafica di uno spettro delle frequenze,
analizzato in 60 bande di frequenza e rappresentato come insieme di barre verticali.

e Per aprire lo Spettroscopio, selezionare Indicatori audio > Spettroscopio.

I livelli di picco vengono visualizzati come linee orizzontali sopra le bande corrispondenti, che
indicano i recenti valori di picco/massimi. Lo Spettroscopio offre una rapida panoramica dello
spettro. Per un‘analisi piu dettagliata dello spettro audio, utilizzare lo Spettrometro.

Nel menu Funzioni, & possibile specificare se visualizzare solo i livelli audio elevati o anche i livelli
medi e bassi.
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Spettrometro
Sono disponibili e sequenti impostazioni:
e Restringi ai livelli audio elevati
e Includii livelli audio medi
e Includii livelli audio bassi
Spettrometro

Lo Spettrometro utilizza le tecniche FFT (Fast Fourier Transform - Trasformata di Fourier veloce)
per visualizzare un grafico della frequenza, fornendo un’analisi della frequenza in tempo reale
precisa e dettagliata.

e Per aprire lo Spettrometro, selezionare Indicatori audio > Spettrometro.

SPECTROMETER

Lo spettro della frequenza corrente viene visualizzato come grafico lineare. I picchi dello spettro
vengono visualizzati come linee orizzontali.

Operazioni di zoom nella finestra Spettrometro

Nella finestra Spettrometro & possibile ingrandire un‘area della frequenza.

e Peringrandire un'area della frequenza, fare clic e trascinare un rettangolo nello spettro. La
visualizzazione viene ingrandita in modo che l'intervallo della frequenza selezionato si adatti
alle dimensioni della finestra.

e Perritornare alla visualizzazione a scala intera, selezionare Funzioni > Riporta
I'ingrandimento indietro del tutto o fare doppio-clic sullo spettro.

Istantanee dello Spettrometro

E possibile scattare delle istantanee dello spettro corrente, ad esempio per verificare gli effetti
dell'aggiunta di determinate impostazioni di equalizzazione.

Le istantanee vengono visualizzate nel grafico dello spettro. E possibile visualizzare fino a cinque
istantanee. La sesta istantanea va a sostituire la prima.
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e Per scattare un’istantanea, selezionare Funzioni > Aggiungi istantanea.

e Per eliminare l'ultima istantanea, selezionare Funzioni > Elimina l'ultima istantanea.

Esportazione di dati FFT in formato di testo ASCII

L'analisi FFT (Fast Fourier Transform - Trasformata di Fourier veloce) € un metodo per convertire
una forma d'onda dal dominio temporale a quello delle frequenze. E possibile esportare i dati FFT
visualizzati come file di testo.

PROCEDIMENTO

1. Nell'Editor audio, selezionare la scheda Analisi.

2. Nella sezione Monitoraggio, attivare Cursore di modifica o Selezione audio.
3. Nella finestra Spettrometro, selezionare Funzioni > Esporta dati FFT in ASCIL.
4. Specificare un nome file e una posizione.
5

Fare clic su Salva.

RISULTATO

Il file di testo risultante puod essere importato in Microsoft Excel o altre applicazioni che
consentono di tracciare dei grafici da file di testo.

Creazione di preset delle impostazioni dello Spettrometro

E possibile salvare fino a 5 diverse Impostazioni dello Spettrometro sotto forma di preset
e assegnarle ai pulsanti dei Preset. Questo consente di comparare rapidamente diverse
configurazioni dello Spettrometro.

PROCEDIMENTO
1. Nella finestra Spettrometro, selezionare Funzioni > Impostazioni.

2. Nella finestra di dialogo Impostazioni dello Spettrometro, definire le impostazioni

desiderate.
3. Fare clic sul menu Preset e selezionare Assegna a un pulsante dei preset.
4. Selezionare il pulsante al quale si intende applicare il preset.
5. Fare clic su OK per chiudere la finestra di dialogo Impostazioni dello Spettrometro.
6. Awviare la riproduzione e fare clic sui pulsanti Applica preset per attivare/disattivare i preset.
Functions R G (1) le B o A
Apply Preset “deffactory”
LINK CORRELATI

Impostazioni dello Spettrometro a pag. 325
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Impostazioni dello Spettrometro

Nella finestra di dialogo Impostazioni dello Spettrometro ¢ possibile definire il comportamento
e 'aspetto degli indicatori e assegnare fino a cinque gruppi di impostazioni dello Spettrometro ai
pulsanti di preset.

e Per aprire la finestra di dialogo Impostazioni dello Spettrometro, aprire la finestra
Spettrometro e selezionare Funzioni > Impostazioni.

Scheda Processamento

Dimensione blocco d'analisi

Maggiore € questo valore, pilu elevata sara la precisione nel dominio delle frequenze
(lo spettro sara cioé diviso in un numero superiore di bande). Allo stesso tempo la

localizzazione temporale viene ridotta. Cid significa che maggiore ¢ il valore e meno
facile & individuare dove inizia e dove finisce una data frequenza a livello temporale.

NOTA

Aumentando il valore della dimensione del blocco sara necessaria una potenza
maggiore della CPU e potrebbe di conseguenza verificarsi una latenza maggiore.
Pertanto, valori elevati dovrebbero essere utilizzati soltanto per il monitoraggio offline.

Sovrapposizione blocchi di analisi

Per offrire risultati piu accurati, il programma puo analizzare i blocchi che si
sovrappongono. Questa impostazione determina il numero di sovrapposizioni tra
questi blocchi: maggiore € il valore, piu precisi sono i risultati.

NOTA

Aumentando questo valore, aumenta anche il carico della CPU. Ad esempio,
un'impostazione del 50% richiede una quantita doppia di potenza della CPU,
un'impostazione del 75% ne richiede una quantita quadrupla, ecc.

Finestra Ammorbidimento

Consente di scegliere quale metodo utilizzare per pre-processare i campioni al fine di
ottimizzare la visualizzazione dello Spettrogramma.

Scheda Visualizzazione

Righello delle frequenze

Determina l'intervallo delle frequenze da visualizzare con la visualizzazione a scala
intera. Si noti che la piu bassa frequenza visualizzata dipende dallimpostazione
Dimensione blocco d'analisi, mentre la frequenza piu alta dipende dalla frequenza
di campionamento.

Scala logaritmica

Se questa opzione € attivata, ciascuna ottava occupera lo stesso spazio in senso
orizzontale nella visualizzazione. Se si necessita di una risoluzione maggiore
nellintervallo delle alte frequenze, si consiglia di disattivare questa opzione.

Righello del livello
Determina l'intervallo del righello di livello verticale in dB.
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Bit-meter

Normalizza la visualizzazione a 0 dB
Se questa opzione € attivata, la visualizzazione del livello & adattata in modo che il
punto piu elevato nella curva venga visualizzato come 0 dB. Questa opzione € attivabile
solo in modalita non in tempo reale.

Ottimizza la scala
Consente di ottimizzare la scala di livello in modo che venga visualizzato solamente
I'intervallo di livello rilevante. Questa opzione ¢ attivabile solo in modalita non in tempo
reale.

Tipo di visualizzazione
Consente di scegliere tra la visualizzazione della curva e quella del diagramma a barre.

Tempo di mantenimento dei picchi
Determina il tempo in cui il grafico del livello dei picchi rimane visualizzato quando il
livello decade.

Colori
Qui e possibile selezionare i colori per le curve, la griglia, lo sfondo, ecc.

Preset

E possibile salvare fino a 5 Impostazioni dello Spettrometro sotto forma di preset. Questo

consente di passare da una configurazione dello Spettrometro all'altra durante la riproduzione.

LINK CORRELATI

Creazione di preset delle impostazioni dello Spettrometro a pag. 324

Bit-meter

Il Bit-meter indica il numero di bit utilizzati.

e Per aprire il Bit-meter, selezionare Indicatori audio > Bit-meter.

BITMETER

Functions

Si pud pensare che il numero massimo di bit sia pari alla precisione del file audio, ma non &
necessariamente cosi.
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Quando si esegue un processamento in tempo reale di qualche tipo su un file audio, i dati audio
vengono trattati a una precisione molto maggiore (64 bit in virgola mobile) per consentire di
mantenere la qualita audio originale. L'unico caso in cui un file a 16 bit viene riprodotto a una
precisione di 16 bit si ha ad esempio quando I'esecuzione avviene senza dissolvenze o effetti e
con i fader master impostati a 0,00.

Come leggere il bit-meter

e Gliindicatori audio interni mostrano il numero di bit utilizzati.

e Gliindicatori audio esterni mostrano il numero di bit utilizzati di recente.

e Il segmento Al di sopra indica il clipping.

e Il segmento 32F indica i campioni con precisione a 32 bit in virgola mobile.

e Il segmento 64F indica i campioni con precisione a 64 bit in virgola mobile.

Quando utilizzare il bit-meter
Il Bit-meter ¢ utile nelle seguenti situazioni:

e Per verificare se & necessario applicare il dithering. Se si sta eseguendo la riproduzione o
effettuando un mixdown a 16 bit e il Bit-meter indica che vengono utilizzati piu di 16 bit, &
consigliabile applicare il dithering.

e Per visualizzare la precisione effettiva di un file audio. Ad esempio, anche se un file ¢ in
formato a 24 bit, & possibile che ne vengano utilizzati soltanto 16, oppure che un file a 32 bit
utilizzi solamente 24 bit.

e Pervedere l'uscita della profondita in bit di un plug-in.

e Per verificare se i campioni sono a 32 bit in virgola mobile, a 64 bit in virgola mobile, o a
qualsiasi tipo di valore di precisione PCM compreso tra 8 bit e 32 bit in corrispondenza del
punto di monitoraggio.

LINK CORRELATI
Impostazioni Bit-meter a pag. 327

Impostazioni Bit-meter

Nella finestra di dialogo Impostazioni Bit-meter ¢ possibile definire il comportamento e
I'aspetto del Bit Meter.

e Per aprire la finestra di dialogo Impostazioni Bit-meter, aprire la finestra Bit Meter e
selezionare Funzioni > Impostazioni.

Colori

E possibile regolare i colori dei segmenti dellindicatore, delle griglie, dello sfondo, ecc.
facendo clic sui corrispondenti pulsanti colorati.

Tempo di mantenimento dei bit
Determina quanto a lungo i valori di picco vengono mantenuti dagli indicatori esterni.

Visualizzazione bit
Determina la modalita di visualizzazione dei bit. In Modalita intuitiva (proporzionale
al livello del segnale), viene visualizzato il valore assoluto del segnale. Il diagramma
a barre indica valori piu elevati con livelli di segnale superiori, in modo analogo a un
indicatore di livello comune.
In Modalita reale (campioni con segno), l'indicatore visualizza la mappatura diretta
dei bit. Tuttavia, poiché i valori reali possono essere negativi, non esiste una relazione
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intuitiva con il livello. Questa modalita & utile se si desidera verificare l'intero intervallo,
poiché vengono visualizzati tutti i bit, indipendentemente dal livello del segnale audio.

LINK CORRELATI
Bit-meter a pag. 326

Oscilloscopio

L'Oscilloscopio offre una vista notevolmente ingrandita della forma d’onda intorno alla posizione
del cursore di riproduzione.

e Per aprire I'Oscilloscopio, selezionare Indicatori audio > Oscilloscopio.

Se si sta analizzando del materiale audio stereo, I'Oscilloscopio normalmente visualizza i livelli
dei due canali separati. Tuttavia, se si attiva I'opzione Visualizza somma e sottrazione nel menu
Funzioni, la meta superiore dell'Oscilloscopio visualizza il mix dei due canali mentre la meta
inferiore visualizza la sottrazione.

Impostazioni dell’'Oscilloscopio

Nella finestra di dialogo Impostazioni dell’Oscilloscopio € possibile impostare i colori di
visualizzazione e attivare/disattivare I'opzione Ingrandimento automatico. Se Ingrandimento
autom. (ampiezza normalizzata) € attivo, la visualizzazione viene ottimizzata in modo che il
livello piu elevato raggiunga tutte le volte la parte superiore della visualizzazione e anche i
segnali piu deboli siano visibili.

e Per aprire la finestra di dialogo Impostazioni dell'Oscilloscopio, aprire la finestra
Oscilloscopio e selezionare Funzioni > Impostazioni.

Ondoscopio

L'Ondoscopio consente di visualizzare una forma d’‘onda in tempo reale che mostra graficamente
il segnale audio in corso di monitoraggio. Questa funzione pud essere utile durante la
registrazione o la renderizzazione di un file se la modalita di monitoraggio Renderizzazione

del file é attiva.

e Per aprire 'Ondoscopio, selezionare Indicatori audio > Ondoscopio.
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LINK CORRELATI
Impostazioni dell'Ondoscopio a pag. 329

Impostazioni dell’'Ondoscopio

Nella finestra di dialogo Impostazioni dell'Ondoscopio & possibile regolare diverse impostazioni
di colore per la visualizzazione dello sfondo, della griglia e della forma d'onda; & inoltre possibile
impostare la velocita di renderizzazione e I'ingrandimento verticale della forma d'onda.

e Per aprire la finestra di dialogo Impostazioni dell’'Ondoscopio, aprire la finestra
Ondoscopio e selezionare Funzioni > Impostazioni.

Colori
Consente di selezionare i colori per I'aspetto grafico della forma d'onda.

Velocita di rendering della forma d’onda
Determina la compressione della visualizzazione della forma d'onda.
Se l'opzione Come lo Spettrogramma Live ¢ attivata, la velocita di renderizzazione
dell’'Ondoscopio ¢ la stessa dello Spettrogramma Live.

Ingrandimento del livello
Determina l'ingrandimento del livello. Impostare un valore elevato se la forma d'onda
presenta un'ampiezza ridotta.

Azzera la forma d'onda quando viene raggiunta la parte destra del pannello

Se questa opzione € attivata, la visualizzazione della forma d'onda viene cancellata
ogni volta che il cursore raggiunge l'estremita destra della visualizzazione. Se questa
opzione non € attiva, la nuova forma d'onda sovrascrive la forma d'onda precedente.

LINK CORRELATI
Ondoscopio a pag. 328

329



Operazioni di scrittura

Per awviare il processo di scrittura di un CD/DVD, € necessario aver completato tutte le relative
operazioni preparatorie.

LINK CORRELATI

Finestra CD a pag. 265

Scrittura dei montaggi audio a pag. 332
Finestra di dialogo Scrivi CD audio a pag. 330

Finestra di dialogo Scrivi CD audio

In questa finestra di dialogo, & possibile scrivere un montaggio audio su un CD audio.

e Quando si desidera scrivere dei montaggi audio su un CD audio, aprire la finestra CD e
selezionare Funzioni > Scrivi CD audio.

v Write Audio CD X

X Cancel

Periferica
Consente di selezionare 'unita masterizzatore da utilizzare.

NOTA

Sui sistemi Mac, inserire un supporto di scrittura nell'unita CD dopo aver aperto
Wavelab Elements. In caso contrario, l'unita sara controllata dal sistema operativo e
non sara disponibile per WavelLab Elements.

Aggiorna
Consente di eseguire la scansione del sistema per rilevare CD nell'unita ottica
connessa. Tale operazione viene eseguita automaticamente all'apertura di questa
finestra di dialogo. Fare clic sull'icona di aggiornamento dopo aver inserito un nuovo
supporto vuoto per aggiornare il menu Velocita.

NOTA

Sui sistemi Mac, inserire un supporto di scrittura nell'unita CD dopo aver aperto
Wavelab Elements. In caso contrario, l'unita sara controllata dal sistema operativo e
non sara disponibile per WavelLab Elements.
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Espelli supporto ottico
Consente di espellere il supporto ottico presente nell'unita selezionata.

Informazioni sulla periferica

Consente di aprire la finestra di dialogo Informazioni sulla periferica, in cui sono
visualizzate varie informazioni sulla periferica selezionata.

Cancella il supporto ottico

Consente di cancellare il supporto ottico presente nell'unita selezionata, a condizione
che si tratti di un disco riscrivibile.

Bypassa la Sezione Master

Se questa opzione € attivata, il segnale audio non viene processato attraverso la
Sezione Master prima di essere scritto sul disco.

Velocita

Consente di selezionare la velocita di scrittura. La velocita massima impostabile varia in
base alle funzionalita del dispositivo di scrittura e al supporto in esso presente.

Copie
Consente di inserire il numero di copie che si desidera scrivere.

Esegui solo un test, senza effettuare la scrittura
Quando questa opzione € attiva, se si fa clic sul pulsante OK, viene avviata una
simulazione di scrittura del CD. Se il test viene superato, 'operazione reale di scrittura
potra essere eseguita correttamente. Se il test non riesce, provare di nuovo a una
velocita di scrittura inferiore.

Trasforma in file temporaneo prima di eseguire la scrittura

Se questa opzione € attivata, prima della scrittura viene creata un‘immagine del

disco. Questo elimina il rischio di interruzione del flusso dati (buffer underrun). Tale
opzione & utile se il progetto utilizza molti plug-in audio durante la scrittura. Essa viene
attivata automaticamente durante la scrittura di copie multiple. Se da un lato questa
opzione allunga i tempi dell'operazione di scrittura, dall'altro consente di selezionare
una velocita superiore.

Compatibile CD-Extra (nuova sessione possibile)
Se questa opzione € attivata, il CD audio risultante & compatibile con il formato CD-
Extra.

Espelli al termine del processo

Se questa opzione € attivata, il disco viene espulso al termine dell'operazione di
scrittura.

LINK CORRELATI
Operazioni di scrittura a pag. 330
Finestra CD a pag. 265

Finestra di dialogo Cancella il supporto ottico

In questa finestra di dialogo, & possibile cancellare in maniera rapida o completa un disco ottico
prima della scrittura.

e Per aprire la finestra di dialogo Cancella il supporto ottico, aprire la finestra di dialogo
Scrivi CD Audio e fare clic sull'icona cestino.
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I Erase Optical Media X

Method
© Quick Erase

Full Erase

V' 0K X Cancel

Cancellazione rapida
Consente di cancellare la tabella dei contenuti del disco.

Cancellazione completa
Consente di cancellare tutte le parti del disco.

Forza la cancellazione, anche se un disco sembra essere vuoto

Se questa opzione € attivata, il disco viene cancellato anche se ¢ stato dichiarato vuoto.
Utilizzare questa opzione per assicurarsi che i dischi che erano stati cancellati in piccola
0 gran parte, vengano cancellati completamente.

LINK CORRELATI
Finestra di dialogo Scrivi CD audio a pag. 330

Scrittura dei montaggi audio

E possibile scrivere dei montaggi audio su un CD audio.

LINK CORRELATI
Scrittura di un montaggio audio su un CD audio a pag. 332

Scrittura di un montaggio audio su un CD audio

PREREQUISITI
Configurare il proprio montaggio audio e regolare le impostazioni relative alla scrittura su CD

nelle Preferenze globali.
NOTA

Sui sistemi Mac, inserire un supporto di scrittura nell’'unita CD dopo aver aperto WavelLab
Elements. In caso contrario, l'unita sara controllata dal sistema operativo e non sara disponibile
per WavelLab Elements.

PROCEDIMENTO

1. Facoltativo: nella finestra CD, selezionare Funzioni > Verifica la conformita del CD, per
verificare che tutte le impostazioni siano in linea con lo standard Red Book.

Inserire un CD vuoto nel lettore.

Nella finestra CD, selezionare Funzioni > Scrivi CD audio.

Dal menu a tendina Periferica selezionare il dispositivo di scrittura da utilizzare.

Se si desidera bypassare la Sezione Master, attivare 'opzione Bypassa la Sezione Master.

Selezionare la velocita di scrittura dal menu a tendina Velocita.

N o un s wWwDN

Selezionare il numero di copie che si desidera scrivere.
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CD-Text

Quando si scrive piu di una copia, si consiglia di attivare 'opzione Trasforma in file
temporaneo prima di eseguire la scrittura.

8. Facoltativo: attivare una o piu delle seguenti opzioni:

e Attivare Esegui solo un test, senza effettuare la scrittura, se si desidera verificare se
'operazione di scrittura pud essere eseguita correttamente.

e Attivare Trasforma in file temporaneo prima di eseguire la scrittura se il montaggio
audio utilizza molti plug-in. In questo modo, i dati audio vengono inviati rapidamente al
masterizzatore CD.

e Attivare I'opzione Compatibile CD-Extra (nuova sessione possibile) se si desidera che il
CD audio risultante sia compatibile con il formato CD-Extra.

e Attivare l'opzione Espelli al termine del processo se si desidera che il disco sia espulso
automaticamente al termine dell'operazione di scrittura.

9. Fare clic su OK.

RISULTATO

L'operazione di scrittura viene avviata.

LINK CORRELATI
Finestra CD a pag. 265
Finestra di dialogo Scrivi CD audio a pag. 330

CD-Text & un'estensione dello standard CD audio Red Book che consente di salvare informazioni
di testo come titolo, paroliere, compositore e ID del disco relativi al CD audio.

I dati di testo vengono quindi visualizzati dai lettori CD che supportano il formato CD-Text. Il
CD-Text pu0 essere incluso anche nel rapporto CD.

NOTA

La funzionalita CD-Text € disponibile solamente se é stata selezionata la modalita Stereo nelle
Proprieta del montaggio audio.

LINK CORRELATI
Proprieta del montaggio audio a pag. 209
Finestra di dialogo Editor del CD-Text a pag. 333

Finestra di dialogo Editor del CD-Text

In questa finestra di dialogo & possibile specificare informazioni come titolo della traccia,
esecutore e paroliere. Tali informazioni vengono scritte sul CD come CD-Text.

E possibile aggiungere informazioni sul disco e su ciascuna traccia. Queste informazioni devono
essere inserite nei campi di testo che scorrono in senso orizzontale. Sono disponibili un pannello
contenente i campi per il disco e un pannello per ogni singola traccia.

NOTA

La funzionalita CD-Text & disponibile solamente se & stata selezionata la modalita Stereo nelle
Proprieta del montaggio audio.
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e Per aprire la finestra di dialogo Editor del CD-Text, nella finestra CD scegliere la traccia per
la quale si desidera modificare il CD-Text, quindi selezionare Funzioni > Modifica CD-Text.

B CD-Text Editor X

mp

Arranger

Western European Language ¥ R Enable CD ting |€ Reset X Cancel

Copia il nome del marker della traccia CD
b

Consente di copiare il nome del marker della traccia CD in questo campo.

Copia il nome dei marker di inizio della traccia CD in tutti i titoli delle tracce CD
»
Consente di copiare il nome di ciascun marker di inizio traccia del CD nel campo del

titolo di ciascuna traccia del CD.

Copia il testo in tutte le tracce seguenti

1

Consente di copiare il testo in tutte le tracce che si trovano dopo quella corrente.

Barra di scorrimento
Consente di navigare tra tutti i CD-Text. La prima posizione corrisponde all'intero CD, le
altre posizioni alle singole tracce.

Lingua
Consente di selezionare il modo in cui i caratteri devono essere codificati su CD.

NOTA

Se un carattere non € compatibile con lo standard CD-Text, viene visualizzato come ?.

Limita al formato ASCII
Al fine di garantire la massima compatibilita con i lettori CD, questa opzione limita i
caratteri al formato ASCII quando si utilizza l'opzione Europa occidentale. Se questa
opzione & attivata e si inserisce un carattere non compatibile, viene visualizzato un ?.
Abilita la scrittura del CD-Text
Se questa opzione € attivata, il CD-Text viene scritto sul CD.
Reinizializza
Ripristina le impostazioni predefinite.

LINK CORRELATI

CD-Text a pag. 333

Finestra CD a pag. 265

Proprieta del montaggio audio a pag. 209
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Progetti CD/DVD dati

Un progetto CD/DVD dati pu0 essere utilizzato per compilare e scrivere un CD, DVD o Blu-ray di
soli dati o per scrivere un'immagine ISO. E possibile inserire un nome per il disco e modificare la
relativa struttura dei file prima di scrivere i dati su CD, DVD, Blu-ray o immagine ISO.

LINK CORRELATI
Creazione di un progetto CD/DVD dati a pag. 335
Scrittura di un progetto CD/DVD dati a pag. 335

Creazione di un progetto CD/DVD dati

Un progetto CD/DVD dati pu0 essere utilizzato per compilare e scrivere un CD, DVD o Blu-ray di
soli dati o per scrivere un'immagine ISO.

PROCEDIMENTO
1. Selezionare File > Strumenti di utility > CD/DVD dati.
2. Aggiungere i file al progetto tramite uno dei seguenti metodi:

e Trascinare i file dalla finestra di WaveLab Elements chiamata Browser dei file o da
Esplora file/macOS Finder alla finestra CD/DVD dati.

e Trascinare nella finestra CD/DVD dati una scheda relativa a un file audio o a un
montaggio audio.

e Fare clic-destro su una scheda file e selezionare Aggiungi a > Aggiungi a un CD/DVD
dati.

3. Facoltativo: fare clic su Nuova cartella, specificare un nome per la cartella e ordinare i file
trascinandoli.

LINK CORRELATI
Progetti CD/DVD dati a pag. 335

Scrittura di un progetto CD/DVD dati

PREREQUISITI

Aprire la finestra di dialogo CD/DVD dati e aggiungere i file che si desidera scrivere sul CD/DVD
dati.

PROCEDIMENTO
1. Fare clic su Scrivi CD/DVD dati.
2. Selezionare un dispositivo di scrittura.
e Sesiseleziona Immagine ISO, specificare un nome e una posizione per il file.

e Sesiseleziona un masterizzatore CD/DVD, specificare la velocita di scrittura e definire le
impostazioni aggiuntive.

3. Fareclicsu OK.

LINK CORRELATI
Progetti CD/DVD dati a pag. 335
Finestra di dialogo Scrivi CD/DVD dati a pag. 337
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Finestra di dialogo CD/DVD dati

In questa finestra di dialogo & possibile creare un progetto CD/DVD dati e scriverlo su CD, DVD,
Blu-ray, o su unimmagine ISO.

e Per aprire la finestra di dialogo CD/DVD dati, selezionare File > Strumenti di utility >

CD/DVD dati.
Data CD/DVD n
Media CD 650 MB (74 min) ¥ Volume Mame Project_01 o

Name

b\Audic\Track 1.mon Total Size: 42.03 kB Folders: 0 Files: 3

X Close

Supporto
Consente di selezionare il tipo di supporto su cui si desidera eseguire la scrittura. Se la
dimensione del supporto multimediale da utilizzare non & elencata, selezionare il tipo
di supporto che offre una dimensione in linea con le proprie esigenze.

Nome del volume
Consente di specificare il nome del volume del CD/DVD.

Apri la posizione del file

Consente di aprire Esplora file/macOS Finder per mostrare la posizione del file
selezionato.

Rimuovi file e cartelle selezionati
Consente di rimuovere dal CD/DVD tutti i file e le cartelle selezionati.

Crea una nuova cartella
Consente di creare una nuova cartella. E anche possibile creare delle sotto cartelle.

Scrivi CD/DVD dati
Consente di aprire la finestra di dialogo Scrivi CD/DVD dati per eseguire la scrittura su
disco.

Elenco CD/DVD dati

Consente di visualizzare i contenuti del progetto CD/DVD, la dimensione, la data di
creazione e il numero di file.

Spazio disponibile sul supporto multimediale

Consente di visualizzare lo spazio utilizzato nel supporto multimediale. Il parametro
Dimensione totale del progetto CD/DVD dati viene visualizzato sotto l'elenco CD/DVD
dati.

Reinizializza
Consente di rimuovere tutti i file dal progetto CD/DVD dati.

LINK CORRELATI

Progetti CD/DVD dati a pag. 335

Scrittura di un progetto CD/DVD dati a pag. 335
Finestra di dialogo Scrivi CD/DVD dati a pag. 337
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Finestra di dialogo Scrivi CD/DVD dati

In questa finestra di dialogo € possibile scrivere un progetto CD/DVD dati su un CD/DVD o in un
file ISO.

e Per aprire la finestra di dialogo Scrivi CD/DVD dati, aprire la finestra di dialogo CD/DVD dati
e fare clic su Scrivi CD/DVD dati.

€0 Write Data CD/DVD X

Eject after Completion

Vv 0K X Cancel

Periferica

Consente di selezionare I'unita masterizzatore da utilizzare. In alternativa € possibile
selezionare Immagine ISO per scrivere un file su disco fisso. La scrittura di
unimmagine ISO consente di creare una copia da utilizzare in un secondo momento
per la scrittura su un supporto ottico.

NOTA

Sui sistemi Mac, aprire WavelLab Elements senza che nel lettore sia inserito alcun disco.
In caso contrario, l'unita sara controllata dal sistema operativo e non sara disponibile
per Wavelab Elements.

Aggiorna
Consente di eseguire la scansione del sistema per rilevare CD nell'unita ottica
connessa. Tale operazione viene eseguita automaticamente quando questa finestra
di dialogo viene visualizzata. Fare clic sull'icona di aggiornamento dopo aver inserito un
nuovo supporto vuoto per aggiornare il menu Velocita.

Espelli il supporto ottico
Consente di espellere il supporto ottico presente nell'unita selezionata.

Informazioni sulla periferica
Consente di aprire la finestra di dialogo Informazioni sulla periferica, in cui sono
visualizzate una serie di informazioni sulla periferica selezionata.

Cancella il supporto ottico/lI'immagine ISO
Consente di cancellare il supporto ottico presente nell'unita selezionata, a condizione
che si tratti di un disco riscrivibile. Se si fa clic sul pulsante quando & selezionata
'opzione Immagine ISO, viene eliminato il file ISO esistente.

Nome del file ISO
Se & selezionata l'opzione Immagine ISO nel menu Periferica, specificare il nome e la
posizione del file ISO nel campo di testo.

Velocita

Consente di selezionare la velocita di scrittura. La velocita massima impostabile varia in
base alle funzionalita del dispositivo di scrittura e al supporto in esso presente.
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Esegui solo un test, senza effettuare la scrittura

Quando questa opzione € attiva, se si fa clic sul pulsante OK, viene avviata una
simulazione di scrittura del CD. Se il test viene superato, 'operazione reale di scrittura
potra essere eseguita correttamente. Se il test non riesce, provare di nuovo a una
velocita di scrittura inferiore.

Crea una sessione CD-Extra
Se questa opzione € attivata, i dati vengono scritti in una nuova sessione dopo le tracce
audio. Questo consente di creare un CD-Extra, conosciuto anche come Enhanced CD e
CD Plus. Affinché questa opzione funzioni, il CD che si trova nell'unita deve contenere
delle tracce audio scritte con l'opzione CD-Extra. In caso contrario, l'operazione non puo
andare a buon fine.

Verifica dopo la scrittura
Se questa opzione € attivata, i dati scritti sul disco vengono automaticamente verificati
al termine del processo di scrittura.

Espelli prima di verificare
Se questa opzione € attivata, il disco viene espulso e reinserito prima del processo di
verifica, in modo da forzare I'uscita dell’'unita dallo stato di scrittura.

NOTA

Questo & possibile solamente se il disco pud essere reinserito automaticamente.

Espelli al termine del processo

Se questa opzione € attivata, il disco viene espulso al termine dell'operazione di
scrittura.

LINK CORRELATI
Finestra di dialogo CD/DVD dati a pag. 336
Scrittura di un progetto CD/DVD dati a pag. 335

Formati CD audio

La conoscenza delle informazioni generali sui formati dei CD & utile per comprendere meglio
come creare i propri CD audio.

LINK CORRELATI
Principali formati CD a pag. 338

Principali formati CD

I contenuti su CD possono essere scritti in diversi formati. Ad esempio, CD audio, CD-ROM e CD-I.
Questi formati sono leggermente diversi 'uno dall'altro.

La specifica per il CD audio e chiamata Red Book. Questo & lo standard a cui WavelLab Elements si
conforma.

NOTA

CD Red Book non & quindi un vero formato file. Tutto 'audio su CD viene salvato in un file
di grandi dimensioni. Sugli hard disk, invece, ciascun file viene salvato separatamente. Occorre
sempre considerare che l'audio, di fatto, non ¢ altro che un lungo flusso di dati digitali.
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LINK CORRELATI
Formati CD audio a pag. 338

Supporto CD-Extra

Il CD-Extra & un formato che consente di scrivere audio e dati su un solo CD, proprio come CD
Mixed Mode. Quando si scrive un CD audio, & possibile predisporlo per il supporto del CD-Extra
(conosciuto anche come Enhanced CD o CD Plus).

Se nei CD Mixed Mode l'audio si trova nelle ultime tracce, i CD-Extra, al contrario, contengono
l'audio nelle prime tracce del CD e i dati in quelle successive.

Tutte le funzionalita previste dello standard per CD audio Red Book sono disponibili con il
formato CD-Extra, a differenza dei CD Mixed Mode. Dopo che un CD Audio & stato scritto con
supporto CD-Extra, & possibile aggiungere i dati al CD in una sessione separata, creando e
scrivendo un progetto CD Dati.

NOTA

Le unita CD di alcuni computer possono non riconoscere i CD in formato CD-Extra.

LINK CORRELATI
Formati CD audio a pag. 338

Tipi di eventi relativi a un CD Audio

E possibile utilizzare tre tipi di eventi per specificare diverse sezioni dell'audio sul CD.

Inizio traccia
Un CD puo contenere fino a 99 tracce. Ciascuna & identificata soltanto dal suo punto di
inizio.

Sotto-indice della traccia

Nei lettori CD avanzati una traccia pud essere suddivisa in sotto-indici (talvolta chiamati
solo indici). Questi vengono utilizzati per identificare le posizioni importanti all'interno
di una traccia. Ogni traccia pud contenere fino a 98 sotto-indici. Tuttavia, poiché la
ricerca e la localizzazione di un sotto-indice € un'operazione complessa che richiede
tempo, molti lettori CD ignorano queste informazioni.

Pausa

Viene aggiunta una pausa prima di ogni traccia. Le pause possono essere di durate
variabili. Alcuni lettori CD indicano le pause tra le tracce sui loro display.

LINK CORRELATI
Formati CD audio a pag. 338

Frame, posizioni, piccoli frame e bit

I dati su un CD audio vengono suddivisi in frame.

Un frame consiste in 588 campioni stereo. 75 frame compongono un secondo di audio. Questo
perché la frequenza di campionamento del formato CD € pari a 44.100 Hz (campioni per
secondo) e 44.100/588 = 75. Quando si specificano le posizioni su CD in WaveLab Elements, si
utilizza il formato mm:ss:ff (minuti:secondi:frame). I valori dei frame variano da 0 a 74, poiché vi
sono 75 frame per secondo.
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Tecnicamente, in un CD non c'@ modo di specificare niente di piu piccolo di un frame. Ne
consegue che la lunghezza dei campioni di una traccia non corrisponde a un numero preciso

di frame e pertanto alla fine di una traccia viene aggiunto dello spazio vuoto. Inoltre, durante la
riproduzione del CD non & possibile passare a un punto compreso tra due frame. Se si necessita
di dati che si trovano al centro di un frame, & quindi necessario leggere l'intero frame. Questa &
un'altra differenza tra il CD e il disco fisso, dove & possibile localizzare qualsiasi byte senza dover
leggere i dati circostanti.

Ma i frame non sono i blocchi di dati piu piccoli su CD. Esistono anche altri elementi chiamati
«piccoli frame». Un piccolo frame € un contenitore di 588 bit. 98 piccoli frame costituiscono un
frame normale. In ciascun piccolo frame vi & spazio soltanto per sei campioni stereo: questo
significa che buona parte dello spazio € riservato ad altri tipi di dati piuttosto che all'audio vero

e proprio. Tali dati sono costituiti dalle informazioni per la codifica, la sincronizzazione del laser

e la correzione degli errori, nonché dai dati PQ per identificare i limiti delle tracce. Questi dati

PQ sono della massima importanza per tutti gli utenti che creano CD autonomamente e possono
essere gestiti agevolmente in WavelLab Elements.

LINK CORRELATI
Formati CD audio a pag. 338

Codici ISRC

L'International Standard Recording Code (ISRC) & un codice identificativo che viene utilizzato
nei CD destinati a una distribuzione commerciale. WaveLab Elements consente di specificare un
codice ISRC per ciascuna traccia audio. Questi codici sono forniti dal produttore o dai clienti.

Il codice ISRC é strutturato nella modalita descritta di seguito:

e Codice del paese (2 caratteri ASCII)
e Codice del proprietario (3 caratteri ASCII o cifre)
e Anno di registrazione (2 cifre o caratteri ASCII)

e Numero di serie (5 cifre o caratteri ASCII)

In molti casi i gruppi di caratteri sono separati da trattini per semplificare la lettura, ma i trattini
non fanno parte del codice.

LINK CORRELATI
Formati CD audio a pag. 338

Codici UPC/EAN

Il codice UPC/EAN (Universal Product Code/European Article Number) € un numero di catalogo
associato a un elemento (come un CD) pensato per la distribuzione commerciale. In un CD, il
codice viene chiamato anche Numero di catalogo. E presente un codice di questo tipo su ogni
disco. Questi codici sono forniti dal produttore o dai clienti.

L'UPC e un codice a barre a 12 cifre largamente diffuso negli Stati Uniti e in Canada. EAN-13

€ uno standard di codici a barre a 13 cifre (12 + una cifra della somma di controllo) definito
dall'organizzazione di standard GS1. EAN & stato ora rinominato International Article Number
(Numero articolo internazionale), ma come acronimo € rimasto invariato.

LINK CORRELATI
Formati CD audio a pag. 338
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Pre-enfasi

La pre-enfasi del CD si riferisce al processamento progettato per incrementare, all'interno di una
banda di frequenze, 'ampiezza di alcune frequenze (solitamente superiori) rispetto all'ampiezza
di altre (solitamente inferiori). Il fine ultimo & quello di migliorare il rapporto segnale-rumore
complessivo abbassando le frequenze durante la riproduzione.

La pre-enfasi viene normalmente utilizzata nelle telecomunicazioni, nelle registrazioni audio
digitali e nelle trasmissioni in FM. La presenza di pre-enfasi in una traccia viene talvolta indicata
da un segno di spunta nella colonna Pre-enfasi § della finestra di dialogo Importa CD audio.

LINK CORRELATI
Formati CD audio a pag. 338
Finestra di dialogo Importa CD audio a pag. 357

Disc-At-Once - Scrittura di CD-R per la copia su CD reali

WavelLab Elements scrive i CD audio solo in modalita Disc-at-Once.

e Sesidesidera creare un CD-R da utilizzare come master per la produzione di CD veri e propri,
€ necessario scrivere il CD-R in modalita Disc-At-Once. In questa modalita, I'intero disco viene
scritto in un solo passaggio. Esistono altre modalita di scrittura su CD, ossia Track-At-Once e
Multisessione. Se si utilizzano questi formati di scrittura, i blocchi di collegamento creati per
legare insieme i diversi passaggi della registrazione verranno rilevati come errori irreversibili
quando si prova a masterizzare dal CD-R. Questi collegamenti possono anche produrre dei
click durante la riproduzione del CD.

e La modalita Disc-At-Once offre maggiore flessibilita quando si specificano le lunghezze delle
pause tra le tracce.

e Disc-At-Once & I'unica modalita che supporta i sotto-indici.

LINK CORRELATI
Formati CD audio a pag. 338

Confronto tra scrittura al volo e scrittura con immagine del CD

Wavelab Elements scrive un CD al volo, ossia non crea un immagine del CD prima di scrivere.
Questo metodo rende pill rapida la scrittura di CD/DVD e richiede meno spazio su disco. E
comunque possibile creare un'immagine prima della scrittura su CD.
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Loop

La riproduzione in loop di un suono consente di ripetere una sezione del campione
indefinitamente per creare un sustain di lunghezza illimitata. I suoni strumentali nei
campionatori si basano ad esempio sulla riproduzione in loop tipica dei suoni di organo.

In WavelLab Elements i loop sono definiti dai relativi marker o dalla selezione audio. I marker di
loop vengono aggiunti, spostati e modificati esattamente come avviene con qualsiasi altro tipo di
marker.

Per avere la certezza di trovare un buon punto di loop, tenere in considerazione quanto segue:

e Unloop lungo suona generalmente in maniera piu naturale rispetto a un loop piu breve.
Tuttavia, se il suono non presenta una sezione stabile al centro (una parte di sustain
uniforme), potrebbe essere difficile trovare un buon loop lungo.

Ad esempio, una nota di piano che decade in maniera continua & piu difficile da riprodurre in
loop in quanto il punto di inizio del loop € piu forte rispetto al punto di fine. Con un flauto &
piu semplice, in quanto il suono nella sezione di sustain & molto stabile.

e Unloop dovrebbe iniziare subito dopo l'attacco, ovvero, quando il suono si & stabilizzato in
una nota di sustain.

e Sesiimposta un loop lungo, dovrebbe terminare il piu tardi possibile, ma prima che il suono
inizi a decadere verso il silenzio.

e Iloop brevi sono difficile da posizione all'interno del suono. Tentare di posizionarli vicino alla
fine.

NOTA

Maggiori informazioni sulla riproduzione in loop in generale e sulle esatte capacita del
campionatore in particolare sono disponibili nel manuale del campionatore.

LINK CORRELATI
Creazione di loop a pag. 342
Rifinitura dei loop a pag. 343

Creazione di loop

E possibile eseguire in loop una selezione audio o utilizzare i marker di loop e regolare il loop
durante la riproduzione.

PROCEDIMENTO

1. Nell’Editor audio, selezionare la sezione audio a cui si desidera applicare il loop.
2. Fare clic-destro sulla selezione audio e selezionare Crea un loop dalla selezione.
3. Nella barra Trasporto, attivare Loop.
4

Fare clic-destro su Riproduci lI'intervallo audio e attivare 'opzione Regione tra le coppie di
marker.

5. Fare clic-destro su Loop e selezionare la modalita con cui si desidera riprodurre I'audio in
loop nel menu Modalita Loop. Sono disponibili le sequenti opzioni:
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e Riproduci in maniera continua
e Riproduci due volte

e Riproduci tre volte

e Riproduci quattro volte

e Riproduci cinque volte

6. Riprodurreil loop.

00 h 00 mn 08 s 959 ms

La selezione audio viene riprodotta in loop.

7. Facoltativo: modificare la posizione dei marker o i bordi sinistro e destro della selezione per
regolare il loop.

8. Facoltativo: modificare i bordi sinistro e destro della selezione per regolare il loop.

DOPO IL COMPLETAMENTO DI QUESTA OPERAZIONE

Questa modalita di creazione di un loop non porta necessariamente a dei loop di buona qualita,
poiché nei punti di transizione potrebbero verificarsi problemi di click o bruschi cambi di timbro.

Si suggerisce di utilizzare questo metodo per la definizione delle lunghezze di base del loop e
di utilizzare quindi le funzioni Regolatore del loop e Uniformatore del timbro del loop per
l'ottimizzazione.

LINK CORRELATI

Riproduzione in loop di audio non particolarmente adatto all'utilizzo in loop a pag. 351
Rifinitura dei loop a pag. 343

Finestra di dialogo Regolatore del loop a pag. 344

Finestra di dialogo Uniformatore del timbro del loop a pag. 352

Rifinitura dei loop

Un loop semplice pud contenere dei click o dei bruschi cambi di timbro nei punti di svolta. Per
creare un loop senza soluzione di continuita, & possibile rifinire il loop. Utilizzare la finestra di
dialogo Regolatore del loop per regolare una selezione del loop esistente in modo che esegua
perfettamente il loop o utilizzarlo per creare un loop da materiale non perfettamente adatto alla
creazione di un loop.

E possibile rilevare automaticamente i punti di loop eseguendo la scansione dell'area tra i due
marker di loop. Inoltre, & possibile specificare i parametri che determinano l'accuratezza del
programma durante il suggerimento dei punti di loop.

Se la ricerca automatica dei punti di loop non viene completata correttamente, & possibile
processare la forma d'onda per consentire loop piu uniformi in corrispondenza di aree di
dissolvenza incrociata della forma d’onda vicino ai punti di inizio e di fine del loop.
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LINK CORRELATI
Finestra di dialogo Regolatore del loop a pag. 344
Rifinitura dei loop a pag. 348

Finestra di dialogo Regolatore del loop

In questa finestra di dialogo & possibile regolare i punti di inizio e fine del loop, nonché eseguire
una dissolvenza incrociata alle estremita del loop. I punti di inizio e fine del loop sono specificati
dai marker di inizio e fine del loop.

Se nel file audio e disponibile piu di una coppia di marker di loop, fare clic nell'area tra una coppia
di marker di loop per regolare i punti di inizio e di fine corrispondenti.

e Per aprire la finestra di dialogo Regolatore del loop, aprire 'Editor audio. Selezionare la
scheda Processa. Nella sezione Loop, fare clic su Regolatore.

Scheda Regolazione dei punti del loop

Questa scheda consente di rifinire manualmente una selezione di un loop trascinando verso
sinistra/destra la forma d’'onda o utilizzando i pulsanti di ricerca automatica per trovare il
punto di loop adatto piu vicino. L'obiettivo € quello di allineare le forme d'onda in modo che
si incontrino a un punto di zero, dove poter avere la massima corrispondenza.

NOTA

Quando si regolano i punti di inizio e di fine del loop nella finestra di dialogo, i marker di loop di
inizio e di fine nella finestra della forma d'onda principale vengono regolati di conseguenza. Tale
movimento potrebbe non essere visibile a seconda dell'entita dello spostamento dei marker e in
base al fattore di ingrandimento selezionato.

SUGGERIMENTO

e Sesidesidera ascoltare la differenza quando si regolano i marker di loop, attivare 'opzione
Loop nella barra di trasporto durante la riproduzione.

e Se non si sta utilizzando una dissolvenza incrociata o una post-dissolvenza incrociata, non &
necessario fare clic su Applica durante la regolazione dei punti di loop.

e Epossibile lasciare aperta la finestra di dialogo Regolatore del loop e adattare
manualmente la posizione dei marker nelle finestre della forma d'onda.
NOTA

Se si utilizza la funzione Regolatore del loop sui file audio surround, solamente i canali
L/R (destro/sinistro) vengono visualizzati e utilizzati per la corrispondenza alle forme d'onda;
vengono comunque processati tutti i canali.
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Loop Tweaker n

“-5mn13=735ms [4 mn 27 5913 ms / 11.27 MEB]

% mn 41 5 668 ms ->

+ >

Automatic Search

Nella parte superiore di questa finestra di dialogo viene visualizzato l'inizio e la fine della forma
d’'onda tra i marker del loop. La parte inferiore di questa finestra di dialogo offre le sequenti
opzioni:
Fine del loop - Frecce interne

Consentono di spostare i punti di fine del loop verso sinistra/destra.

Fine del loop - Frecce esterne

Consentono di eseguire una ricerca automatica per il punto di loop migliore piu vicino
alla parte sinistra/destra del punto di fine del loop e di spostare il punto di fine in tale
posizione.

Inizio del loop - Frecce interne
Consentono di spostare i punti di inizio del loop verso sinistra/destra.

Inizio del loop - Frecce esterne

Consentono di eseguire una ricerca automatica per il punto di loop migliore piu vicino
alla parte sinistra/destra del punto di inizio del loop e di spostare il punto di inizio in
tale posizione.

Unione stereo

Se questa opzione ¢ attivata per un file stereo, le due forme d'onda vengono
sovrapposte. Altrimenti, vengono visualizzate in due sezioni separate.

Sovrapponi
Se questa opzione e attivata, le forme d'onda di ciascuna meta proseguono nell'altra
meta. L'opzione consente di visualizzare I'aspetto della forma d'onda subito prima e
subito dopo il loop.

Visualizza I'audio processato
Questa opzione ha senso solamente dopo che é stata applicata una dissolvenza
incrociata. Se questa opzione ¢ attivata, sul display viene visualizzata un’anteprima
della forma d'onda dopo la dissolvenza incrociata. Se I'opzione e disattivata, viene
visualizzato I'aspetto della forma d'onda senza dissolvenza incrociata.
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Ingrandimento verticale automatico

Se questa opzione € attivata, I'ingrandimento verticale viene regolato in modo che la
forma d'onda si adatti sempre in senso verticale all'intero display.

Ingrandimento
Consente di impostare il fattore di ingrandimento.

Corrispondenza corrente

Consente di indicare in quale misura le forme d'onda vicine ai punti del loop
corrispondono l'una all'altra. Il valore di sinistra fornisce una stima della somiglianza
tra diversi cicli d'onda, mentre il valore di destra stima la somiglianza di alcuni campioni
vicini ai punti di loop. Maggiori sono i valori, migliore sara la corrispondenza.

Corrispondenza ricercata (0-1000)
Consente di impostare la ricerca automatica dei punti ottimali di loop. Questa opzione
definisce in che misura la sezione trovata deve somigliare alla sezione a cui viene
confrontata per essere considerata una corrispondenza adatta. Maggiore & il valore,
piu precisa sara la somiglianza. Un valore di 1.000 richiede una corrispondenza
perfetta al 100%.

Precisione della ricerca (1-9)
Consente di determinare il numero di campioni che devono essere tenuti in
considerazione dalla ricerca automatica. Valori elevati producono una maggiore
precisione, ma il tempo di processamento € superiore.

Collega i punti di inizio e fine
Se questa opzione € attivata, quando si regolano manualmente i punti del loop anche
i punti di inizio e fine del loop si spostano simultaneamente. Cio significa che la
lunghezza del loop rimane esattamente la stessa e l'intero loop si sposta.

Memorie temporanee
Questa opzione consente di salvare fino a cinque diversi insiemi di punti del loop,
che possono essere richiamati in seguito. In tal modo & possibile provare diverse
impostazioni di loop. Per salvare un insieme, fare clic sul pulsante M, quindi su uno dei
pulsantida 1 a5.

Scheda Dissolvenza incrociata

In questa scheda & possibile applicare una dissolvenza incrociata tra l'audio al termine di un loop
e l'audio all'inizio del loop. Questa funzionalita puo essere di aiuto per ottenere una transizione
pil omogenea tra l'inizio e la fine di un loop, in particolare quando si ha a che fare con materiali
non perfettamente adatti alla creazione di un loop. Per regolare l'inviluppo della dissolvenza
incrociata, utilizzare i punti di trascinamento dell'inviluppo o i controlli di scorrimento dei valori.
Fare clic su Applica per creare la dissolvenza incrociata.
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Loop Tweaker n

Crossfade Audio at End of Loop with Audio before Loop
Length  51.5

Shap m Equal Gain to Equal

Untitled y By Apply

Esegui una dissolvenza incrociata alla fine del loop, con l'audio prima del loop

Attivare questa casella di controllo per abilitare la dissolvenza incrociata. La dissolvenza
incrociata viene applicata quando si fa clic su Applica.

Lunghezza
Consente di determinare la lunghezza della dissolvenza incrociata. Solitamente, &
preferibile che la dissolvenza incrociata sia piu corta possibile, con un risultato
comunque accettabile.

NOTA

e Lutilizzo di una dissolvenza incrociata lunga consente di uniformare il loop.
Tuttavia, una sezione maggiore della forma d'onda verra processata e ne verra
quindi modificato il carattere.

e Una dissolvenza incrociata piu breve influisce in misura minore sul suono, ma il
loop & meno uniforme.

Forma (da guadagno costante a potenza costante)

Consente di determinare la forma della dissolvenza incrociata. Si consiglia di utilizzare
valori bassi per suoni semplici e valori elevati per suoni complessi.

Scheda Post-dissolvenza incrociata

Con ‘post-dissolvenza incrociata’ si intende la dissolvenza incrociata del loop nell'audio dopo la
fine del loop, in modo che non siano presenti discontinuita quando la riproduzione continua
dopo il loop. L'operazione viene eseguita miscelando una copia del loop con l'audio.

In questa scheda & possibile applicare una dissolvenza incrociata al termine del loop, mixando
una copia del loop stesso con l'audio. Per regolare l'inviluppo della dissolvenza incrociata,
utilizzare i punti di trascinamento dell'inviluppo o i controlli di scorrimento dei valori. Fare clic
su Applica per creare la post-dissolvenza incrociata.
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Loop Tweaker n

Post-Crossfade

e

Loop Post-Loop

Crossfade Audio after Loop with Audio of Loop Start

Length

Shap m Equal Gain to Equal

Untitled y By Apply

Esegui una dissolvenza incrociata dopo il loop, con l'audio dell'inizio del loop

Attivare questa casella di controllo per abilitare la dissolvenza incrociata. La dissolvenza

incrociata viene applicata quando si fa clic su Applica.

Lunghezza

Consente di determinare la lunghezza della dissolvenza incrociata. Solitamente, &
preferibile che la post-dissolvenza incrociata sia piu corta possibile, con un risultato
comunque accettabile.

NOTA

e L'utilizzo di una post-dissolvenza incrociata lunga consente di uniformare il loop.
Tuttavia, una sezione maggiore della forma d'onda verra processata e ne verra
quindi modificato il carattere.

e Una post-dissolvenza incrociata piu breve influisce in misura minore sul suono, ma
il loop € meno uniforme.

Forma (da guadagno costante a potenza costante)

Consente di determinare la forma della post-dissolvenza incrociata. Si consiglia di
utilizzare valori bassi per suoni semplici e valori elevati per suoni complessi.

Rifinitura dei loop

E possibile rifinire i loop utilizzando la finestra di dialogo Regolatore del loop.

PROCEDIMENTO

1.

.

2
3.
4
5

.

Nell'Editor audio, creare un loop semplice utilizzando una coppia di marker di loop.
Fare clic tra il marker di inizio e il marker di fine del loop che si desidera rifinire.
Selezionare la scheda Processa.

Nella sezione Loop, fare clic su Regolatore.

Nella finestra di dialogo Regolatore del loop, rifinire il loop come desiderato.
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6. Fare clic su Applica.

LINK CORRELATI
Creazione di loop a pag. 342
Finestra di dialogo Regolatore del loop a pag. 344

Spostamento manuale dei punti di loop

Se il loop continua a presentare discontinuita o salti nei punti di transizione, & possibile utilizzare
la finestra di dialogo Regolatore del loop per spostare i punti in piccoli incrementi, in modo da
rimuovere questi artefatti audio.

Tale operazione & simile allo spostamento dei punti di loop nella visualizzazione della forma
d'onda, ma con un feedback visivo per facilitare I'individuazione di buoni punti di loop.

Sono disponibili due modalita di spostamento manuale dei punti di loop nella scheda
Regolazione dei punti del loop nella finestra di dialogo Regolatore del loop:

e Trascinare la forma d'onda a sinistra e a destra.

e Utilizzare le frecce blu sotto la forma d'onda per spingere I'audio verso sinistra e verso
destra. Ciascun clic del mouse sposta il punto di loop di un singolo campione.

Le operazioni seguenti si possono applicare durante lo spostamento manuale di punti di loop:

e Per spostare il punto di fine in una posizione precedente o successiva, muovere la parte
sinistra della schermata.

e Per spostare il punto di inizio in una posizione precedente o successiva, muovere la parte
destra della schermata.

e Per spostare contemporaneamente i punti di inizio e di fine, attivare Collega i punti di
inizio e fine. In questo modo, quando si regola un punto di loop, la lunghezza del loop non
cambia, ma viene spostato l'intero loop.

e Einoltre possibile regolare i marker di loop nella finestra della forma d’'onda.

Rilevazione automatica di buoni punti di loop

La finestra di dialogo Regolatore del loop consente di cercare automaticamente i punti di loop
migliori.

PROCEDIMENTO

1. Nell’Editor audio, selezionare il loop che si desidera rifinire facendo clic tra il relativo marker
di inizio e di fine del loop.

2. Selezionare la scheda Processa.
3. Nella sezione Loop, fare clic su Regolatore.

4. Nellafinestra di dialogo Regolatore del loop, nella scheda Regolazione dei punti del loop,
assicurarsi che sia disattivata 'opzione Collega i punti di inizio e fine.

5. Nella sezione Ricerca automatica, specificare i valori Corrispondenza ricercata e
Precisione della ricerca.

6. Fare clic sui pulsanti freccia bianchi per avviare la ricerca automatica di un punto di loop
ottimale.

Wavelab Elements esegue la scansione a partire da o verso il punto corrente, fino a trovare
un punto corrispondente. E possibile interrompere in qualsiasi momento l'operazione
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facendo clic sul pulsante destro del mouse. Il programma torna quindi alla migliore
corrispondenza trovata.

7. Verificare il loop riproducendolo.

8. Facoltativo: se si ritiene sia possibile ottenere un punto di loop migliore, continuare la
ricerca.

Salvataggio temporaneo dei punti di loop

Il salvataggio e il ripristino temporaneo dei punti di loop consente di confrontare diverse
impostazioni di loop.

PREREQUISITI
Configurare un loop semplice e aprire la finestra di dialogo Regolatore del loop.

NOTA

e Sono disponibili cinque slot per il salvataggio temporaneo dei punti di loop per ciascuna
finestra della forma d'onda e di montaggio. Se nel file sono presenti diversi set di loop, €
necessario prestare attenzione a non richiamare il set errato.

e Solo le posizioni di loop sono salvate temporaneamente.

PROCEDIMENTO

1. Nella scheda Regolazione dei punti del loop, nella sezione Memorie temporanee, fare clic
su M.

2. Selezionare uno dei cinque slot di memoria.

Dissolvenze incrociate nei loop

L'utilizzo delle dissolvenze incrociate ¢ utile per creare delle transizioni pit omogenee tra l'inizio
e la fine di un loop, in particolare quando si utilizzano materiali non particolarmente adatti alla
creazione di un loop.

A volte & impossibile trovare un loop che non provochi alcuna discontinuita. E vero in particolare
per materiali stereo, in cui € possibile trovare un candidato perfetto per un solo canale.

In questo caso, la dissolvenza incrociata diffonde il materiale intorno al punto di loop di fine
in modo da esequire perfettamente il loop. Cio € possibile mixando il materiale dal punto
precedente all'inizio del loop con materiale posizionato prima della fine del loop.

NOTA

Questa tecnica altera la forma d'onda e di conseguenza modifica il suono.

Creazione di una dissolvenza incrociata

PROCEDIMENTO
1. Nell’Editor audio, creare un loop nella maniera migliore possibile.
2. Selezionare la scheda Processa.

3. Nella sezione Loop, fare clic su Regolatore.
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4. Nella finestra di dialogo Regolatore del loop, decidere se si desidera creare una dissolvenza
incrociata o una post-dissolvenza incrociata:

e Sesidesidera creare una dissolvenza incrociata, fare clic sulla scheda Dissolvenza
incrociata.

e Sesidesidera creare una post-dissolvenza incrociata, fare clic sulla scheda Post-
Dissolvenza incrociata.

5. Assicurarsi che l'opzione Esegui una dissolvenza incrociata alla fine del loop, con l'audio
prima del loop (scheda Dissolvenza incrociata) o Esegui una dissolvenza incrociata dopo
il loop, con l'audio dell'inizio del loop (scheda Post-Dissolvenza incrociata) sia attivata.

6. Specificare la lunghezza della dissolvenza incrociata trascinando la maniglia della lunghezza
o regolando il valore Lunghezza sotto il grafico.

7. Specificare la forma di dissolvenza incrociata trascinando la maniglia della forma o
regolando il valore Forma (da guadagno costante a potenza costante).

8. Fareclic su Applica.

Il suono viene processato. Ogni volta che si fa clic su Applica, il processo di loop precedente
viene automaticamente annullato. In tal modo & possibile provare rapidamente diverse
impostazioni.

NOTA

Non spostare i punti del loop dopo aver eseguito una dissolvenza incrociata. La forma d’'onda
e stata specificamente processata per le impostazioni loop correnti.

DOPO IL COMPLETAMENTO DI QUESTA OPERAZIONE

e E possibile verificare a livello visivo la dissolvenza incrociata selezionando la scheda
Regolazione dei punti del loop e attivando Visualizza I'audio processato. Se questa
opzione & attivata, nel display viene visualizzata un'anteprima della forma d'onda dopo
la dissolvenza incrociata. Se l'opzione ¢ disattivata, nel display viene visualizzata la forma
d’'onda originale. Questa funzione consente di confrontare le due forme d'onda.

Post-dissolvenze incrociate

Con post-dissolvenza incrociata si intende la dissolvenza incrociata del loop nell'audio dopo la
fine del loop, in modo che non siano presenti discontinuita quando la riproduzione continua
dopo il loop. L'operazione viene eseguita mixando una copia del loop nell'audio.

E possibile configurare la post-dissolvenza incrociata nella scheda Post-Dissolvenza incrociata
della finestra di dialogo Regolatore del loop.

La post-dissolvenza incrociata consente di analizzare la parte della forma d'onda presente subito
dopo l'inizio del loop e di processare un‘area specifica che inizia alla fine del loop. Il parametro

di lunghezza regola la dimensione di tale area. Tutto il resto & identico alla dissolvenza incrociata
regolare.

Riproduzione in loop di audio non particolarmente adatto
all'utilizzo in loop

I suoni che presentano un decadimento di livello costante o nei quali il timbro cambia
continuamente sono difficili da riprodurre in loop. La finestra di dialogo Uniformatore del
timbro del loop consente di creare dei loop da suoni di questo tipo.
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L'opzione Uniformatore del timbro del loop applica un processamento al suono che uniforma
le modifiche delle caratteristiche timbriche e di livello in modo che tale suono venga riprodotto
in loop in maniera corretta. Ad esempio, & utile per creare campioni riprodotti in loop per un
campionatore hardware o softsynth.

La funzione Uniformatore del timbro del loop include un'opzione di dissolvenza incrociata
che consente di dissolvere il suono originale nelle sezioni processate quando la riproduzione si
awvicina all'inizio del loop.

Per utilizzare la funzione Uniformatore del timbro del loop & necessario che sia stato creato
un loop mediante la definizione di una coppia di marker di loop. La lunghezza originale del loop
viene mantenuta.

Finestra di dialogo Uniformatore del timbro del loop

Questa finestra di dialogo consente di creare dei suoni da riprodurre in loop a partire da
materiale audio non particolarmente adatto ad essere utilizzato come loop. Si tratta di suoni
che in genere presentano un decadimento di livello costante o per cui il timbro cambia
continuamente.

e Per aprire la finestra di dialogo Uniformatore del timbro del loop, aprire I'Editor audio,
selezionare la scheda Processa e, nella sezione Loop, selezionare Uniformatore del timbro.
Scheda Uniformazione

Questa scheda consente di specificare i metodi utilizzati per uniformare il suono che si desidera
riprodurre in loop.

Loop Tone Uniformizer n

Chorus Smoothing

Slice Mi

Number o

Qg Apply

Mixaggio delle sezioni

Consente di suddividere il loop in sezioni, le quali vengono poi mixate insieme per
uniformare il suono.

Per il mixaggio delle sezioni, & necessario determinare il numero di sezioni. Solo
sperimentando & possibile individuare il numero di sezioni necessarie, ma solitamente
maggiore e il numero di sezioni, piu naturale sara il suono. Tuttavia, il programma
pone una restrizione al numero di sezioni, in modo tale che nessuna sia mai inferiore a
20 ms.

Ad esempio, se si specificano otto sezioni, il loop viene suddiviso in otto sezioni della
stessa lunghezza. Queste sezioni vengono poi sovrapposte e mixate insieme come un
unico suono ripetuto otto volte. Questo nuovo contenuto audio sostituisce tutto l'audio
allinterno del loop, senza pericolo che si verifichi una cancellazione armonica a causa
di scostamenti di fase.
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Mixaggio delle sezioni - Numero di sezioni
Maggiore € il numero di sezioni utilizzate, piu il suono cambia.

Ammorbidimento del chorus
Questo processore utilizza un metodo di phase vocoding per filtrare gli armonici.
Questo metodo, raccomandato per eseguire il loop di ensemble e suoni corali, pud
modificare drasticamente il timbro.
Ammorbidimento del Chorus - Timbro
Consente di regolare il grado di modifica delle caratteristiche timbriche del campione
da uniformare. Maggiore € il valore, piu pronunciato sara l'effetto.
Ammorbidimento del Chorus - Chorus
Consente di determinare la profondita dell'effetto chorus.

Ammorbidimento del Chorus - Aumenta il calore
Consente di creare un suono pilt omogeneo e caldo.

Ammorbidimento del Chorus - Espansione stereo
Consente di aumentare 'ampiezza del campione nellimmagine sonora stereo.

Scheda Pre-dissolvenza incrociata

In questa scheda é possibile eseguire una dissolvenza incrociata tra la fine del loop e l'inizio della
sezione appena processata, in modo che la transizione verso quest'ultima risulti piu morbida
durante la riproduzione. Per regolare la dissolvenza incrociata, utilizzare i punti di trascinamento
dell'inviluppo o i cursori dei valori.

E necessario utilizzare questa funzione in quanto I'Uniformatore del timbro del loop modifica
il timbro solo all'interno del loop. Cio significa che la transizione nel loop non & uniforme come
previsto, a meno che non si applichi la dissolvenza incrociata.

Loop Tone Uniformizer n

Pre-Crossfade

Attack
yssfade Audio before Loop with Audio of End of Loop
Length 20

Equal Gain to Equal P

B Apply

Esegue una dissolvenza incrociata tra I'audio prima del loop e I'audio alla fine del loop
Consente di abilitare la dissolvenza incrociata, applicata quando si fa clic su Applica.

Lunghezza

Consente di determinare la lunghezza della dissolvenza incrociata. Solitamente, e
preferibile che la post-dissolvenza incrociata sia piu corta possibile, con un risultato
comunque accettabile.

e Una dissolvenza incrociata lunga produce un loop pit uniforme. Tuttavia, una
sezione maggiore della forma d'onda verra processata e ne verra quindi modificato
il carattere.
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e Una dissolvenza incrociata piu breve influisce in misura minore sul suono, ma il
loop & meno uniforme.

Forma (da guadagno costante a potenza costante)

Consente di determinare la forma della dissolvenza incrociata. Si consiglia di utilizzare
valori bassi per suoni semplici e valori elevati per suoni complessi.

Riproduzione in loop di un contenuto audio che apparentemente
non puo essere riprodotto in loop

PROCEDIMENTO

1. Nell'Editor audio, creare un loop semplice utilizzando una coppia di marker di loop.
2. Fareclictra il marker diinizio e il marker di fine del loop che si desidera rifinire.

3. Selezionare la scheda Processa.

4. Nella sezione Loop, fare clic su Uniformatore del timbro.

5

Nella finestra di dialogo Uniformatore del timbro del loop, assicurarsi che le opzioni
Mixaggio delle sezioni e/o Ammorbidimento del chorus siano attivate, quindi definire le
proprie impostazioni.

6. Facoltativo: selezionare la scheda Pre-Dissolvenza incrociata e impostare una dissolvenza
incrociata.

7. Fareclic su Applica.

Il suono viene processato. Ogni volta che si fa clic su Applica, viene definito un nuovo loop.
In tal modo é possibile provare rapidamente diverse impostazioni.

NOTA

Non spostare i punti del loop dopo aver eseguito una dissolvenza incrociata. La forma d’onda
& stata processata in maniera specifica per le impostazioni correnti del loop.

DOPO IL COMPLETAMENTO DI QUESTA OPERAZIONE

Dopo aver utilizzato la finestra di dialogo Uniformatore del timbro del loop, |a transizione tra
la fine del loop e la fine del file potrebbe risultare poco naturale. Per porre rimedio a questo
problema, € possibile creare una post-dissolvenza incrociata utilizzando la finestra di dialogo
Regolatore del loop.

LINK CORRELATI
Finestra di dialogo Uniformatore del timbro del loop a pag. 352
Finestra di dialogo Regolatore del loop a pag. 344

Attributi dei campioni

Gli attributi dei campioni consentono di definire le impostazioni per un campione audio prima di
caricarlo in un campionatore hardware o software.

Gli attributi dei campioni non processano il campione, forniscono solo le proprieta del file
utilizzabili dal campionatore ricevente. Questo consente di includere le informazioni relative
all'altezza del campione, rilevabili automaticamente, all'intervallo di altezze su cui si estende il
campione e all'intervallo delle velocity da occupare. Per i file WAV e AIFF, queste informazioni
sono salvate nell'intestazione del file. Per impostazione predefinita, non sono presenti attributi
dei campioni in un file audio.
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NOTA

A seconda del campionatore e del protocollo utilizzato per la comunicazione, gli attributi dei
campioni potrebbero non essere supportati.

Modifica degli attributi dei campioni

PROCEDIMENTO

1. Aprire 'Editor audio.

2. Selezionare Finestre degli strumenti di utility > Attributi dei campioni.
3. Nella finestra Attributi dei campioni, fare clic su Crea.
4

Facoltativo: se si desidera rilevare automaticamente l'altezza di una selezione audio,
selezionare un intervallo audio, quindi fare clic su Rileva dalla selezione audio.

g

Specificare gli attributi del campione.

6. Salvare il file audio per memorizzare le impostazioni degli attributi nel file audio.
Gli attributi del campione vengono salvati soltanto nei file WAV e AIFF.

Finestra Attributi dei campioni

In questa finestra € possibile creare gli attributi per un campione audio.

e Per aprire la finestra Attributi dei campioni, aprire 'Editor audio e selezionare Finestre
degli strumenti di utility > Attributi dei campioni.

SAMPLEATTRIB

==
m Remove

Tune {ey Range Velocity Range

Detune

Detect from Audi

Crea/Rimuovi
Consente di creare/rimuovere attributi del campione per il file audio attivo.

Altezza - Nota
Consente di specificare quale tasto riproduce il suono alla sua altezza di base.

Altezza - Disaccordatura

Consente di specificare se il campione deve essere riprodotto a un‘altezza leggermente
diversa. L'intervallo € £50% di un semitono, che si traduce in un quarto di tono in
ciascuna direzione.

Rileva dalla selezione audio
Consente di rilevare l'altezza di una selezione audio. Assicurarsi che l'intervallo
selezionato contenga un’altezza definita chiaramente.

Intervallo dei tasti - Alto/basso

Consente di specificare l'intervallo dei tasti da associare al campione se il campione &
parte di una mappa tasti multipla.
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Intervallo delle velocity - Alto/basso
Consente di specificare l'intervallo della velocity da associare al campione se il
campione & parte di una mappa tasti multipla con campioni con velocity variabili.
Guadagno

Per i file WAV e AIFF & possibile specificare il guadagno degli attributi dei campioni.
Questa opzione non ha effetto sul volume della riproduzione.
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Finestra

E possibile leggere tracce audio da normali CD e salvarle come copia digitale in qualsiasi formato
audio sull’'hard disk.

Benché Wavelab Elements supporti un ampio numero di unita CD, & necessario prestare
attenzione ad alcune restrizioni:

e Esistono numerosi protocolli per il recupero dell'audio da un'unita CD-ROM/CD-R. WavelLab
Elements supporta il maggior numero di questi metodi, ma non garantisce il funzionamento
con tutte le unita esistenti. Questo si applica a CD-Text e ISRC.

e Osservare e rispettare qualsiasi avviso di copyright sui CD da cui si stanno importando
tracce.

Quando si importano le tracce, queste vengono chiamate «Traccia XX» per impostazione
predefinita, dove XX & un numero che inizia da 01. Lo schema di numerazione pud essere
modificato.

NOTA

L'importazione di tracce CD audio & tecnicamente piu complicata della lettura di file da un
CD-ROM o hard disk, in quanto pu0 essere difficoltoso rilevare i settori audio. Alcuni CD che non
si conformano totalmente agli standard CD possono causare problemi, in particolare quando
sono protetti da copia.

LINK CORRELATI
Importazione di tracce CD audio a pag. 360

di dialogo Importa CD audio

In questa finestra di dialogo, & possibile importare uno o pit tracce da un CD audio.

e Per aprire la finestra di dialogo Importa CD audio, selezionare File > Importa e fare clic su
CD audio.
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Finestra di dialogo Importa CD audio

Import Audio CD n

Functions Rename Tracks
na G 4 F

15
Source

CDDVDW SH-216l

ISRC CD-Text

11 n
14 mn
1

Range

Length 4mni3s

Select All M Play W save

Menu Funzioni

Informazioni sul CD
Consente di visualizzare la lunghezza del CD e il codice UPC/EAN, se disponibile.

Estrai codici ISRC

Consente di leggere i codici ISRC e di visualizzarli nell'elenco tracce. A seconda
dell'unita CD, I'operazione pud richiedere del tempo.

Esamina CD-Text

Consente di aprire la finestra di dialogo CD-Text in cui & possibile visualizzare il CD-
Text. Non tutte le unita CD supportano CD-Text.

Estrai CD-Text
Consente di estrarre il CD-Text e di visualizzare un riepilogo nell'elenco tracce.

Menu Rinomina tracce

Nome
Consente di rinominare le tracce in base allo schema di rinomina selezionato.

Cerca i nomi delle tracce su internet (gnudb)

Consente di cercare i nomi delle tracce in un database Internet. Se viene individuato
I'album, I'elenco delle tracce del CD viene aggiornato.

Invia i nomi delle tracce su internet (gnudb)
Consente di inviare le informazioni sul CD audio al database gnudb.

Menu Converti

Converti tutte le tracce in montaggio audio
Consente di estrarre tutte le tracce CD e di utilizzarle per creare un montaggio audio.
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Converti le tracce selezionate in montaggio audio

Consente di estrarre le tracce CD audio selezionate e di utilizzarle per creare un
montaggio audio.

Scheda Azioni

Sorgente
Selezionare l'unita CD da cui importare le tracce CD audio.

Velocita

Consente di impostare la velocita di scrittura. La massima velocita impostabile varia in
base al dispositivo di scrittura utilizzato e al disco in esso presente.

Aggiorna
Se siinserisce un CD durante la visualizzazione della finestra di dialogo Importa CD
audio, & necessario fare clic su questo pulsante per mostrare i contenuti di tale CD
nell'elenco.

Espelli supporto ottico
Consente di espellere il supporto dall'unita selezionata.

Elenco tracce
Consente di visualizzare le tracce sul CD.

Intervallo - Inizio/Lunghezza

Se si desidera importare solo una sezione di una traccia, utilizzare i campi Inizio e
Lunghezza per definire un punto di inizio e la rispettiva lunghezza.

Uscita - Posizione
Consente di impostare la posizione di uscita.

Uscita - Formato file
Consente di impostare il formato file di output.

Seleziona tutto
Consente di selezionare tutte le tracce CD nell’elenco tracce.

Riproduci
Consente di riprodurre la traccia CD selezionata.

Scheda Opzioni

Taglia silenzio
Se questa opzione € attivata, viene rimosso il silenzio tra le tracce importate. Viene
rimosso solo il silenzio digitale, ovvero i campioni con un livello zero.

Aggiornamento automatico al cambio del CD

Se questa opzione ¢ attivata, WavelLab Elements verifica la presenza di un nuovo
CD nell'unita varie volte al secondo. Se viene trovato un nuovo CD, viene aggiornato
I'elenco delle tracce.

Estrai automaticamente i codici ISRC
Se questa opzione € attivata, vengono automaticamente estratti i codici ISRC quando
viene inserito un CD.

Estrai automaticamente CD-Text

Se questa opzione € attivata, viene automaticamente estratto CD-Text quando viene
inserito un CD.
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Ricerca automatica dei nomi delle tracce su internet

Se questa opzione € attivata, vengono automaticamente cercati i nomi delle tracce su
internet quando viene inserito un CD.

Recupera la pausa prima della prima traccia (se disponibile)

Se questa opzione € attivata, quando una sezione audio si trova prima della prima
traccia, essa verra estratta insieme a questa prima traccia. In tal modo & possibile
importare delle bonus track nascoste.

Usa un decoder CD-Text Giapponese

Se questa opzione € attivata, il CD-Text verra interpretato come Giapponese (alla
successiva estrazione).

Crea file di picco

Se questa opzione & attivata, verra creato un file di picco insieme ai file renderizzati.

Mostra tempo con le unita di frame del CD

Se questa opzione € attivata, viene visualizzato il tempo nelle unita di frame del CD.
Sono disponibili 75 frame del CD per secondo.

Riproduci attraverso la Sezione Master

Se questo pulsante ¢ attivato, la Sezione Master viene ignorata. Se il pulsante &
disattivato, il segnale audio passa attraverso la Sezione Master.

Converti i titoli e il CD-Text in metadati

Se questa opzione & attivata quando si importano tracce in un formato audio che
supporta i metadati (ad esempio, MP3 e WMA), i titoli delle tracce e il CD-Text sono
aggiunti automaticamente all'intestazione del file.

Usa modalita ultra-sicura (lenta)

Se questa opzione € attivata, ciascuna traccia CD viene letta piu volte fino a quando
viene trovato lo stesso identico risultato (sono utilizzate le somme di controllo).
Specificare il numero di volte in cui una traccia deve essere letta con lo stesso risultato
prima di essere salvata sul disco.

Lettura dell'audio prima e dopo le tracce

E possibile accertarsi che le tracce vengano importate nella loro interezza, definendo le
parti di audio che dovranno essere lette prima e dopo ciascuna traccia CD.

LINK CORRELATI
Importazione di CD audio a pag. 357

Importazione di tracce CD audio

E possibile importare I'audio dai CD audio all'interno dei progetti di WavelLab Elements.

PROCEDIMENTO

1. Inserire un CD nel lettore CD-ROM/CD-R.

2. Selezionare File > Importa.

3. Fareclic su CD audio.

4. Nella finestra di dialogo Importa CD audio, sezione Sorgente, selezionare l'unita dalla quale
si desidera eseguire la lettura, quindi specificare la velocita di lettura.

5. Facoltativo: rinominare i file e regolare lo schema di numerazione.

Le tracce devono avere nomi univoci se si desidera importarle tutte.
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6. Facoltativo: nella scheda Opzioni, sezione Lettura dell’audio prima e dopo le tracce,
definire la quantita di audio da leggere prima e dopo ciascuna traccia CD.

7. Nellelenco delle tracce, selezionare le tracce che si desidera importare.

8. Facoltativo: se e stato selezionato solo un file, nella sezione Intervallo & possibile definire
valori di Inizio e Lunghezza per importare solo una parte della traccia.

9. Nella sezione Uscita fare clic sullicona della cartella e selezionare una posizione di uscita.

E inoltre possibile trascinare una o piu tracce CD in una traccia montaggio audio.

10. Nella sezione Uscita fare clic sul campo del formato file e selezionare un formato file per i
file audio importati.

11. Fare clic su Salva.

RISULTATO
Le tracce vengono importate nella posizione specificata.

LINK CORRELATI
Finestra di dialogo Importa CD audio a pag. 357

Ricerca dei nomi delle tracce su internet

E possibile cercare informazioni sui propri CD utilizzando il database gnudb.

PREREQUISITI
E necessario essere connessi a internet per utilizzare la funzione gnudb.

PROCEDIMENTO

1. Inserire un CD nel lettore CD-ROM/CD-R.
2. Selezionare File > Importa.

3. Fare clic su CD audio.
4

Nella finestra di dialogo Importa CD audio, selezionare Rinomina tracce > Cerca i nomi
delle tracce su internet (gnudb).

LINK CORRELATI
Finestra di dialogo Importa CD audio a pag. 357

Invio dei nomi delle tracce su internet

E possibile inviare le informazioni sul CD audio al database gnudb.

PREREQUISITI
E necessario essere connessi a internet per utilizzare la funzione gnudb.

PROCEDIMENTO

1. Inserire un CD nel lettore CD-ROM/CD-R.
2. Selezionare File > Importa.

3. Fare clic su CD audio.
4

Nella finestra di dialogo Importa CD audio, rinominare ciascuna traccia.
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5. Selezionare Rinomina tracce > Invia i nomi delle tracce su internet (gnudb).

6. Nella finestra di dialogo Invia le informazioni sul CD, riempire i campi di testo e inserire un
indirizzo e-mail.

NOTA

E necessario un indirizzo e-mail per comunicare eventuali errori di invio. Questa
informazione non verra in alcun caso salvata e archiviata.

Il database gnudb non offre la possibilita di inserire artisti o generi diversi per le singole
tracce. Se gli artisti variano da traccia a traccia, & possibile scrivere il titolo delle tracce come
segue: Titolo/Artista.

7. Fareclicsu OK.

LINK CORRELATI
Finestra di dialogo Importa CD audio a pag. 357

Modalita ultra-sicura

Capita talvolta che una piccola porzione di una traccia CD non venga recuperata correttamente,
causando artefatti audio indesiderati. Questa eventualita varia a seconda della qualita dell'unita
CD utilizzata. Per risolvere il problema, € possibile attivare la modalita ultra-sicura nelle opzioni
della finestra di dialogo Importa CD Audio.

Se questa opzione € attivata, e possibile specificare il numero di volte in cui ciascuna traccia CD
viene letta con lo stesso risultato prima di venire salvata sul disco.

LINK CORRELATI

Finestra di dialogo Importa CD audio a pag. 357

Conversione di tracce CD audio in un montaggio audio

E possibile convertire delle tracce CD audio in un montaggio audio.

PROCEDIMENTO

1. Inserire un CD nel supporto CD-ROM/CD-R.
2. Selezionare File > Importa.

3. Fareclic su CD audio.
4

Facoltativo: nella finestra di dialogo Importa CD audio, scheda Opzioni, selezionare le
informazioni che si intende estrarre dal CD audio in fase di conversione.

5. Decidere se convertire solo le tracce selezionate o tutte le tracce.

e Per convertire solo le tracce selezionate, selezionare Converti > Converti le tracce
selezionate in montaggio audio.

e Per convertire tutte le tracce, selezionare Converti > Converti tutte le tracce in
montaggio audio.

RISULTATO

Una volta terminata la conversione, i file importati vengono aperti nella finestra Montaggio
audio.
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LINK CORRELATI
Finestra di dialogo Importa CD audio a pag. 357
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Video

WavelLab Elements consente di aggiungere dei file video a un montaggio audio. E possibile
riprodurre i file video in diversi formati direttamente da WaveLab Elements, estrarre I'audio da un
file video e modificare I'audio insieme al video.

LINK CORRELATI

Compatibilita dei file video a pag. 369
Traccia video a pag. 364

Finestra Video a pag. 368

Traccia video

La traccia video nella finestra del montaggio audio consente di aggiungere dei file video al
montaggio.

Il file video importato viene visualizzato sotto forma di clip nella traccia video. Le miniature
rappresentano i fotogrammi nella pellicola. Il file audio contenente I'audio per il video viene
posizionato in una nuova traccia del montaggio audio, sotto la traccia video.

E possibile importare piu file video di formati diversi nella stessa traccia video. Pud esistere una
sola traccia video per ciascun montaggio audio.

LINK CORRELATI

Modifica dell'audio estratto dal video a pag. 366

Aggiunta di tracce video a pag. 364

Inserimento di file video nei montaggi audio esistenti a pag. 365
Importazione di file video in un nuovo montaggio audio a pag. 365
Tracce a pag. 213

Aggiunta di tracce video

E possibile aggiungere una traccia video per ciascun montaggio audio.

PROCEDIMENTO

e Nellafinestra Montaggio audio, eseguire una delle sequenti operazioni:
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e Fareclicsu+in cima all'area dei controlli delle tracce e selezionare Traccia video.

e Fare clic-destro nell'area dei controlli delle tracce per aprire il menu a tendina Traccia e
selezionare Aggiungi una traccia > Traccia video.

RISULTATO

Per impostazione predefinita, la nuova traccia viene aggiunta sotto la traccia attiva. Se si desidera
posizionarla sopra la traccia attiva, premere Ctrl/Cmd al momento dell'aggiunta della nuova
traccia.

LINK CORRELATI
Area dei controlli delle tracce a pag. 191

Inserimento di file video nei montaggi audio esistenti

E possibile inserire dei file video nel proprio montaggio audio.

OPZIONI
e Nellafinestra Montaggio audio, selezionare la scheda Inserisci e fare clic su File video nella
sezione Importa. Selezionare il file video che si desidera inserire e fare clic su Apri.
La traccia video viene automaticamente creata.
e Trascinare il file video che si intende inserire, dalla finestra File alla traccia video.
e Trascinare il file video che si intende inserire, da Esplora file/macOS Finder alla traccia video.
RISULTATO

Il file video viene inserito nel montaggio audio.

NOTA

Se la frequenza di campionamento dell'audio incluso non corrisponde alla frequenza

di campionamento del montaggio audio, si apre la finestra di dialogo Frequenze di
campionamento non conformi. Questa finestra di dialogo consente di creare una copia
ricampionata dell'audio.

LINK CORRELATI

Aggiunta di tracce video a pag. 364

Importazione di file video in un nuovo montaggio audio a pag. 365
Finestra di dialogo Frequenze di campionamento non conformi a pag. 219

Importazione di file video in un nuovo montaggio audio

E possibile importare dei file video sotto forma di clip video in un nuovo montaggio audio.

PROCEDIMENTO

1.
2.

Selezionare File > Importa > Video.

Selezionare il file video che si desidera importare e fare clic suImporta.

RISULTATO

Il file video importato viene visualizzato sotto forma di clip nella traccia video. Le miniature
rappresentano i fotogrammi nella pellicola. Il file audio contenente I'audio per il video viene
posizionato in una nuova traccia del montaggio audio, sotto la traccia video.

365



Video
Traccia video

Modifica dell’'audio estratto dal video

E possibile modificare la traccia audio di una traccia video. Quando si importa un file video,
I'audio corrispondente viene estratto e posizionato in una nuova traccia del montaggio audio
sotto la traccia video.

Dopo aver modificato I'audio proveniente dal video, & possibile renderizzare il montaggio audio
per sostituire I'audio originale con l'audio modificato.

Per conoscere i formati audio incorporati supportati, fare riferimento al servizio di supporto

Steinberg sul sito web di Steinberg.

LINK CORRELATI
Sostituzione dell'audio nel video a pag. 366

Sostituzione dell’'audio nel video

E possibile sostituire la traccia audio di un video con un altro file audio o con una versione
modificata dell'audio originale. Puo essere sostituita l'intera traccia audio o parti di essa.

PREREQUISITI
E stato aggiunto al proprio montaggio audio il file video contenente I'audio da sostituire.

PROCEDIMENTO
1. Eseguire una delle sequenti operazioni:

e Sesidesidera sostituire 'audio del video con una versione modificata dell’audio
originale, modificare il file audio originale.

e Per sostituire I'audio originale del video con altro materiale audio, eliminare l'audio della
traccia audio originale e aggiungere il nuovo audio.

Una volta terminate le operazioni di modifica dell'audio, & possibile renderizzare il
montaggio audio per creare un video con il nuovo audio.

Selezionare la traccia video.
Selezionare la scheda Renderizza.

Nel menu Sorgente, selezionare Intervallo della clip video attiva.

v o LN

Nella sezione Uscita, specificare un Nome e una Posizione per il file video renderizzato.

NOTA

Il file video renderizzato mantiene il formato file del video originale. Il video non viene
renderizzato una seconda volta; cio significa che il processo non comporta alcuna perdita di
qualita.

6. Nella sezione Opzioni, fare clic su Opzioni ed eseguire una delle seguenti operazioni:

e Per creare una copia della clip video originale con l'audio modificato, attivare l'opzione
Crea un video con l'audio risultante.

e Per aprire il video renderizzato in un nuovo montaggio audio, attivare l'opzione
Reimporta il video in un nuovo montaggio audio.

e Per aprire il file audio renderizzato del file video nell’Editor audio, attivare 'opzione Apri
il file audio renderizzato.

7. Nella sezione Renderizza, fare clic su Avvia la renderizzazione.
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Modifica delle clip video

LINK CORRELATI
Inserimento di file video nei montaggi audio esistenti a pag. 365
Importazione di file video in un nuovo montaggio audio a pag. 365

Modifica delle clip video

Quando si importa un file video in un montaggio audio viene creata automaticamente una clip
video.

NOTA

Prima di iniziare a modificare e rifinire 'audio del proprio file video, &€ necessario aver terminato
le operazioni di modifica del video tramite un editor video dedicato.

Quando si lavora con le clip video, & possibile eseguire le seguenti operazioni di modifica:

Per copiare una clip video, fare clic sull'area superiore della clip video desiderata e trascinarla
nella nuova posizione scelta.

Per tagliare la fine di una clip video, fare clic sulla fine della clip desiderata ed eseguire un
trascinamento verso sinistra.

Per disabilitare tutte le modifiche per le clip video, fare clic su Blocca nell'area dei controlli
della traccia video.

Tell me more

e Per modificare la clip audio di una clip video, utilizzare gli strumenti di modifica dell'audio di
Wavelab Elements.
LINK CORRELATI

Traccia video a pag. 364

Area dei controlli delle tracce video a pag. 194

Inserimento di file video nei montaggi audio esistenti a pag. 365
Importazione di file video in un nuovo montaggio audio a pag. 365

Modalita 'il video segue le modifiche'

La Modalita 'il video segue le modifiche' consente di modificare I'audio, mantenendo un
riscontro visivo continuo nella finestra Video.

Per attivare la funzione Modalita 'il video segue le modifiche', selezionare la scheda
Modifica e attivare Modalita 'il video segue le modifiche' nella sezione Clip.

367



Video
Finestra Video

Se si attiva I'opzione Modalita 'il video segue le modifiche’, il video nella finestra Video segue
automaticamente ogni modifica apportata. Questo consente di vedere in maniera istantanea la
posizione nel video in cui € in corso 'operazione di modifica.

In Modalita 'il video segue le modifiche’, la finestra Video offre un riscontro visivo. Questo
significa che Iimmagine riflette la posizione del cursore di modifica. Si ottiene un riscontro visivo
durante le seguenti azioni:

e Selezione degliintervalli e regolazione dei bordi degli intervalli

e Spostamento delle clip audio

e Operazioni di spinta delle clip audio

e Ridimensionamento delle clip audio o degli intervalli di selezione

e Regolazione delle maniglie delle dissolvenze delle clip audio

LINK CORRELATI
Finestra Video a pag. 368
Scheda Modifica (Montaggio audio) a pag. 199

Finestra Video

Se si importa un video nel montaggio audio e si avvia la riproduzione, il video viene riprodotto
nella finestra Video. E possibile ridimensionare la finestra Video e disancorarla in modo da
posizionarla ad esempio su un altro schermo.

e Per aprire la finestra Video, selezionare Finestre degli strumenti di utility > Video.

NOTA

Per migliorare le prestazioni del sistema, disancorare la finestra Video e utilizzarla in una finestra
indipendente.

LINK CORRELATI
Traccia video a pag. 364
Attivazione/disattivazione del timecode della traccia video a pag. 369
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Attivazione/disattivazione del timecode della traccia video

Il timecode nella finestra Video rappresenta il tempo in ore, minuti, secondi e fotogrammi,
e consente di fornire una posizione per ogni periferica. Ciascun fotogramma rappresenta un
fotogramma nella pellicola o nel video.

PROCEDIMENTO
1. Selezionare File > Preferenze > Montaggi audio.
2. Fare clic su Tutti i montaggi audio.

3. Nella sezione Finestra Video, attivare/disattivare 'opzione Visualizza il timecode.

Compatibilita dei file video

Quando si lavora con dei file video in WavelLab Elements, € necessario accertarsi che il tipo di file
video utilizzato sia effettivamente supportato.

NOTA

Se non si & in grado di riprodurre uno specifico file video, utilizzare un‘applicazione esterna per
convertire il file in un formato compatibile.

Per conoscere i tipi di file video supportati, fare riferimento all'Help Center sul sito web di
Steinberg.

LINK CORRELATI

Formati di contenitore video a pag. 369

Codec video a pag. 370

Frequenze dei fotogrammi del video a pag. 370

Formati di contenitore video
I file video e altri tipi di file multimediali vengono forniti all'interno di un formato di contenitore.

Questo contenitore include una serie di informazioni relative al video e all'audio, oltre a dei
metadati come ad esempio le informazioni sulla sincronizzazione necessarie per riprodurre
insieme l'audio e il video. Nel formato di contenitore possono inoltre essere contenuti i dati
relativi alla data di creazione, agli autori, ai contrassegni dei capitoli, ecc.

I sequenti formati di contenitore sono supportati da WavelLab Elements:
MoV
Si tratta di un filmato QuickTime.

MPEG-4

Questo formato puo contenere diversi metadati per lo streaming, la modifica, la
riproduzione locale e l'interscambio di contenuti. L'estensione file &€ .mp4.

AVI
Un formato di contenitore multimediale introdotto da Microsoft.

LINK CORRELATI

Compatibilita dei file video a pag. 369
Codec video a pag. 370

369



Video
Frequenze dei fotogrammi del video

Codec video

I codec sono dei metodi per la compressione dati utilizzati per ridurre la dimensione dei file
video e audio, rendendoli cosi pil gestibili per i computer. Per maggiori dettagli, fare riferimento
all'Help Center sul sito web di Steinberg.

LINK CORRELATI
Compatibilita dei file video a pag. 369
Formati di contenitore video a pag. 369

Frequenze dei fotogrammi del video

Wavelab Elements supporta diversi valori di frequenza dei fotogrammi per i video e le pellicole.
La frequenza dei fotogrammi del video deve coincidere con la frequenza dei fotogrammi del
montaggio audio.

Wavelab Elements assume automaticamente la frequenza dei fotogrammi del video importato.
La frequenza dei fotogrammi puo essere regolata anche manualmente nella finestra di dialogo
Formato tempo.

¥ Time Format e

Frames p cond

(SMPTE Non-Drop)

X Cancel

Sono supportati i sequenti valori di frequenza dei fotogrammi:

Fotogrammi (frame) al secondo

Indipendentemente dal sistema di conteggio dei fotogrammi, la velocita effettiva a
cui i fotogrammi del video scorrono in tempo reale corrisponde alla frequenza dei
fotogrammi reale.

Wavelab Elements supporta i sequenti valori di frequenza dei fotogrammi:

23,98 fps
Questo valore di frequenza dei fotogrammi viene utilizzato per materiale su pellicola
trasferito su video NTSC e che deve essere rallentato per poter eseguire un
trasferimento telecinema di tipo 2-3 pulldown. Esso viene inoltre utilizzato per il tipo di
video HD denominato 24 p.

24 fps
Si tratta della reale velocita delle macchine a pellicola standard.
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24,98 fps
Questo valore di frequenza dei fotogrammi &€ comunemente utilizzato per facilitare i
trasferimenti tra video PAL e NTSC e i nastri originali su pellicola. Esso viene usato
principalmente per compensare alcuni errori.

25 fps
Si tratta della frequenza dei fotogrammi del video in formato PAL.
29,97 fps/29,97 dfps
Il valore di frequenza dei fotogrammi del video in formato NTSC. Il conteggio pud

essere sia non-drop che drop-frame.

30 fps/30 dfps

Questo valore di frequenza dei fotogrammi non costituisce piu uno standard video, ma
& stato a lungo utilizzato nelle registrazioni musicali. Parecchi anni fa rappresentava
inoltre lo standard di trasmissione in bianco e nero NTSC. Questo valore equivale

a portare un video NTSC alla velocita della pellicola (pull-up) in seguito a un
trasferimento telecinema 2-3. Il conteggio pud essere sia non-drop che drop-frame.

50 fps
Questo valore di frequenza dei fotogrammi viene chiamato anche 50 p.

59,94 fps
Questo valore di frequenza dei fotogrammi video € supportato dalle videocamere in
alta definizione ed & compatibile con il formato NTSC.

60 fps
Questo valore di frequenza dei fotogrammi video & supportato dalla maggior parte
delle videocamere in alta definizione. Il valore 59,94 fps, compatibile con il formato
NTSC, & comunque molto pit comune.

IMPORTANTE

I formati video con un valore di frequenza dei fotogrammi variabile (VFR) non sono supportati.

LINK CORRELATI
Finestra di dialogo Formato tempo a pag. 56
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WavelLab Exchange

E possibile utilizzare WaveLab Elements come editor esterno per Cubase Pro, Cubase Artist e
Nuendo e viceversa.

IMPORTANTE

Wavelab Exchange ¢ disponibile solamente per Cubase Pro 8.5.10 o superiore, Cubase Artist
8.5.10 o superiore e Nuendo 7.1.20 o superiore.

Wavelab Exchange supporta il formato file Wave.

WavelLab Elements come editor esterno per Cubase/Nuendo

E possibile aprire gli eventi di Cubase/Nuendo in WavelLab Elements. Questa funzione consente
di utilizzare le funzionalita di editing di WavelLab Elements e di applicarle agli eventi di Cubase/
Nuendo.

Ad esempio, in WavelLab Elements sono disponibili le sequenti opzioni di editing avanzate:

Correzione degli errori audio
Operazioni di editing e di processamento per i singoli canali

Indicatori di analisi, analisi globale (raccomandazioni EBU R-128) e analisi delle frequenze in
3D

RestoreRig
MasterRig

Modifica degli eventi audio di Cubase/Nuendo in WaveLab Elements

PREREQUISITI
Aprire il proprio progetto di Cubase/Nuendo in Cubase /Nuendo.

PROCEDIMENTO

1.

Nella Finestra progetto di Cubase/Nuendo, selezionare |'evento audio che si desidera
modificare in WaveLab Elements.

E anche possibile selezionare solamente una parte dell'evento audio utilizzando lo strumento
Selezione oggetto.

Selezionare Audio > Modifica in Wavelab.
In WavelLab Elements, modificare I'evento audio.

Una volta terminate le operazioni di editing, fare clic su Attiva un aggiornamento in
Cubase/Nuendo nella barra dei comandi.

Ce(Bn@nal€

Trigger Cubase/Muendo Update
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RISULTATO
Le modifiche all'evento audio vengono applicate al progetto di Cubase/Nuendo.

Cubase/Nuendo come editor esterno per WaveLab Elements

Quando si lavora su un file audio o su una clip in WaveLab Elements, & possibile aprire in
Cubase/Nuendo il relativo progetto. Questa funzione consente di correggere delle eventuali
problematiche che dovessero emergere nel corso del mixaggio e correggerle direttamente nel
file audio all'interno di Cubase/Nuendo.

Quando successivamente si va ad esportare il file audio in Cubase/Nuendo e si utilizza lo stesso
nome file, il file audio o la clip vengono automaticamente aggiornati in WavelLab Elements.

Preparazione di un progetto di Cubase/Nuendo per WaveLab
Exchange

PROCEDIMENTO

In Cubase/Nuendo, aprire il progetto che si desidera preparare per WavelLab Exchange.
Selezionare File > Esporta > Mixdown audio.

Nella finestra di dialogo Esporta mixdown audio, specificare un nome file e un percorso.
Nel menu a tendina Formato file, selezionare File Wave o File Wave 64.

Attivare l'opzione Inserisci informazioni iXML.

o v kA W N =

Fare clic su Esporta.

Modifica dei file audio in Cubase/Nuendo

PREREQUISITI
Il progetto di Cubase/Nuendo é stato preparato per WavelLab Exchange.

PROCEDIMENTO
1. InWavelab Elements, aprire il file audio nell’Editor audio.

Una linea gialla sopra la scheda file indica che il file & stato renderizzato in Cubase/Nuendo.
2. Selezionare la scheda Modifica.

3. Nella sezione Sorgente, fare clic su Modifica progetto.

Si apre il progetto di Cubase/Nuendo contenente i file audio.
4. In Cubase/Nuendo, apportare le modifiche desiderate al file audio.
5. Selezionare File > Esporta > Mixdown audio.

6. Nella finestra di dialogo Esporta mixdown audio, attivare 'opzione Inserisci informazioni
iXML.

IMPORTANTE

Non modificare il nome e il percorso del file.

7. Fareclic su Esporta.
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LINK CORRELATI
Preparazione di un progetto di Cubase/Nuendo per WavelLab Exchange a pag. 373
Indicatori di cambio scheda a pag. 62
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Conversione batch

E possibile convertire in un altro formato piu file audio contemporaneamente. Se non &
necessario alcun processamento, 'operazione puo essere eseqguita utilizzando la finestra di
dialogo Conversione batch.

LINK CORRELATI
Finestra di dialogo Conversione batch a pag. 375
Conversione dei file in modalita batch a pag. 376

Finestra di dialogo Conversione batch

Questa finestra di dialogo consente di convertire il formato di un gruppo di file audio.

e Per aprire la finestra di dialogo Conversione batch, selezionare File > Strumenti >
Conversione batch.

Batch Conversion n

Files to Convert

Progress

Output

Folder C:\Wavelab\Audio\|

File Format Wav 24 bit

Icona di aggiunta del file
=

Consente di aprire una finestra di dialogo in cui & possibile selezionare i file da
aggiungere all'elenco.

Rimuovi i file selezionati
||

Consente di rimuovere I'elemento selezionato dall'elenco.

File da convertire
Visualizza I'elenco dei file da convertire.

Scheda Uscita

Cartella
Consente di specificare la cartella in cui vengono salvati i file convertiti.

375




Conversione batch
Conversione dei file in modalita batch

Formato file

Consente di aprire la finestra di dialogo Formato file audio, nella quale & possibile
impostare il formato del file.

Scheda Opzioni

Avvio automatico al rilascio dei file
Se questa opzione € attivata, la conversione inizia automaticamente quando si trascina
un file nell'elenco.

Rimuovi automaticamente i file convertiti
Se questa opzione € attivata, un file viene rimosso dall'elenco dopo l'avvenuta corretta
conversione. In caso contrario, questo restera nell'elenco e sara caratterizzato da un
simbolo verde che ne indica lo stato.

Interrompi quando vi & un errore

Se questa opzione € attivata, il processo globale viene interrotto in caso di errore.
In caso contrario, il file associato all'errore viene contrassegnato in rosso e viene
processato il file successivo.

LINK CORRELATI
Conversione dei file in modalita batch a pag. 376

Conversione dei file in modalita batch

E possibile convertire piu file audio in un altro formato, in una singola operazione batch.

PROCEDIMENTO

1. Selezionare File > Strumenti > Conversione batch.

2. Fare clic sull'icona piu per aggiungere dei file o trascinare i file nell'elenco File da convertire.
3. Nella scheda Uscita, selezionare una posizione e un formato file.
4

Fare clic su Inizio per avviare la conversione dei file.

LINK CORRELATI
Finestra di dialogo Conversione batch a pag. 375
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Un podcast € una serie episodica costituita da dei file audio. Gli utenti possono ascoltare in
streaming o scaricare i podcast sui propri dispositivi. WaveLab Elements, grazie agli strumenti
di editing audio e agli effetti integrati consente di creare degli episodi di podcast e caricarli su
diversi servizi di hosting.

E possibile utilizzare I'Editor audio e la finestra del montaggio per creare un episodio di podcast.
Ciascun file audio o montaggio audio in WavelLab Elements pud essere caricato come episodio di
podcast.

LINK CORRELATI

Feed RSS a pag. 381

Servizi di hosting dei podcast a pag. 377
Caricamento di un episodio di podcast a pag. 378

Servizi di hosting dei podcast

I servizi di hosting dei podcast consentono di ospitare e distribuire i podcast. WaveLab Elements
permette di caricare direttamente i propri podcast in diversi servizi di hosting.

Servizi di hosting supportati

Wavelab Elements supporta il caricamento diretto sui seguenti servizi di hosting:

e Spreaker
e Podbean
e SoundCloud

e Buzzsprout

e (Castos
e Blubrry
e Captivate

Autorizzazioni dei servizi di hosting

Per collegare WaveLab Elements con un servizio di hosting, &€ necessario autorizzare il
collegamento tra Wavelab Elements e il servizio di hosting.

Il processo di autorizzazione varia a seconda del servizio di hosting selezionato.

LINK CORRELATI
Caricamento di un episodio di podcast a pag. 378

Codifica dei file prima del caricamento sui servizi di hosting

Se il file audio o il montaggio audio che si intende caricare su un servizio di hosting sono dei file
audio non codificati, &€ possibile codificarli. Alcuni servizi di hosting accettano esclusivamente file
audio codificati. I formati file audio codificati sono ad esempio MP3, MP4, M4A o MP2.
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Quando si renderizza un file audio o un montaggio audio vengono tenuti in considerazione i
plug-in e le impostazioni della Sezione Master.

A seconda del file audio o del montaggio audio selezionati, si applica quanto segue:

e Seiilfile audio che si intende caricare utilizza un formato codificato, 'opzione Codifica del
file audio viene disattivata. La codifica dei file audio gia codificati puo infatti portare a una
perdita di qualita.

e Seiifile audio attivi utilizzano un formato non codificato, 'opzione Codifica del file audio
é disponibile ma non obbligatoria. Tuttavia, a seconda del servizio di hosting utilizzato, pud
essere necessario codificare il file audio.

e I montaggi audio devono essere renderizzati prima di poterli caricare in un servizio di
hosting. Se il file attivo € un montaggio audio, & necessario utilizzare l'opzione Codifica del
file audio per renderizzare il montaggio audio.

Se il file audio o il montaggio audio attivi sono stati salvati, il file codificato viene salvato nella
stessa cartella, con lo stesso nome e I'estensione file appropriata.

Se il file audio o il montaggio audio attivi non sono stati salvati, si apre una finestra di dialogo che

consente di selezionare una cartella e un nome per il file renderizzato.

LINK CORRELATI
Caricamento di un episodio di podcast a pag. 378

Caricamento di un episodio di podcast

E possibile caricare sotto forma di episodio di podcast I'audio che & stato creato nell’Editor audio
o nella finestra Montaggio audio.

PREREQUISITI
E stato creato un file audio o un montaggio audio.

PROCEDIMENTO
1. Nell’Editor audio o nella finestra Montaggio audio, selezionare la scheda Modifica.

2. Nella sezione Podcast, fare clic su Carica l'episodio.
Si apre la scheda Pubblica.

3. Nella sezione Servizio host, selezionare il servizio di hosting su cui si intende caricare
l'episodio.

Host Service

4. Fare clic su Autorizza per consentire a WavelLab Elements di accedere al servizio di hosting
selezionato.

Il browser internet predefinito apre il sito web di autorizzazione del servizio di hosting
selezionato.

5. Segquire le istruzioni nel browser per completare il processo di autorizzazione.

378



Podcast
Scheda Pubblica

6. In Wavelab Elements, selezionare il Podcast al quale si intende aggiungere l'episodio di
podcast.

7. Specificare un Titolo per I'episodio di podcast.

8. Aseconda del servizio di hosting selezionato, potrebbe essere necessario codificare il file
audio o il montaggio audio. Se si desidera codificare il file audio, attivare I'opzione Codifica
del file audio e selezionare un nuovo encoder.

9. Fare clic su Upload.

RISULTATO

Il file audio o il montaggio audio vengono renderizzati e caricati sul servizio di hosting
selezionato.

Remaining time: 5.3 s

¥ Cancel

LINK CORRELATI
Scheda Pubblica a pag. 379
Codifica dei file prima del caricamento sui servizi di hosting a pag. 377

Scheda Pubblica

La scheda Pubblica consente di selezionare il servizio di hosting sul quale si intende caricare
il proprio episodio di podcast. E possibile selezionare diversi servizi di hosting e selezionare
I'encoder per il file audio da caricare.

e Per aprire la scheda Pubblica, selezionare la scheda File, quindi selezionare Podcast >
Pubblica.

Servizio host
Consente di selezionare il servizio di hosting sul quale si intende caricare il proprio
episodio di podcast.

Autorizza
Consente a Wavelab Elements di accedere al servizio di hosting selezionato.

Se si fa clic su Autorizza, il browser internet predefinito apre il sito web di
autorizzazione del servizio di hosting selezionato.

Episodio
e Codifica del file audio consente di codificare il file audio in un altro formato file
audio.
NOTA

Se é stato selezionato un file MP3 da caricare, l'opzione Codifica del file audio
viene disattivata. Tuttavia, se si aggiungono degli effetti al file MP3 tramite la
Sezione Master, I'opzione Codifica del file audio & disponibile.

e Podcast consente di selezionare il podcast al quale si intende aggiungere
I'episodio di podcast.
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e Aggiorna i podcast disponibili consente di aggiornare I'elenco dei podcast che
viene recuperato dal proprio account Spreaker.

e Titolo consente diinserire un titolo per I'episodio di podcast.

Upload
Consente di caricare il file audio sul servizio di hosting selezionato.

LINK CORRELATI
Podcast a pag. 377
Caricamento di un episodio di podcast a pag. 378
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Il podcasting € un metodo di distribuzione dei file multimediali su internet utilizzato ad esempio
per la riproduzione su dispositivi mobili e personal computer. I podcast vengono distribuiti
utilizzando lo standard RSS (Rich Site Summary).

RSS & uno standard per la distribuzione di notizie e altre informazioni tramite internet. Un feed
di notizie RSS invia brevi messaggi su un argomento specifico da uno specifico sito web. Per
leggere i messaggqi, I'utente deve utilizzare un programma in grado di monitorare feed multipli e
scaricare i nuovi messaggi su base regolare. Puo essere ad esempio utilizzato un lettore speciale
di feed su un browser internet.

LINK CORRELATI
Podcast a pag. 377

Editor dei feed RSS

R\ RSS FEEDEDITOR

W FILE

€ EDIT

R Podcast 1

L'Editor dei feed RSS € diviso in varie schede. Le sezioni Feed ed Episodi consentono di
visualizzare le informazioni per il feed o per un episodio, a seconda dell'elemento selezionato
nell'elenco sotto. Qui & possibile aggiungere file, collegamenti internet o informazioni di testo
al feed RSS e ai relativi episodi. La sezione Principale consente di visualizzare un elenco degli
elementi del feed di base e di tutti gli episodi inclusi nel feed RSS.

Internet Link (URL)

Description

Episodio
Nella sezione Episodio, & possibile creare, eliminare e spostare i singoli episodi di un feed RSS.

Nuovo
Consente di aggiungere un nuovo episodio senza titolo.
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Duplica
Consente di aggiungere un nuovo episodio copiando tutte le informazioni dall'episodio
esistente a quello nuovo.

Elimina
Consente di eliminare I'episodio selezionato. In alternativa, & possibile escludere un
episodio dal feed RSS disattivando I'opzione Abilitato.

Taglia/Copia/Incolla
Consentono di tagliare, copiare e incollare I'episodio selezionato.

Sposta verso l'alto/Sposta verso il basso

Consente di spostare I'episodio selezionato di una posizione verso l'alto o verso il basso
nell’elenco. In alternativa, utilizzare la funzione di trascinamento e rilascio.

FTP
Nella sezione FTP & possibile definire la posizione in cui il feed RSS sara caricato tramite FTP.

Aggiorna tutti gli elementi

Consente di caricare/aggiornare il file XML del feed RSS sul server FTP. Questa funzione
consente inoltre di caricare tutti i file multimediali associati, ma solo se questi non sono
ancora disponibili sul server FTP. Si tratta della funzione pilt comunemente utilizzata
per caricare e aggiornare il feed RSS.

Aggiorna I'elemento selezionato

Consente di caricare/aggiornare il file XML del feed RSS sul server FTP. Viene caricato
anche il file multimediale dell'elemento selezionato nell'elenco, ma solo se questo non
e ancora disponibile sul server FTP.

Carica/Sostituisci tutti gli elementi

Questo comando ¢ analogo a Aggiorna tutti gli elementi, ma carica/sostituisce
sempre tutti i file multimediali appartenenti all'elemento. Si rivela utile se, ad esempio, i
dati audio sono stati modificati.

Carica/Sostituisci gli elementi selezionati

Questo comando ¢ analogo a Aggiorna I'elemento selezionato, ma carica/sostituisce
sempre il file multimediale dell'elemento selezionato nell'elenco. Si rivela utile se, ad
esempio, i dati audio sono stati modificati.

Impostazioni FTP

Apre la finestra di dialogo Impostazioni FTP che consente di modificare le
impostazioni dell'FTP relative a questo feed RSS.

Feed RSS

Nella sezione Feed RSS € possibile verificare se la pubblicazione del feed RSS & stata completata
con successo e specificare delle opzioni globali per I'Editor dei feed RSS.

Visualizza il feed RSS pubblicato

Consente di aprire il proprio feed RSS (tramite 'URL specificato nelle impostazioni del
sito FTP) utilizzando il browser internet predefinito.

Visualizza il codice XML sorgente
Consente di aprire un editor XML per visualizzare il codice sorgente del feed RSS.
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Opzioni globali
Consente di modificare il ridimensionamento automatico delle immagini, di impostare
un fuso orario sulla base del Greenwich Mean Time e di specificare il percorso
dell'editor HTML.

Feed

Nella scheda Feed, & possibile specificare un titolo per il proprio feed RSS.

Episodi

Nella scheda Episodi & possibile specificare i titoli degli episodi.

Principale

Nella scheda Principale, & possibile assegnare dei parametri al proprio feed RSS. A seconda che
sia selezionato un feed o un episodio, i parametri disponibili cambiano. Le etichette di campo in
grassetto contrassegnano i campi obbligatori.

Titolo
Consente di impostare il titolo del feed, ad esempio 'argomento del proprio feed RSS.

Descrizione
Offre uno spazio in cui inserire un'ulteriore descrizione del contenuto del feed.

Importa file HTML (disponibile solo per gli episodi)
Consente di ricercare un documento HTML sostitutivo della descrizione.

Link internet (URL)
Il collegamento principale del feed visualizzato dall'utente. Utilizzare tale collegamento
per indirizzare gli utenti verso un sito web correlato al feed. Facendo clic sull'icona del
mondo, si apre I'URL specificato nel browser Internet predefinito.

File audio (disponibile solo per gli episodi)
Consente di impostare il percorso del file audio che si desidera aggiungere all'episodio.
Il file audio pud essere di qualsiasi formato supportato dal lettore multimediale del
browser. Un file .MP3 garantisce la massima compatibilita. Fare clic sull'icona per
elencare i file audio gia aperti in WavelLab Elements. Selezionarne uno per I'episodio.
In alternativa, € possibile trascinare I'icona di elenco di un file audio nel pannello
dei file audio. Fare clic sull'icona di riproduzione per aprire il file specificato nel
lettore o nel visualizzatore multimediale predefinito del proprio sistema per riprodurre
un‘anteprima o a scopo di verifica.

Immagine (disponibile solo per i feed)
In base agli standard RSS, questa immagine non deve essere piu grande di 144 x 400
pixel, in modo che possa essere automaticamente ridimensionata. Se si fa clic sullicona
dellimmagine, 'immagine specificata si apre nel visualizzatore di immagini predefinito
del proprio sistema.

@

Icona dellimmagine

Data e ora di pubblicazione

Consente di impostare la data e I'ora di pubblicazione del feed o dell'episodio. Facendo
clic su Adesso, vengono trasferite data e ora correnti del proprio sistema.
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Come l'episodio piu recente (disponibile solo per i feed)

Se questa opzione € attivata, la data e I'ora dell'episodio piu recente vengono
assegnate automaticamente.

Info

Nella scheda Info, & possibile assegnare dei parametri al proprio feed RSS. A seconda che sia
selezionato un feed o un episodio, i parametri disponibili cambiano.

Per un feed sono disponibili i sequenti parametri:

e Webmaster (indirizzo e-mail)

e Editor (indirizzo e-mail)

e Copyright

e (Categoria

e Dominio relativo (URL)

e Lingua

e Frequenza di aggiornamento

e Salta ore (da 0 a 23, separate da una virgola)

e Tempo divita (humero di minuti)
Per un episodio sono disponibili i sequenti parametri:

e Autore (indirizzo e-mail)
e Commenti (URL)

e (Categoria

e Dominio relativo (URL)
e Titolo

e Dominio originale (URL)

iTunes

Nella scheda iTunes & possibile attivare I'estensione iTunes, che consente di specificare
informazioni aggiuntive sul feed e sull'episodio. A seconda che sia selezionato un feed o un
episodio, i parametri disponibili sono diversi.

Per un feed sono disponibili i sequenti parametri:

e Sottotitolo

e Indice

e Categorie

e Parole chiave (separate da una virgola)
e Autore

e Nome del proprietario

e E-mail del proprietario

e Immagine

e Nuovo URL del feed

e NascondiiniTunes

e Contenuti espliciti
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Per un episodio sono disponibili i sequenti parametri:

e Sottotitolo

e Indice

e Parole chiave (separate da una virgola)
e Autore

e Durata

e NascondiiniTunes

e Contenuti espliciti

LINK CORRELATI
Opzioni globali dei feed RSS a pag. 385

Opzioni globali dei feed RSS

Alcune opzioni supplementari sono valide per tutte le schede dell'Editor dei feed RSS.

e Per aprire la finestra di dialogo Opzioni globali dei feed RSS, aprire I'Editor dei feed RSS,
selezionare la scheda Modifica e fare clic su Opzioni globali.

Ridimensionamento immagini automatico (non per iTunes)

Definisce cosa fare se le immagini specificate superano la dimensione massima
consentita dallo standard RSS. Se le immagini necessitano di ridimensionamento, le
immagini originali sull'hard disk non verranno modificate.

Compensazione oraria con GMT (Greenwich Mean Time)
Le date e gli orari visualizzati sono locali. Se il proprio sistema & stato configurato
correttamente, WavelLab Elements modifichera automaticamente la compensazione
del tempo in relazione al GMT. Tuttavia, se si desidera che l'ora e la data siano relativi a
una zona oraria differente, & possibile regolare il relativo valore con questa opzione.
Editor HTML

Consente di impostare il percorso per I'editor HTML esterno che viene lanciato quando
si fa clic sul pulsante penna nella sezione Importa file HTML. L'opzione Importa file
HTML é disponibile solamente per gli episodi.

LINK CORRELATI
Editor dei feed RSS a pag. 381

Creazione di un feed RSS

I nuovi feed RSS o episodi possono essere creati in vari modi.

e Per creare un nuovo feed RSS, selezionare File > Nuovo e fare clic su Crea feed RSS.

e Per aggiungere un nuovo episodio senza titolo a un feed RSS, nell’Editor dei feed RSS
selezionare la scheda Modifica e fare clic su Nuovo.

e Per aggiungere un file audio all'episodio selezionato, selezionare la scheda Principale, fare
clic sul campo File audio e selezionare l'opzione Seleziona il file utilizzando il selettore
standard. Selezionare quindi il file audio desiderato in Esplora file/macOS Finder e fare clic
su Apri.

E possibile anche trascinare un file audio dalla finestra Browser dei file al campo File audio.
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e Per duplicare I'episodio selezionato, selezionare la scheda Modifica e fare clic su Duplica.
Questo aggiunge un nuovo episodio e copia tutte le informazioni dall'episodio esistente su
quello nuovo.

Configurazione di un FTP per la pubblicazione di un feed RSS

Per poter caricare un feed RSS sul proprio server FTP, € necessario inserire prima i dettagli del
server.

PROCEDIMENTO

1. Nell'Editor dei feed RSS, selezionare la scheda Modifica.

2. Nella sezione FTP, fare clic su Impostazioni FTP.

3. Nella finestra di dialogo Impostazioni FTP, inserire i sequenti dettagli:
e Idettagli di accesso per il server FTP.
e Il percorso relativo e il nome file del feed (estensione . xml).
e Ll'indirizzo del proprio sito Web, incluso il percorso per il feed.

4. Fare clicsu OK.

LINK CORRELATI
Editor dei feed RSS a pag. 381
Finestra di dialogo Impostazioni FTP a pag. 386

Finestra di dialogo Impostazioni FTP

Nella finestra di dialogo Impostazioni FTP & possibile gestire tutte le informazioni necessarie per
il processo di caricamento del feed RSS.

e Per aprire la finestra di dialogo Impostazioni FTP, aprire I'Editor dei feed RSS, selezionare la
scheda Modifica e fare clic su Impostazioni FTP.

D FIP Settings *

Host

User Name

X Cancel

Host
Il nome dell’host o l'indirizzo IP del server FTP.

Nome utente
Il nome di accesso per il proprio server FTP.

Password
La password di accesso.

Usa la modalita passiva

Lasciare questa opzione attivata e modificarla solamente se si dovessero riscontrare
dei problemi con la connessione FTP.
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Nome del file di Feed (con percorso)

Il nome del file RSS visualizzato sul proprio server FTP (estensione .xml), incluso

il relativo percorso d'accesso. Il nome del file e il percorso d'accesso sono parte
dell'indirizzo internet pubblico finale del feed RSS, percio si consiglia di evitare nomi
eccessivamente lunghi.

Sito web associato (URL)
L'indirizzo del proprio sito Web, incluso il percorso del feed.

Esempio di impostazioni FTP

I FTP Settings X

Host ftp.MyPage.com|

User Mame ftp-account-login-name

Password sesssssess

Feed File Mame (with Path)
iated V [URL) mypage.com/podcasts

V' 0K X Cancel

e l'indirizzo dell'host FTP & «ftp.MyPage.com», l'indirizzo del sito web pubblico &
«www.MyPage.com».

e Limpostazione del nome del file del feed e «podcasts/fantastic-cast.xml», 'impostazione del
sito Web associato & «www.MyPage.com/podcasts».

e Ifile multimediali del feed RSS saranno caricati sul server FTP all'indirizzo «ftp.MyPage.com/
podcasts».

e Il file del feed RSS stesso e I'indirizzo internet da distribuire saranno reperibili allindirizzo
«www.MyPage.com/podcasts/fantastic-cast.xml».

Ciascun feed RSS salva le informazioni complete relative al proprio sito FTP. E anche possibile
salvare e richiamare dei preset di siti FTP utilizzando le funzioni Preset nella parte inferiore della
finestra di dialogo.

Pubblicazione dei feed RSS

E possibile caricare un feed RSS direttamente da WaveLab Elements al proprio server FTP.

PREREQUISITI
Definire le impostazioni FTP all'interno di WaveLab Elements.

PROCEDIMENTO
1. Nell'Editor dei feed RSS, selezionare la scheda Modifica.
2. Nella sezione FTP, selezionare una delle seguenti opzioni:
e Aggiorna tutti gli elementi
e Aggiorna l'elemento selezionato
e Carica/Sostituisci tutti gli elementi sull'FTP
e Carica/Sostituisci gli elementi selezionati

3. Nella finestra di dialogo Impostazioni FTP, verificare se le impostazioni FTP sono corrette e
fare clic su OK.
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Verifica del completamento della pubblicazione dei feed RSS

RISULTATO
Il feed RSS viene caricato sul proprio sito FTP.

LINK CORRELATI
Editor dei feed RSS a pag. 381
Configurazione di un FTP per la pubblicazione di un feed RSS a pag. 386

Verifica del completamento della pubblicazione dei feed RSS

Dopo aver creato e pubblicato un feed RSS, e possibile verificare se 'upload é stato eseguito
correttamente.

e Pervisualizzare i contenuti del file XML del feed nel proprio editor XML predefinito, aprire
I'Editor dei feed RSS, selezionare la scheda Modifica e fare clic su Visualizza il codice XML
sorgente.

e Per aprire il proprio browser internet predefinito e ricevere il feed RSS appena pubblicato da
internet, aprire I'Editor dei feed RSS, selezionare la scheda Modifica e fare clic su Visualizza
il feed RSS pubblicato.

LINK CORRELATI
Editor dei feed RSS a pag. 381
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Personalizzare significa configurare le impostazioni in modo da gestire il comportamento e
I'aspetto del programma secondo le proprie preferenze.

LINK CORRELATI

Personalizzazione della finestra della forma d'onda e della finestra di montaggio a pag. 389
Personalizzazione delle scorciatoie a pag. 391

Personalizzazione delle barre dei comandi a pag. 395

Organizzazione dei plug-in a pag. 396

Touch Bar (solo macOS) a pag. 404

Personalizzazione della finestra della forma d’onda e della
finestra di montaggio

E possibile configurare la finestra della forma d'onda/di montaggio, definendo i colori di forme
d’'onda, sfondo, linee del cursore, ecc., nonché modificando I'aspetto del righello e altri dettagli
della finestra.

La personalizzazione pud essere eseguita nei seqguenti modi:

e Modificando lo stile predefinito.

e Assegnando diversi stili, in base a condizioni specifiche. Ad esempio, un tipo specifico di file o
uno specifico nome file.

LINK CORRELATI
Assegnazione di colori personalizzati alla finestra della forma d’onda o di montaggio a pag. 389
Assegnazione di colori personalizzati in base alle condizioni a pag. 390

Assegnazione di colori personalizzati alla finestra della forma d’onda
o di montaggio

PROCEDIMENTO

1. Aseconda che si desideri personalizzare i colori della finestra della forma d'onda o della
finestra del montaggio, eseguire una delle seguenti azioni:

e Per lafinestra della forma d'onda, selezionare File > Preferenze > File audio e
selezionare la scheda Stile.

e Perlafinestra di montaggio, selezionare File > Preferenze > Montaggi audio e
selezionare la scheda Stile.

2. Selezionare la parte che si desidera colorare dall'elenco Parti.

3. Specificare un colore mediante il selettore dei colori o i campi RGB.

LINK CORRELATI

Personalizzazione della finestra della forma d'onda e della finestra di montaggio a pag. 389
Scheda Stile (Preferenze dei file audio) a pag. 413

Scheda Stile (Preferenze dei montaggi audio) a pag. 416
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Copia delle impostazioni dei colori a pag. 390

Assegnazione di colori personalizzati in base alle condizioni

E possibile applicare automaticamente diversi schemi di colore a clip differenti, in base ai relativi
nomi o alle proprieta dei rispettivi file audio.

IMPORTANTE

Se si ridefiniscono i colori, prestare attenzione a non scegliere colori che potrebbero provocare la
sparizione di altri elementi.

PROCEDIMENTO

1. Aseconda che si desideri personalizzare i colori della finestra della forma d'onda o della
finestra di montaggio, eseguire una delle seguenti azioni:

e Per lafinestra della forma d'onda, selezionare File > Preferenze > File audio e
selezionare la scheda Stile.

e Per lafinestra di montaggio, selezionare File > Preferenze > Montaggi audio e
selezionare la scheda Stile.

2. Esequire una delle seguenti operazioni:

e Nelle Preferenze dei file audio, selezionare una delle opzioni Condizionale dal menu a
tendina nella parte superiore della finestra di dialogo.

e Nelle Preferenze dei montaggi audio, nell'elenco Parti, selezionare una delle voci
Personalizzate.

3. Specificare un colore mediante il selettore dei colori o i campi RGB.

4. Nella sezione Questo stile viene usato se si applicano queste condizioni, specificare le
condizioni.

5. Fare clic su OK.

LINK CORRELATI

Personalizzazione della finestra della forma d'onda e della finestra di montaggio a pag. 389
Scheda Stile (Preferenze dei file audio) a pag. 413

Scheda Stile (Preferenze dei montaggi audio) a pag. 416

Copia delle impostazioni dei colori a pag. 390

Copia delle impostazioni dei colori

Quando si regolano le impostazioni dei colori per la finestra della forma d'onda o per la finestra
del montaggio, e possibile copiare le impostazioni dei colori di una parte, o di tutte le parti di uno
schema di colori personalizzato.

PREREQUISITI

E possibile assegnare dei colori personalizzati alla finestra della forma d'onda e alla finestra del
montaggio nella scheda Stile delle Preferenze dei file audio e delle Preferenze dei montaggi
audio.

OPZIONI

e Per copiare unimpostazione del colore, scegliere la parte da cui si desidera copiare il colore
e selezionare Copia colore. Scegliere quindi la parte in cui copiare il colore e selezionare
Incolla.
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e Per copiare tutte le impostazioni di colore personalizzate, trascinare il nome di
un'impostazione di colore personalizzata in un altro nome di colore personalizzato e fare
clic su OK.

LINK CORRELATI

Personalizzazione della finestra della forma d'onda e della finestra di montaggio a pag. 389
Scheda Stile (Preferenze dei file audio) a pag. 413

Scheda Stile (Preferenze dei montaggi audio) a pag. 416

Personalizzazione delle scorciatoie

In WavelLab Elements ¢ possibile controllare molte funzioni tramite le scorciatoie per velocizzare
il flusso di lavoro. E possibile modificare le scorciatoie esistenti e crearne di nuove.

La maggior parte delle scorciatoie sono limitate a uno specifico editor, il che significa che &
possibile riutilizzare la stessa combinazione di scorciatoie in editor diversi. L'unica eccezione
e rappresentata dalla Sezione Master, in cui tutte le scorciatoie sono valide per l'intera
applicazione.

Le scorciatoie nelle sezioni Navigazione (tastierino numerico) e Comandi di vista e
navigazione della scheda Scorciatoie sono dedicate alla navigazione in WavelLab Elements.

Le scorciatoie che non possono essere modificate sono evidenziate in grigio. Le scorciatoie
create dall'utente sono visualizzate in blu nell’'editor.

E possibile creare una nuova scorciatoia specificando una sequenza di tasti composta da uno fino

a quattro tasti, da premere in un ordine specifico per eseguire 'operazione desiderata.

LINK CORRELATI
Scheda Scorciatoie (Preferenze) a pag. 391

Scheda Scorciatoie (Preferenze)

Questa scheda consente di personalizzare le scorciatoie per WaveLab Elements. Viene qui
mostrato un elenco delle scorciatoie assegnate per i comandi e per le opzioni dei menu di
Wavelab Elements.

e Per aprire la scheda Scorciatoie, selezionare File > Preferenze > Scorciatoie.
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Search Name

Key Sequence

E then B
FthenF

F then Home

|% Reset ~ D Summary ¥

Menu a tendina di ricerca
Consente di selezionare la parte dell'elenco dei comandi in cui viene eseguita la ricerca.

Campo di ricerca
Consente di cercare un comando.

Utilizza i metacaratteri
Se questa opzione € attivata, & possibile utilizzare i metacaratteri «*» e «?».
«*» sostituisce zero o piu caratteri, mentre «?» sostituisce un singolo carattere.
Ad esempio, se € selezionata I'opzione Ricerca per scorciatoia da tastiera, digitare
«*» per visualizzare tutti i comandi che sono gia associati a una scorciatoia.
Espandi/Riduci
Consente di espandere o ridurre la struttura ad albero.

Elenco dei comandi
Consente di visualizzare tutti i comandi e le relative scorciatoie. La sezione sotto
I'elenco dei comandi mostra una serie di informazioni supplementari per il comando
selezionato.

Reinizializza
Consente di riportare i comandi alle impostazioni predefinite.

Indice
Consente di aprire un menu in cui & possibile generare un elenco di tutti i comandi e
delle relative scorciatoie in formato HTML o come stampata.

Modifica le scorciatoie

Consente di aprire la finestra di dialogo Definizione delle scorciatoie in cui & possibile
modificare la scorciatoia per il comando selezionato.
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LINK CORRELATI
Personalizzazione delle scorciatoie a pag. 391
Modifica delle scorciatoie a pag. 393

Modifica delle scorciatoie

E possibile visualizzare I'elenco di tutte le scorciatoie nella finestra di dialogo Scorciatoie, quindi
modificare e definire le scorciatoie nella finestra di dialogo Definizione delle scorciatoie.

La scheda Scorciatoie fornisce un set di comandi diverso per ciascun menu o finestra di dialogo.

e Per aprire la finestra di dialogo Definizione delle scorciatoie, selezionare File >
Preferenze > Scorciatoie, selezionare un comando e fare clic su Modifica le scorciatoie.
Si apre in tal modo la finestra di dialogo Definizione delle scorciatoie.

e E possibile definire una scorciatoia da tastiera per comando. Ogni scorciatoia pud essere
composta da una sequenza di massimo quattro pressioni di tasti.

e Per riportare alcuni o tutti i tipi di scorciatoie alle impostazioni di fabbrica, utilizzare il
pulsante Reinizializza.

LINK CORRELATI
Scheda Scorciatoie (Preferenze) a pag. 391
Finestra di dialogo Definizione delle scorciatoie a pag. 393

Finestra di dialogo Definizione delle scorciatoie

Questa finestra di dialogo consente di definire delle scorciatoie personalizzate per una
particolare funzione.

e Per aprire la finestra di dialogo Definizione delle scorciatoie, selezionare File >
Preferenze > Scorciatoie, selezionare un comando e fare clic su Modifica le scorciatoie.

v Shortcut Definitions (Activate Fade Tab) s

Key Sequence

W OK X Cancel

Sequenza di tasti

1° tasto premuto
Consente di selezionare il primo tasto di una sequenza che comprende fino a quattro
tasti. Impostare il focus sul campo del tasto premuto, quindi premere la combinazione
di tasti desiderata. Se non viene visualizzato nulla, un tasto non € consentito in questo
contesto.

2°/3°/4° tasto premuto (opzionale)

Consente di selezionare dei tasti aggiuntivi che devono essere utilizzati per eseguire
il comando. Il comando verra eseguito solo se questi eventi tasto si attivano dopo il
primo/secondo/terzo.
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Cancella
Consente di eliminare tutti i campi degli evento tasto.

LINK CORRELATI
Modifica delle scorciatoie a pag. 393
Scheda Scorciatoie (Preferenze) a pag. 391

Definizione delle sequenze di tasti

E possibile definire delle sequenze di tasti per una tastiera.
Sui computer Mac, i comandi per i menu principali devono essere costituiti da un singolo tasto.

Quando si utilizzano piu comandi di pressione di un tasto, assicurarsi che i comandi da tastiera
non interferiscano gli uni con gli altri. Ad esempio, quando si ha una scorciatoia con Shift-L, M
e se ne definisce un‘altra con Shift-L, questa seconda scorciatoia non ha alcun effetto.

PROCEDIMENTO
1. Selezionare File > Preferenze > Scorciatoie.

2. Nell'elenco dei comandi, selezionare il comando per il quale si desidera definire una
sequenza di tasti e fare clic su Modifica le scorciatoie o fare doppio-clic sulla colonna
Sequenza di tasti del comando corrispondente.

3. Nella finestra di dialogo Definizione delle scorciatoie, fare clic nei campi Tasto premuto e
premere i pulsanti che si desidera utilizzare come sequenza di tasti.

4. Fare clicsu OK.

RISULTATO

Quando vengono quindi premuti i tasti/pulsanti specificati nella finestra di dialogo, viene
eseguita l'operazione corrispondente. Le pressioni di tasti devono essere eseguite una dopo
l'altra.

LINK CORRELATI

Scheda Dispositivi di controllo remoto a pag. 22

Scheda Scorciatoie (Preferenze) a pag. 391

Finestra di dialogo Definizione delle scorciatoie a pag. 393

Comandi da tastiera indicizzati

I comandi da tastiera indicizzati consentono di saltare a specifiche posizioni all'interno del
proprio progetto, ad esempio a un marker specifico o a uno slot della Sezione Master.

I comandi da tastiera indicizzati disponibili sono elencati nella scheda Scorciatoie, della sezione
Navigazione (tastierino numerico).
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ch Name

ommand Name Key Sequence

e Per attivare un comando da tastiera indicizzato, digitare il numero dell'elemento al quale si
desidera saltare e premere il tasto corrispondente sulla tastiera.

ESEMPIO

Per saltare al quinto marker nella finestra di ricerca file, premere 5 sul tastierino numerico della
tastiera, quindi premere M.

Per saltare alla decima scheda file, premere 1 poi 0 sul tastierino numerico della tastiera, quindi
premere F.

LINK CORRELATI
Scheda Scorciatoie (Preferenze) a pag. 391

Creazione di un elenco di tutte le scorciatoie

E possibile generare un file HTML o stampare un elenco contenente tutte le scorciatoie.

PROCEDIMENTO
1. Selezionare File > Preferenze > Scorciatoie.
2. Fareclic suIndice e selezionare una delle seguenti opzioni:

e Per aprire la finestra di dialogo Anteprima di stampa, dalla quale stampare l'elenco di
tutte le scorciatoie, selezionare Anteprima di stampa. Perché I'opzione Anteprima di
stampa sia disponibile, € necessario che sia collegata una stampante.

e Per aprire I'elenco di tutte le scorciatoie in formato file HTML nel browser standard,
selezionare Rapporto HTML.

LINK CORRELATI
Scheda Scorciatoie (Preferenze) a pag. 391

Personalizzazione delle barre dei comandi

E possibile nascondere o visualizzare i singoli pulsanti delle barre dei comandi. In questo modo la
personalizzazione delle barre dei comandi viene eseguita rimuovendo i comandi non desiderati.

PROCEDIMENTO
1. Inuna finestra degli strumenti utility, aprire il menu e selezionare Personalizza la barra dei
comandi.

2. Per mostrare un comando specifico nella barra dei comandi, attivare la casella di controllo
nella colonna Barra per il comando corrispondente.
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3. Fareclicsu OK.

Organizzazione dei plug-in

Wavelab Elements & fornito con numerosi plug-in ed & possibile aggiungerne altri. Per ottenere
una panoramica dei plug-in che sono rilevanti per il proprio progetto, € possibile organizzare i

plug-in in gruppi.
Nella scheda Organizza della finestra di dialogo Preferenze dei plug-in, € possibile specificare

la modalita di visualizzazione dei plug-in nei menu del programma. Nell'elenco dei plug-in, sono
disponibili delle sotto cartelle che rappresentano i gruppi di plug-in.

Inizialmente, i plug-in sono organizzati per fornitore, categoria, plug-in preferiti e plug-in
utilizzati di recente.

Se le versioni a 32 bit e a 64 bit di WavelLab Elements sono utilizzate sullo stesso sistema,
le relative impostazioni vengono condivise. Un'eccezione a questa regola & riscontrabile nelle
seguenti opzioni delle Preferenze dei plug-in:

e Cartelle dei plug-in VST aggiuntive
e Ignorai plug-in che si trovano nelle seguenti sotto-cartelle

Questo perché i plug-in a 32 bit non possono essere utilizzati in WavelLab Elements a 64 bit e
viceversa.

LINK CORRELATI

Scheda Plug-in (Preferenze) a pag. 399
Aggiunta di ulteriori plug-in VST a pag. 398
Esclusione di plug-in a pag. 398

Esclusione dei plug-in da determinati menu di plug-in

E possibile escludere i plug-in dalla visualizzazione nei menu dei plug-in in determinate aree di
Wavelab Elements.

PROCEDIMENTO

1. Selezionare File > Preferenze > Plug-in.

2. Selezionare la scheda Organizza.

3. Nell'elenco dei plug-in, individuare il plug-in che si desidera escludere.
4

Disattivare la casella di controllo per il plug-in. Quando si selezionano piu plug-in, & possibile
disattivarli tutti con un solo clic.

e Per escludere il plug-in dai menu di selezione dei plug-in, disattivare la casella di
controllo nella colonna Effetto.

e Per escludere il plug-in dal pannello Effetto di finalizzazione/Dithering della Sezione
Master, disattivare la casella di controllo nella colonna Fin/Dith.

LINK CORRELATI
Scheda Plug-in (Preferenze) a pag. 399
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Aggiunta di plug-in al menu dei preferiti

E possibile aggiungere plug-in in uso regolarmente al menu Preferiti del menu di selezione dei
plug-in.

PROCEDIMENTO

1. Selezionare File > Preferenze > Plug-in.

2. Selezionare la scheda Organizza.

3. Nell'elenco dei plug-in, individuare il plug-in che si desidera aggiungere ai preferiti.
4

Attivare la casella di controllo per il plug-in corrispondente nella colonna Preferiti l.
NOTA

Se il menu Preferiti € vuoto, non viene visualizzato nei menu di selezione dei plug-in.

LINK CORRELATI
Scheda Plug-in (Preferenze) a pag. 399

Personalizzazione dei gruppi di plug-in

E possibile personalizzare I'aspetto e I'ordine dei plug-in nella scheda Organizza delle Preferenze
dei plug-in.

e Per aggiornare l'albero di visualizzazione, fare clic su Visualizza le modifiche.

Customize

4= Show Changes

Sort by Vendor, Then Category ¥

e Le etichette delle categorie che sono utilizzate per creare la gerarchia vengono fornite
dai produttori dei plug-in. Per modificare il nome della categoria, raggiungere la tabella
Rinomina Categoria, fare clic sulla colonna Originale e selezionare la categoria che si
desidera rinominare. Fare quindi clic sulla colonna Modificato e immettere un nuovo nome.

e Per modificare l'ordine dei gruppi di plug-in, selezionare se eseguire I'ordinamento per
categoria o per fornitore nel menu di ordinamento della sezione Personalizza. Se un plug-in
non contiene il nome del fornitore o una categoria, viene utilizzato come nome del fornitore
o categoria il nome della cartella sul disco in cui si trova il plug-in, a condizione che non si
tratti della cartella radice dei plug-in VST.

e Per raggruppare tuttii plug-in che iniziano con lo stesso prefisso in un sotto menu, attivare
Crea dei sotto menu sulla base dei prefissi e specificare il numero di plug-in che devono
iniziare con lo stesso prefisso. Se viene raggiunto questo numero viene creato un sotto
menu.

e Perraggruppare i plug-in in un unico sotto menu anche se il numero & inferiore a un valore
specificato, attivare Comprimi la gerarchia e specificare il valore soglia. Una struttura viene
appiattita a un singolo sotto menu se il numero ¢ inferiore alla soglia. Questo impedisce di
avere dei sotto menu di piccole dimensioni.

e Per attivare la categoria Utilizzati di recente, attivare 'opzione Sotto-menu con i plug-in
utilizzati di recente e specificare il numero massimo di plug-in utilizzati di recente da
visualizzare in questa categoria.

e Epossibile rendere la categoria Utilizzati di recente globale per tutte le posizioni o
indipendente per ciascun contesto, ad esempio per la Sezione Master, per una traccia di un
montaggio audio, o per una clip di un montaggio audio. Per rendere la categoria Utilizzati
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di recente indipendente per ciascun contesto, attivare 'opzione Menu indipendenti dei
plug-in utilizzati di recente.

LINK CORRELATI
Scheda Plug-in (Preferenze) a pag. 399

Aggiunta di ulteriori plug-in VST

E possibile specificare delle cartelle in cui possono trovarsi plug-in VST aggiuntivi. Questo &
utile se sono in uso dei plug-in VST di terze parti che non si desidera salvare nella cartella VST
standard.

PROCEDIMENTO
1. Selezionare File > Preferenze > Plug-in.
2. Selezionare la scheda Generale.

3. Nella sezione Cartelle dei plug-in VST aggiuntive (Specifico per WaveLab Elements), fare
clic sull'icona della cartella e individuare la cartella che contiene i plug-in VST che si desidera
aggiungere.

LINK CORRELATI
Scheda Plug-in (Preferenze) a pag. 399

Esclusione di plug-in

E possibile specificare un elenco di plug-in che non saranno aperti da Wavelab Elements.

PROCEDIMENTO
1. Selezionare File > Preferenze > Plug-in.
2. Selezionare la scheda Generale.

3. Nellasezione Non caricare i seguenti plug-in, digitare il nome del plug-in che non si
desidera aprire:

e Inserire il nome esatto del file, senza percorso ed estensione del file.
e Inserire un nome per riga.

e Sesiinserisce il carattere «*» prima del nome, qualsiasi plug-in contenente tale nome
viene ignorato.

LINK CORRELATI
Scheda Plug-in (Preferenze) a pag. 399

Sostituzione di plug-in mancanti

Quando si apre un montaggio audio e alcuni plug-in per tracce o clip risultano mancanti, &
possibile selezionare altri plug-in per sostituire quelli non trovati.

PROCEDIMENTO

1. Nella finestra di dialogo Plug-in mancanti, fare clic su Sostituto e selezionare un sostituto
per il plug-in visualizzato nella colonna Originale.
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I Missing Plug-ins in C:\Wavelab\Audio\Track 1.mon *

Missing Plug-ins

Click in the right co

eplacements as Default
p

v OK X Abort

2. Sesidesidera utilizzare da qui in avanti il nuovo plug-in, attivare I'opzione Salva i sostituti
come predefiniti.

3. Fare clic su OK.

Scheda Plug-in (Preferenze)
In questa scheda, € possibile accedere a una serie di opzioni per la gestione dei plug-in VST.

E possibile specificare dove Wavelab Elements deve cercare i plug-in VST e quali di questi devono
essere ignorati. Si puo inoltre decidere in che modo i potenziometri dei plug-in VST rispondono
alle azioni del mouse e con quale frequenza viene aggiornata la visualizzazione grafica.

Se si utilizza la propria struttura dei file personalizzata per organizzare e salvare i plug-in VST,
questa finestra di dialogo consente di avere il pieno controllo su quali plug-in vengono caricati
e su quali vengono invece ignorati. Questa funzionalita ¢ utile se si desidera disattivare un
particolare plug-in o per ignorare i plug-in che non si intende utilizzare con WavelLab Elements.

e Per aprire le Preferenze dei plug-in, selezionare File > Preferenze > Plug-in.
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Scheda Generale

¥ Force Plug-in Detection at Next Launch
Fast
VST Plug-in K|

Circular h

Circular h

© Linear

Cerca le cartelle condivise standard dei plug-in VST

Se questa opzione € attivata, WavelLab Elements cerca i plug-in VST nelle cartelle dei
plug-in VST predefinite.

Informazioni relative alle cartelle cercate
Fare clic sull'icona info @ per vedere in quali cartelle WaveLab Elements ha effettuato
la ricerca dei plug-in quando é stato avviato il programma.

T Plug-in Folders

»B

b Elem

o oo

Se non & possibile trovare un particolare plug-in in WavelLab Elements, questa funzione
consente ad esempio di determinare se & stata specificata la cartella corretta.

B Wavelab Elements 11 X

Cartelle dei plug-in VST aggiuntive (specifico per WaveLab Elements)
Consente di specificare cartelle aggiuntive in cui & possibile trovare i plug-in VST.
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Ignora i plug-in che si trovano nelle seguenti sotto-cartelle (separare i nomi delle
cartelle con un punto e virgola)

Consente di specificare i nomi delle cartelle che WavelLab Elements deve ignorare
durante la ricerca di plug-in VST.

Non caricare i seguenti plug-in
Consente di specificare i plug-in non aperti da WavelLab Elements. Inserire i nomi dei
file, senza percorso ed estensione del file. Scrivere ogni plug-in in una nuova riga.

Se siinserisce il carattere * prima del nome, qualsiasi plug-in contenente tale nome
viene ignorato.

Forza l'individuazione dei plug-in al lancio successivo

Consente di analizzare i plug-in al successivo avvio di WavelLab Elements. Per ridurre
il tempo di avvio di WavelLab Elements, i plug-in non vengono analizzati a ogni avvio
di WavelLab Elements. Tuttavia, WavelLab Elements mantiene un elenco dei plug-in e lo
aggiorna automaticamente quando viene rilevata una modifica di data o dimensioni.

Ignora i plug-in aggiornati durante il rilevamento dei plug-in

Se questa opzione € attivata, WavelLab Elements non verifica se le proprieta dei plug-in
aggiornati sono cambiate. Se si hanno dei plug-in che vengono aggiornati spesso,
questa opzione velocizza I'avvio di WavelLab Elements.

Tuttavia, alcuni produttori combinano piu plug-in in un unico file. Se si ha la certezza
che alcuni plug-in sono stati aggiunti dal produttore ma non compaiono in WavelLab

Elements, disattivare questa opzione e riavviare WavelLab Elements. Successivamente &
possibile riattivare questa opzione.

Aggiornamento della grafica piu rapido (consumo maggiore di potenza di calcolo)
Consente di aggiornare la grafica dei plug-in VST piu rapidamente.

Manopole plug-in VST

Consente di impostare la modalita per l'utilizzo delle manopole nei plug-in. Le opzioni
disponibili sono Modalita circolare, Modalita circolare (movimento relativo) e
Modalita lineare.
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Scheda Organizza

i=Collapse < Show All Plug-ins ¥

me Precision Effect Final W Shortcut Custom Category File Name
4= Show Changes
Sort by
Compress Hi

5

bmenus
naming

Original Modified

Submenu with Recently Used Plug-ins

Elenco dei plug-in

Consente di visualizzare la gerarchia dei plug-in in WaveLab Elements. Nella colonna
Fin/Dith é possibile specificare se un plug-in deve essere disponibile dai menu

di selezione dei plug-in e/o dal pannello Effetto di finalizzazione/Dithering della
Sezione Master.

E possibile aggiungere dei plug-in all'elenco Preferiti, creare scorciatoie per i plug-in,
specificare categorie personalizzate e decidere se utilizzare l'interfaccia utente generica
o l'interfaccia utente specifica per il plug-in.

La colonna Precisione visualizza la precisione del processamento di ciascun plug-in.
I plug-in a 64 bit in virgola mobile sono in grado di eseguire il processamento a
precisione doppia. Negli altri menu degli effetti allinterno di WaveLab Elements, i
plug-in capaci di eseguire il processamento a precisione doppia sono contrassegnati
dalla dicitura «64 F», a indicare 64 bit in virgola mobile (float).

NOTA

Il processamento a 64 bit in virgola mobile, rispetto al formato 32 bit in virgola
mobile ha una precisione doppia ma richiede un tempo di processamento leggermente
maggiore.

Espandi/Riduci
Consente di espandere o ridurre la struttura ad albero.

Campo di ricerca
Consente di filtrare I'elenco dei plug-in in base ai nomi.
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e Fare clic sul campo diricerca e inserire il testo che si desidera cercare.
e Per portare il focus dal campo di ricerca all'elenco di plug-in, premere Freccia giu.
e Per portare il focus dall'elenco di plug-in al campo di ricerca, premere Ctrl/Cmd -
F.
Menu Filtro
Consente di visualizzare solamente i plug-in che possiedono determinate proprieta.

e L'opzione Visualizza tutti i plug-in consente di visualizzare tutti i plug-in.

e L'opzione Visualizza i nuovi plug-in consente di visualizzare solamente i plug-in
individuati di recente.

e L'opzione Visualizza i plug-in a 32 bit in virgola mobile consente di visualizzare
solamente i plug-in in grado di gestire il processamento a 32 bit in virgola mobile.

e |'opzione Visualizza i plug-in a 64 bit in virgola mobile consente di visualizzare
solamente i plug-in in grado di gestire il processamento a 64 bit in virgola mobile.

e Visualizza i plug-in con una categoria personalizzata consente di visualizzare
solamente i plug-in che hanno una categoria personalizzata.

e Visualizza i plug-in senza una categoria personalizzata consente di visualizzare
solamente i plug-in che non hanno una categoria personalizzata.
Rimuovi lo stato "nuovo"

Consente di reinizializzare lo stato «nuovo» dei plug-in recentemente rilevati.

Visualizza le modifiche
Consente di aggiornare la struttura dei plug-in in base alle impostazioni correnti.

Ordinamento
Determina il modo in cui sono organizzati i plug-in. Gli altri parametri agiscono su tale
gerarchia.

Comprimi la gerarchia

Consente di unire tutti gli elementi in un singolo sotto menu, nel caso in cui un sotto
menu e tutti i relativi sotto menu contengono un numero di plug-in inferiore rispetto a
un valore specifico (Soglia).

Il valore Soglia determina il numero minimo di elementi necessari per comprimere la
gerarchia.
Crea dei sotto menu sulla base dei prefissi

Consente di creare un sotto menu con etichetta uguale al prefisso nel caso in cui piu
elementi in un sotto menu iniziano con lo stesso prefisso.

Il valore Soglia determina il numero minimo di elementi che devono iniziare con lo
stesso prefisso, necessari per creare dei sotto menu con etichetta uguale al prefisso.
Fondi i singoli sotto menu
Consente di unire sotto menu che contengono un altro sotto menu con un singolo
elemento.
Rinomina Categoria

Le etichette delle categorie utilizzate per creare la gerarchia vengono fornite dal
produttore del plug-in. In questa sezione & possibile modificare il nome della categoria.
E inoltre possibile unire due categorie in una, rinominandole con lo stesso nome.

Sotto-menu con i plug-in utilizzati di recente
Se questa opzione € attivata, viene visualizzato il sotto menu Utilizzati di recente.
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Il valore Dimensione massima consente di determinare il numero massimo di plug-in
nel sotto menu Utilizzati di recente.

L'opzione Menu indipendenti dei plug-in utilizzati di recente consente di
determinare se il sotto menu Utilizzati di recente é globale per tutte le posizioni in cui
é possibile selezionare i plug-in o se & indipendente per ciascun contesto.

Plug-in ignorati
Consente di aprire la finestra di dialogo Plug-in ignorati in cui & possibile visualizzare
i plug-in che non sono stati caricati. Mediante questa finestra di dialogo & possibile
impostare una nuova scansione dei plug-in all'avvio successivo di WavelLab Elements.
Si tratta di un‘operazione pil rapida rispetto all'esecuzione di una nuova scansione
completa.

Numero di plug-in
Consente di visualizzare il numero di plug-in disponibili in WaveLab Elements.

Touch Bar (solo macOS)

La Touch Bar in cima alla tastiera offre delle scorciatoie per le funzioni di WaveLab Elements. La
Touch Bar cambia automaticamente in base a dove ci si trova all'interno di WavelLab Elements
e offre un sotto insieme delle opzioni disponibili. La Touch Bar puo essere personalizzata a
seconda delle proprie necessita.

NOTA

La Touch Bar & disponibile solamente su determinati prodotti Apple.

LINK CORRELATI
Personalizzazione della Touch Bar (solo macOS) a pag. 404

Personalizzazione della Touch Bar (solo macOS)

E possibile personalizzare la Touch Bar nella rispettiva finestra di personalizzazione.

OPZIONI

e Per aprire la finestra di personalizzazione della Touch Bar, selezionare WaveLab Elements
11 > Personalizza Touch Bar.

e Per aggiungere un'opzione alla Touch Bar, utilizzare il cursore per trascinare le opzioni
preferite dalla finestra di personalizzazione alla Touch Bar stessa.

Completata l'operazione, toccare Fine sulla Touch Bar o fare clic su Fine sullo schermo.

e Per modificare I'ordine delle opzioni all'interno della Touch Bar, trascinarle verso sinistra o
verso destra.

e Per rimuovere le opzioni dalla Touch Bar, trascinarle in alto e al di fuori della Touch Bar
stessa.

LINK CORRELATI
Touch Bar (solo macOS) a pag. 404
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Elements

E possibile configurare WaveLab Elements in base alle proprie esigenze.
NOTA

Le impostazioni definite nelle preferenze vengono applicate quando si passa ad un‘altra finestra
di WavelLab Elements.

Preferenze globali

Le Preferenze globali sono preferenze che si applicano in WavelLab Elements in senso
complessivo. Prima di iniziare a lavorare con WavelLab Elements, si consiglia di modificare queste
preferenze in modo da configurare il programma sulla base delle proprie esigenze.

e Per aprire le Preferenze globali, selezionare File > Preferenze > Globale.

LINK CORRELATI

Scheda Generale (Preferenze globali) a pag. 405

Scheda Visualizzazione (Preferenze globali) a pag. 407
Scheda Audio (Preferenze globali) a pag. 408

Scheda Formati (Preferenze globali) a pag. 409

Scheda Scrittura CD (Preferenze globali) a pag. 410

Scheda Opzioni (Preferenze globali) a pag. 410

Scheda Applicazioni esterne (Preferenze globali) a pag. 410

Scheda Generale (Preferenze globali)

In questa scheda & possibile modificare la localizzazione dei file delle impostazioni e la lingua
dell'interfaccia utente. Affinché le modifiche abbiano effetto & necessario riavviare il programma.

e Per aprire la scheda Generale delle Preferenze globali, selezionare File > Preferenze >
Globale e fare clic su Generale.

Generale

Lingua
Consente di selezionare la lingua dell'interfaccia utente.

Localizzazione delle impostazioni

Comune per tutti gli utenti

Consente di condividere le impostazioni delle preferenze con tutti gli utenti sul
computer in uso.

Indipendente per ciascun utente
Consente a ogni utente del computer in uso di configurare le impostazioni preferite.
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Cartella dell'applicazione (installazione portatile)
Consente di salvare le impostazioni nella directory dell'applicazione. Utilizzare questa
opzione per installare I'applicazione su un dispositivo portatile.

Cartella specifica
Consente di salvare le impostazioni in una cartella specifica.

Apri la cartella delle impostazioni

Consente di aprire la cartella utilizzata per salvare le impostazioni. In questo modo
é possibile conoscere la posizione di salvataggio delle impostazioni ed eseguirne il
backup.

Impostazioni di sincronizzazione

Cartella master
Consente di specificare la posizione di salvataggio delle impostazioni delle preferenze.

Sincronizza a ciascun lancio
Se questa opzione € attivata, le impostazioni vengono sincronizzate ogni volta che
viene lanciato WavelLab Elements.

Sincronizza al prossimo lancio
Se questa opzione € attivata, le impostazioni vengono sincronizzate al successivo lancio
di WavelLab Elements.

Gestione delle preferenze
Consente di determinare la modalita di sincronizzazione delle preferenze (ovvero, tutte
le impostazioni tranne i preset). E possibile ignorarle o rispecchiarle.

Gestione dei preset
Consente di determinare la modalita di sincronizzazione dei preset salvati nella cartella
master. Sono disponibili le sequenti opzioni:
e Ignorai preset: se ¢ attivata, i preset non vengono sincronizzati.

e Rispecchiai preset: se é attivata, i preset vengono ripristinati dalla cartella
master, indipendentemente dal relativo time stamp. Qualsiasi preset locale
aggiuntivo viene eliminato.

e Importa i nuovi preset: se ¢ attivata, vengono importati i preset nella cartella
master che non sono disponibili nel computer.

e Aggiorna i vecchi preset: se € attivata, i preset esistenti vengono sovrascritti se &
disponibile una nuova versione nella cartella master.
Ignora le cartelle dei preset seguenti (separarle con un punto e virgola)

Consente di specificare quali cartelle dei preset ignorare durante la sincronizzazione
delle impostazioni. Ad esempio, per ignorare le impostazioni della sezione Connessioni
audio, aggiungere Connessioni audio al campo.

Aggiorna il master

Se si fa clic su questo pulsante, le impostazioni in uso durante il lancio di WavelLab
Elements vengono utilizzate per aggiornare la cartella master.

NOTA

Questa procedura pud essere eseguita dall'amministratore di sistema se sono in uso
piu workstation di WaveLab Elements.
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LINK CORRELATI
Preferenze globali a pag. 405

Scheda Visualizzazione (Preferenze globali)

Questa scheda consente di modificare numerosi aspetti dell'interfaccia utente da applicare
allintero programma. Le opzioni qui presenti forniscono una serie di informazioni e funzioni
utili per migliorare I'utilizzo del prodotto, le quali possono comunque essere disattivate per
semplificare e ottimizzare l'interfaccia.

e Per aprire la scheda Visualizzazione delle Preferenze globali, selezionare File >
Preferenze > Globale e fare clic su Visualizzazione.

Stile

Tema
Consente di alternare i diversi schemi di colori di WaveLab Elements.

Opzioni varie

Visualizza I'applicazione a DPI elevato (solo Windows)

Se questa opzione € attivata e lo schermo utilizzato supporta l'alta risoluzione,
Wavelab Elements viene visualizzato in alta risoluzione. Se l'alta risoluzione non &
supportata, questa opzione viene ignorata.

NOTA

Le finestre dei plug-in non vengono visualizzate in alta risoluzione. Se le finestre dei
plug-in appaiono troppo piccole, disattivare 'opzione Visualizza I'applicazione a DPI
elevato.

Limita la scala ai multipli di 100

Se questa opzione € attivata, sono supportati solamente i fattori di scala multipli di
100. Ad esempio, se si utilizza un fattore di scala del 150 % in WaveLab Elements, il
ridimensionamento utilizzato & pari al 200 %.

Se questa opzione & disattivata, sono possibili anche valori intermedi come il 150 %.

Utilizza il selettore dei file di sistema per aprire i file

Se questa opzione € attivata, quando si seleziona Salva con nome si apre il selettore
dei file standard.

Apri il selettore rapido dei file quando si salvano i file

Se questa opzione € attivata e si salva un file per mezzo della scorciatoia del comando
di salvataggio, si apre una finestra di dialogo al posto della scheda File.

Nascondi le schede non utilizzate della barra multifunzione
Se questa opzione € attivata, le schede non utilizzate della barra multifunzione
vengono nascoste.

Visualizza il logo di WaveLab Elements all'avvio
Consente di determinare se visualizzare il logo di WaveLab Elements durante
I'inizializzazione del programma.

Visualizza i tooltip

Se questa opzione € attivata, i tooltip vengono visualizzati quando si sposta il cursore
del mouse sui pulsanti della barra dei comandi o sui marker.

407



Configurazione di WavelLab Elements
Preferenze globali

Nascondi le finestre piu in alto quando l'applicazione non é attiva (solo Windows)
Se questa opzione € attivata, tutte le finestre fluttuanti vengono automaticamente
nascoste quando un’altra applicazione diventa attiva. Se & disattivata, le finestre
fluttuanti rimarranno in alto rispetto alle altre finestre dell'applicazione.

Storia

Numero massimo di voci nei menu dei file recenti
Consente di impostare il numero massimo di file elencati nei menu dei file recenti.

LINK CORRELATI
Preferenze globali a pag. 405

Scheda Audio (Preferenze globali)

Questa scheda consente di modificare le preferenze audio, come ad esempio la precisione del
processamento.

e Per aprire la scheda Audio delle Preferenze globali, selezionare File > Preferenze > Globale
e fare clic su Audio.

Precisione del processamento

L'opzione Precisione del processamento consente di selezionare la precisione del
processamento per i plug-in.

e Sesiseleziona 64 bit in virgola mobile e un plug-in & in grado di processare i
campioni a 64 bit, il processamento opera a 64 bit senza perdita di qualita.

Se un plug-in puo gestire solamente i campioni a 32 bit, WaveLab Elements
converte tutti i campioni a 64 bit in virgola mobile nel formato 32 bit in virgola
mobile prima di inviarli al plug-in. Al termine del processamento del plug-in,
Wavelab Elements converte nuovamente i campioni a 32 bit in virgola mobile nel
formato 64 bit in virgola mobile senza alcuna perdita di qualita.

e Sesiseleziona il formato 32 bit in virgola mobile, WavelLab Elements converte
tutti i campioni a 64 bit in virgola mobile nel formato 32 bit in virgola mobile prima
di inviarli al plug-in. Al termine del processamento del plug-in, WavelLab Elements
converte nuovamente i campioni a 32 bit in virgola mobile nel formato 64 bit in
virgola mobile senza alcuna perdita di qualita.

Nei menu dei plug-in, gli indicatori «32F» e «64F» accanto ai nomi dei plug-in mostrano
rispettivamente se uno specifico plug-in & in grado di operare a 32 bit in virgola mobile
0 a 64 bit in virgola mobile.

NOTA

Il processamento a 64 bit in virgola mobile, rispetto al formato 32 bit in virgola
mobile ha una precisione doppia ma richiede un tempo di processamento leggermente
maggiore.

L'opzione File temporanei consente di selezionare la precisione dei file temporanei che
vengono creati da WavelLab Elements nel corso del processamento dell'audio.

Per impostazione predefinita, WavelLab Elements crea dei file temporanei a 32 bit in
virgola mobile. Utilizzare l'opzione 64 bit in virgola mobile se si desidera creare dei file
audio a 64 bit in virgola mobile o dei file PCM a 32 bit.
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NOTA

I file temporanei a 64 bit in virgola mobile hanno una precisione doppia ma richiedono
un tempo di lettura e scrittura maggiore rispetto al formato 32 bit in virgola mobile e i
relativi file hanno dimensione doppia.

LINK CORRELATI
File temporanei a pag. 69
Preferenze globali a pag. 405

Scheda Formati (Preferenze globali)

Questa scheda consente di regolare le impostazioni per alcuni dei formati e delle unita audio
utilizzati da WavelLab Elements.

e Per aprire la scheda Formati delle Preferenze globali, selezionare File > Preferenze >
Globale e fare clic su Formati.

Formati

Usa lo standard AES17 per i valori RMS
Consente di determinare la modalita di segnalazione dei valori RMS.

e Se questa opzione € attivata, il livello visualizzato per un file audio a onda seno a
scala piena € 0 dB. Segue lo standard AES17.

e Se questa opzione e disattivata, il livello visualizzato per un file audio a onda seno a
scala piena é -3 dB.

Altezza di A3 (usata nella conversione da frequenza a nota)
Consente di impostare I'altezza di riferimento in WaveLab Elements. Le conversioni da
frequenza a nota useranno questo valore di altezza come riferimento.

Crea dei nomi per i file compatibili con Windows (solo macOS)

Alcuni caratteri per i nomi dei file, come ad esempio | e\, non sono supportati in
Windows. Se questa opzione é attivata e si salva un file, WavelLab Elements converte i
caratteri non supportati in caratteri che sono supportati in Windows.

Visualizzazione delle note MIDI

Le opzioni in questa sezione consentono di scegliere se visualizzare i vari tasti in WavelLab
Elements con l'altezza o il numero della nota MIDI del tasto. Nella notazione musicale, i tasti sono
delimitati in base alle altezze relative. Ad esempio, C3 indica la nota C (Do) nella terza ottava.

Ciascun tasto corrisponde a un numero di nota MIDI da 0 a 127. Ad esempio, il tasto C3
corrisponde al numero di nota MIDI 48. I numeri di nota MIDI consentono ai campionatori di
mappare automaticamente i campioni dei tasti corretti.
Stile numerico

Consente di determinare il formato per le note MIDI visualizzate come numeri.

C centrale (nota #60)
Consente di determinare la convenzione dei tasti per I'intervallo di note MIDI (0-127).

Riquadro di visualizzazione

Consente di determinare la modalita di visualizzazione delle note MIDI
nell'applicazione.
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LINK CORRELATI
Preferenze globali a pag. 405

Scheda Scrittura CD (Preferenze globali)

In questa scheda & possibile impostare una serie di parametri per la scrittura di un CD.

e Per aprire la scheda Scrittura CD delle Preferenze globali, selezionare File > Preferenze >
Globale e fare clic su Scrittura CD.

Scrittura di un CD

Utilizza Burnproof
Consente di risolvere automaticamente possibili errori di buffer underrun, a patto che
il masterizzatore di CD supporti questa tecnologia.

Consenti I'overflow del disco
Consente a WavelLab Elements di tentare di scrivere piu dati (massimo 2 minuti)
rispetto alla capacita ufficiale del disco.

Dimensione massima del CD Audio

Consente di specificare la lunghezza massima per un CD. Se il progetto audio supera
questa lunghezza, viene visualizzato un messaggio di allerta. La lunghezza massima
standard & di 74 minuti.

LINK CORRELATI
Preferenze globali a pag. 405

Scheda Opzioni (Preferenze globali)

Questa scheda consente di reinizializzare i riquadri dei messaggi predefiniti.

e Per aprire la scheda Opzioni delle Preferenze globali, selezionare File > Preferenze >
Globale e fare clic su Opzioni.
Reinizializza le risposte predefinite

Consente di riportare tutte le opzioni dei box dei messaggi alle rispettive impostazioni
predefinite. Ad esempio, vengono disattivate tutte le opzioni Non mostrare piu.

LINK CORRELATI
Preferenze globali a pag. 405

Scheda Applicazioni esterne (Preferenze globali)
Questa scheda consente di specificare un browser dei file esterno alternativo.

e Per aprire la scheda Applicazioni esterne delle Preferenze globali, selezionare File >
Preferenze > Globale e fare clic su Applicazioni esterne.

Browser dei file esterno alternativo

Consente di specificare un browser dei file esterno alternativo che si apre quando si
utilizzano le opzioni Mostra la cartella in Esplora file/Mac OS Finder o Mostra i file
in Esplora file/Mac OS Finder in WavelLab Elements.

Se l'applicazione richiede una speciale formattazione della riga di comando, & possibile
specificarla nel campo Riga di comando. Utilizzare %1 come segnaposto per il file o la
cartella che si desidera raggiungere.
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LINK CORRELATI
Preferenze globali a pag. 405
Browser dei file esterno alternativo a pag. 420

Preferenze dei file audio

In questa finestra di dialogo € possibile definire una serie di impostazioni relative alle operazioni
di editing effettuabili nell’Editor audio. Tali impostazioni hanno comunque effetto anche su altre
parti di Wavelab Elements. E possibile scegliere le impostazioni predefinite per la modifica e |a
riproduzione, regolare l'aspetto dei display delle forma d'onda e determinare il funzionamento di
Wavelab Elements con l'audio e i file di picco.

e Per aprire la scheda Preferenze dei file audio, selezionare File > Preferenze > File audio.

LINK CORRELATI

Scheda Modifica (Preferenze dei file audio) a pag. 411
Scheda File (Preferenze dei file audio) a pag. 413
Scheda Stile (Preferenze dei file audio) a pag. 413

Scheda Modifica (Preferenze dei file audio)

Visualizzazione

Salva le impostazioni associate nel file compagno
Se questa opzione € attivata, le impostazioni di ingrandimento, le impostazioni del
righello e facoltativamente il preset della Sezione Master associato al file audio,
vengono salvati in un file compagno. Se il file audio viene riaperto, vengono utilizzate
queste impostazioni. L'eliminazione di un file compagno non modifica i contenuti
audio.

Salva in una cartella indipendente

Se questa opzione € attivata, il file compagno non viene salvato nella stessa cartella del
relativo file audio, ma in una cartella diversa che & possibile specificare.

Modifica

Consente di aprire la finestra di dialogo Cartelle dove & possibile specificare la
posizione di salvataggio dei file compagno.

Visualizza la vista globale quando si aprono dei nuovi file audio
Se questa opzione e attivata, quando viene aperto un file audio viene visualizzata
anche una vista panoramica. Se questa opzione € disattivata, viene visualizzata
solamente la vista principale.

Visualizza I'anteprima solamente per i file mono e stereo
Se questa opzione e attivata, la finestra della vista d'insieme viene visualizzata quando
si aprono dei file mono e stereo, mentre viene nascosta quando si aprono file audio
multicanale. Per visualizzare la vista d'insieme per i file audio multicanale, fare clic in
cima alla finestra principale ed eseguire un trascinamento verso il basso.
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Vista panoramica: gli indicatori passivi coprono anche la forma d'onda

Se questa opzione € attivata, l'indicatore dell'intervallo visualizzato nel righello del
tempo della vista panoramica copre anche l'area della forma d'onda. A differenza
dell'indicatore del righello del tempo, l'indicatore dell'intervallo & passivo e non pud
essere modificato.

Emulazione analogica della forma d'onda al livello di zoom dei campioni

Se questa opzione € attivata e una forma d'onda viene zoomata al livello dei singoli
campioni nella linea del tempo, viene visualizzata un'emulazione analogica della forma
d’'onda.

Ingrandimento automatico per conservare la vista d'insieme

Se questa opzione € attivata e si apre un file audio, ingrandimento della vista
d'insieme & impostato in modo da visualizzare l'intero file.

Visualizza I'estensione dei file nelle schede

Se questa opzione € attivata, nelle schede vengono visualizzati i nomi dei file con le
relative estensioni. Ad esempio, «piano.mp3» al posto di «piano».

Numero di secondi da visualizzare all'apertura

Consente di specificare l'intervallo di tempo da visualizzare quando si apre un file audio
per la prima volta. WavelLab Elements converte questo intervallo di tempo nel fattore di
ingrandimento appropriato.

Intero file audio

Se questa opzione € attivata, I'ingrandimento orizzontale & impostato in modo da
visualizzare l'intero file.

Modifica

Processa l'intero file se non € presente una selezione

Se questa opzione ¢ attivata e sta per essere applicato un processo a un file audio,
viene processato l'intero file nel caso in cui non & selezionata alcuna parte audio.

Nella medesima situazione, se 'opzione non é attiva viene visualizzato un messaggio di
allerta.

Consenti I'annullamento delle modifiche dopo il salvataggio

Se questa opzione € attivata, € possibile annullare le modifiche dopo il salvataggio del
file. Questa opzione puo essere disattivata se si desidera utilizzare meno spazio su
disco o per rimuovere tutti i file temporanei durante il salvataggio del file.

Scrubbing della riproduzione

Solo con lo strumento Riproduci
Se questa opzione € attivata, la funzione ha effetto solo se viene utilizzato lo strumento
Riproduci.

Sensibilita
Consente di impostare la durata del loop del micro audio che viene eseguito quando si
sposta il cursore del mouse sopra il righello del tempo.

Aggancia selezione al punto di zero

Non eseguire I'agganciamento a fattori di ingrandimento elevati

Se questa opzione € attivata, lo scatto non ha luogo se viene visualizzata la forma
d’'onda a un fattore di ingrandimento elevato.
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Intervallo di scansione

Consente di definire I'intervallo in base al quale WavelLab Elements cerca un punto di
zero in direzione sinistra e destra.

LINK CORRELATI
Preferenze dei file audio a pag. 411
Scrubbing della riproduzione a pag. 106

Scheda File (Preferenze dei file audio)

Supporto del formato file RF64

Se questa opzione ¢ attivata, WavelLab Elements crea dei file WAV che possono essere
piu grandi di 2 GB.

NOTA

Questo formato file non & supportato da tutte le applicazioni.

Frequenza di campionamento predefinita per i file senza intestazione
Consente di specificare la frequenza di campionamento dei file audio che non
possiedono un’intestazione che descrive questa proprieta.

Crea file di picco in una cartella indipendente

Se questa opzione € attivata, i file di picco non vengono salvati nella stessa cartella del
file audio di riferimento. Per specificare la posizione della cartella, fare clic su Modifica.

LINK CORRELATI
Preferenze dei file audio a pag. 411

Scheda Stile (Preferenze dei file audio)

Questa scheda consente di specificare dei colori personalizzati per le diverse parti della finestra
della forma d'onda.

Tema

In questo elenco e possibile selezionare gli stili condizionali e predefiniti.

Parti

Vengono mostrate le parti a cui & possibile applicare un colore. Fare clic su una parte
per modificarne la colorazione.

Nascondi (solo per specifiche parti)
Consente di selezionare la parte selezionata.

Linea punteggiata (solo per specifiche parti)
Consente di modificare la linea in una linea punteggiata.

Trasparenza (solo per specifiche parti)
Consente di modificare il grado di trasparenza dell'elemento selezionato.

Dimensioni dell’elemento (solo per specifiche parti)
Consente di modificare le dimensioni dell'elemento selezionato.
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Cambia entrambi i canali, se applicabile

Consente di definire impostazioni di colore separate per il lato destro e sinistro di un
file stereo. Se questa opzione € attivata, le impostazioni per il lato sinistro di un file si
rispecchiano automaticamente sul lato destro e viceversa.

Attenua il cursore di riproduzione per i canali in mute
Se questa opzione & attivata, la parte del cursore di riproduzione che si sovrappone ai
canali audio in mute é trasparente.

Modifica la vista principale e la vista d'insieme
Consente di configurare impostazioni di colore separate per la vista principale e
quella d'insieme. Se questa opzione & attivata, le impostazioni per la vista principale
si rispecchiano automaticamente sulla vista d'insieme e viceversa.

Selettore del colore
Consente di selezionare il colore per la parte selezionata. Fare clic nel cerchio esterno
per selezionare la tinta. Fare clic nel triangolo per regolare la saturazione e la
luminosita.

Rosso/Verde/Blu
Consente di specificare i componenti rosso, verde e blu dello spettro di colori RGB.

Copia colore
Consente di copiare il colore corrente negli appunti.

Incolla
Consente di incollare il colore dagli appunti.

Questo stile viene usato se si applicano le seguenti condizioni

Queste opzioni consentono di definire le condizioni in base alle quali viene applicato
uno specifico stile di colori.

L'estensione del file & una tra le seguenti
Se questa opzione € attivata, lo stile viene applicato ai file con l'estensione specificata.
Separare le estensioni con un carattere «;».

Il nome contiene una delle seguenti parole chiave

Se questa opzione € attivata, lo stile viene applicato ai file il cui nome contiene
specifiche parole chiave. Separare le parole chiave con un carattere «;».

La frequenza di campionamento é compresa tra
Se questa opzione € attivata, lo stile viene applicato ai file che presentano una
frequenza di campionamento ricompresa entro l'intervallo specificato.

La profondita in bit & compresa tra
Se questa opzione € attivata, lo stile viene applicato ai file che presentano una
profondita in bit ricompresa entro l'intervallo specificato.

Il numero di canali & pari a

Se questa opzione € attivata, lo stile viene applicato ai file che presentano il numero di
canali specificato.

LINK CORRELATI

Preferenze dei file audio a pag. 411
Assegnazione dei colori agli elementi dell'Editor audio a pag. 415
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Assegnazione dei colori agli elementi dell’Editor audio

E possibile assegnare dei colori personalizzati ai vari elementi dellEditor audio. A seconda
dell'elemento selezionato, & possibile configurare impostazioni aggiuntive per trasparenza,
aspetto o definire se & necessario punteggiare una linea, ad esempio.

Canale sinistro/Canale destro

Forma d'onda
Il colore della forma d’'onda.

Forma d'onda (selezionata)
Il colore della forma d'onda della parte selezionata della forma d'onda.

Contorno della forma d'onda
Il colore del contorno della forma d'onda.

Contorno della forma d'onda (selezionato)
Il colore del contorno della parte selezionata della forma d'onda.

Sfondo alto
Il colore dello sfondo alto.

Sfondo alto (selezionato)
Il colore della parte selezionata dello sfondo alto.

Sfondo basso
Il colore dello sfondo basso.

Sfondo basso (selezionato)
Il colore della parte selezionata dello sfondo basso.

Asse principale della forma d'onda
Il colore dell'asse principale della forma d'onda e del relativo stile.

Asse 50% della forma d'onda
Il colore dell'asse 50% della forma d’onda e il relativo stile.

Elementi della forma d’onda

Separatore di canale
Il colore della linea separatore di canale.

Cursore (modifica)
Il colore del cursore di modifica, la relativa ampiezza e trasparenza.

Cursore (modifica, no focus)
Il colore del cursore di modifica per un file che non presenta il focus.

Cursore (riproduzione)
Il colore del cursore durante la riproduzione.

Segnale Pre/Post-Roll
Il colore del segnale pre/post-roll.

Linea dei marker
Il colore delle linee dei marker e una trasparenza opzionale.

Linea dell'indicatore di modifica
Il colore della linea dell'indicatore di modifica.
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Testa dell'indicatore di modifica
Il colore della testa dell'indicatore di modifica.

Indicatore di fine file
Il colore dell'indicatore di fine file.

Stile del righello dei tempi
Il colore del righello dei tempi e il relativo stile.

Font del righello dei tempi
Il colore del font nel righello dei tempi e la dimensione del font.

Stile del righello del livello
Il colore del righello del livello, il relativo stile e trasparenza.

Font del righello del livello
Il colore del font nel righello del livello e la dimensione del font.

LINK CORRELATI
Preferenze dei file audio a pag. 411
Scheda Stile (Preferenze dei file audio) a pag. 413

Preferenze dei montaggi audio

Questa finestra di dialogo consente di definire una serie di parametri generali per tutti i
montaggi audio o solo per il montaggio audio attivo.

e Per aprire la scheda Preferenze dei montaggi audio, selezionare File > Preferenze >
Montaggi audio.

LINK CORRELATI
Scheda Stile (Preferenze dei montaggi audio) a pag. 416

Scheda Stile (Preferenze dei montaggi audio)

Questa scheda consente di specificare i colori personalizzati di clip e parti di una clip nella
finestra di montaggio.
Tema

Consente di alternare i diversi schemi di colori di WaveLab Elements.

Parti
Vengono mostrate le parti a cui & possibile applicare un colore. Fare clic su una parte
per modificarne la colorazione.

Casella di controllo
Consente di selezionare piu parti da colorare tutte contemporaneamente.

Annulla
Consente di annullare I'ultima modifica. Questa azione & possibile anche dopo il
salvataggio del file.

Ripeti
Consente di ripetere le modifiche precedentemente annullate. Questa azione &
possibile anche dopo il salvataggio del file.
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Nascondi
Nasconde la parte selezionata.

Cambia entrambi i canali, se applicabile

Consente di configurare impostazioni di colore separate per il lato destro e sinistro
delle clip stereo. Se questa opzione ¢ attivata, le impostazioni per il lato sinistro di una
clip si rispecchiano automaticamente sul lato destro e viceversa.

Attenua il cursore di riproduzione per le tracce in mute

Se questa opzione & attivata, la parte del cursore di riproduzione che si sovrappone alle
tracce in mute e trasparente.

Selettore del colore
Consente di selezionare il colore per la parte selezionata. Fare clic nel cerchio esterno
per selezionare la tinta. Fare clic nel triangolo per regolare la saturazione e la
luminosita.

Rosso/Verde/Blu
Consente di specificare i componenti rosso, verde e blu dello spettro di colori RGB.

Copia colore
Consente di copiare il colore corrente negli appunti.

Incolla
Consente di incollare il colore dagli appunti.

Questo stile viene usato se si applicano le seguenti condizioni
Queste opzioni consentono di definire le condizioni in base alle quali viene applicato
uno specifico stile di colori.

L'estensione del file & una tra le seguenti
Se questa opzione € attivata, lo stile viene applicato alle clip che fanno riferimento a un
file con I'estensione specificata. Separare le estensioni con un carattere «;».

Il nome contiene una delle seguenti parole chiave
Se questa opzione € attivata, lo stile viene applicato alle clip il cui nome contiene
specifiche parole chiave. Separare le parole chiave con un carattere «;».

La frequenza di campionamento & compresa tra
Se questa opzione € attivata, lo stile viene applicato alle clip che fanno riferimento
a un file che presenta una frequenza di campionamento ricompresa entro l'intervallo
specificato.

La profondita in bit & compresa tra

Se questa opzione € attivata, lo stile viene applicato alle clip che fanno riferimento a un
file che presenta una profondita in bit ricompresa entro l'intervallo specificato.
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Il numero di canali & pari a

Se questa opzione € attivata, lo stile viene applicato alle clip che presentano il numero
di canali specificato.

LINK CORRELATI
Preferenze dei montaggi audio a pag. 416
Assegnare i colori agli elementi di un montaggio audio a pag. 418

Assegnare i colori agli elementi di un montaggio audio

E possibile assegnare dei colori personalizzati ai vari elementi della finestra di un montaggio
audio.

Colori delle clip
Sono disponibili i sequenti tipi di clip:

Regione della dissolvenza incrociata
Consente di impostare il colore dello sfondo per le sezioni delle clip sovrapposte.

Standard
I colori predefiniti, utilizzati per le clip per le quali non é stato selezionato alcun colore
specifico.

Bloccata
I colori utilizzati per le clip completamente bloccate.

In mute
I colori utilizzati per le clip in mute.

Personalizzato

Queste opzioni corrispondono agli elementi presenti nei sotto menu dei colori.
E possibile definire delle condizioni nella sezione Questo stile viene usato se
si applicano queste condizioni per impostare quando queste devono essere
automaticamente applicate.

Sono disponibili i seqguenti elementi del colore:

Sfondo alto/basso

I colori dello sfondo della clip. Gli sfondi di visualizzazione risultanti sono dissolvenze
sfumate dai colori in alto a quelli in basso.

Forma d’onda (normale, selezionata)
Il colore della forma d'onda per le clip selezionate e non selezionate.

Contorno della forma d’onda (normale, selezionato)
Il colore del contorno della forma d’onda per le clip selezionate e non selezionate.

Bordo
Il bordo sinistro e destro della clip.

Bordo (selezionato)
Il bordo sinistro e destro di una clip selezionata.

Asse (livello zero)

Il colore della linea punteggiata orizzontale al centro di una clip, che indica il livello
zero.
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Asse (meta livello)

Il colore delle linee punteggiate orizzontali a meta dal centro di una clip, che indica
meta livello.

Separatore di canale (clip stereo)
La linea che divide i due lati in una clip stereo.

Nome della clip
L'etichetta con il nome della clip.

Nome della clip attiva
L'etichetta con il nome della clip attiva.

Sfondo del nome della clip attiva
Lo sfondo dell'etichetta con il nome della clip attiva.

Varie

Sfondo alto/basso
I colori dello sfondo della vista della traccia per le aree senza una clip.

Sfondo (porzione selezionata) alto/basso
I colori dello sfondo nelle porzioni selezionate.

Cursore (modifica)/Cursore (modifica, no focus)/Cursore (riproduzione)
Il colore del cursore corrispondente.

Linea dei marker
Il colore delle linee dei marker nel montaggio audio.

Linea del cue-point
Il colore delle linee di cue-point punteggiate verticali e delle linee di cue-point di fine.

Linea della griglia temporale
Il colore della griglia temporale, se attivata nel menu del righello del tempo.

LINK CORRELATI
Preferenze dei montaggi audio a pag. 416
Scheda Stile (Preferenze dei montaggi audio) a pag. 416

Sincronizzazione delle impostazioni di WaveLab Elements su
piu computer

E possibile rendere alcune impostazioni di riferimento disponibili per altre installazioni di
Wavelab Elements. Queste impostazioni possono quindi essere utilizzate da altre workstation
di WavelLab Elements per mantenere le impostazioni sincronizzate su piu computer.

PROCEDIMENTO
1. Selezionare File > Preferenze > Globale.
2. Selezionare la scheda Generale.

3. Nella sezione Localizzazione delle impostazioni, specificare la posizione di salvataggio delle
impostazioni.
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Impostazioni multiutente

Se si utilizzano piu stazioni di WavelLab Elements in uno studio, una scuola, ecc., € possibile
impostare una di queste stazioni di WavelLab Elements come stazione master. I preset e le
preferenze condivisi di questa stazione possono quindi essere utilizzati da un’altra stazione slave.

E possibile ad esempio salvare queste impostazioni nella rete locale.

Se 'amministratore aggiorna queste impostazioni, le diverse stazioni di WavelLab Elements
possono sincronizzarsi con le impostazioni master. E inoltre possibile utilizzare questa
funzionalita per i singoli computer allo scopo di eseguire il backup di un'impostazione di
riferimento e tornarvi, se necessario.

Le impostazioni nella scheda Generale della finestra di dialogo Preferenze globali non sono
sincronizzate. Queste vengono salvate per ciascun utente nei file startup.ini (Windows) o
startup.plist (Mac).

IMPORTANTE

La sincronizzazione delle impostazioni non puo essere eseguita tra PC e Mac.

Impostazione di una configurazione multiutente

E possibile utilizzare le impostazioni applicate in una stazione WavelLab Elements master per altre
stazioni WaveLab Elements slave.

PROCEDIMENTO

1. Configurare una stazione WavelLab Elements con tutte le impostazioni e i preset che si
desidera utilizzare in altre stazioni WaveLab Elements.

2. Assegnare un accesso in sola lettura alla cartella delle impostazioni della stazione WavelLab
Elements master.

3. Aprire WavelLab Elements in un‘altra stazione per cui si desidera utilizzare le impostazioni
master.

4. Selezionare File > Preferenze > Globale.
5. Selezionare la scheda Generale.

6. Nella sezione Impostazioni di sincronizzazione, configurare la Cartella master, specificare
dove sincronizzare le impostazioni e se includere preferenze e/o preset.

7. Chiudere Wavelab Elements.

8. Copiareilfile startup.ini (Windows) o startup.plist (Mac) della stazione slave di
Wavelab Elements nella cartella delle impostazioni delle altre stazioni slave di WaveLab
Elements.

RISULTATO

Tutte le stazioni WavelLab Elements slave utilizzano le impostazioni della stazione WavelLab
Elements master.

Browser dei file esterno alternativo

Per impostazione predefinita, WavelLab Elements utilizza il browser dei file del proprio sistema
operativo quando si cercano ad esempio dei file audio. E comunque possibile specificare un
browser dei file esterno alternativo nelle Preferenze.
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LINK CORRELATI
Impostazione di un browser dei file esterno alternativo a pag. 421

Impostazione di un browser dei file esterno alternativo

PROCEDIMENTO

1. Selezionare File > Preferenze > Globale.

2. Selezionare Applicazioni esterne.

3. Attivare la voce Browser dei file esterno alternativo.

4. Fare clic sul campo di testo per aprire il browser dei file.

5. Specificare la posizione file del browser dei file esterno alternativo.
6. Fare clic su OK.

LINK CORRELATI
Browser dei file esterno alternativo a pag. 420
Scheda Applicazioni esterne (Preferenze globali) a pag. 410
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